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1. Safety precautions

» Observe these precautions carefully to ensure safety.
» After reading this manual, pass the manual on to the end user to retain for future
reference.

» The user should keep this manual for future reference and refer to it as necessary. This
manual should be made available to those who repair or relocate the units. Make sure
that the manual is passed on to any future air conditioning system user.

: indicates a hazardous situation which, if not avoided, could result in

AWARNING . death or serious injury.

: indicates a hazardous situation which, if not avoided, could result in

A CAUTION|N minor or moderate injury.

CAUTION : addresses practices not related to personal injury, such as product
and/or property damage.

1-1. General precautions

A WARNING

Do not install the controller in areas where large amounts of oil, steam, organic solvents,
or corrosive gases (such as ammonia, sulfuric compounds, or acids), or areas where
acidic/alkaline solutions or special chemical sprays are used frequently. These substances
may significantly reduce the performance and corrode the internal parts, resulting in
electric shock, malfunction, smoke, or fire.

To reduce the risk of short circuits, current leakage, electric shock, malfunction, smoke, or
fire, do not wash the controller with water or any other liquid.

To reduce the risk of electric shock, malfunction, smoke, or fire, do not touch the electrical
parts, USB memory, or touch panel with wet fingers.

To reduce the risk of injury or electric shock, before spraying a chemical around the
controller, stop the operation and cover the controller.

To reduce the risk of injury, keep children away while installing, inspecting, or repairing the
controller.

If you notice any abnormality (e.g., burning smell), stop the operation, turn off the
controller, and consult your dealer. Continuing the operation may result in electric shock,
malfunction, or fire.

Properly install all required covers to keep moisture and dust out of the controller. Dust
accumulation and the presence of water may result in electric shock, smoke, or fire.

To reduce the risk of fire or explosion, do not place flammable materials or use flammable
sprays around the controller.

To reduce the risk of electric shock or malfunction, do not touch the touch panel, switches,
or buttons with a sharp object.

To avoid injury from broken glass, do not apply excessive force to the glass parts.

To reduce the risk of injury, electric shock, or malfunction, avoid contact with the sharp
edges of certain parts.
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Consult your dealer for the proper disposal of the controller. Improper disposal will pose a
risk of environmental pollution.

1-2. Precautions for relocating or repairing the unit

The controller must be repaired or moved only by qualified personnel. Do not disassemble
or modify the controller. Improper installation or repair may result in injury, electric shock,
or fire.

1-3. Additional precautions

CAUTION

To avoid discoloration, do not use benzene, thinner, or chemical rag to clean the controller.
When the controller is heavily soiled, wipe the controller with a well-wrung cloth that has
been soaked in water with mild detergent, and then wipe off with a dry cloth.

This appliance is not intended for use by persons (including children) with reduced
physical, sensory or mental capabilities, or lack of experience and knowledge, unless they
have been given supervision or instruction concerning use of the appliance by a person
responsible for their safety. Children should be supervised to ensure that they do not play
with the appliance.
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2. Introduction

AE-200A/AE-50A/AE-200E/AE-50E is a centralized controller.

EW-50A/EW-50E is an LCD-less total management system.

Any connected air conditioning systems can be operated or monitored on the AE-200A/AE-50A/AE-200E/AE-50E’s
LCD or the Web browser.

Each AE-200A/AE-50A/EW-50A/AE-200E/AE-50E/EW-50E can control up to a total of 50 indoor units and other
equipment. By connecting AE-200A/AE-200E (main controller) and AE-50A/AE-50E/EW-50A/EW-50E (sub
controllers), up to 200 indoor units and other equipment can be controlled.

Additionally, by integrating AE-200A/AE-50A/EW-50A/AE-200E/AE-50E/EW-50E using the Integrated Centralized
Control Web, up to 2,000 indoor units can be controlled.

Note: When connecting HWHP (QAHV) units or chiller units, the following restrictions must be observed.

+ Count each HWHP (QAHV) unit as two air conditioning units, and make sure the number of units that are equivalent to the
number of air conditioning units will not exceed 50 units.

* When connecting chiller units and other units together, count each chiller unit as three air conditioning units, and make
sure the number of units that are equivalent to the number of air conditioning units will not exceed 50 units.

* When connecting chiller units only, up to 24 chiller units can be connected.

This manual explains methods for configuring the necessary initial settings for when using the Air Conditioning
Control System.

Flow of the initial settings and trial run are shown in section 2-2 “Flow of the initial settings and trial run”.

2-1. Terms used in this manual
- “Centralized Controller AE-200A/AE-200E” is referred to as “AE-200.”
- “Centralized Controller AE-50A/AE-50E” is referred to as “AE-50.”
- “Centralized Controller EW-50A/EW-50E" is referred to as “EW-50.”
- “Booster unit” and “Water HEX unit” are referred to as “Air To Water (PWFY) unit.”
- “Advanced HVAC CONTROLLER” is referred to as “AHC.”
- “Hot Water Heat Pump unit” is referred to as “HWHP (CAHV, CRHV, QAHV) unit.”
- “e-Series chiller unit (EAHV, EACV)” is referred to as “Chiller unit.”
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2-2. Flow of the initial settings and trial run
This explains one example of settings procedures.

| Preparation of the PC

N\

4

[AE-200’s LCD or Web B

Settings with each centralized controller

rowser for Initial Settings]

« Unit Info./Basic Settings (including Date and Time settings)
» Network (IP address registration for each centralized controller)

N\

4

AE-200/AE-50/EW-50 update

or more AE-50/EW-50
Vv

Managing up to 200 units
with one AE-200 and one

Managing up to 50 units
with each AE-200/EW-50
respectively

AE-200’s LCD
Unit Info.: [System Exp] “Expand”

A4

AE-200’s LCD
Unit Info.: [System Exp] “Do not expand”
No settings with AE-50/EW-50

AE-200’s LCD
Network: Controller [Exp1-Exp4] selection
: Destination IP address setting

Vv

A4

License registration:
[AE-200’s LCD or Web Browser for Initial Settings]

N\

4

[Initial Setting Tool
Web Browser for Initial Settings
» Groups * HW Supply (AE-200’s LCD)

+ Pl Controller/Al Controller (Settings in

Unit Settings
, AE-200’s LCD, or

(for each centralized controller)]
+ Interlocked LOSSNAY - Blocks

» Energy Management Block (Initial Setting Tool or AE-200’s LCD)

“Measurement” screen on the AE-200’s

LCD and Web Browser for Initial Settings)

Not use Integrated Centralized Control
Web

Use Integrated Centralized Control

\/ Web

Floor for Integrated Cen

“Manage” for

tralized Control Web (in Floor Settings):

[Initial Setting Tool]
Set the [Managed centralized controller] setting to

each centralized controller.

\

Function
[AE-200’s LCD or Web Browser for Initial

respectively.
settings are available only on the Web

[Initial Se
* The interlocking control setting is availa

Settings
Settings (for each centralized controller)]

» Peak Cut and Interlock control will be available with a license registration

+ Set Temperature Range Limit, Night Mode Schedule and System-changeover

Browser for Initial Settings.
tting Tool]
ble only on the Initial Setting Tool.

\

| Trial run

N

| Settings

back-up

N

| Completed

* For dealers and contractors

Prepare a PC with which to use the Initial Setting
Tool and Web Browser for Initial Settings.
(See section 10-1.)

(Common: See sections 4-2 and 4-3.

LCD: See sections 5-1-3, 5-1-4, and 5-1-5.

Web Browser for Initial Settings: See sections 7-1-
1and 7-1-2.)

Update the AE-200/AE-50/EW-50, and ensure the
software version matches.
(See section 4-4.)

Configure the [System Exp] setting on the AE-200’s
LCD.
(See section 5-1-4.)

Register the license for the AE-200/AE-50/EW-50.
(See section 4-5.)

Configure unit settings for the AE-200/AE-50/
EW-50.
(See sections 5-1, 5-2, 6-3, 6-4, 7-1, and 7-2.)

(See section 6-5-3.)

(LCD: See sections 5-2 to 5-4.
Initial Setting Tool: See section 6-7.
Web Browser for Initial Settings: See sections 7-2
to 7-4.)
* Items that can be set will differ depending on
settings methods. Refer to section 2-3 and
configure, ensuring that no items are omitted.

Carry out a trial run in order to check that the
AE-200/AE-50/EW-50 are operating in accordance
with settings.

Backup settings, and retain the settings data so
that it can be used for recovery in the event of
malfunction.

(LCD: See section 8-1.

Web Browser for Initial Settings: See section 8-2.)

Properly carry out initial settings and trial runs, and take care to ensure that no settings have been omitted or configured incorrectly.
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Initial settings for AE-200/AE-50/EW-50 can be configured on the LCD, Initial Setting Tool, and Web Browser for
Initial Settings.

Each has specific characteristics as below.

*LCD
Method for setting the AE-200/AE-50/EW-50 from the AE-200’s LCD.
Configuration of initial settings for single AE-200 systems is possible.
Methods of setting from the LCD are explained in section 5 “Settings on the LCD”.

Note: Configure the expansion controller connection settings from the AE-200’s LCD.
Note: The EW-50 does not have an LCD, therefore it is necessary to configure settings from either the Initial Setting Tool or
Web Browser for Initial Settings.

* Initial Setting Tool
The Initial Setting Tool is used for configuring settings from a PC.
This allows configuration of initial settings for multiple AE-200/EW-50 systems, and allows batch configuration
of initial settings for up to a total of 40 AE-200/AE-50/EW-50 units.
A check sheet can be output to be used for trial runs.
The settings data created using the Initial Setting Tool is written from the PC to the AE-200/AE-50/EW-50 over
a LAN connection. Additionally, settings data can be created beforehand at another location such as an office.
Methods of setting from the Initial Setting Tool are explained in section 6 “Settings using Initial Setting Tool”.

Note: It is necessary to set the apportioned electricity billing function initial settings and Integrated Centralized Control Web
function initial settings from the Initial Setting Tool.
Note: It is necessary to set the BACnet® connection function initial settings from the BACnet® Setting Tool.

» Web Browser for Initial Settings
The Web Browser for Initial Settings is used for configuring settings from a PC Web browser.
This allows separate logins to a single AE-200/AE-50/EW-50, and configuration of initial settings.
Methods of setting from the Web Browser for Initial Settings are explained in section 7 “Settings using Web
Browser for Initial Settings”.
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The settings ranges for each of these settings are as below.

e E e

! AE-200 system No. 1 1

[} [}

' AE-200 ! N

e e

P 3 <2

| | | L
L R |

| | |

.

(AW E s

50 50 50 50 EXLE
Initial Setting Tool ' —_ M-NET I I M-NET I I M-NET M-NET : : LCD
or Web Browser : | AC units y  ACunits y y ACunits § y AC units y ’ N
for Initial Settings tecceccccecccccccccccccccccaccacaccscacancaaans ce===d
teececcccscccccccccsccccccssccascsscasaaaasaann -]
! AE-200 system No. 2 H ! 1 Initial Setting Tool
(] (] I___I
r——n r——- ! —_
| AE-200 | | AE-50 I ' Ir | Web Browser for
I | i -'| ' L Initial Settings
L ] " (]
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50 I 50
M-NET M-NET
I_AC units l LAC UnitSJ
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50
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I_AC units I
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EW-50 system
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50
M-NET

Lacne |

WT07627X03 10



2-3. Functions that can be set
The functions that can be set by using the LCD, Initial Setting Tool, and Web Browser for Initial Settings are

different.

See the table below to check the functions to be used, and configure the settings combining multiple initial
settings methods.

Functions that can be set are as follows.

Setting item Description LCD In|t|a_II_OSOe|tt|ng V\Ilﬁitt)igrg\g;ﬁ:;?r
Date and time settings Thg curre.mt date/time and daylight v v
savings time can be set.
License registration Licensles for optional functions can Vv v
be registered.
Unit information Basic settings can be made. \% \% \%
Language The language to be used for display v
can be set.
Whether or not to use an AE-200
M-NET M-NET can be selected. v
Whether or not to use an expansion
Expansion controller controller (AE-50/EW-50) can be \%
selected.
Basic Whether or not to use an AE-200
settings Billing function apportioned electricity billing V™
function can be selected.
“Time Master/Sub”, “Schedule:
Advanced settings Season_ s.e.tting”, ar’1’d “O.Id model \% \% \
compatibility mode” settings can be
made.
Network settings Settings for the network-related Vv v
items can be made.
IP address of IP address of AE-200/AE-50/EW-50 Vv Vv
AE-200/AE-50/EW-50 "4 | can be set.
IP address of expansion Destingtion IP address of an
controller expansion cqntroller (AE-50/EW-50) \Y
can be set with AE-200.
Air conditioning units, Air To Water
(PWFY) units, LOSSNAY units,
HWHP (CAHV, CRHV) units, chiller
Group settings units, general equipment, remote \% V \%
controllers, sub system controllers,
and AHC can be registered to a
Unit setti group.
nit setlings HW Supply seftings HWHP (QAHV) units can be v
registered to a group.
Set the refrigerant system
Refrigerant system settings | connection information in the
(for apportioned electricity apportioned electricity billing V™
billing function) function to distribute the outdoor
unit electric energy to indoor units.
Interlocked LOSSNAY The operation of indoor units and Vv Vv Vv
settings LOSSNAY units can be interlocked.
Block (operation block) The groups can be registered to a
. \ \ \Y
settings block.
Energy management block | The groups can be registered to an v Vv
settings energy management block.
PI controller or Pulse Input (PI)
PI controller settings set“tings such as “electzicity meter” Vv v Vv
or “water supply meter” can be
Function made.
settings Al controller “temperature sensor”
Al controller settings and “humidity sensor” settings can \% \% \%
be made.
E-Mail Error notiﬁcation e-mail and e-mail v
alarm settings can be made.
Peak Cut method and Peak Cut
Peak Cut control details for each control level Vs V5
can be set.
Energy Management Set to use the energy management
A ) . \Y \Y
settings function to display graphs.
WTO07627X03
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Setting item

Description

LCD

Initial Setting
Tool

Web Browser for
Initial Settings

Function
settings

Set Temperature Range
Limit

Set to restrict the local remote
controller set temperature range.

\

Night Mode (quiet operation)
Schedule

Set to switch outdoor units to quiet
operation for a certain period of
time.

\Y

System-changeover

Set to automatically switch indoor
unit operation mode (heating

and cooling) based upon room
temperature and set temperatures.

External Temperature
Interlock

Set to interlock the temperature
differential between the set
temperature and the outdoor air
temperature to use automatic
adjustment.

Night Setback Control

Set to automatically cool or heat if
the indoor temperature goes outside
a set range at night.

Interlock control

Set interlock restrictions for interlock
operation when conditions have
been met.

V"6

6

AHC Port Name settings

Advanced HVAC CONTROLLER
(AHC) port name can be set.

Night purge

Set night purge to bring in cooler
outside night air.

BACnet® 2

BACnet® objects can be set.

Floor settings

Floor settings

Set monitoring by displaying the
floor layout using the LCD.

Floor settings for Integrated
Centralized Control Web

Set monitoring by displaying the
floor layout using the Integrated
Centralized Control Web.

Billing
function
settings

Billing Function settings

Apportioned electricity billing
function settings can be made.

Vv

Outdoor Unit settings

Set outdoor unit parameters for
electric energy apportionment.

A

Indoor Unit settings

Set indoor unit parameters for
electric energy apportionment.

v

Measurement settings

Set connection relationship for
electric energy apportionment
metering devices and units.

v

Charges settings

Time period setting for the seasonal
charges can be made.

User settings

User settings for LCD

Set functions and passwords
that can be used with the LCD.
(Maintenance user/building
manager)

User settings for Integrated
Centralized Control Web *3

Set general user and tenant
manager settings for Integrated
Centralized Control Web.

Maintenance

Data back-up/import

Save settings data to a USB
memory device. Also, this can
write settings data saved on

a USB memory device to the
AE-200/AE-50/EW-50 to restore
status.

Software update

Update AE-200/AE-50/EW-50
software.

Others

Check sheet for air-
conditioner ON/OFF trial run

A check sheet to be used for air
conditioning unit trial run can be
output.

*1 For details, refer to the Instruction Book (Apportioned Electricity Billing Function).
*2 Make the settings on the BACnet® Setting Tool. Refer to the Instruction Book (BACnet® Setting Tool).

*3 Make the settings on the Integrated Centralized Control Web. Refer to the Instruction Book (Integrated Centralized Control Web).
*4 LAN2 IP address (IPv4) for BACnet® can be set. IP address (IPv6) can be set only from the BACnet® Setting Tool.

*5 “Energy Management License Pack” is required. (AE-200E/AE-50E/EW-50E only)

*6 “Interlock control” license is required. On version 7.50 and later, make the settings from the Initial Setting Tool.

WT07627X03
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3. Parts to be used

This section explains parts required for initial settings.
Refer to the Installation Manual for parts required for installation of AE-200/AE-50/EW-50.

3-1. Separately sold parts

Item Qty Description

Required to operate functions that require a license.

License Required number | o ister for each of AE-200/AE-50/EW-50.
AE-200 update file "1 1 . .
Required to ensure that all AE-200/AE-50/EW-50 versions are the same.
QE'EO/EW'W update 1 If versions do not match, then they will not operate.
ile

Use to carry out initial settings.

Required when using Integrated Centralized Control Web and apportioned
Initial Setting Tool *1 1 electricity billing functions.

Depending on the version of AE-200/AE-50/EW-50, the version of the Initial
Setting Tool that can be used will differ. *2

*1 Contact your dealer regarding the update files.

*2 When performing initial settings using the Initial Setting Tool, it is necessary to ensure that all AE-200/AE-50/EW-50 versions are the same.
Depending on the version of AE-200/AE-50/EW-50, the version of the Initial Setting Tool that can be used will differ as shown in the table

below.
Initial Setting Tool version AE-200/AE-50/EW-50 version .NET Framework
Ver. 1.3 Ver. 7.2-7.5 Ver. 4.5.2 or later
Ver. 1.2 Ver. 7.2-7.4 Ver. 4.5.2 or later
Ver. 1.1 Ver. 7.2-7.3 Ver. 4.5.2 or later
Ver. 1.0 Ver. 7.2 Ver. 4.5 or later
Cannot be used. Ver. 7.1 -

3-2. Commercially available parts

Item Qty Description
PC 1 PC with which to use the Initial Setting Tool and Web Browser for Initial
Settings.
USB memory 1 Required for backup of settings data.
LAN cable Required number ) )
— - Required for connection of AE-200/AE-50/EW-50 and PC.
Switching HUB Required number

Use a USB memory device that meets the following conditions.
* Supports USB 2.0
» Formatted with FAT32 or FAT (FAT16)
* Security function is not provided or not required to be set.
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3-3. PC requirements
The operating environment for the PC with which to use the Initial Setting Tool and Web Browser for Initial Settings
is as below.

Item Requirements
CPU 1 GHz or better (at least 2 GHz recommended)
Memory 1GB
Screen resolution 1024 x 768 or better (at least 1366 x 768 recommended)
oS Windows 7 SP1 (32bit/64bit), Windows 8.1 (64bit), Windows 10 (64bit)
Operating environment .NET Framework 4.5.2 or later

(only required for Initial Setting Tool) | * Required when Microsoft® Excel 2007/2010/2013/2016 trial run check sheet is used.

Microsoft® Internet Explorer 8.0

Microsoft® Internet Explorer 9.0

Microsoft® Internet Explorer 10.0

Microsoft® Internet Explorer 11.0

* Java execution environment is required.
(Verified to run on Oracle® Java Plug-in Ver. 1.8.0_101.)

* Install Oracle® Java Plug-in that is appropriate for your operating system. When using a
64-bit Internet Explorer, install a 64-bit Java Plug-in.

* The version of the Oracle® Java Plug-in can be verified by clicking [Java] in the Control

Browser
(only required for Web Browser for
Initial Settings)

Panel.
Internal LAN port or LAN card 100 BASE-TX or better
Pointing device Mouse, etc.

WT07627X03 14



4. Preparation

4-1. Logging in to the Web Browser for Initial Settings
Check that the Web Browser for Initial Settings can be logged in.

(1) Enter the web page address in the address field of the Web browser as follows:
http://[IP address of each AE-200, AE-50, or EW-50]/init/administrator.html
Press the [Enter] key. A login screen will appear.

WT07627X03

Note: If the IP address of the AE-200/AE-50/EW-50 is [192.168.1.1], : e

E s hep1921681.iniverysdminsraorumi £-ox

the web page address is [http: //192.168.1.1/init/administrator. sl
html].
Note: Default IP address of AE-200, AE-50, and EW-50 is

[192.168.1.1].
When one or more AE-50/EW-50 controllers are connected,
none of their IP addresses should overlap. The recommended IP
address ranges are as follows.
AE-200: Between [192.168.1.1] and [192.168.1.40]
AE-50/EW-50 (when used for system expansion):

Between [192.168.1.211] and [192.168.1.249]
EW-50 (when used alone):

Between [192.168.1.1] and [192.168.1.40]

M Login Page M Registration of Optional Functions

MR

Refer to section 4-3 “IP address settings” for how to change the | I ]

IP addresses.

Note: When one or more AE-50/EW-50 controllers are connected, log
in to all AE-200, AE-50, and EW-50 Web browsers to make initial
settings for AE-200, AE-50 and EW-50 respectively. The Web
browser cannot be switched among the AE-200, AE-50, and
EW-50.

Note: If the login screen does not appear then take the steps explained
in section 9-1 “Notes on connecting to Web browser” to delete
the temporary files.

Note: The web page will be displayed in the same language as the operating system on the PC.
The web page can be displayed in other languages by entering the web page address as follows:

Chinese http://[IP address of each AE-200, AE-50, or EW-50]/init/zh/administrator.html
English http://[IP address of each AE-200, AE-50, or EW-50]/init/en/administrator.html
French http://[IP address of each AE-200, AE-50, or EW-50]/init/fr/administrator.html
German http://[IP address of each AE-200, AE-50, or EW-50]/init/de/administrator.html
Italian http://[IP address of each AE-200, AE-50, or EW-50]/init/it/administrator.html

Japanese http://[IP address of each AE-200, AE-50, or EW-50]/init/ja/administrator.html
Portuguese  http://[IP address of each AE-200, AE-50, or EW-50]/init/pt/administrator.html
Russian http://[IP address of each AE-200, AE-50, or EW-50)/init/ru/administrator.html
Spanish http://[IP address of each AE-200, AE-50, or EW-50]/init/es/administrator.html

Note: You can add the web page address to your Favorites on the login screen for easy access in the future.
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(2) Enter the user name and the password in the login screen, and click [Login]. A setting screen will appear.
The table below shows the default user names, passwords, and functions that are available for maintenance
users and building managers.

User Default Default Available functions
user name password
Initial Settings Date and Time, Basic System, Groups,
9 Interlocked LOSSNAY, Blocks
. E-Mail, Peak Cut, Measurement,
Functions 1 .
Energy Management Settings
Functions 2 Set Temperature Range Limit,
Night Mode Schedule, System-changeover
Maintenance |. ... .
initial init
user Functions 3 External Temperature Interlock,
Night Setback Control, AHC Port Name Settings
Ventilation .
Setting Night purge
User Settings User Settings
Utility Back up/import settings data
Building . . Out of the functions listed above, the items to which access rights
administrator | admin . . .
manager have been given on the User Settings screen are available.

Note: A maintenance user can specify the functions to be made available for building managers. Refer to section 7-6 “User
Settings” for details.

Note: It is recommended to change the default user name and password so that the users other than the maintenance users
and building managers will not be able to change the settings.

Note: When one or more AE-50/EW-50 controllers are connected, log in to all AE-200, AE-50, and EW-50 Web browsers
to make initial settings for AE-200, AE-50, and EW-50 respectively. The Web browser cannot be switched among the

AE-200, AE-50, and EW-50.
Note: The user name and password for Integrated Centralized Control Web differ from the ones for the maintenance user and

building manager above. Set the user name and password for Integrated Centralized Control Web on the Integrated
Centralized Control Web.

WT07627X03
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(HTTPS connection)
AE-200/AE-50/EW-50 can encrypt communication data using HTTPS (SSL).

When connecting the AE-200/AE-50/EW-50 to the LAN that is accessible to the general public, it is recommended

that the following settings be made so that the units are monitored and controlled on the encrypted web page.
Note: Depending on the operating system or the Java version, HTTPS encrypted communication may not be enabled properly. If

this happens, use an HTTP connection as explained in the previous page.

(1) Prefix the web address with [https], enter the rest of the address, and
press the [Enter] key.

https://[IP address of each AE-200, AE-50, or EW-50]/init/
administrator.html

Note: If the IP address of the AE-200/AE-50/EW-50 is [192.168.1.1], the web page
address is [https: //192.168.1.1/init/administrator.html].

The encrypted data communication will begin, and the Login screen will
appear.

When the first time the Web browser is accessed, a security certificate
error page appears instead of the Login screen. Go to step (2) below.

M Login Page

(2) Enter the following web page address in the address field of the Web browser, and press the [Enter] key:

http://[IP address of each AE-200, AE-50, or EW-50]/cacert.cer

(3) A notification bar or a window to confirm about file download will appear.
Click [Open].

(4) A certificate dialog will appear.
Click [Install Certificate...].

(5) A Certificate Import Wizard window will appear.
Click [Next].

WT07627X03 17

File Download - Security Warning | 2 ‘
Do you want to open or sawe this file?

Name: cacert.cer
é Type: Security Certificate, 1.57KB
From: 192.168.1.1

[ open ][ s ] [ oancel

i .H‘I ‘While files from the Internet can be uzeful, this file type can
\a potentislly harm your computer. IFyou do not trust the source, do
LA R e i T e e

Certificate @
General | Details | Certification Path

& Certificate Information

This certificate is intended for the following purpose(s):

* Ensures the identity of a remote computer
« Allissuance policies

Issued to: Mitsubishi Electric CA 08C64-215

Issued by: Mitsubishi Electric CA 08C64-215

Valid from 2014/ 04/ 01 ko 2051/ 01/ 01

Install Certificate...| | Issuer Statement

Learn more about Lertificates

Certificate Import Wizarel ==

Welcome to the Certificate Import
Wizard

This wizard helps you copy certificates, certficate trust
lists, and certificate revocation lists from your disk toa

1
¢
- certificate store.

=

A certificate, bya
a confirmation of your identity anc
ct 1o estabi

tficate store is

) Cee ]




(6) Choose [Place all certificates in the following store] and click the
[Browse...] button.
Select [Trusted Root Certification Authorities], click [OK], and then click
[Next].

(7) Click [Finish] on completing the Certificate Import Wizard.

(8) Click [Yes] on the security warning to install the certificate.

(9) Certificate import process starts. A window will appear when the import
completes successfully.
Click [OK].
Note: The valid period of the certificate is from April 1st, 2014 to January 1st,
2051. The system date and time of the PC must be within the period.
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Certificate Import Wizard =

Certificate Store
Certificate stores are system areas where certificates are kept.

Windows can automaticaly select a certificate store, or you can speafy a location for
the certificate.

Automatically select the certficate store based on the type of certificate
@ Place al certificates in the folloning store
Certficate store:
Select Certificate Store ==

Select the certficate store you want to use.

=] personal =
3 3
=] Enterprise Trust H
7] Intermediate Certification Authorities

[Clshow physical stores

Certificate Import Wizard =

Completing the Certificate Import

Wizard
1
j The certificate wil be imported after you cick Finish
(== You have specified the following settings:

Certificate Store Selected by User BTSSRI o0 e
Content Certificate

O m ] 3

Security Warming x|

You are about to install  certificate from a certification authority (CA)
A dziming to represent:

Mitsubishi Electric CA 08C64-215

Windows cannot validate that the certificate is actually from
*Mitsubishi Electric CA 08C64-215". You should confirm its origin by
contacting "Mitsubishi Electric CA 08C64-215". The following number
ou in this process:

will assis

Thumbprint (shal): EFLEEFEE 76FECBAD D1C3540B 14502873 T3FECOCS

Warning:

If you install this roct certificate, Windows will automatically trust any
certificate iss: this CA. Installing a certificate with an unconfirmed
thumbprint you click "Yes” you acknowledge this
risk.

y ris

Do you want to install this certificate?

Certificate Import Wizard @

| The import was successful.




4-2. Date and time setting
Set the date and time for the AE-200/AE-50/EW-50. There are two ways to set the date and time — from the AE-200’s
LCD, and individually from the AE-200/AE-50/EW-50 Web Browser for Initial Settings.

If an expansion controller is connected in an AE-200 system, connect the AE-200 to the expansion controller over
a LAN, then set the date and time from the AE-200. Setting the date and time on the AE-200 will synchronize the
date and time on the expansion controller with the AE-200, therefore setting the date and time on the expansion

controller is not necessary.
Note: After the “Integrated Centralized Control Web” license is registered, the date and time can be set on the Integrated
Centralized Control Web. For details, refer to [Settings] — [Initial settings] — [Date and Time Settings] in the Instruction Book
(Integrated Centralized Control Web).

[1] When setting date and time on the AE-200’s LCD

(1) Touch the [Date and time] tab. T & renctiont X Functionz]| b [ R = |

Referring to section 5-1-3 “Date and time”, set the current date, Date and time License Unit Info. ul > |
current time, and daylight saving time, and then touch [Save
Settings].
Note: The AE-200’s current date and time will be synchronized to
each AE-50/EW-50 and remote controllers. o SEeoRd
Note: In order to synchronize the date and time with the
AE-50/EW-50, it is necessary to set the date and time. : - IEE
Note: The setting will not be saved until [Save Settings] is touched.

Make sure to touch [Save Settings] after the setting is e it SRing) GETEES

completod

Save Settings
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[2] When setting date and time on the AE-200/AE-50/EW-50’s Web Browser for Initial Settings
Click [Initial Settings] in the menu bar, and then click [Date and Time] to access the date and time settings screen.
Set the current date and time, and then click [Save Settings].
Note: The date and time settings may not be accessible if logged in as a building manager.
Note: The date and time settings made on this screen will be reflected on all the units in the M-NET system, all connected
AE-50/EW-50 units, and the AE-200 units whose [Time Master] setting is set to [Sub].
Note: The date and time cannot be set on this screen if the [Time Master] setting is set to [Sub].
Note: The daylight saving time setting is required only on the AE-200.
Note: Changing the date and/or time when the charging function is in use can affect the calculation of the charges.
Note: When AE-50/EW-50 controller, DIDO controller (PAC-YG66DCA), Al controller (PAC-YG63MCA), or PI controller (PAC-
YG60MCA) is added to the system, set the current date and time on this screen to synchronize the date and time on the

added controller.

Note: Although date and time settings can be made on each AE-50/EW-50, the date and time synchronization from AE-200 is
performed once at AM 5: 00 every day. Make the date and time settings on the AE-50/EW-50 only after the AE-50/EW-50 is

replaced.

Daylight saving time
setting

Click to enable the daylight
saving time setting.

Refresh

Click to acquire the current
date and time from the
AE-200/AE-50/EW-50.

Q\ )| i hitp: /1524681 1 init/en/edministrator html

£ - &% || _imrsusie i Conditone... % [

===

File Edit View Favorites Tools Help

Initial Settings

Date and Time Basic System Groups Interlocked L OSSNAY Blocks

M Date and Time

Current date and time

Year Month Day
ROz 2 pia  pE 2
gy g &

Hour Minute Second

Ma : s = Mg

¥ iAftomaticaily adjust ciock for dayiight saving changes;

Custom Settings ~ P Custom Settings
@®Refresh Save Seftings @

A

Enter the current date and
time.

Save Settings
Click to save the changes
made.

®100% -

(1) Enter the current date and time.

(2) To adjust the daylight saving time automatically, check the [Automatically adjust clock for daylight saving
changes] checkbox, and select the applicable country in the pulldown menu.

If the applicable country is not in the pulldown menu, select [Custom Settings] instead. A [Custom Settings]
button will appear on the right of the pulldown menu.
Click the [Custom Settings] button to open the Custom Settings screen, and configure the daylight saving

time setting.

WT07627X03

Custom Settings

Day ronth Time
01 & - Joa 2 02 2{:fo0 & »
01 &~ [0 2 03 ${:fo0 & »

Cancel |

03 242 o0 2

0z & :fo0 &

Ok |

Custom Settings screen
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4-3. IP address settings

Set AE-200/AE-50/EW-50 IP addresses, and configure the expansion controller connection settings on the AE-200’s
LCD.

For an AE-200 system, set using the following procedure.

Expansion controller No expansion controller
connected connected
NV Set the IP address of AE-50 on the LCD or the Web Browser
| IP address setting of AE-50/EW-50 for Initial Settings, and set the IP address of EW-50 on the
Web Browser for Initial Settings.
(See section 4-3-1 “Setting IP addresses of AE-50/EW-50".)
V vV
| M-NET setting Set whether or not to use an AE-200 M-NET on the AE-200’s
LCD.
(See section 4-3-2 “Setting IP addresses of AE-200".)
V
| Expansion controller setting Set whether or not to use an expansion controller on the
AE-200’s LCD.
(See section 4-3-2 “Setting IP addresses of AE-200".)
\V vV
| IP address setting of AE-200 Set the IP addresses of AE-200 on the AE-200’s LCD or the
- ) Web Browser for Initial Settings.
Expansion controller Mo expansion controllel (See section 4-3-2 “Setting IP addresses of AE-200".)
V
Destination IP address setting of Set the connecting IP addresses of expansion controllers on
expansion controller the AE-200’s LCD.
(See sections 4-3-2 “Setting IP addresses of AE-200” and
5-1-5 [5] “Communication error detection”.)
V V
Completed

For an EW-50 system, set using the following procedure.

Set the IP addresses of EW-50 on the EW-50’s Web Browser
| IP address setting of EW-50 | for Initial Settings.

(See section 4-3-1 “Setting IP addresses of AE-50/EW-50".)

A4
| Completed |
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[1] Settings for connecting the AE-200/AE-50/EW-50 to a dedicated LAN

(1) Enter the AE-200, AE-50, or EW-50’s IP address in the [IP Address] field. If the LAN has been newly set up,
allocate IP addresses to the AE-200 units in a sequential order starting with [192.168.1.1]. For example, the
first AE-200 unit will have an IP address of [192.168.1.1], the second AE-200 unit will have an IP address of
[192.168.1.2] and so on.

Allocate IP addresses to the AE-50/EW-50 units in a sequential order starting with [192.168.1.211].

Note: The recommended IP address ranges are as follows.
AE-200: Between [192.168.1.1] and [192.168.1.40]
AE-50/EW-50: Between [192.168.1.211] and [192.168.1.249]
PC: Between [192.168.1.101] and [192.168.1.150]

[IP address setting example]

Hub
100 BASE-TX LAN straight cable |
AE-200 E AE-50 E AE-50 E
| 192.168.1.1 | [192.168.1.211| [192.168.1.212 | | 192.168.1.101

Note: Some hubs have dedicated ports for connection with another hub.
Connect the AE-200/AE-50/EW-50 and PC to the normal ports.

(2) Enter [255.255.255.0] in the [Subnet Mask] field (unless otherwise specified).

(3) When monitoring the system remotely or using e-mail function via a dial-up router, enter the router IP

address in the [Gateway] field.
Leave the [Gateway] field blank when not connecting a dial-up router.

[Remote Monitoring System example]
Telecommunication Network

Dial-up router Dial-up router, cellular phone etc.
[ IPAddress: 192.168.1.254 |

AE-200 |z

IP Address: 192.168.1.1 IP Address: 192.168.1.101
Subnet Mask: 255.255.255.0 Subnet Mask: 255.255.255.0
Gateway: 192.168.1.254 Gateway: Blank

Note: [192.168.1.254] is recommended for use as the IP address of the dial-up router. Refer to the dial-up router

instruction manual for details of how to set the IP address.
Note: The use of a dial-up router with no modem requires a modem (for analog or ISDN) to be connected between the

router and the public phone line.
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[2] Settings for connecting the AE-200/AE-50/EW-50 to an existing LAN

(1) When connecting the AE-200/AE-50/EW-50 to an existing LAN, consult the system administrator to decide

the IP, subnet mask, and gateway addresses.

[Existing LAN System example]

Backbone LAN

Gateway

[ 10.1.1.250 |

Gateway

| 10.1.2.250 |

AE-200 |=

Obtain the addresses from
= the system administrator.

Obtain the addresses from
the system administrator.

X

¥\
IP Address: 10.1.1.1

Subnet Mask: 255.255.255.0
Gateway: 10.1.1.250

IP Address: 10.1.1.101

IP Address: 10.1.2.51

Subnet Mask: 255.255.255.0 Subnet Mask: 255.255.255.0

Gateway: 10.1.1.250

Gateway: 10.1.2.250

WT07627X03
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4-3-1. Setting IP addresses of AE-50/EW-50
Set the AE-50/EW-50 IP addresses. Settings screens will differ depending on the unit model.
AE-50: AE-50’s LCD or AE-50’s Web Browser for Initial Settings
EW-50: EW-50’s Web Browser for Initial Settings

Note: Set IP address for “LAN1.”

Note: “LAN2” is exclusively used for BACnet® function. To use the BACnet® function, configure the BACnet® settings on the BACnet®
Setting Tool. Refer to the Instruction Book (BACnet® function) for the BACnet® function settings.

[1] When setting on the AE-50’s LCD

(1) After the power is turned on to the AE-50, a language selection
screen will appear.

Select the language to be used for display, and then touch [OK]. Deutsch

Note: It will take approximately one minute for the display to appear - .

after the power is turned on. Bl FrEsle

Note: Once the initial settings have been made, [Monitor/Operation]
screen will appear after the power is turned on.

AE-58E Ver.7.45 (1.87)

Italiano Portugués
Tiirkge

B4

(2) The [Date and time] screen will appear.

Month Year

/om g mg

Hour Minute Second

im0 ml =l

Daylight saving changes

Custom settings

Save Settings

(3) Touch the right triangle button to display the [Network] tab, and | EEETE X Function | X Fnctionz] o IR |
touch it. n Unit Info.2 Advanced Network u
Referring to section 5-1-5 “Network”, set the AE-50’s IP

. LAN1 Setti M-NET Setti
address, and then touch [Save Settings]. 1P Address MAAET Address.
The AE-50 will reboot.
. Subnet Mask Range of Prohibited Controllers
Note: When multiple AE-50 controllers are connected, set the IP
addresses on all AE-50. MAC Address TE——
Note: The AE-200 and AE-50’s IP addresses must have the same 38EQBEEATT34 e
LAN common settings
network address. Gateway /Not_in use
<Reference: Default IP address> ]
AE-200 | 192.168.1.1
AE-50 | 192.168.1.211 L Nz v | Save Settings
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[2] When setting on the AE-200/AE-50’s Web Browser for Initial Settings

Click [Initial Settings] in the menu bar, and then click [Basic System] to access the Basic System settings screen.
Note: The Basic System settings may not be accessible if logged in as a building manager.

[E=BEoE
[ ¢ces

g \‘ _ I http://192.168.1.1/init/en/sdministrator. html
i <

0~ ¢ % || _immsusisHiAir Conditione. ‘ ‘

Initial Settings User Seftings
Date and Time ed L OSSNAY Blocks
M Basic System
Unit Settings System Configuration Settings
Name [E-200 'M-NET Settings
UnitiD [oO0001 (6 igures) N-NET Address [l
SERIAL No. 23164116 Range of Prohibited Controllers~ [§scRC [IRC Only
. Software Version 7.10(1.00)
Network Settings —| SE——
Setthe IP address and [N [ [ [ —r——
Network Settings B Emeruency Stop (Level sianaly
subnet mask of the F i
P Address I i o F‘ OMOFF (Level sianaly
AE'SO/EW-SO. Subnet Mask 285  [265  [285 0 i | OMNOFFIProhibitP ermit (Pulse signal
Gateway R i .
MAC Address 00269241B94A . @ Advanced Setting|
Display Format =
Unit of Temperature: Ic it |
Pressure unit of measure MPa  BPSI  [kaffer? =
NS Date Format szzotz fizstzotz  Beotznzst | ‘
Time Format oeoopw  H18:00 i
Group Names on Ovenview Monitor Hon  [loFF
Filter Sign Display Hon  Tlore =
@®Refrech Save Setfings®
‘¥— Save Settings
I Ck (0 save tho changes
f100% v made.

Note: Although the settings for LAN1 (Network Settings) and LAN2 (Network Settings 2) will appear on the screen, only the

settings for LAN1 is required. However, only when the LAN1 IP address is required to be set to [192.168.2.1], change the
default LAN2 IP address to avoid address overlap.

Note: After the AE-200 IP address is changed, the AE-50/EW-50 power will be reset.

Network Settings —
IP Address HEE . |1e2 . I1 . ]
Subnet Mask 255 ; 255 ; 255 . o LAN1
Gateway | | | |
MAC Address 00269241B94A ]
Hetwork Settings 2 —
IP Address IEE . HEE . |2 . 1
Subnet Mask 255 . 285 . |25 . 0 LAN2
MAC Address 00269241B94B |

WT07627X03
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4-3-2. Setting IP addresses of AE-200

Set the AE-200 IP address and the expansion controller connection.
[1] AE-200 initial start-up for a system without connection to an AE-50/EW-50 controller

(1) After the power is turned on, a language selection screen will AE-286E Ver.7.45 (1.87)

appear.
Select the language to be used for display, and then touch [OK]. Deutsch
Note: It will take approximately one minute for the display to appear
after the power is turned on.
Note: Do not touch the LCD before any settings screen appears. Italiano Por tuguds
Note: Once the initial settings have been made, [Monitor/Operation]
screen will appear after the power is turned on.

Frangais

Tiirkge

B#EE

(2) Touch the [Unit Info.] and [Unit Info. 2] tabs. Unit Info.
Referring to section 5-1-4 “Unit Information”, make necessary A s Y
basic settings, and then touch [Save Settings]. it nfo:
Note: Make sure to set the [System Exp] setting for the AE-200 to [Do . TR

not expand]. Mitsubishi Electric 31/12/2015 18:00
Note: Make sure to set the [AE-200 M-NET] setting to [Use]. Unit ID SyeteslEan Temperature  Language

060881

(6 Fioures) Pressure unit Screen lock
AE-208 M-NET m 5 o e
“ Occupancy Brightness

Volume Control 8/8 /=
Sound Brightness

Save Settings

Unit Info. 2

gs ! Func!lon unction,

n Unit Info.2 Advanced Network

Air-conditioner Settings

Test run Temperature display Humidity

Room temp. OFF

Do not use (Always)

Save Settings

[2] AE-200 initial start-up for a system with connection to one or more AE-50/EW-50 controllers

(1) After the power is turned on to the AE-200, a language
selection screen will appear.
Select the language to be used for display, and then touch [OK]. Deutsch
Note: It will take approximately one minute for the display to appear
after the power is turned on.
Note: Do not touch the LCD before any settings screen appears. Italiano Por tugués
Note: Once the initial settings have been made, [Monitor/Operation]
screen will appear after the power is turned on.

Francais

Tiirkce

B4
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(2) Touch the [Unit Info.] and [Unit Info. 2] tabs.
Referring to section 5-1-4 “Unit Information”, make necessary
basic settings, and then touch [Save Settings].
Note: Make sure to set the [System Exp] setting for the AE-200 to
[Expand].
Note: The [AE-200 Apportion] setting will appear only when the
“Charge” license has been registered.

(3) Touch the right triangle button to display the [Network] tab, and
touch it.
Referring to section 5-1-5 “Network”, make sure that [AE200]
is selected as [Controller], set the AE-200’s IP address and
subnet mask, and then touch [Save Settings].
The AE-200 will reboot.
When the reboot process is complete, log in to the Initial
Settings menu.

Note: Refer to section 5-1-1 “Logging in to the Initial Settings menu”
for how to log in.
Note: Do not touch the LCD during the reboot.

(4) In the [Controller] section, select [1], [2], [3], or [4] to make
settings for each AE-50/EW-50.
Referring to section 5-1-5 “Network”, set the IP address of
each AE-50/EW-50 that is connected to the AE-200, and
M-NET address, and then touch [Save Settings].
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Unit Info.

Initial \ L 2,
Settings 1

IR Unit Info.2

Unit Information Display Format
Name Date Time

Mitsubishi Electric 31/12/2015 18:00

System Exp Temperature  Language

(6 fioures) Pressure unit Screen lock
AE-208 M-NET D o e
Occupancy Brightness
Sound Brightness

Save Settings

Unit Info. 2

! Func!lon unction,

Unit Info.2 Advanced Network

Air-conditioner Settings

Test run Temperature display Humidity

Room temp. OFF

Do not use (Always)

Save Settings

q\ Initial 3
Settings
| <« || Unit Info.2

Control ler LF4LL] Mitsubishi Electric

LAN1 Settings M-NET Settings
IP Address M-NET Address
Subnet Mask Range of Prohibited Controllers

MAC Address
810203048586 External Input Setting

LAN common settings ON/OFF/Prohibit/Permit
Gateway (Pulse signal)

Save Settings

Initial

Unit Info.2

Control ler

LAN Settings M-NET Settings
Dstn IP address M-NET Address
192.168.1. 211

Version Range of Prohibited Controllers
Ver.7.308(1. 85) SC/RC

External Input Setting

Demand (Level signal)
/Not in use

Save Settings




4-4. Software Update
Refer to the AE-200/AE-50 Installation Manual for how to update the software for AE-200/AE-50.
Refer to the EW-50 Installation and Instructions Manual for how to update the software for EW-50.
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4-5. License registration for optional functions
There are two ways to register the license — from the AE-200’s LCD, and individually from the AE-200/AE-50/
EW-50 Web Browser for Initial Settings.

Please contact your dealer as regards optional functions and purchasing license numbers.
Note: After the “Integrated Centralized Control Web” license is registered, licenses can be registered on the Integrated Centralized
Control Web. For details, refer to [Settings] — [Initial settings] — [License Registration] in the Instruction Book (Integrated
Centralized Control Web).

[11 When registering a license on the AE-200’s LCD

Touch [Initial Settings] in the menu bar, and then touch [License].
Note: The current date and time settings are required for license registration. Refer to section 5-1-3 “Date and time” for date and
time settings.
Note: The license registration is required for each AE-200/AE-50/EW-50.
Note: The [Controller] setting will appear (only on the AE-200’s LCD) when the [System Exp] setting on the [Unit Info.] screen is set
to [Expand]. Switch the [Controller] setting between [AE200] and [Exp1] through [Exp4] to register licenses for each AE-200,
AE-50, and EW-50 individually.

Important

e \When one or more AE-50/EW-50 controllers are connected, licenses for the AE-50/EW-50 must be registered with the
AE-50/EW-50 properly connected to ensure proper settings.

Controller A Initial \ Functionl| & E R I
Select [AE] to register \ Settings
licenses for AE-200, and Date and time License
select [1], [2], [3], or [4] to
register licenses for each Control ler m Mitsubishi
AE-50/EW-50.

Selecting Optional Function

(b)Charge
Selecting Optional

Function Current Status

Select the optional function

to be registered. Available

License number entry field

Registration of License Number

SRAT-CSRA-FGSR-BHEA-UAFE-EHQU

This indicates whether the SerialiNo:
optional function is available 81156-818
for use.

Current status

Register the license

Register the license
Serial No. Touch to register the license.

(1) Inthe [Selecting Optional Function] section, select the optional function to be registered. The current
availability will appear in the [Current Status] section.

(2) Inthe “License number entry field” button, enter the license number and touch [Register the license].
In the [Current Status] section, a word [Available] will appear.
If the registration is unsuccessful, verify that the selected optional function and the license number are correct.
Note: Alphabet “O” and “I” are not used for license number.
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[2] When registering a license on the AE-200/AE-50/EW-50’s Web Browser for Initial Settings

Note: The current date and time settings are required for license registration. Refer to section 7-1-1 “Date and Time” for date and
time settings.
Note: The license registration is required for each AE-200/AE-50/EW-50.

(1) On the login screen, click [Registration of Optional Functions].

Q@

B Login Page — Registration of Optional Functions

The [Registration of Optional Functions] screen will appear.

a )| i tpi//192.168.1.1 imt/en/administrator bt P~ x\|4MnsuBIsHlAwcundmunem ‘ ‘

M Registration of Optional Functions Wicnrae <—— Login Page
Selecting Optional » ing Optional Function gcl;rcelétno return to the login
Function [orcnarse H .

Select the optional function

. Ci it Statt
to be registered. aremsRe

Available

License number entry field
current Status Registration of License Number /
This indicates whether the [ .

optional function is available /SoﬂwareVersion

for use.

AE-200A  Ver. 7.30(1.05)

Register the license

Register the license

Software version ; ) -
Click to register the license.

H100% ~

(2) In the [Selecting Optional Function] section, select the optional Selecting Optional Function
function to be registered. The current availability will appear in
the [Current Status] section. |(6) Charge =l

(3) In the [License number entry] field, enter the license number Registration of License Number
and click [Register the license].
In the [Current Status] section, a word “Available” will appear.
If the registration is unsuccessful, verify that the selected
optional function and the license number are correct.
Note: Alphabet “O” and “I” are not used for license number.

[fovz  -fiFvz  -J2ev  -pevz  -[FYED  -[iNiB
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5. Settings on the LCD

5-1. Initial Settings
5-1-1. Logging in to the Initial Settings menu

(1) Touch [[X]] to display the login window. mm

Tenant F Tenant 6 Tenant H Tenant I Tenant J

B = EH

(2) Enter the user name and the password on the keyboard
screen (See [1] “Keyboard screen”), and touch [Login].
[Initial Settings] menu screen will appear. USerinae
The table below shows the default user names,

passwords, and functions that are available for _

maintenance users and building managers. Password

Login / Panel cleaning

7.38 (1. 85)

User Default Default Available functions
user name password
Maintenance user initial init All functions

The items to which access rights have been given on the [User

Building manager administrator admin .
Info] screen are available.

*1 A maintenance user can specify the functions to be made available for building managers. Refer to section 5-5 “User Information” for
details.

*2 ltis recommended to change the default user name and password so that the users other than the maintenance users and building
managers will not be able to change the settings.
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[1] Keyboard screen

The entered characters will
appear here.

Touch to display the
keyboard for entering capital
alphabetic characters.

Touch to display the
keyboard for entering lower-
case alphabetic characters.

Arrow
Touch to move the cursor.

/ 74
4
7 4

/ /
Wi tletric— | <] > pette
N
aflofclafefl¢Nallnlil.Nchlifo]
nfofNoNallrHsNHeNullviol«<lvfz]

Delete

Touch to delete one
character to the left of the
cursor.

Touch to display the keyboard for
entering numeric characters and
symbols.

5-1-2. Locking the screen
Locking the screen prevents unauthorized users from accessing.

(1) To activate the screen lock function, set the [Screen

lock] setting to [Use] on the [Unit Info.] screen under the
[Initial Settings] menu.
If the screen lock function is activated, the screen locks
when the backlight turns off (after three minutes of not
touching the screen).

Note: The default setting is [Do not use].

Note: The screen lock function will not be activated when any
screen under the [Initial Settings] menu is open.

(2) Touch [M]] on the login screen to lock the screen

immediately.

To unlock the screen, enter the same user name and
password used to log in.

WT07627X03
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Cancel

Touch to undo the changes
made and return to the
previous screen.

k

Cancel

OK

Touch to save the entered
characters and return to the
previous screen.

Disnlay Format
Date Time

Temperature Language
°c Engl ish
Pressure unit|Screen lock

Login / Panel cleaning

User name

Password




5-1-3. Date and time

Touch [Initial Settings] in the menu bar, and then touch [Date and time].
Set the current date and time, and then touch [Save Settings].

Note:
Note:

Note:

Note

Note:

Note:
Note:

Note

Note:

The date and time settings may not be accessible if logged in as a building manager.

The date and time settings made on this screen will be reflected on all the units in the M-NET system, all connected
AE-50/EW-50 units, and the AE-200 units whose [Time Master/Sub] setting is set to [Sub].

The date and time cannot be set on this screen if the [Time Master/Sub] setting is set to [Sub].

: The daylight saving time setting is required only on the AE-200.
Note:

The date and time settings made on the AE-50/EW-50 unit whose [Time Master/Sub] setting is set to [Sub] will not be sent to
the other AE-50/EW-50 units.

If the current time is moved forward while the scheduled operation is performed, the operation that was scheduled to take
place during the time that was skipped will not be performed.

Changing the date and/or time when the charging function is in use can affect the calculation of the charges.

If the system is connected to a TG-2000A, make or change the settings from the TG-2000A.

: When AE-50/EW-50 controller, DIDO controller (PAC-YG66DCA), Al controller (PAC-YG63MCA), or PI controller (PAC-

YG60MCA) is added to the system, set the current date and time on this screen to synchronize the date and time on the
added controller.

Although date and time settings can be made on each AE-50/EW-50, the date and time synchronization from AE-200 is
performed once a day. Make the date and time settings on the AE-50/EW-50 only after the AE-50/EW-50 is replaced.

Important

e When one or more AE-50/EW-50 controllers are connected, the date and time settings must be made with the AE-50/EW-50
properly connected to ensure proper settings.

Current date and time
Set the current date and

Daylight saving time

time.

Touch to set the country
to automatically adjust the
daylight saving time.

Daylight saving changes

Edit
Touch to manually configure
the daylight saving time

Custom settings

Save Settings

setting.

Save Settings
Touch to save the changes
made.

(1) Set the current date and time.

(2) To automatically adjust the daylight saving time, touch the “Daylight saving time” button. Touch the applicable
country, and then touch [OK].

Note: When not using the daylight saving time function, touch “----.

Note: If the applicable country is not found, touch [Custom settings] at the bottom, and touch [OK]. Then, touch [Edit] to open

WT07627X03

the screen below, and manually configure the daylight saving time setting.
Custom settings

Month Time

»maa

-3 o

Time

Day

Time

Time
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Note

e Message that will appear when the date and time have been reset
If the power supply is cut off for a long time due to power failure or other reasons, the date and time will be reset, and the

following popup message will appear when the power is turned on next. If this message appears, set the date and time
again.

Date and Time

* This message will appear periodically until the date and time setting is made.
* If the controller is used without the date and time being set, the Schedule function or the Night Setback Control will not work properly.

* If the [Time Master/Sub] setting for the given controller is set to [Sub], temporarily change the setting to [Master], set the current date and
time, and then set the setting back to [Sub].

WT07627X03
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5-1-4. Unit Information

Touch [Initial Settings] in the menu bar, and then touch [Unit Info.] or [Unit Info. 2].
Make necessary basic system settings such as unit settings, display format, sound/brightness settings, use or non-
use of test run, and display or non-display of room temperature/humidity, and then touch [Save Settings].

Note: The Unit Information settings may not be accessible if logged in as a building manager.

Unit Info.

Unit Information
Set the unit name and unit
ID.

Sound and brightness
Set the sound and
brightness levels.

Unit Info. 2

Air-conditioner Settings
Set the test run setting
and display option of room
temperature/humidity.

[1] Unit Information

nitial
Settings

Unit Info.

Unit Information
Name

Mitsubishi Electric

Unit ID System Exp
00808681 Expand

AE-288 M_NET

Volume Control
Sound

Brightness
100 %

Initial ;
A Settings ! Function?

Unit Info.2 || p |

Display Format
Date Time

Temperature Language
°C
Pressure unit Screen lock

Occupancy Brightness

Display Format
Set the screen display items.

Save Settings

Save Settings
Touch to save the changes
made.

Unit Info.2 Advanced

Air-conditioner Settings
Test run

Temperature display
Room temp.

Network

Humidity
OFF

Save Settings

Save Settings
Touch to save the changes
made.

Follow the instructions below to set the unit name, unit ID, and System Expansion setting.

(1) Touch the [Name] button to display the keyboard. Enter the unit name in 40 alphanumeric or symbol characters
or less. The name entered here will be used on the screen of the software that controls multiple AE-200 units

and will also be used as a sender name in the error notification e-mail and e-mail alarm.
Note: The following characters cannot be used: <, >, &, “, or*
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()

@)

(4)

Touch the [Unit ID] button to display the keyboard. Enter the unit ID in 6 figures. Use this setting to manage
the multiple unit IDs. The unit ID entered here will be used on the screen of the software that controls multiple
AE-200 units and will also be used as a sender ID in the error notification e-mail and e-mail alarm.

When connecting one or more AE-50/EW-50 controllers, set the [System Exp] setting to [Expand].
Note: The [System Exp] section does not appear on this screen on the AE-50.
Note: When the [System Exp] setting is set to [Expand], make sure to make network settings for the AE-50/EW-50 controllers
on the [Network] screen. (Refer to section 5-1-5 “Network” for details.)
Set the EW-50’s IP address on the Web Browser for Initial Settings. (Refer to section 4-3-1 “Setting IP addresses of
AE-50/EW-50" for details.)

When using an AE-200 apportioned electricity billing function or when not using an AE-200 M-NET, set the

[AE-200 M-NET] setting to [Do not use].
Note: When [Do not use] is selected, up to four AE-50/EW-50 controllers can be connected.
Note: The [AE-200 M-NET] section does not appear on this screen on the AE-50.
Note: The [AE-200 Apportion] section appears when “Charge” license is registered. To use an electricity charge apportioning
function of TG-2000A, set the [AE-200 Apportion] setting to [Do not use].

Initial = 3 < 7,
RTHEI ~Finctiont X Functionz| 3|
|« | Unit Info. Unit Info.2

Unit Information Display Format
Name Date Time

Mitsubishi Electric 31/12/2015 18:00
Unit ID System Exp Temperature  Language
°C
Pressure unit Screen lock

Do not use

Occupancy Brightness
Volume Contro /=
Sound Brightness

Save Settings

[2] Sound and brightness

(1)

()

In the [Sound] section, select the volume (Level 0-3) of the buzzer that sounds when the screen is touched.

(Level 0: No sound)
Note: Although the change will be reflected right away, it will not be saved until [Save Settings] is touched.

In the [Brightness] section, select the brightness (70%, 80%, 90%, 100%) of the screen. (The greater the

value, the brighter the brightness.)
Note: Although the change will be reflected right away, it will not be saved until [Save Settings] is touched.

[3] Display Format

(1)
()
®)
(4)
®)
(6)

(7)

In the [Date] section, select the desired display format for year, month, and date.
In the [Time] section, select the desired display of time format.

In the [Temperature] section, select the desired temperature unit [°C] or [°F].

In the [Language] section, select the desired display language.

In the [Pressure unit] section, select [MPa], [PSI], or [kgf/cm?2].

In the [Screen lock] section, select [Use] or [Do not use]. Select [Use] to activate the screen lock function. (Refer
to section 5-1-2 “Locking the screen” for details.)

In the [Occupancy] section, make the Show/Hide setting for the occupancy/vacancy status that is detected

by the built-in occupancy sensor on the ME remote controller (North America: PAR-U0O1MEDU, Europe: PAR-
UO2MEDA).

Select [Hide] not to display the occupancy/vacancy status on the [Floor] or [Block] display.

Select [ & ] (blue) to display the occupancy icon when the sensor on the remote controller detects occupancy.
Select [ & ] (gray) to display the vacancy icon when the sensor on the remote controller detects vacancy.
Select[ & .~ & ] (blue/gray) to display the occupancy or vacancy icon according to the occupancy status of

the room.
Note: If the ME remote controller has no built-in occupancy sensor, the occupancy/vacancy icons will not be displayed on the
[Floor] or [Block] display.
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(8) In the [Brightness] section, make the Show/Hide setting for the brightness/darkness status that is detected
by the built-in brightness sensor on the ME remote controller (North America: PAR-U0O1MEDU, Europe: PAR-
UO2MEDA).

Select [Hide] not to display the brightness/darkness icons on the [Floor] or [Block] display.

Select[ = ] (yellow) to display the brightness icon when the brightness level in the room reaches the
predetermined brightness level.

Select [ = ](gray) to display the darkness icon when the darkness level in the room reaches the
predetermined darkness level.

Select[ = . = ] (yellow/gray) to display the brightness or darkness icon according to the brightness/
darkness level of the room.

Note: If the ME remote controller has no built-in brightness sensor, the brightness/darkness icons will not be displayed on the
[Floor] or [Block] display.

Note: The brightness/darkness detection thresholds are set on the ME remote controller (North America: PAR-U0O1MEDU,
Europe: PAR-U02MEDA)

[4] Air-conditioner Settings

(1) Inthe [Test run] section, select [Use] or [Do not use]. Select [Use] when performing a test run from the
operation settings screen, or when editing the electricity meter reading value on the [Measurement] display.

Editing measurement values

Momtor/ 2 L
oo LV Sl o AL .
|| Floor || Block |[eveeyey [»] |
Controller  [IERN Mitsubishi

E B 020000

309, 9Kk 459824, Bkih

Measurement value edit

,

1. Touch the “Measurement value edit” button to open the screen below.
Note: The “Measurement value edit” button will appear only when the [Test run] setting is set to [Use].

Monntor/
Uperat ion

____Floor | Block If |

Edit the adjusted Edit the offset value

measurement value Corrected Measurement value Offset

123457. 78 WLLEEER Y EAN 123456, 78 N1

2. Touch the “Edit the adjusted measurement value” button. Enter the current electricity meter reading value,
and then touch [OK].

Note: Set the setting back to [Do not use] after completing a test run.

Note: The setting will go back to [Do not use] when the time on the AE-200/AE-50 reaches 0: 00 in the morning.

Note: Only the electric energy values on the [Measurement] display will change. This setting will not affect the energy-
control-related screens.

Note: To reset the adjusted measurement value to the original cumulative value, touch the “Edit the offset value” button
and set to “0”.
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(2) Inthe [Temperature display] section, select the desired display option for the room temperature or the set

temperature to be used on the [Floor] or [Block] display.
Select [Room temp. (Always)] to display the room temperature at all times, [Room temp. (During operation)]
to display the room temperature only during operation, [Set temp.] to display the set temperature at all times,
[Room temp.(Always)/Set temp.] to display both the room temperature and set temperature at all times, [Room
temp.(During op.)/Set temp.] to display the room temperature only during operation and to display the set
temperature at all times, and [Hide] not to display the room temperature or the set temperature.

Note: This setting is effective only on the LCD and will not be reflected to the Integrated Centralized Control Web.

Note: The room temperature shown may be higher than the actual temperature especially when the unit is stopped during

the Heat mode. Therefore, selecting [Room temp. (During operation)] is recommended when displaying the room
temperature.

(3) In the [Humidity] section, make the Show/Hide setting for the humidity reading of the built-in humidity sensor
on the ME remote controller (North America: PAR-UO1MEDU, Europe: PAR-UO2MEDA).
Select [ON] to display the humidity reading on the [Floor] or [Block] display.

Note: The table below summarizes the items that are displayed on the Monitor/Operation screen according to the combination
of the settings for “Temperature display” and “Humidity.”

Temperature display
Room temp.(Always)/
Room temp. (Always [
Humidity [ opr ( yo)l Set temp.] _
[Room temp. (During [Set temp ] or Hide
operatién)] [Room temp.(During op.)/
Set temp.]
OFF Upper: Room temp. Upper: Set temp. Upper: Room temp. Upper: N/A
Lower: N/A Lower: N/A Lower: Set temp. Lower: N/A
ON Upper: Room temp. Upper: Set temp. Upper: Room temp. Upper: N/A
Lower: Humidity Lower: Humidity Lower: Set temp. Lower: Humidity
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5-1-5. Network

Touch [Initial Settings] in the menu bar, and then touch [Network].
Make necessary basic system settings such as LAN settings, M-NET settings, and external input settings for each
AE-200, AE-50, and EW-50, and then touch [Save Settings]. A message will appear asking whether or not to restart

the controller. Touch [OK] to restart the AE-200/AE-50 to reflect the changes.
Note: The Network settings may not be accessible if logged in as a building manager.
Note: The [Controller] setting will appear (only on the AE-200’s LCD) when the [System Exp] setting on the [Unit Info.] screen is set
to [Expand]. Switch the [Controller] setting between [AE200] and [Exp1] through [Exp4] to make settings for each AE-200,
AE-50, and EW-50 individually.

Important

e Network settings for the AE-50/EW-50 must be made with the AE-50/EW-50 properly connected to ensure proper settings.
Those settings made without the connection of AE-50/EW-50 will not be reflected.

1st page
Initial ;
A “Settines =|unc!|0n|
Controller :
Select [AE] to make Unit Info.2 Advanced M-NET Settings
Settlngs forAE-200, and Control ler AE208 Mitsubishi Electric Set the M-NET address
select [1], .[2]’ [3], or [4] and range of prohibited
to make settings for each LAN1 Settings M-NET Settings controllers.
AE-50/EW-50. IP Address M-NET Address
LAN1 Settings 192.168.1.1
Set the IP address, subnet .
mask, and gateway address. Subnet Mask RangProhlblted Control lers External Input Setting
m - Set the external signal input

MAC Address mode.
818283046586 External Input Setting

LAN common settings ON/OFF/Prohibit/Permit
Gateway (Pulse signal)

u n Save Settings
Touch to go to the next Save Settings

page. Touch to save the changes
made.

2nd page

Initial ;
A Settings ! Function?

Unit Info.2 Advanced Network

Control ler GFLEY Mitsubishi Electric
LANZ Settings

LAN2 Settings - d 18 21
Exclusively used for - -
BACnet® function *1. Subnet Mask

MAC Address
0810283048506

LAN common settings
Gateway

u n Save Settings

Touch to go to the previous
page.

*1 BACnet® is a registered trademark of ASHRAE (American Society of Heating, Refrigerating and Air-Conditioning Engineers, INC.).
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(When connecting one or more expansion controllers)

Initial \
‘\ Settings ! | H”!“ll”

Advanced Network Groups
Control ler m Mitsubishi
Communication error detection Detect communication
IP address ; iy Communica o error

192.168.1. 1 Detect 1

192.168.1. 2 Do not detect

Save Settings

Touch to go to the previous Save Settings
page. Touch to save the changes
made.

[1] LAN1 Settings

LAN1 settings vary depending on whether the AE-200/AE-50 is connected to a dedicated LAN or an existing LAN.
See the sections below for how to set the AE-200/AE-50 IP addresses, subnet mask, and gateway addresses.
Although the settings for LAN1 and LAN2 will appear on the screen, only the settings for LAN1 is required if the
BACnet® function is not used. Before making the settings, make sure that the LAN cable is connected to LAN1 port.

LAN1 Settings
IP Address
192.168.1. 1

Subnet Mask

MAC Address

8182083648506

LAN common settings
Gateway

(1) LAN1 settings for connecting the AE-200/AE-50/EW-50 to a dedicated LAN

Settings for an AE-200
Note: See the procedures below when making LAN1 settings on the AE-50.

(1) Make sure that [AE200] is selected in the [Controller] section.

(2) Enter the AE-200’s IP address in the [IP Address] field. If the LAN has been newly set up, allocate IP
addresses to the AE-200 units in a sequential order starting with [192.168.1.1]. For example, the first
AE-200 unit will have an IP address of [192.168.1.1], the second AE-200 unit will have an IP address of
[192.168.1.2] and so on. (The same IP addresses cannot be used.)

Allocate IP addresses to the AE-50/EW-50 units in a sequential order starting with [192.168.1.211].

Note: The recommended IP address ranges are as follows.
AE-200: Between [192.168.1.1] and [192.168.1.40]
AE-50/EW-50: Between [192.168.1.211] and [192.168.1.249]
PC: Between [192.168.1.101] and [192.168.1.150]

Note: After the AE-200 IP address is changed, the AE-50/EW-50 power will be reset.

Note: A communication error “6920” will be detected by the AE-50/EW-50 when the AE-200’s IP address is changed
with the AE-50/EW-50 connected. In the [Communication error detection] section in the [Network] screen,
change the communication error detection setting for the previous IP address from “Detect” to “Do not detect.”

(3) Enter [255.255.255.0] in the [Subnet Mask] field (only when the IP address is [192.168.1.%]).
Note: If [255.255.255.0] is entered, set the IP addresses of all AE-50 units to [192.168.1.%].
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(4) When monitoring the system remotely or using e-mail function via a dial-up router, enter the router IP
address in the [Gateway] field.
Leave the [Gateway] field blank when not connecting a dial-up router.
[192.168.1.254] is recommended for use as the IP address of the dial-up router. Refer to the dial-up router
instruction manual for details of how to set the IP address.

Note: [192.168.1.254] is recommended for use as the IP address of the dial-up router. Refer to the dial-up router
instruction manual for details of how to set the IP address.

Note: The use of a dial-up router with no modem requires a modem (for analog or ISDN) to be connected between the
router and the public phone line.

Settings for when connecting one or more AE-50/EW-50 controllers

LAN Settings
Dstn IP address

192.168. 1. 211

Version
Ver. 7.38(1. 85)

(1) Select [1], [2], [3], or [4] in the [Controller] section to make settings for each AE-50/EW-50.

(2) Enter the IP address of the AE-50/EW-50 that is connected to the AE-200 in the [Dstn IP address] field.
A message that indicates that the connection information of the AE-50/EW-50 is being collected will appear
for a few minutes.

Note: AE-50/EW-50 will not operate properly and the AE-50/EW-50 software version will not appear if the entered IP
address does not match the ones that have been set on the AE-50/EW-50.

Note: AE-50/EW-50 will not operate properly and the AE-50/EW-50 software version will not appear if the versions of
AE-200 and AE-50/EW-50 do not match regardless of the correctness of the entered IP address. Update the
software so that the versions match.

(2) LAN1 settings for connecting the AE-200/AE-50 to an existing LAN

(1) When connecting the AE-200/AE-50 to an existing LAN, consult the system administrator to decide the IP
addresses, subnet mask, and gateway addresses.

(3) LAN2 settings for connecting the AE-200/AE-50 to a dedicated LAN

(1) Do not use the LAN2 port.
Note: Change the LAN2 IP address only when the LAN1 |IP address is required to be set to [192.168.2.1].

(4) LAN2 settings for connecting the AE-200/AE-50 to an existing LAN

(1) Do not use the LAN2 port.
Note: Change the LAN2 IP address only when the LAN1 IP address is required to be set to [192.168.2.1].

[2] LAN2 Settings

LAN2 port is exclusively used for BACnet® function.

For how to make BACnet® function settings, refer to the Instruction Book (BACnet® function).
Note: An IP address set using LAN1 should not be used as a LAN2 IP address.

[3] M-NET Settings
Note: Make the M-NET settings only on the AE-200.

M-NET Settings
M-NET Address

Range of Prohibited Controllers
SC/RC

(1) Switch the [Controller] setting between [AE200] and [Exp1] through [Exp4] to make settings for each AE-200,
AE-50, and EW-50 individually.

(2) Enter [0] in the [M-NET Address] field (unless otherwise specified).
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(38) Select [SC/RC] to prohibit the operation from both the sub system controllers and the remote controllers.
Select [RC Only] to prohibit the operation only from the remote controllers.

[4] External Input Setting

Using the external signal input function, the following types of collective operations can be performed for all
connected air conditioning units: Demand level, Emergency stop, ON/OFF operation, and Prohibit/Permit local
remote controller operation.

A separately-sold external input/output adapter (PAC-YG10HA-E) is required.

Note: Make the M-NET settings only on the AE-200.

Note: A separate license is required to activate the Peak Cut control using the external input function. Make sure that the required
license has properly been registered on the [License] screen. (Refer to section 4-5 “License registration for optional
functions” for details.)

External Input Setting

ON/OFF/Prohibit/Permit
(Pulse signal)

(1) Switch the [Controller] setting between [AE200] and [Exp1] through [Exp4] to make settings for each AE-200,
AE-50, and EW-50 individually.

(2) Select [Demand (Level signal)/Not in use], [Emergency Stop (Level signal)], [ON/OFF (Level signal)], or [ON/
OFF/Prohibit/Permit (Pulse signal)]. Refer to the Installation Manual for details.

[5] Communication error detection
By switching the communication error detection setting, communication error between AE-200 and AE-50/EW-50
(6920) can either be detected or not detected by the AE-50/EW-50.
Note: This settings screen will appear when making the settings for AE-50/EW-50 on the AE-200’s LCD, or when making the
settings on the AE-50’s LCD.
Note: When the IP address of AE-200 is changed, make sure to set the communication error detection setting for the IP address

of the AE-200 before change to “Do not detect.” If not set, AE-50/EW-50 will detect a “6920” error for the IP address of the
AE-200 before change.

\ Initial
Settings

Control ler m Mitsubishi

Communication error detection Detect communication
IP address of AE-200 Ip & 3 Communication error error

t Select whether “Detect”

192.168.1.1 or “Do not detect”
communication error for

192.168.1. 2 Do not detect each IP address.

Save Settings

Touch to go to the previous L Save Settings
page. Touch to save the changes
made.

(1) Select whether “Detect” or “Do not detect” communication error for each IP address.
Select “Detect” for the IP address of the AE-200 that is connected.
Select “Do not detect” for the IP address of the AE-200 that is not currently connected.
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5-1-6. Groups
Touch [Initial Settings] in the menu bar, and then touch [Groups].
Register the groups of air conditioning units, LOSSNAY units (ventilators), Air To Water (PWFY) units, AHC, HWHP
(CAHV, CRHV) units, chiller units, or general equipment to be connected to the AE-200/AE-50/EW-50, and then

touch [Save Settings].

Note: Register HWHP (QAHV) units by following the procedure in section 5-1-7 “HW Supply”.

Note: Some settings may not be accessible if logged in as a building manager.

Note: If the system is connected to a TG-2000A, make or change the settings from the TG-2000A.

Note: The [Controller] setting will appear (only on the AE-200’s LCD) when the [System Exp] setting on the [Unit Info.] screen is set
to [Expand]. Switch the [Controller] setting between [AE200] and [Exp1] through [Exp4] to make settings for each AE-200,
AE-50, and EW-50 individually.

Note: When registering LOSSNAY units or OA Processing units, do not combine the units that support Night Purge function and
the units that do not in one group.

Important

e Group settings for the AE-50/EW-50 must be made with the AE-50/EW-50 properly connected to ensure proper settings.
Those settings made without the connection of AE-50/EW-50 will not be reflected.
e The units connected to AE-200 cannot be grouped together with the units connected to AE-50/EW-50.

Initial - ;
i ! Function1

Netuork

Controller

Select [AE] to make Control ler m Mitsubishi AHC registration
settings for AE-200, and
select [1], [2], [3]1 or [4] Entrance 1 Remote controller
to make settings for each — i registration
AE-50/EW-50. W 101
Group No. 2202

System controller
182 registration

Group name

Unit selection Entrance 3

Save Settings

Save Settings
Touch to save the changes
made.

[1] Setting group names

(1) Touch the “Group name” button to display the keyboard. Enter the group name in 20 alphanumeric or symbol

characters or less.
Note: The following characters cannot be used: <, >, &, “, or
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[2] Registering air conditioners, Air To Water (PWFY) units, LOSSNAY units, HWHP (CAHV, CRHV)
units, or chiller units to a group

(1) To register air conditioners, Air To Water (PWFY) units,

Grour1 Entrance 1

LOSSNAY units, HWHP (CAHV, CRHV) units, and chiller
units to each group, touch the “Unit selection” button
under the target group name. A screen to select the units
will appear.

Select the group type in the [Model] section, and select
the address numbers of the units to be registered.

The selected unit addresses will appear with an orange
frame. Touch again to deselect.

Note: Each group can contain up to 16 units.

Note: Units other than general equipment cannot be combined
with general equipment in one group. To register general
equipment to a group to which units other than general
equipment are already registered, delete the existing
registration first before registering general equipment to it.

Note: The addresses of the units that have been registered
to other groups will appear with a gray background and
cannot be selected.

(2) To change the unit icon to be used, touch the icon. A

screen to select an icon will appear. Select an icon to be
used, and touch [OK].

[3] Registering remote controllers to a group

(1) To register remote controllers to a group, touch the

“Remote controller registration” button under the target
group name. A screen to select the units will appear.

Select the address numbers of the remote controllers to
be registered.

The selected unit addresses will appear with an orange
frame. Touch again to deselect.

Note: Each group can contain up to two remote controllers.

Note: Each group can contain up to four remote and system
controllers combined.

Note: MA remote controllers do not need to be registered to a
group.
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[4] Registering system controllers to a group

(1) To register system controllers to a group, touch the
“System controller registration” button under the target
group name. A screen to select the units will appear. pisreniioniell oy

Group1 Entrance 1

Select the address numbers of the system controllers to
be registered.

The selected unit addresses will appear with an orange
frame. Touch again to deselect.

Note: Each group can contain up to four remote and system “

controllers combined.

[5] Registering AHC to a group

(1) To register AHC to a group, touch the “AHC registration”
button under the target group name. A screen to select the
unit will appear.

Group1 Entrance 1

Select the address number of the AHC to be registered.
The selected unit address will appear with an orange
frame. Touch again to deselect.

Note: Each group can contain one AHC.
Note: AHC must be registered to a group in which air
C |
conditioners are registered. Do not register AHC to a group “

in which units other than air conditioners are registered.
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[6] Registering general equipment to a group

(1) To register general equipment to a group, touch the “Unit
selection” button under the target group name. A screen to
select the units will appear.

Select [General Equipment (via PAC-YG66DCA)] in the
[Model] section, and select the unit address of the DIDO
controller (PAC-YG66DCA) that is connected to the
general equipment to be registered.

The selected number will appear with an yellow-green
frame.

Then, select contact points to which the general equipment
are connected, and touch the address assigned to another
unit to register the first selected item to the group. The
yellow-green frame will change to an orange frame. (The
item with a yellow-green frame is the currently selected
unit, and the ones with an orange frame are the units that
are already registered to a group.)

Touch again to deselect.

Note: Each contact of DIDO controller counts as one unit.

Note: Each group can contain up to 16 general equipment.

Note: Up to six general equipment can be registered for each
DIDO controller.

Note: Units other than general equipment cannot be combined
with general equipment in one group. To register general
equipment to a group to which units other than general
equipment are already registered, delete the existing
registration first before registering general equipment to it.

Note: General equipment groups cannot include remote
controllers or system controllers.

(2) To change the unit icon to be used, touch the icon under
the [Icon] section. A screen to select an icon will appear.
Select an icon to be used, and then touch [OK].

Group4 Meetting room

VContact Points

(36
(30 J 39 [ e |
45 46 [ a7 [ a0 [ a9 | 58 ]

‘ 0K I w Cancel I

(3) In the [Allow Operations] section, make the setting to allow or disallow operation.
Select [In batch and on individual group] to allow the operator to turn on or off the general equipment

collectively or by the groups.

Select [On individual group] to allow the operator to turn on or off the general equipment by the groups.
Select [No operations (Monitor only)] to disallow the operator to turn on or off the general equipment.

(4) In the [Monitor] section, select which status will be used to reflect the units’ ON/OFF status to the unit icons on

the [Monitor/Operation] menu screen.

Select [Output status] to use the status that is sent to the general equipment, and [Input status] to use the

status that is sent from the general equipment.
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5-1-7. HW Supply
Touch [Initial Settings] in the menu bar, and then touch [HW Supply].
Set the address, group names, and detail settings for each group of HWHP (QAHV) unit that is connected to AE-200.

Touch [Save Settings] when done.
Note: Group settings for HWHP (QAHV) units can only be set on the AE-200’s LCD.
Note: The HW Supply settings may not be accessible if logged in as a building manager.

Important
e Settings must be made while communication between HWHP (QAHV) and AE-200 is established.

Initial
Settings

Group name Unit selection

Detail settings

Indicates group’s operation
status (normal/error). -
that the initial startup
procedure has not been

Save Settings

Save Settings
Touch to save the changes
made.

[1] Setting group names

(1) Touch the “Group name” button to display the keyboard. Enter the group name in 20 alphanumeric or symbol

characters or less.
Note: The following characters cannot be used: <, >, &, “, or

[2] Registering HWHP (QAHV) units to a group

(1) To register HWHP (QAHV) units to each group, touch the Hot Water Supplyl
“Unit selection” button located at the right of the target
group name. Hot Water Supply
A screen to select the units will appear.

t Address

Select the address numbers of the units to be registered.
The selected unit addresses will appear with an orange
frame. Touch again to deselect.

Note: Up to 16 HWHP (QAHV) units can be registered to each oK | \ Cancel
group, and up to 24 systems can be registered to each
AE-200.

Note: When controlling HWHP (QAHYV) units, air conditioning
units, and other equipment under the same AE-200,
count each HW Supply units as equivalent to three air
conditioning units, and make sure the number of units that
are equivalent to the number of air conditioning units will
not exceed 50 units.

Note: HWHP (QAHV) units and other models of units cannot be
registered to the same group.
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(2) To change the unit icon to be used, touch the icon.
A screen to select an icon will appear. Select an icon to be

used, and touch [OK]. ﬁ E

Hot Water Supply1

[3] Initial startup of HWHP (QAHV)

(1) When done registering all HW Supply unit groups, touch
[Save Settings].
Initial startup procedure for HW Supply units will start.
When the process is completed, the icon will change to

indicate its completion.
Note: Initial startup procedure will take 2 to 5 minutes.
Note: If an error occurs during the initial startup procedure,
check HWHP (QAHV) units for proper connections.

equipment st

Initial startup procedure | Initial startup procedure Error
not complete complete
e
[4] Detail settings for HWHP (QAHV) units
(1) Inthe [HW Supply] screen, touch the “Detail settings” |
button Hot Water Supplyl
The detail settings window will appear. PSS o e > oo
Note: Only the “Detail settings” buttons for the HW Supply N cor 1 B sencor 2 R 5.
groups whose initial startup procedure has been - - o
Completed are aValIabIe for Se|eCtI0n Op. ON sensor Op. OFF sensor Op. ON differential
(2) Set the settings that are related to operation modes under ok 3 Op. O sensor 0p. OFF sersor On. N dierential
“Mode setting.”
Set the number corresponding to the sensor to be used to ETRER M T
determine the “Thermo-ON” status under “Operation ON T
sensor.”
Set the number corresponding to the sensor to be used |

to determine the “Thermo-OFF” status under “Operation
OFF sensor.”

Set “Operation ON differential” to a temperature between
0.5°C (1°F) and 23.0°C (46°F).

Units will start operating when the differential between the
set temperature and the temperature setting for “Operation
ON sensor” exceeds the value set for “Operation ON
differential.”
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Note: Specify the “Operation ON sensor” with a number equal to or smaller than that of the “Operation OFF sensor.”
Note: Operation will be carried out as shown in the figure below when “Sensor 1” is set for “Operation ON sensor” and “Sensor
3" is set for “Operation OFF sensor” in [Mode setting] for 3-sensor-type model of units.

Operation starts when the formula “Sensor 1 temperature
< (Set temperature - Operation ON differential)” is
satisfied.

Outlet HW temperature Outlet HW temperature

Sensor 1 Sensor 1

- Sensor 2
- Tank

Sensor 3

Sensor 3

Operation ends when the formula “Sensor
3 temperature > Set temperature” is
satisfied.

Note: Operation will be carried out as shown in the figure below when “Sensor 1” is set for “Operation ON sensor” and “Sensor
6” is set for “Operation OFF sensor” in [Mode setting] for 6-sensor-type model of units.

Operation starts when the formula “Sensor 1 temperature
< (Set temperature - Operation ON differential)” is
satisfied.

Outlet HW temperature

Sensor 4

Sensor 5

Tank 2

Sensor 6

Outlet HW temperature

Sensor 4

Sensor 5

Sensor 6

Operation ends when the formula “Sensor
6 temperature > Set temperature” is
satisfied.

(3) Set “Outlet HW ” to a temperature between 40.0°C (104°F) and 90.0°C (194°F).
(4) Touch [OK] to enable the settings.

[6] Completing the settings for HWHP (QAHV) units

(1) When done setting the detail settings for all HW Supply unit groups, touch [Save Settings].
Note: It takes 2 to 5 minutes to transmit the settings.
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5-1-8. Interlocked LOSSNAY
The ON/OFF status of the LOSSNAY unit can be interlocked with the operation of indoor units.
Touch [Initial Settings] in the menu bar, and then touch [Interlock]. Set the interlocking conditions for each AE-200,

AE-50, and EW-50, and then touch [Save Settings].
Note: The Interlocked LOSSNAY settings may not be accessible if logged in as a building manager.
Note: If the system is connected to a TG-2000A, make or change the settings from the TG-2000A.
Note: The ON/OFF status of the indoor units are not interlocked with the ON/OFF status of the LOSSNAY unit.
Note: The [Controller] setting will appear (only on the AE-200’s LCD) when the [System Exp] setting on the [Unit Info.] screen is set
to [Expand]. Switch the [Controller] setting between [AE200] and [Exp1] through [Exp4] to make settings for each AE-200,
AE-50, and EW-50 individually.

Important

e Interlock settings for the AE-50/EW-50 must be made with the AE-50/EW-50 properly connected to ensure proper settings.
Those settings made without the connection of AE-50/EW-50 will not be reflected.

e The interlock settings between the units connected to the AE-200 and the AE-50/EW-50, as well as between the units
connected to different AE-50 controllers, cannot be made.

.\Initigl A Fu
Settings

Controller n Inter lock Blocks
Select [AE] to make S
settings for AE-200, and Control ler m Mitsubishi Interlocked indoor unit

select [1], [2], [3], or [4]
to make settings for each
AE-50/EW-50.

Interlocked LOSSNAY unit
registration

Touch to display the screen
for registering the LOSSNAY
unit.

registration

Touch to display the screen
for registering the air
conditioners.

Save Settings

Save Settings
Touch to save the changes
made.

(1) Touch the “Interlocked LOSSNAY unit registration” button.
A screen to select the units will appear.
Select the address number of the LOSSNAY unit to be IniCnJocked RIS
registered. The selected unit address will appear with an B
orange frame.
Touch again to deselect.

(2) Touch the “Interlocked indoor unit registration” button. A
screen to select the units will appear.
Select the address numbers of the indoor units to which celaiot Wit
the selected LOSSNAY unit will be interlocked. The @H@@@ﬂ 7 J sl o lre]
selected unit addresses will appear with an orange frame. - m IIEI-EEI
Touch again to deselect. 23] 25 | 28| 38

Note: Each LOSSNAY unit can be interlocked with up to 16 air
conditioners.
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5-1-9. Blocks

By making block settings, multiple groups in a given block can be collectively monitored or operated.
Touch [Initial Settings] in the menu bar, and then touch [Blocks]. Register the groups to each block, and then touch

[Save Settings].

Note: Some settings may not be accessible if logged in as a building manager.

Note: If the system is connected to a TG-2000A, make or change the settings from the TG-2000A.

Note: The [Controller] setting will appear (only on the AE-200’s LCD) when the [System Exp] setting on the [Unit Info.] screen is set
to [Expand]. Switch the [Controller] setting between [AE200] and [Exp1] through [Exp4] to make settings for each AE-200,
AE-50, and EW-50 individually.

Note: The ventilation will stop when the Peak Cut control runs for the LOSSNAY units or OA Processing units that perform Night
purge operation. For this reason, do not register the LOSSNAY units and OA Processing units that perform Night purge
operation in the same block.

Important

e Block settings for the AE-50/EW-50 must be made with the AE-50/EW-50 properly connected to ensure proper settings.
Those settings made without the connection of AE-50/EW-50 will not be reflected.

,\ Initial
Settings

Controller <« | Interlock
Select [AE] to make
settings for[AE_]QOO, and Control ler m Mitsubishi
select [1], [2], [3], or [4]
to make settings for each Entrance
AE-50/EW-50.

1 Entrance 1 6 Waiting room

Block No.
Lobby Group name

2 Lobby A

Lobby
3 Lobby B

Meeting room

Save Settings

Block name

Group No.

“AE-50 No. - Group No.”

will appear if one or more
AE-50/EW-50 controllers are
connected.

3
/!

Group registration

Save Settings
Touch to save the changes
made.

(1) Touch the “Block name” button to display the keyboard. Enter the group name in 20 alphanumeric or symbol

characters or less.
Note: The following characters cannot be used: <, >, &, “, or*

(2) Touch the “Group registration” button of the target block. A
screen to select the groups will appear.
Touch the group numbers to be registered. (The name of Group2 Lobby _(South)
the group that was touched last will appear.)
The selected group numbers will appear with an orange
frame. Touch again to deselect.

Note: HWHP (CAHV, CRHV, QAHV) unit groups and chiller unit
groups cannot be registered to a block.

Block2 Blocks 2
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5-1-10. EM Blocks
Carrying out EM block (energy management block) settings enables batch status monitoring and operation of
multiple blocks covering AE-200/AE-50/EW-50.
Touch [Initial Settings] in the menu bar, and then touch [EM Blocks]. Register the blocks to each EM block, and then

touch [Save Settings].
Note: Some settings may not be accessible if logged in as a building manager.

‘\ Igéﬂ?rl‘gs : Functioni Function2

EM Block Floor Layout System View
EM block No. Entrance
1 Entrance 4 Meeting room
Lobby
2 Lobby A 3 Lobby B Block No.
EM block name _ “AE-50 No._- Block No.”
registration Tenant 4 will appear if one or more
AE-50/EW-50 controllers are
5 Tenant A 6 Tenant B 7 Tenant C connected.
EM block registration Block name

Meeting room

8 Meeting room 9 Meeting room

Save Settings

Save Settings
Touch to save the changes
made.

(1) Touch the “EM block registration” button of the target EM
block. A screen to select the blocks will appear.

EM Block1 Entrance

Block
Block1 Entrance

(2) Switch to the controllers ([AE200], [Exp1] through [Exp4]) to which the blocks to register belong.

(38) Touch the block numbers to be registered. (The name of the block that was touched last will appear.)
The selected block numbers will appear with an orange frame. Touch again to deselect.
Note: To select a LOSSNAY unit that is interlocked with indoor units, touch the | ¥ | button and select an address number.

(4) Touch the “EM block name registration” button to display the keyboard. Enter the EM block name in 20
alphanumeric or symbol characters or less.
Note: The following characters cannot be used: <, >, &, “, or*
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5-1-11. Floor Layout
The floor layout on the [Floor] display under the [Monitor/Operation] menu can be changed, and the display position

of the groups on the floor can be changed.
Touch [Initial Settings] in the menu bar, and then touch [Floor Layout]. All unit groups that are under the control of

both AE-200 and AE-50 can be displayed on the Floor Layout screen of the AE-200.
Note: Some settings may not be accessible if logged in as a building manager.

Note: Up to 30 groups can be assigned to each area.
Note: Groups of air conditioners, Air To Water (PWFY)) units, LOSSNAY units, and general equipment can be assigned to the floor

layout.

Important
e Although the Floor Layout settings can also be made on the AE-50’s LCD, only the unit groups that are under the control of

AE-50 controllers can be set on the AE-50’s LCD.
e In independent EW-50 systems, setting of the floor layout using the Initial Setting Tool is possible. (Refer to section 6-5 “Floor

Settings” for details.)

Q, Initial
Settings

| ﬂ B | ocs | FI otir La;out

Floor selection

Area selection
1F Lobby

P

Unassigned groups — I:H:H:l

Touch to display the groups &
that have not been assigned

to an area. P
i = ) N

Basic floor settings : -
Save Settings

Save Settings
Touch to save the changes
made.

Cut
Paste

[1] Basic floor settings

(1) Touch the “Basic floor settings” button to display the
basic floor settings screen.
Total Floors Floor Name

m| o -
2F T t fl
Floor Layout enan oor
"

| & |
ﬂ Floor plan (988 x 1898 dots)
4

=
A

Read from USB Memory

Gridline Hidth of movement

Cancel

(2) Touch [A][¥] to set the total number of floors, and select Total Floors
the floor layout to be used. u

Note: If the total number of floors is set to “--,” none of the
floor layouts can be selected.
Note: Up to ten floors can be registerted. Floor Layout

WT07627X03 53



The display range of the area on the [Floor Layout] screen vary, depending on the selected floor layout.

Floor layout Display area Floor layout Display area

U\l
L

th

JLIE

(38) Touch the “Floor level name” button to display the
keyboard. Enter the floor level name in 3 alphanumeric
or symbol characters or less.

Then, touch the “Floor name” button to display the
keyboard. Enter the floor name in 20 alphanumeric or
symbol characters or less.

(4) To read floor plan files from the USB memory, touch
[Read from USB Memory]. Refer to [2] below for the
restrictions on the floor plan files to be read.

(5) To set the width of the gridlines on the floor layout
screen, touch [Gridline], and switch between [Do not
show] and [Show].

(6) To change the icon movement width when moving icons
on the floor layout screen, touch [Width of movement],
and switch between [Small], [Middle], and [Large].

Small 7 Middle

[2] Restrictions on the floor plan files to be read

Floor level name
Floor name

Floor plan (988 x 1898 dots)
Read from USB Memory

Gridl ine

Show

Width of movement

Middle

Gridl ine

Show

Hidth of movement

Middle

File size 630 dots
—>

450 dots $ H

900 (height) x 1890 (width) dots for each floor plan
Note: The file size must be 900 (height) x 1890 (width) dots regardless of the display range of the area. (Even
when the floor layout shows only one display area, the file size must be 900 (height) x 1890 (width)

dots. In this case, create a file plan only in the left top area.)

1890 dots

IQOO dots

gif

cannot be read.

File format Note: Files that contain extension data (metadata such as XMP, transparent GIF, interlace GIF, animated GIF)
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Floor *1 File name Floor *1 File name
1 floor_01.gif 6 floor_06.gif
2 floor_02.gif 7 floor_07.gif
3 floor_03.gif 8 floor_08.gif
File name 4 floor_04.gif 9 floor_09.gif
5 floor_05.gif 10 floor_10.gif
*1  The floor numbers in the table are not the actual floor level name, but the number counted from the bottom on the [Floor
Layout] screen. Even if the floor level name is set to “15F,” the file name will be “floor_01.gif” when the floor is the first
floor in the setting.
File location In the root folder of the USB memory
R G B R G B R G B R G B
224 71 72 101 112 150 130 150 153 176 255 185
221 151 152 126 137 176 105 134 135 238 255 240
81 66 81 142 149 175 37 96 86 154 255 163
105 89 105 175 180 199 204 214 211 198 255 203
17 16 17 33 77 225 48 64 59 106 255 116
51 42 52 37 83 234 250 255 253 137 255 144
27 23 30 39 86 240 227 255 243 226 252 227
165 145 185 41 89 245 241 255 248 124 233 125
33 37 57 42 92 249 237 249 243 250 255 250
2 17 85 46 93 246 67 97 79 167 229 166
6 35 160 23 47 124 59 78 66 107 145 104
6 28 122 63 104 238 61 116 80 182 211 180
9 40 168 77 116 241 85 128 100 23 95 15
12 45 176 99 137 255 154 177 162 149 211 141
154 162 194 126 146 214 14 45 24 128 140 126
211 214 227 149 170 235 59 93 70 95 202 74
15 49 182 70 79 108 178 187 181 194 231 186
17 53 188 179 189 222 46 181 88 147 169 142
20 57 195 191 202 230 59 157 90 41 177 3
24 64 205 192 210 241 90 213 129 166 203 154
17 46 149 163 170 180 214 255 225 208 224 202
21 52 163 236 242 250 224 239 228 219 235 211
28 70 215 159 185 210 129 155 135 172 187 164
32 64 178 144 154 162 178 194 182 203 211 197
45 80 204 204 228 245 115 255 143 241 244 238
44 75 190 112 183 219 99 193 117 199 201 195
55 90 213 126 139 145 182 201 185 110 114 98
69 99 205 214 241 251 59 255 88 127 129 119
99 122 202 159 240 253 19 255 48 210 211 196
Available colors
(RGB) to be R G B R G B R G B R G B
/ ) 255 253 185 179 159 1 225 148 50 195 195 195
used in the file 193 193 150 172 169 147 214 159 89 193 193 193
255 255 221 187 185 169 77 76 75 191 191 191
121 121 106 179 177 162 230 211 206 189 189 189
162 162 147 205 203 187 207 203 202 185 185 185
142 142 129 224 222 206 225 197 192 179 179 179
94 94 89 212 201 139 225 8 8 173 173 173
212 212 203 136 134 122 221 179 179 171 171 171
235 235 227 158 156 143 152 151 151 169 169 169
213 213 207 217 215 202 255 255 255 166 166 166
203 203 198 230 228 216 250 250 250 161 161 161
137 137 134 142 128 71 249 249 249 154 154 154
116 116 114 254 246 220 246 246 246 148 148 148
245 245 242 244 237 215 243 243 243 143 143 143
85 85 84 33 25 2 241 241 241 133 133 133
121 121 120 111 110 107 239 239 239 129 129 129
253 253 252 63 43 4 236 236 236 103 103 103
119 117 23 106 104 100 232 232 232 82 82 82
255 253 143 133 132 130 228 228 228 70 70 70
253 241 7 116 79 14 225 225 225 64 64 64
174 173 157 254 251 246 220 220 220 58 58 58
208 195 0 255 151 0 217 217 217 51 51 51
220 210 64 93 61 13 215 215 215 44 44 44
156 153 113 254 221 171 211 211 211 41 41 41
201 199 175 157 97 18 209 209 209 34 34 34
151 150 136 211 205 197 207 207 207 4 4 4
187 175 71 205 128 31 205 205 205 0 0 0
195 193 175 187 116 28 202 202 202 255 170 63
198 197 187 219 138 35 198 198 198 255 203 131
* Use the colors in the table above, otherwise the floor plan will appear in different colors.
* The default background color is RGB [103, 103, 103].
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[3] Moving a group to other areas

(1) On the [Floor Layout] screen, touch the group icon to 7\ IEQi?Ags

be moved. The selected group icon will appear with an [ Floor Lavout BT
orange frame.
Note: When the “Unassigned groups” button is touched,
groups that have not been assigned to any area will
appear in the order of their group numbers. (Up to 30
groups will appear in an area.)

Save Settings

Settings

(2) Touch [Cut]. 2 Initial "
The orange frame will change to a pale orange frame. I | : [ Floor Layout

Save Settings

(3) With the pale orange frame being displayed, select the Menu bar
area to move the group to, and touch [Paste] to move |[ /—Sub menu bar
the selected group to the selected area. Tnitial

Note: A popup message will appear when you touch the item
in the menu bar or sub menu bar to see other screens
without the changes being saved. Note that the changes
will NOT be saved unless the [Save Settings] button is
pressed.

Save Settings

Area selection Paste
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,\ Initial
Settings

(4) Touch [Save Settings].
Note: To move the pasted group icon within the area, refer to [4]

“Moving a group within the area” below.

1F Lobby
EEE
VAT
“ Save Settings

[4] Moving a group within the area
Note: It is recommended to use a commercially available touch pen
(1) On the [Floor Layout] screen, touch the group icon to A Initial
be moved. The selected group icon will appear with an

orange frame.

1F Lobby

===

(2) Touch and hold the group icon for one second. The A Igitial
orange frame will change to an yellow-green frame.
Note: The group icons cannot be moved on the screen that
appears when the “Unassigned groups” button.

(8) Drug and drop the icon to move anywhere within the

area.

1F Lobby

===

Save Settings

(4) Touch [Save Settings].

57
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5-1-12. System View
Refrigerant system information (connection information of outdoor and indoor units) can be checked for each AE-200,
AE-50, and EW-50.
Touch [Initial Settings] in the menu bar, and then touch [System View].
Note: This screen shows the information of the units that have been registered to a group and have started up successfully.
Note: The [Controller] setting will appear (only on the AE-200’s LCD) when the [System Exp] setting on the [Unit Info.] screen is set

to [Expand]. Switch the [Controller] setting between [AE200] and [Exp1] through [Exp4] to display the information for each
AE-200, AE-50, and EW-50 individually.

Initial
A T L)

Controller EM Block Floor Layout System View
Select [AE] to display the .
informaticEn f(erE-2%0yand Controller m Mitsubishi Indoor unit address
select [1]| [2]’ [3]' or [4] to Outdoor Unit (Sub unit) Indoor Units Unit address of the indoor

units that are connected to
the outdoor unit will appear.
Air to Water (PWFY) units
will appear, and LOSSNAY,
HWHP (CAHV, CRHYV,

display the information for

each AE-50/EW-50. 51 (52)

12 3 7 8 916

A 61 (62) 11 12 13 14 15 16
Outdoor unit address

“Unit address of the main 67 17 QAHV)_units, and chiller
unit (Unit address of the sub units will not appear.
unit)” will appear. 8 18
73 19 20
4 27

95

(1) Switch the [Controller] setting between [AE200] and [Exp1] through [Exp4] to check the system information for
each AE-200, AE-50, and EW-50 individually. (Only on the AE-200’s LCD)
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5-1-13. Advanced settings
Touch [Initial Settings] in the menu bar, and then touch [Advanced].

Make necessary settings, and then touch [Save Settings].
Note: The Advanced settings may not be accessible if logged in as a building manager.

Initial w
J\ gslet’lc?ngs

Advanced Network Groups

Advanced Setting
" Time Master/Sub
Master

Time Master/Sub

Old model compatibility
mode 0ld model compatibility mode Hold type

OFF

Schedule: Season setting
Available

Hold type

Schedule: Season setting &

Save Settings

Save Settings
Touch to save the changes
made.

[1] Time Master/Sub

The default setting is [Master].

This setting is required to change only for a system with multiple AE-200 controllers connected to an AE-50
controller (System configuration (1) below).

System configuration

— : Time setting flow

: [Time Master/Sub] setting

(1) System with multiple AE-200 controllers connected to an AE-50 controller

Set to [Master] on only one of the AE-200 controllers in a system.

AE-200 >

|:|T AE-50 Outdoor unit Indoor unit

AE-200
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(2) System with an AE-200 controller connected to AE-50 controllers

Leave the default setting [Master] as it is.

aster
— — >  a
: ——
AE-200 AE-50 Qutdoor unit Indoor unit
AE-50 Qutdoor unit Indoor unit

(3) System with a high-level system (i.e., TG-2000A) connected to AE-200 controllers

Leave the default setting [Master] as it is.

Master|
-

TG-2000A AE-200 Outdoor unit Indoor unit

Master|
L -

AE-200 Outdoor unit Indoor unit

[2] Old model compatibility mode
In the [Old model compatibility mode] section, select [ON] or [OFF].
When [ON] is selected, the Dual set point function and Prohibit Remote Controller function (Timer, Air Direction, Fan
Speed) cannot be used.
Note: If the setting is changed, the controller will reboot.

Note: When changing the old model compatibility mode while this mode is used, note the following.

+ The set temperature will go back to the default setting value. Write down the current set temperature of each group to
reconfigure the set temperature settings later.

* The set temperature for the schedule settings will be cleared. Write down the current set temperature of each group for
schedule settings to reconfigure the set temperature settings later.

+ Some equipment whose operation is to be interlocked with another equipment support the dual set point function in the
Auto mode. Reconfigure the Interlock Control setting if it is affected by the change of the old model compatibility mode.
[3] Hold type
The Hold function is a function to disable the operations that were scheduled for air conditioning unit groups.
If the setting for [Hold] is set to [ON] on the operation settings screen under the [Monitor/Operation] menu and the
[Hold type] on the screen above is set to [Forced], the [Hold] setting can be cancelled only from the AE-200/AE-50.

If the [Hold type] is set to [Normal], the [Hold] setting can be cancelled from AE-200/AE-50, other system controllers,
or remote controllers.

Note: The Hold function can be used on the AE-200A/AE-50A, but not on the AE-200E/AE-50E.

Note: The Hold function cannot be used on general equipments.

Note: The setting [Forced] will not be effective on Air To Water (PWFY)) unit groups, LOSSNAY unit groups, HWHP (CAHV, CRHV)
unit groups, general equipment groups, and air conditioning unit groups that do not support the Hold function (i.e., Mr. Slim
M-Series/P-Series indoor units). If the setting for [Hold] is set to [ON] on those unit groups on the operation settings screen
and the [Hold type] on the screen above is set to [Forced], the setting [Normal] will be effective.

[4] Schedule: Season setting

In the [Schedule: Season setting] section, select [Available] to enable the seasonal settings of the weekly schedules
and [Not Available] to disable. Unless otherwise specified, leave the default setting [Available] as it is.
Note: The settings made on this screen on the AE-200 will be reflected on this screen on the AE-50.
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5-2. Function1

5-2-1. Peak Cut (Energy-save control function)
According to the selected Peak Cut method, the AE-200/AE-50/EW-50 obtains the demand level or the electric
energy values to determine the control level, and operates outdoor units and blocks of indoor units below the
specified maximum capacity that corresponds to the control level.
Touch [Functions 1] in the menu bar, and then touch [Peak Cut] to access the Peak Cut control settings screen.
Make necessary settings, and then touch [Save Settings].

Important

e The amount of electricity that is actually used may exceed the maximum power demand due to unexpected problems
such as controller malfunctions or broken transmission cables. Mitsubishi Electric will not be responsible for exceeding the
maximum power demand.

e An energy-save control can be performed, regardless of the electric energy consumption status. To perform an energy-
save control at the same level (control level 0) at all times, make the control settings for control level 0 for given outdoor and
indoor units. (In this case, Peak Cut method setting is not necessary.)

Note: Peak Cut settings using the LCD are possible on the AE-200/AE-50 from Ver. 7.23 onwards.

Note: After completing the settings, perform a test run and confirm proper connections of equipment before using the Peak Cut
function.

Note: A separate license is required to use the Peak Cut function. Make sure that the required license has properly been registered
on the [License] screen. (Refer to section 4-5 “License registration for optional functions” for details.) If the license is not
registered, the settings can be saved, but the function will not be available until the license is registered. When the license is
not registered, a message “License not registered” will appear at the left bottom of the screen.

Note: Some settings may not be accessible if logged in as a building manager.

Note: Peak Cut control cannot be performed on DIDO controller (PAC-YG66DCA), AHC, Air To Water (PWFY)) unit, HWHP (CAHV,
CRHYV, QAHV) unit, or chiller unit.

Note: The Peak Cut control of indoor units is performed per block. Be sure to make block settings to use the Peak Cut function.

Note: The Peak Cut control settings between the outdoor and indoor units connected to the AE-200, AE-50, and EW-50, as well as
between the units connected to different AE-50/EW-50 controllers, cannot be made.

Note: Do not make the Peak Cut control settings for heat pump models of outdoor units or some types of outdoor units. For details,
refer to section 5-2-1-2 (2) “Control details for outdoor units (All Peak Cut methods)”.

T 4 Functioni [&

Controller Peak Cut Settings Measureme

Select [AE200] to make 3
settings for AE-200, and Control ler GFLN Mitsubishi Electric
select [1], [2], [3], or [4]
to make settings for each Peak Cut methad
AE-50/EW-50. PI Controller
Peak Cut method Wartthour meter

int and inlet.

Save Settings

Save Settings
Touch to save the changes
made.
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5-2-1-1. Peak Cut method

Touch the [Settings] tab in the Peak Cut control settings screen.

[PLC Software for Demand Input]

Demand level is
input.

Demand level
signal is sent.

4 N\

[Electric Amount Count Software]
e N

Reads electric
energy values.

Electric Amount Pulse-watt-
Demand-Input Count PLC h
i Demand S our meter
‘ - PLC controller '
o]+ o] -
Maximum ten Maximum fourteen
z <) AE-200/AE-50/EW-50 units z —! ) AE-200/AE-50/EW-50 units
. J . J
[Pl Controller]
/ TN

<When a PI controller (PAC-YG60MCA) is used>

Reads electric
energy values.

»
» | —

Pulse-watt-
hour meter

Pl controller

Reads control
level.

AE-50 [2

Peak Cut method [Remote AE]

Maximum three
AE-200/AE-50/EW-50 units

<When a built-in Pulse Input (PI) is used>

A

— | |AE-200}:

(Built-in Pulse Input (PI)) Pulse-watt-
hour meter
- N
fReads control

|_—_ level.

AE-50 |2

Peak Cut method [Remote AE]

Maximum three
AE-200/AE-50/EW-50 units

[External Contact point input] (1)

External input/output
adapter (PAC-YG10HA-E)

LAN \
" [

Reads control
level.

Demand level is
input.

Demand
controller

L\

Maximum three
AE-200/AE-50/EW-50 units

Peak Cut method [Remote AE]
\ J

WT07627X03
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[External Contact point input] (2)

External input/output
adapter (PAC-YG10HA-E)

N\

Demand level is
input.

AE-200|3

Demand
controller

AE-50 3

AE-50 Maximum three
AE-200/AE-50
AE-50 [ J/EW-50 units
\ y,




[From external system]
e N

Demand level
signal is sent.

AE

PLC etc. Pulse-watt-

AE-50 ¢ hour meter

Maximum ten
AE-200/AE-50/EW-50 units

4_
AE-50 |3 €
<

AE-50 [2

. J

(A) When the Peak Cut method [PLC Software for Demand Input] is selected

1st page
Peak Cut
Control ler i Mitsubishi Electric
Peak Cut method !
Peal Cut d
PLC Software for Demand Input
Initialize
IP address of PLC IP ad FLC
192.168. 1. 191
Temperature difference emp re diffe oint and inlet.
between set point and Save Settings
inlet
Save Settings
2nd page
Peak Cut
Control ler WLl Mitsubishi Electric
IP address of controller PLC Software for Demand Input

control ler
192.168.1.1 A 192.168.1.2
192.168.1. 3 LN 192.168.1. 4
192.168.1. 5 (8 192.168.1.6
192.168.1.7 (N 192.168.1.8

192.168.1. 9 (N 192.168.1.18

Save Settings 4-— Save Settings

(1) Inthe [IP address of PLC] field, enter the IP address of the Demand-Input PLC.

(2) When using the Demand-Input PLC for the first time, initialize its internal memory.
Note: Do not initialize the Demand-Input PLC after the operation has begun, for it will reset all settings to the default settings
and will not properly perform the Peak Cut control.
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(3) Inthe [Temperature difference between set point and inlet] section, a temperature differential can be set to
between 3 and 9 as necessary. The Peak Cut control setting that corresponds to the control level 0 will be
disregarded for the indoor unit groups in which the temperature difference between the set temperature and

the room temperature is greater than the specified temperature differential.
Note: The Peak Cut control setting that corresponds to the control levels 1 to 4 will be effective regardless of the temperature
differential setting.

(4) Inthe [IP address of controller] field, enter the IP addresses of the AE-200/AE-50/EW-50 units to which the
demand level signal is sent. Up to 10 IP addresses can be registered.

(B) When the Peak Cut method [Electric Amount Count Software] is selected

1st page
Peak Cut Settings
Peak Cut method Control ler FLL) Mitsubishi Electric
Pealc Cut method
IP address of PLC Electric Amount Count Software
— Initialize
DI Board 1P address of PLC o
192.168. 1. 151
DI Board Pulse Unit
kih / pulse
Pulse Unit il

oint and inlet.

Save Settings

Temperature difference
between set point and

inlet Save Settings
2nd page
Peak Cut Settingsm
Control ler Wil Mitsubishi Electric
Peak Cut method
Control levels Electric Amount Count Software

Save Settings 4—-— Save Settings

(1) Inthe [IP address of PLC] field, enter the IP address of the Electric Amount Count PLC.
Note: Each PLC can be registered to up to ten AE-200/AE-50 units.
Note: This setting is required for each AE-200/AE-50.

(2) When using the Electric Amount Count PLC for the first time, initialize the internal memory.
Note: Do not initialize the Electric Amount Count PLC after the operation has begun, for it will reset all settings to the default
settings and will not properly perform the Peak Cut control.
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(38) Touch the [DI Board] or [Pulse Unit] button to open the window to select the DI board number to which the watt-
hour meter is connected, and the terminal number. If the watt-hour meter is connected to terminal 2 on a DI

board 1, select 1-2.
Note: Select a DI board number 1 or 2, and select a terminal number/code between 0 and F.

Peak Cut

Board number 1Sy
’ Board number

@ =

Terminal number

el 1 flzfafallsHell7

Terminal number

(s floflalfeflcofefr]

(4) Inthe [Pulse Unit] field, enter the pulse value that the watt-hour meter outputs. Set the pulse value according to
the watt-hour meter to be used.

Important: Check the watt-hour meter readings several times on the hour and the half-hour. Then, be sure to check
that the increase in the watt-hour meter reading for each 30-minute period and the average electric power
consumption in the same period that the Peak Cut function is used are the same amount.
The average electric power for the period that the Peak Cut function is used can be checked on the [Peakcut]
screen.

(5) Inthe [Control levels] section, the range of the electric power must be set for each control level. For control
level 4, enter the value that is 10% to 15% below the maximum power demand (average electric energy that
cannot be exceeded in any 30-minute period). For control levels 3 to 0, enter the value that is decreased by
about 10% from the set value of the previous control level. (The screenshot above shows the setting example

of the maximum demand of 200 kW.)
Note: The optimum setting depends on the system configuration of the electric equipment and on the indoor environment in
each building. Determine the appropriate values accordingly.

(6) Inthe [Temperature difference between set point and inlet] section, a temperature differential can be set to
between 3 and 9 as necessary. The Peak Cut control setting that corresponds to the control level 0 will be
disregarded for the indoor unit groups in which the temperature difference between the set temperature and

the room temperature is greater than the specified temperature differential.
Note: The Peak Cut control setting that corresponds to the control levels 1 to 4 will be effective regardless of the temperature
differential setting.
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(C) When the Peak Cut method [Pl Controller] is selected

1st page
< Peak Cut Settings
Peak Cut method Controller  [RZLL] Mitsubishi Electric
Pealc Cut method

Watthour meter

Save Settings

Temperature difference
between set point and

inlet Save Settings
2nd page
Peak Cut Settings [T 0
Control ler LR Mitsubishi Electric
Pealk Cut method
Control levels PI Controller

Save Settings T Save Settings

WT07627X03 66



(1) Touch the [Watthour meter] button to open the window to select the Pl controller to which the watt-hour meter
used for the Peak Cut function is connected.

Watthour meter

Note: Only the watt-hour meters that have been registered on the [Measurement] screen are selectable. (Refer to section 5-2-
2 “Measurement” for how to register metering devices.)

Note: When a built-in Pulse Input (PI) is used, [Channel No. + (space) + Metering device name] will appear. (For example, if
the watt-hour meter used for the Peak Cut function is connected to channel 3 of CN7 of AE-200 and the metering device
name is “For Peak Cut function,” [3 For Peak Cut function] will appear.)

When a PI controller (PAC-YG60MCA) is used, [PI controller address + “-” + Channel No. + (space) + Metering device
name] will appear. (For example, if the watt-hour meter used for the Peak Cut function is connected to channel 2 of a PI
controller (address 10) and the metering device name is not registered, [10-2] will appear.)

Note: To deselect the selection, select [-- --].

(2) Inthe [Temperature difference between set point and inlet] section, a temperature differential can be set to
between 3 and 9 as necessary. The Peak Cut control setting that corresponds to the control level 0 will be
disregarded for the indoor unit groups in which the temperature difference between the set temperature and
the room temperature is greater than the specified temperature differential.

Note: The Peak Cut control setting that corresponds to the control levels 1 to 4 will be effective regardless of the temperature
differential setting.

(3) Inthe [Control levels] section, the range of the electric power must be set for each control level. For control
level 4, enter the value that is 10% to 15% below the maximum power demand (average electric energy that
cannot be exceeded in any 30-minute period). For control levels 3 to 0, enter the value that is decreased by
about 10% from the set value of the previous control level. (The screenshot above shows the setting example
of the maximum demand of 200 kW.)

Note: The optimum setting depends on the system configuration of the electric equipment and on the indoor environment in
each building. Determine the appropriate values accordingly.

Note: Other than the AE-200/AE-50/EW-50 units that use a built-in Pulse Input (PI) or a Pl controller (PAC-YG60MCA), up
to three more AE-200/AE-50/EW-50 units can be controlled. Refer to (D) “When the Peak Cut method [Remote AE] is
selected” below for details.

(D) When the Peak Cut method [Remote AE] is selected

Peak Cut Settinos [T 0

Control ler LR Mitsubishi Electric

Peak Cut method

Peak Cut method

Remote AE

IP Ad

192.168.1. 2

IP Address

Temperature difference
between set point and
inlet

Temperature diffe set point and inlet.

Save Settings 4-— Save Settings

WT07627X03 67



(1) Inthe [IP address] field, enter the IP address of the AE-200/AE-50/EW-50 that uses one of the following.
- Built-in Pulse Input (PI)
- PI controller (PAC-YG60MCA)
- External contact input (Refer to (E) “When the Peak Cut method [External Contact point input] is selected”
for details.)

Note: As the control level is obtained every minute from the AE-200/AE-50/EW-50 that uses a built-in Pulse Input (PI) or a PI
controller (PAC-YG60MCA), the control will be late for up to one minute on the AE-200/AE-50 whose Peak Cut method
setting is [Remote AE].

Note: Up to three AE-200/AE-50/EW-50 units can be connected to the AE-200/AE-50/EW-50 unit that uses a built-in Pulse
Input (PI) or a PI controller (PAC-YGB0MCA). When five or more AE-200/AE-50/EW-50 units are connected, add the
settings explained in (C) “When the Peak Cut method [Pl Controller] is selected” or use the Peak Cut method [Electric

Amount Count Software].

(2) Inthe [Temperature difference between set point and inlet] section, a temperature differential can be set to
between 3 and 9 as necessary. The Peak Cut control setting that corresponds to the control level 0 will be
disregarded for the indoor unit groups in which the temperature difference between the set temperature and

the room temperature is greater than the specified temperature differential.
Note: The Peak Cut control setting that corresponds to the control levels 1 to 4 will be effective regardless of the temperature
differential setting.

(E) When the Peak Cut method [External Contact point input] is selected

Note: The external signal can be input to AE-200, AE-50, and EW-50, so that all outdoor units and blocks of indoor units can be

selected.
- engs ‘\ Functionl . UNCT 10N, 13
Peak Cut Settings Measurem¢ P> |
Peak Cut method Control ler LR Mitsubishi Electric

Peak Cut method

External Contact point Input

Temperature difference
between set point and
inlet

Temperature difference between set point and inlet.

Save Settings 4—-— Save Settings

(1) Inthe [Temperature difference between set point and inlet] section, a temperature differential can be set to
between 3 and 9 as necessary. The Peak Cut control setting that corresponds to the control level 0 will be
disregarded for the indoor unit groups in which the temperature difference between the set temperature and

the room temperature is greater than the specified temperature differential.
Note: The Peak Cut control setting that corresponds to the control levels 1 to 4 will be effective regardless of the temperature
differential setting.
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(F) When the Peak Cut method [From external system] is selected

Peak Cut Settings

Peak Cut method Controller (lsrlii) Mitsubishi Electric

Peal Cut method

From external system

Temperature difference
between set point and
inlet

Save Settings 4-— Save Settings

(1) Inthe [Temperature difference between set point and inlet] section, a temperature differential can be set to
between 3 and 9 as necessary. The Peak Cut control setting that corresponds to the control level 0 will be
disregarded for the indoor unit groups in which the temperature difference between the set temperature and

the room temperature is greater than the specified temperature differential.
Note: The Peak Cut control setting that corresponds to the control levels 1 to 4 will be effective regardless of the temperature
differential setting.
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5-2-1-2. Unit settings
Touch the [Air-con] tab in the Peak Cut control settings screen.

(1) Control details for blocks of indoor units

Follow the instructions below to make the Peak Cut control settings for each control level for given blocks of

indoor units.
If the block settings have not been made, refer to section 5-1-9 “Blocks” for how to make the block settings.

Important

e An energy-save control at the same level (control level 0) can be performed at all times regardless of the electric energy
consumption status.

1st page (Indoor unit settings)

‘tngs \ Functionl &
Peak Cut —

Control ler i Mitsubishi Electric

Trdoor Units:  Ertrance Batch Operations

Control Method Control Time

Batch Operations
Copy
Paste

Control Method Control Time

Control levels

5 e o |[5s][3]
ENEE anREa
BEAamEa

"®__ Touch to switch the blocks.

Touch to go to the next page
(outdoor unit settings).

(1) Touch E] or |z| to display the block whose settings are to be made. To make settings for all blocks at once,
check the [Batch Operations] checkbox.
Then, select the control method for each control level, referring to the table below.
Note: Only the control method “OFF” is effective for Air To Water (PWFY) units. Other methods can be selected, but are not
effective.

Table: Indoor Unit Control Method

Control Method Control details
None Peak Cut control will not be performed.

During the Peak Cut control, the set temperature in the Cool or Dry mode will be offset by +2°C (+4°F),
and the set temperature in the Heat mode will be offset by -2°C (-4°F).
Note: Peak Cut control will not be performed during the Fan or Auto mode.
Note: When the unit of temperature is Fahrenheit, the set temperature may not be offset by +4°F exactly
1+2°C (14°F) because 2°C is used for the calculation first, and then the temperature in Celsius is converted into
the temperature in Fahrenheit.
Note: The set temperature will be adjusted within the set temperature restrictions settings made on the
Set Temperature Range Limit screen (accessible via the Web Browser for Initial Settings). Refer to
section 7-3-1 “Set Temperature Range Limit” for details.

During the Peak Cut control, free-plan indoor units and A-control Mr. Slim indoor units (M-Series/P-Series
indoor units) will go in to the Thermo-OFF state, and the units older than free-plan units will operate

in the Fan mode. (When the units are in the Thermo-OFF state, the operation mode on the remote
controller LCD will not change.)

During the Peak Cut control, the units will stop.

OFF ™1 Note: If the control method is set to [OFF] and the Control Time is set to [30] minutes, the groups that are
operated in the Peak Cut control cannot be operated from any controller.

Fan ™1

*1 When the indoor unit Peak Cut control function is used during the heating operation, it takes a while to resume operation to prevent cold air
draft. This may negatively affect the performance of the unit for a certain period of time after the operation is resumed. To ensure maximum
performance, it is recommended to use an outdoor unit capacity-save control function (that will not stop the compressor operation) during the
heating operation. If the indoor unit Peak Cut control function is still used, selecting [3] minutes in the Control Time section is recommended.
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(2) For each control level, set the total time in which When [6] minutes is selected I Control time
the Peak Cut control is performed during every 30

minutes. ===

0 3 5 8 10 1315 18 20 23 25 28 30 min

Each Peak Cut control is performed for three Group 1
minutes. If [6] minutes is selected, three-minute &

Peak Cut control will be performed twice during Group 2
every 30 minutes.

If any time other than [30] minutes is selected, the %upﬁg.

indoor units will operate in rotation so that they will
not perform the Peak Cut control at the same time.

(3) To copy the settings of a block to the settings for other blocks, display the block whose settings are to be copied
and touch [Copy], then display the block to which the copied settings are to be pasted and touch [Paste]. The
rectangular icons next to the selected buttons will appear in yellow-green.

(2) Control details for outdoor units (All Peak Cut methods)

Follow the instructions below to make the Peak Cut control settings for each control level for given outdoor units.
Note: If the outdoor unit is a City Multi unit, the M-NET address will appear. If the outdoor unit is an A-control (Mr. Slim) unit, the
M-NET address and group name will appear.
Note: As for A-control outdoor units, only the inverter models can perform Peak Cut control. The Peak Cut control settings for
constant-speed models can not be made.
Note: Do not make the Peak Cut control settings for heat pump models of outdoor units or some types of outdoor units.

2nd page (Outdoor unit settings)

Peak Cut Air-con

Control ler Ll Mitsubishi Electric
Copy

its: A Batch Operations Copy | Paste
Maximum Capacity I GGRUE Batch Operations | _Cony | B
//

Batch Operations

Control Time
Ma i mum Control Time

Control levels m m

oo 5o J o0 | 70 [ eo | 5o

"_ Touch to switch the outdoor
unit addresses.

Save Settings

Touch to go to the previous Save Settings

page (indoor unit settings).

(1) Touch [A]or [¥] to display the address of the Capacity
outdoor unit whose settings are to be made. A
To make settings for all outdoor units at once,
check the [Batch Operations] checkbox.
Then, set the maximum operating capacity for 80% [---=-=----------- o
each control level.
The smaller the maximum operating capacity,
the more energy will be saved.

Note: Energy-saving effects cannot be expected

during low-load operation with the capacity
below the selected maximum capacity.

e.g., Maximum capacity at 80%

'~ = "1 Energy saved

Operating
Capacity

No energy-saving effects Energy-saving effects

> Time
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Note: For heat pump outdoor units and City Multi S series (PUMY) outdoor units, leave the default setting [100%)] as it is not to
activate the capacity-save control.
However, [50%] though [100%] can be set on the following models.
PUMY-P**KM or later
PUMY-P**KM-A or later
PUMY-P**HMC-S or later
PUMY-P**HMC-C or later
PUMY-P**KMC-C or later
PUMY-P**YKM.TH(-T) or later
Note: AE-200/AE-50/EW-50 that support Maximum Capacity [50%] are from Ver. 7.23 or later.

(2) For each control level, set the total time in which the Peak Cut control is performed during every 30 minutes.
Setting the time to [30] minutes is preferable, for shorter control time is not likely to bring much benefit.
If any time other than [30] minutes is selected, the outdoor units will operate in rotation so that they will not
perform the Peak Cut control at the same time.

(3) To copy the settings of an outdoor unit to the settings for other outdoor units, display the outdoor unit whose
settings are to be copied and touch [Copy], then display the outdoor unit to which the copied settings are to be
pasted and touch [Paste]. The rectangular icons next to the selected buttons will appear in yellow-green.
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5-2-2. Measurement
Measurement settings must be made to use temperature sensors, humidity sensors, and metering devices.
Touch [Function1] in the menu bar, and then touch [Measurement]. Set the measurement settings for each AE-200
and AE-50, and then touch [Save Settings].
Note: The measurement settings may not be accessible if logged in as a building manager.
Note: If the system is connected to a TG-2000A, make or change the settings from the TG-2000A.
Note: The [Controller] setting will appear (only on the AE-200’s LCD) when the [System Exp] setting on the [Unit Info.] screen is set
to [Expand]. Switch the [Controller] setting between [AE200] and [Exp1] through [Exp4] to make settings for each AE-200,
AE-50, and EW-50 individually.

Important

o Measurement settings for the AE-50/EW-50 must be made with the AE-50/EW-50 properly connected to ensure proper
settings. Those settings made without the connection of AE-50/EW-50 will not be reflected.

Controller

Select [AE] to make 3
settings for AE-200, and Controller m Mitsubishi
select [1], [2], [3], or [4]
to make settings for each

k= 25 ol A : x— Touch to show the address
AE-50/EW-50. Exhibition hall(T) to which the Al or PI
1 controller will be connected.

M-NET address of Al or PI B 25.0% ‘J},—za. a'c = 1ee.aC ‘+1@. 9°c

controller
Exhibition hall (H)
2

&) 650z ‘0@.@% —h 100 o ‘H@.B%

Selection of Al or Pl

controller
Setting details

Save Settings

Save Settings
Touch to save the changes
made.

[1] Registering Al controllers and temperature/humidity sensors
Follow the instructions below to make the system settings for measurement sensors. Up to two measurement
sensors can be connected to an Al controller (PAC-YG63MCA).

Upper/lower ON- and OFF-
threshold settings for

Measurable range ! :
e-mail alarm function

Sensor name

Al controller icon Upper limit

(ON-threshold)

Upper limit
(OFF-threshold)

48 = | Lower limit

) B (OFF-threshold)
- Lower limit
(ON-threshold)

Setting details of sensor 1

Setting details of sensor 2

Offset value

Temperature or humidity
sensor settings

(1) Touch [4] or [¥] to select the address to which the Al controller (PAC-YG63MCA) will be connected.

(2) Select the Al controller icon ( '—B é).

Note: Touch again to deselect.
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(38) Touch the “Sensor name” button to display the keyboard. Enter the name of the sensor in 20 characters or
less.
Note: The following characters cannot be used: <, >, &, “, or*

(4) Touch the “Temperature or humidity sensor settings” Selection of temperature or humidity
button to display the sensor settings screen. sensor icon
Select the temperature sensor icon (&J) or the humidity /

sensor icon (‘@). )
fensornanme )
Top
— ,

Corrected Sensor value Dffset
\ o — o o
weee = 98t + | KM

0K Cancel

Measurable range Offset value

(5) Touch the [Bottom] and [Top] buttons to display the
keypad. Enter the measurable range of the sensor, and
then touch [OK].

Note: The settable range for temperature sensor is between
-100.0°C (-148.0°F) and +100.0°C (+212.0°F), and for
the humidity sensor is between 0.0% and +100.0%.

Note: When the Pt100 sensor is connected, the range must be
between -30°C (-22°F) and +60°C (+140°F).

When the sensors other than the Pt100 sensors are
connected, enter the ranges that are described in the
operation manuals of the sensor.

(6) To set the offset value for the measured values, touch the [Offset] button to display the keypad. Enter the offset
value, and then touch [OK].

Note: The settable offset value range for temperature sensor is between -10.0°C (-18.0°F) and +10.0°C (+18.0°F), and for the
humidity sensor is between -10.0% and +10.0%.

(7) To receive an e-mail alarm when the temperature or the Upper limit (ON-threshold)
humidity exceeds certain predetermined values, set the
ON- and OFF-thresholds for both the upper and lower
limit temperatures.

Touch the “Upper/lower ON- and OFF-threshold settings
for e-mail alarm function” section to display the settings
screen.

Touch the [U alarm ONJ/[L alarm ON] and [U alarm OFF}/
[L alarm OFF] buttons to display the keypad. Enter the
ON- and OFF-thresholds for the upper and lower limit
temperatures, and then touch [OK].

Uprler/Lower limit temp. settings

Note: To clear the ON- and OFF-thresholds for the upper limit

temperatures, touch [U clear]. To clear the ON- and Lower limit (ON-threshold)
OFF-thresholds for the lower limit temperatures, touch [L Lower limit (OFF-threshold)
clear].

Note: To avoid frequent ON/OFF cycling, the minimum
differential between the ON- and OFF-threshold values
should be 1°C (2°F).

(8) Touch [Save Settings].
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[2] Registering Pl controllers and metering devices

Important

e The built-in Pulse Input (PI) settings cannot be made on the TG-2000A.
e The built-in Pulse Input (PI) cannot be used for the electricity charge apportioning function of TG-2000A.

Follow the instructions below to make the system settings of the metering devices. Up to four metering devices can
be connected to a PI controller (PAC-YG60MCA) or CN7 of AE-200/AE-50/EW-50.
Note: Although the maximum settable total number of built-in Pulse Input (PI) and PI controllers (PAC-YG60MCA) for each
AE-200/AE-50/EW-50 is 15, the number of them in a system with connection to one or more AE-50/EW-50 controllers must
be 20 or less. (Each built-in Pulse Input (PI) counts as one unit.)

<When a built-in Pulse Input (PI) is used>

Mame Pulse Weight
=l _— Pulse value

1

Built-in Pulse Input (PI) 2

Bl

icon Measurement unit

~ 4
Metering device name

Pulse value

1

N\ 2 Measurement unit

N
49

B s

Metering device name 4

Pl controller icon

(1) Touch [A] or [¥] to display the address to which the PI controller (PAC-YGBOMCA) will be connected or to
display the settings area for a built-in Pulse Input (PI) at the top.

(2) Select the PI controller icon (;_ﬁ)

When a built-in Pulse Input (PI) is used, the top row shows the setting area for the built-in Pulse Input (PI) and
there is no need to select an icon.
Note: Touch again to deselect.

(3) Touch the “Metering device name” button to display the keyboard. Enter the name of the metering device in 20

characters or less.
Note: The following characters cannot be used: <, >, &, “, or*

(4) Touch the “Pulse value” button to display the keypad. Enter
the pulse value of the metering device, and touch [OK].
Note: The settable range is between 0.01 and +100.
Note: If the pulse value field is left blank, the reading of the
metering device cannot be properly obtained. Be sure to set
the pulse value.
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(5) Touch the “Measurement unit” button to select the measurement unit.
Note: The measurement unit can be selected from [kWh], [m3], [MJ], [--(no unit)], or [(blank)]. Select the blank when not using

a metering device.

Important

e Set the pulse value according to the metering device to be used. To ensure proper settings, first check the value
measured by the metering device and the value counted by the built-in Pulse Input (PI) or the PI controller (PAC-
YG60MCA). Then, after a certain time, check that both values have increased by equal values. (The values that
the built-in Pulse Input (PI) or the PI controller (PAC-YG60MCA) counts can be checked on the [Measurement]

display under the [Monitor/Operation] menu.)

(6) Touch [Save Settings].
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5-2-3. Energy Management
On the Energy Management screen, make the settings for the energy-control-related items that appear on
the screens under the [Energy Mgmt] menu, such as temperature sensor to measure the outdoor temperature
with, electricity meters that are used for acquiring the data to display the trend graph of indoor unit electricity
consumption, and also the mode that are used for apportioning indoor unit electricity consumption.
Touch [Function1] in the menu bar, and then touch [Energy Management].

Note: Electricity consumption is apportioned based on the electricity consumed by outdoor units. The electricity consumed by

indoor units is not considered.

Note: HWHP (CAHV, CRHV, QAHV) units and chiller units do not support this function.

Important

e Al and PI controller settings are required beforehand to make energy management settings. Refer to section 5-2-2
“Measurement” for details.

e The energy management settings must be made after all units have been started up. The settings that have been saved
while one or more units are starting up may be lost.

Select a temperature sensor

i A Functionl g

Energy Management
Temperature sensor Control ler LVEL] Mitsubishi Electric

to measure the outd(_)or ST g 49-1 Outside temp
temperature with.

Indoor unit operation
apportioning mode

(1)

()

Indoor unit operation

P ame

Indoor unit electricity

Groupn1 1 EAST meter
Entrance 2 47-1 1F

Entrance 3 47-1 1F

Entrance 4 47-1 1F n

Save Settings

Save Settings
Touch to save the changes
made.

Touch the “Temperature Sensor” button. The name of the  [FFEESR.
temperature sensor that is connected to the Al controller or
the AHC will appear. ==
Select a temperature sensor to measure the outdoor

temperature with, and then touch [OK].
Note: To deselect the selection, select [-- --].
Note: This setting is not required when not showing the outdoor
temperature in a line graph on the [Energy Use Status]

screen.
Note: This setting is interlocked with the temperature sensor
setting on the [External Temperature Interlock] screen. x|

Touch the [Indoor unit operation apportioning mode] button.

Select the way indoor units’ operation time is counted that is used to apportion the electricity consumption,
which appears on the screens under the [Energy Mgmt] menu.

Select [Fan operation time] to apportion the electricity consumption based on the fan operation time, and select
[Thermo-ON time] to apportion the electricity consumption based on the Thermo-ON time of the indoor units.
Select [Capacity save amount] to apportion the electricity consumption based on the indoor unit operation time
that was calculated based on the amount of energy saved on the indoor units.

The selected setting must meet the system requirements. Selecting [Capacity save amount] is recommended.
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Note

Note:

(38) Touch the [Indoor unit electricity meter] button.
Select the electricity meter to be used to measure the
electricity consumption of each group of indoor units.
[‘Address”+ Pl controller address + “-” + Electricity meter
number + Electricity meter name] will appear when a Pl
controller (PAC-YG60MCA) is connected, or [‘Meter” +
Channel No. + Electricity meter name] will appear when a
metering device is directly connected to the controller.

Note:
Note:

Note:

Note:

Note:

Note:

: To deselect the selection, select [-- --].
Note:
Note:
Note:
Note:

“FAN operation time” is the cumulative duration of time in which the indoor unit is powered on.

“Thermo-ON time” is the cumulative duration of time in which the refrigerant is flowing into the indoor unit.

“Capacity save amount” is the cumulative operation time of the outdoor unit based on its capacity.

Electricity consumption is apportioned based on the electricity consumed by outdoor units. The electricity consumed by
indoor units is not considered.

When an AE-200 apportioned electricity billing function is used, this setting is not effective because the billing function
settings are used to apportion the electricity consumption.

(S | __ _

Electricity meter

To deselect the selection, select [-- --].
If the electricity meter name is long, only part of it may be
displayed.

The electricity meter name will be blank if it has not been “
registered. —T
Only the electricity meters whose measurement unit setting ekt ER AL

is set to [kWh] on the Measurement screen are available for
selection.

LOSSNAY unit groups and general equipment (connected
via DIDO controller PAC-YG66DCA) groups are excluded.
(Apportioned calculation is not available for these groups.)
When an AE-200 apportioned electricity billing function is
used, this setting is not effective because the billing function
settings are used to apportion the electricity consumption.

(4) Touch [Save Settings] to save the settings.
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5-3. Function2

5-3-1. External Temperature Interlock

Based on the temperature difference between the set temperature and the outdoor temperature, the set temperature
can be adjusted automatically. Making this control setting on the air conditioning unit at an entrance of a building
prevents extreme temperature change from distressing our bodies and sending us into shock.

Touch [Function2] in the menu bar, and then touch [Ext Temp Interlock].
Note: Either an Al controller (PAC-YG63MCA) or AHC, and an outdoor temperature sensor are required to measure the outdoor

temperature.

Note: When connecting one or more AE-50/EW-50 controllers, connect an Al controller (PAC-YG63MCA) or AHC, and outdoor

temperature sensor on each AE-50/EW-50.

Note: The External Temperature Interlock settings may not be accessible if logged in as a building manager.

Note: The External Temperature Interlock settings between the units connected to the AE-200 and the AE-50/EW-50, as well as
between the units connected to different AE-50/EW-50 controllers, cannot be made.

Note: The [Controller] setting will appear (only on the AE-200’s LCD) when the [System Exp] setting on the [Unit Info.] screen is set
to [Expand]. Switch the [Controller] setting between [AE200] and [Exp1] through [Exp4] to make settings for each AE-200,
AE-50, and EW-50 individually.

Important

e External Temperature Interlock settings for the AE-50/EW-50 must be made with the AE-50/EW-50 properly connected to
ensure proper settings. Those settings made without the connection of AE-50/EW-50 will not be reflected.

Controller

Select [AE] to make
settings for AE-200, and
select [1], [2], [3], or [4]
to make settings for each
AE-50/EW-50.

Temperature Sensor
Select a temperature sensor
to measure the outdoor
temperature with.

Group No. and group
name

(1) Touch the “Temperature Sensor” button. The name of the
temperature sensor that is connected to the Al controller or

. A\ Settings| -\

Control ler

Entrance 1

Lobby A

Lobby B

Meeting room

the AHC will appear.

Select a temperature sensor to measure the outdoor
temperature with, and then touch [OK].

Note: To deselect the temperature sensor, select [-- --].
Note: Connect the temperature sensor to either the Analog Input 1

or Analog Input 2 port on the AHC.

Note: This setting is interlocked with the temperature sensor
setting on the [Energy Management] screen.

WT07627X03
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Save Settings

Ext Temp Sensor

47-2
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Control levels

Select a maximum
temperature value to be
added to or subtracted from
the set temperature.

Save Settings
Touch to save the changes
made.

| o | 47-1 Outdoor status



(2) Inthe [Control levels] section, select a maximum temperature value for each group to be added to or
sabtracted from the set temperature.
For example, when [£4°C] (+8°F) is selected and the set temperature for the Cool or the Dry mode is set to
24°C (75°F), the set temperature will be adjusted to a maximum of 28°C (83°F) based on the temperature
difference between the set temperature and the outdoor temperature. When [+2°C] (+4°F) is selected, the set

temperature will be adjusted to maximum of 26°C (79°F).
Note: When the unit of temperature is Fahrenheit, the selected temperature value may not be added to the set temperature
accurately because 2°C is used for the calculation first, and then the temperature in Celsius is converted into the

temperature in Fahrenheit.

(8) Touch [Save Settings].
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When the External Temperature Interlock function is active, the set temperature will be adjusted as shown
below.

H “Cool” and “Dry” modes

36 ~| Outdoor temperature i
35
" N//\\
33
) 32 / Set temperature after being adjusted
o / when [Control levels] is set to [+4°C]
o 3 / (+8°F)
2 30
S 2 / N\
S % / L\
& / 1 L\
6 /1 L\
oe lo—_| D\
24
23 !_S'et temperature |:
Time
Outdoor temperature conditions Set temperature after being adjusted

Outdoor temperature =
Set temperature + 1.5°C (3°F)

Outdoor temperature =
Set temperature + 4.5°C (9°F)

Outdoor temperature =
Set temperature + 6.5°C (12°F)

Outdoor temperature =
Set temperature + 7.5°C (14°F)

Set temperature + 1°C (2°F)

Set temperature + 2°C (4°F)

Set temperature + 3°C (6°F)

Set temperature + 4°C (8°F)

M “Heat” mode
Set temperature
19 N
18 —~_ b |/
17 N L I
16 N\ L I/
O 15 \ | /
R \ 7 /
2 13 | | Set temperature after being adjusted /
g 12 | | when [Control levels] is set to [+4°C] /
S 4 | a8 /
E ||
€ 10 \ /
9 \ A
8 \ /\
7 \L /| Outdoor temperature
5 N |
Time
Outdoor temperature conditions Set temperature after being adjusted

Outdoor temperature <
Set temperature - 4.0°C (8°F)

Outdoor temperature <
Set temperature - 6.0°C (11°F)

Outdoor temperature <
Set temperature - 8.0°C (15°F)

Outdoor temperature <
Set temperature - 10.0°C (18°F)

Set temperature - 1°C (2°F)

Set temperature - 2°C (4°F)

Set temperature - 3°C (6°F)

Set temperature - 4°C (8°F)
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5-3-2. Night Setback Control
The Night Setback Control function (hereafter abbreviated as Setback Control) prevents indoor condensation by
performing heating operation automatically when the room temperature goes outside of the specific range during
the night. Touch [Function2] in the menu bar, and then touch [Setback].
Heating operation starts when a given group is stopped and the room temperature drops below the specified

minimum temperature.

Note: The Setback Control function also prevents excessive temperature rise by performing cooling operation automatically when
the room temperature goes outside of the specific range. Cooling operation starts when a given group is stopped and the
room temperature rises above the specified maximum temperature.

Note: If the operation settings (on/off, operation mode, or set temperature) is changed from a local remote controller during the
Setback Control, the settings selected before the Setback Control will not be restored.

Note: If the room temperature is measured by the return air temperature sensor on the air conditioning unit, the measured value
may not be an accurate representation of the temperature in the room, especially when the air conditioning unit is stopped
and the room air is stagnant. When this is the case, use an external temperature sensor (PAC-SE40TSA) or remote
controller sensor to measure the room temperature.

Note: The Setback Control may not be accessible if logged in as a building manager.

Note: The [Controller] setting will appear (only on the AE-200’s LCD) when the [System Exp] setting on the [Unit Info.] screen is set
to [Expand]. Switch the [Controller] setting between [AE200] and [Exp1] through [Exp4] to make settings for each AE-200,
AE-50, and EW-50 individually.

Important

e Setback Control settings for the AE-50/EW-50 must be made with the AE-50/EW-50 properly connected to ensure proper
settings. Those settings made without the connection of AE-50/EW-50 will not be reflected.

. ! Settings -

Controller
Select [AE] to make Ext Temp Interlock Sethack
settings for AE-200, and Ehmal lar m Mitsubishi

select [1], [2], [3], or [4]
to make settings for each GeniroImi 81:80 - 89:08
AE-50/EW-50. e

Group Mame Minimum Temp - Maximum Temp

Temperature range

Control Time

Entrance 1 17°c - ==

Lobby A 18°c - 38°C
Group No. and group
name Lobby B 25°cC - 28C

Meetina room

Save Settings

Save Settings
Touch to save the changes
made.

(1) Touch the [Control Time] button to display the settings Setback
screen.
Set the [Setback] setting to [Use], set the time period in Sl
which Setback Control is performed, and then touch [OK]. m
Note: When [00: 00 - 00: 00] is selected, Setback Control is active Setback Control Time Period
for 24 hours. Hour Minute Hour Minute

AM AM
mS ol » a5-on
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(2) Touch the “Temperature range” button to display the
settings screen.
Set the maximum and minimum temperatures for each
group. u u
For example, if [Control Time] is set to [01:00 - 05:00] and "[: - I
“Temperature range” is set to [12°C - --°C] ([53°F - --°F]), n n
heating operation starts automatically when the room
temperature drops below the set temperature 12°C (53°F) ‘ oK | ‘ Cancel |
between 1:00 and 5:00. When the Setback Control ends at
5:00, the set temperature returns to the original setting, and
the operation stops.

Minimum Temp Maximum Temp

Note: The air conditioning units in the heating operation will stop and the set temperature will return to the original setting
when the Setback Control period is over or the room temperature rises to the minimum temperature plus 3°C (6°F).
Likewise, the air conditioning units in the cooling operation will stop and the set temperature will return to the original
setting when the Setback Control period is over or the room temperature drops to the maximum temperature minus 3°C
(6°F).

Setback
operation
ends.

Room temp.
21°C (69°F) —OND — — — = — —

Setback
operation -
starts.

Min. temp.
12°C (53°F)= = = = = == A{WV\/
Heat ON Heat OFF Heat ON Heat OFF
21°C (69°F) 12°C (53°F) 21°C (69°F)
>
-

Setback Control period

When the temperature drops below the minimum temperature (heating operation)

Setback
operation
Max. temp. ends.
28°C(83°F) = = =)= = = = = = FA = — = — — — =
Setback
Room temp. operation

24°C (75°F) = AN AF"— — — = — - starts. e
Cool ON Cool OFF Cool ON Cool OFF
24°C (75°F) 28°C (83°F) 24°C (75°F)
>
- -

Setback Control period

When the temperature rises above the maximum temperature (cooling operation)

(8) Touch [Save Settings].
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5-4. Ventilation setting
5-4-1. Night purge

During summer, the Night purge function draws cooler outside air into the room to suppress temperature rises at

night. This energy conservation reduces the load when air conditioning starts the next morning.

Note: During the Night purge operation, LOSSNAY units operate in the Bypass mode.

Note: Night purge setting cannot be made from AE-200 for the LOSSNAY units that are connected to the AE-50/EW-50 in
communication error.

Note: Some models of LOSSNAY units do not support the Night purge function from AE-200. (As of October 2015, only LGH-
RVX-E models support the function.)
For more details about the Night purge function, refer to the Installation Manual, Instruction Book, or technical documents
that are provided with the LOSSNAY unit.

[1] Night purge settings on the LCD
Log in to the Initial Settings menu, touch [Ventil. Settings] in the menu bar, and then touch [Night purge].
All LOSSNAY unit groups that support the Night purge function from AE-200 will appear.

(1) Touch one or more group icons whose settings are to be made, and then touch [Edit].

A Ventil.
Settings

Edit

(2) Inthe [Night purge] section, select [Available] to enable the Night purge settings, make detail settings (days
of the week, start time, end time, outdoor temperature threshold, temperature difference between room
temperature and outdoor temperature, initial fan speed), and then touch [OK].

Note: When [Not Available] is selected in the [Night purge] section, the detail settings cannot be made.
Note: Touch [Cancel] to return to the previously saved settings without making any changes.

iF
Lobby
Night purge Days of the week Days of the week

[Available]/
[Not Available]

End Ti
Start Time nd Time
Outdoor temperature Initial fan speed
threshold
Temperature

difference between
room temperature and
outdoor temperature
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Setting item

Setting method

Remarks

1) Night purge
[Available]/[Not Available]

Touch [Available] to enable the
Night purge settings, and [Not
Available] not to.

(2) | Days of the week

Touch one or more days on
which the Night purge control is
executed at the selected Start
Time below.

<Example>
When the settings are made as follows, the
Night purge control starts at 23:00 on Monday
and ends at 6:00 on Tuesday.

Days of the week: Monday

Start Time: 23:00

End Time: 6:00

* If the [Edit] button is touched with the multiple group
icons selected, all days of the week are selected
when the settings window opens.

(3) | Start Time

Touch E' EI to set the time at
which the Night purge control
starts.

(4) | End Time

Touch El El to set the time at
which the Night purge control
ends.

(5) Outdoor temperature
threshold

Touch E] El to set the outdoor
temperature threshold value as
a condition for activating the
Night purge operation.

Touching E] or El will increase or decrease the
value in 1°C increments.

The settable temperature is between 15°C and
30°C.

Temperature difference
(6) | between room temperature
and outdoor temperature

Touch El El to set the
temperature difference as a
condition for activating the Night
purge operation.

Touching El or E\ will increase or decrease the
value in 1°C increments.

The settable temperature is between 0°C and
7°C.

(7) | Initial fan speed

Touch El El to set the fan
speed to be set when the Night

purge operation activates.

(Fan speed 1) (Fan speed 2) (Fan speed 3 or 4)

* The maximum number of available fan speed setting
from AE-200 is three.
Auto cannot be set for the initial fan speed even for
the units that support the Auto setting.
The initial fan speed setting will not appear for the
units with no fan speed switching function.

Note: Setting the “Night purge” setting to [Not Available] during the Night purge operation will stop the Night purge operation of the

ventilation units (LOSSNAY).

Note: The settings changed from a local remote controller will be reflected on this screen.
Note: When [Not Available] is selected in the [Night purge] section, the detail settings (days of the week, start time, end time,
outdoor temperature threshold, temperature difference between room temperature and outdoor temperature, initial fan

speed) cannot be made.
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Night purge control time chart sample
The time chart when conditions below meet is as follows.

7F
Lobby

Days of the week

available || sun || Mon || Tue || Wed || Thu || Fri || sat |

Not Available

Setting value 1 Setting value 2

Setting value 3 Setting value 4

Starting condition
Condition #1: LOSSNAY units stop at 20:00.
Condition #2: Between the start time 1:00 (setting value 1) and the end time 6:00 (setting value 2)
Condition #3: LOSSNAY units detected the outdoor temperature threshold 17°C (setting value 3) or higher in
the past 24 hours.
Condition #4: The current room temperature is higher than 22°C. (The temperature 22°C cannot be set from
AE-200.)
Condition #5: The temperature difference between room temperature and outdoor temperature is greater than
the temperature difference 5°C (setting value 4).
* LOSSNAY units start the Night purge operation at 3:00 when the temperature difference between room
temperature and outdoor temperature exceeds 5°C.
» The Night purge operation is not activated at 1:00 or 2:00 because the temperature difference between room
temperature and outdoor temperature is less than 5°C.

Time 12:00 16:00 20:00 1:00 3:00 6:00
hvd <z v A4 Av A7
Condition #4 Condition #5
/‘\\ Room temp.: 25°C Temp. difference: 6°C
% ;

Condition #3

Temperature Maximum outdoor
| temperature:29°C |

STt T T T T T T T T 1:00 2:00 \
= Qutdoor temp. i

Temp. Temp. i
= = Room temp. 17°cf4- - - - - - - - - -+ - —" - — - —————————— difference: |+ difference: | — — — —— 4
20C 4°C i

Night purge
LOSSNAY ON OFF operation OFF
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5-5. User Information

5-5-1. Maintenance User
On the [Maintenance User] screen, the user names and passwords of maintenance users can be changed.

Touch [User Info] in the menu bar, and then touch [Maintenance User].

Note: The Maintenance User settings are not be accessible if logged in as a building manager.
Note: The Maintenance User settings are required for each AE-200/AE-50/EW-50.

Settings 4, User Info
. Maintenance User Bui lding Manager
Maintenance user name

and password User name, Password

User name and password User name Password Retype password

can be changed. initial

Save Settings

Save Settings
Touch to save the changes
made.

(1) To change the maintenance user name or password, touch the [User name], [Password], and [Retype

password] buttons. Enter new information on the keyboard.
Note: The user name must contain only alphanumeric characters.
Note: The user name and password are case-sensitive.
Note: The user name must be in 20 characters or less, and the password in 3 to 10 characters.

(2) Touch [Save Settings].
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5-5-2. Building Manager
On the [Building Manager] screen, the user names and passwords of building managers can be changed, and the
available functions for building managers can be limited.
For example, you can allow building managers to change the group name settings when the tenant is changed, or
disallow them to change the basic system settings such as unit settings or network settings.
Touch [User Info] in the menu bar, and then touch [Building Manager].
Note: The Building Manager settings are required for each AE-200/AE-50.

‘l o E i A User Info

Maintenance User Bui lding Manager

Building manager’s user
name and password User name, Password
User name and password User name Password Retype password

can be changed. administrator m

Available Functions

Available Functions . HuiiET ) e
Select the available Date and time Unit Info.
functions for building
managers. Network Advanced

Groups Groups
(Group Name) (Group Structure)

HW Supply HW Supply
(Name/Advanced) (Structure)
Interlock

Save Settings

Save Settings
Touch to save the changes
made.

(1) To change the building manager’s user name or password, touch the [User name], [Password], and [Retype
password] buttons. Enter new information on the keyboard.
Note: The user name must contain only alphanumeric characters.
Note: The user name and password are case-sensitive.
Note: The user name must be in 20 characters or less, and the password in 3 to 10 characters.

(2) Touch the functions to be made available for building Available Functions

managers. The selected functions will appear with an Date and tine Unit Info.

orange frame.

Touch again to deselect. SIS

. . . G G

For more information on each function, refer to the table o iete

below. HH Supply HH Supply
(Name/Advanced) (Structure)

Note: If the user logs in as a building manager, the currently Interlock
available functions can be checked, but cannot be changed.

Note: The settings on this screen will not be reflected to the (Block Name) (Block Structure)
functions on the Web browser. EM Block EM Block
(Block Name) (Block Structure)
Floor layout Floor_ layout
(Floor Name) (Floor Structure)
Functionl

Peak Cut Peak Cut
Setting Control details

—
=
-
o
w
m
-+
-+
=
-]
w

Measurement Energy Management

Function2

Ext Temp Interlock Setback

Ventilation Settings

Night purge Setting

(3) Touch [Save Settings].
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Table. Available Function List

Function

Content

Date and time

Refer to section 5-1-3 “Date and time” for details.

Unit Info. ™1 Refer to section 5-1-4 “Unit Information” for details.
Advanced *1 Refer to section 5-1-13 “Advanced settings” for details.
Network 1 Refer to section 5-1-5 “Network” for details.
Group Name ) )
Groups " Refer to section 5-1-6 “Groups” for details.
Group Structure "1
HW Supply "1 Refer to section 5-1-7 “HW Supply” for details.
Initial Settings | Interlock *1 Refer to section 5-1-8 “Interlocked LOSSNAY” for details.
Block Name
Blocks Refer to section 5-1-9 “Blocks” for details.
Block Structure *1
Energy Name
Management Refer to section 5-1-10 “EM Blocks” for details.
Blocks Structure *1
Floor Name ) .
Floor layout " Refer to section 5-1-11 “Floor Layout” for details.
Floor Structure *1
Setting Refer to section 5-2-1 “Peak Cut (Energy-save control function)”
Peak Cut - :
. Control details for details.
Function1
Measurement Refer to section 5-2-2 “Measurement” for details.
Energy Management Refer to section 5-2-3 “Energy Management” for details.
Function2 Ext Temp Interlock Refer to section 5-3-1 “External Temperature Interlock” for details.
unction
Setback Refer to section 5-3-2 “Night Setback Control” for details.
\S/str;it:;tlon Night purge Refer to section 5-4-1 “Night purge” for details.

*1 At factory shipment, these settings by the building managers are prohibited.
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6. Settings using Initial Setting Tool

6-1. Flow of the initial settings on Initial Setting Tool
Follow the procedures from step 3) onwards to make the initial settings for the apportioned electricity billing
function.

As shown in flow (D below, settings data can be created beforehand at another location, such as office, to send it to
the centralized controller on the day of the trial run.

Initial settings (new registration) (3 When changing the settings
@ (When making the @ (When making the
initial settings off-site) initial settings on-site)
By the day L 2
before the trial Creating the settings
run (at office) dlta
Saving the settings data
On the day of v v | 2
22?1 :;f;)r”” On-site system check Collecting the settings data from AE-200
Creating the settings
Work on data Settings file
site can be ¢ p (collected from AE-200)
reduced _ ) 7 LAN
Saving the settings data Initial Setting Tool —
¢ Loading the settings data via LAN "3
|
. . ; ; i 1
| Sending the settings data to AE-200 | Saving the settings as pre-change data

Example: 20150401A.dat

d

Changing the settings
Settings file : -
(new settings data) ’ ¢ 2
- LAN
Initial Setting Tool ‘ Saving the settings as post-change data "4
Sending the settings data via LAN *3 Example: 20150401B.dat

)

Sending the settings data to AE-200

Settings file
(Post-change data)

LAN
inital Setting Tool DI

Sending the settings data via LAN "3

*1 To change the existing AE-200/AE-50/EW-50 settings, make sure to save the settings file (collected from AE-200) before the change.

*2  After the settings data are loaded on the Initial Setting Tool and the changes are made, do not change the settings on the AE-200’s LCD or
from the Web Browser for Initial Settings until you finish sending the setting changes data.

*3 The settings data created on the Initial Setting Tool cannot be loaded or written to the AE-200 using a USB memory.
*4  Store the settings files set on the Initial Setting Tool (pre-change data and post-change data) in a safe place.
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6-2. General descriptions of Initial Setting Tool
This section explains operation methods that are common to all setting screens of Initial Setting Tool.

6-2-1. Starting up the Initial Setting Tool

J\

AE-200 Initial Setting Tool

The screen below will appear when the Initial Setting Tool is started up.

| MITSUBISHI Air Conditioning Control System - Initial Setting Tool ==

New
X Click to newly create a
plek ‘ settings file.
Open
Click to open the existing
settings file 20 ‘

‘COPYRIGHT (C) 2015 MITSUBISHI ELECTRIC GORPORATION ALL RIGHT RESERVED

When [New] is clicked, all the settings in an unset status will be displayed.

When [Open] is clicked, the “Open” screen will be displayed. You can then select and load the settings file saved on
the PC (filename.dat) which has been created beforehand. Once the settings file are loaded, the settings screen will
be displayed with the settings in the file applied.

Note: When [Open] is clicked, the “Library” > “Documents” folder will be selected for the first time. Select the file saved on the
Initial Setting Tool.
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6-2-2. Screen configurations and common items

lﬁ MITSUBISHI Air Gonditioning Control System - Initial Setting Tool

@ Tool bar File (E) _Data acquistion (M) _Send (5) _Data verification (V) _Option (0) _Help ()
@ Tab (UPPer) — (s et s ot [ocss | st )
(Lower) | O o convatend conrter
(3 Target centralized /‘ Group Settings )
controller ]
&= 3
| o i
@ Setting area o
=
) =
;‘l
=
: =
;‘l
Fenant O =
. =
_,"
® [Save] — \— ® [Back]
Function Operation method Description
Tool bar Operations such as to create, save, Refer to section 6-2-3 “List of tool bar
® load and send the settings files, and to operations”.
monitor the status of the settings from the
centralized controller are possible.
Tab Click the tab to switch between setting When the “tab” of which you want to make
screens. the settings is clicked, settings screen will be
® When the upper tabs are switched, the displayed. Enter the settings data and then
corresponding lower tabs will be displayed. | click [Save].
Click the tab of which you want to make the
settings.
Target centralized From the list of the centralized controllers Depending on the settings screen, this may
controller with connection configuration set, select not be displayed.
® one to make the settings.
Settings are required for each centralized
controller.
Setting area The area in which settings are made. Refer to sections 6-3 “Basic settings”, 6-4
@ “Unit settings”, 6-5 “Floor Settings”, 6-6 “Billing
function settings”, and 6-7 “Interlock Control”
for how to make settings.
[Save] Click to save the settings in the Initial Even when [Save] is clicked, the settings data
Setting Tool. will not be sent to the AE-200/AE-50/EW-50.
After all of the settings are completed, click
[Send settings] in the tool bar to send it to the
® AE-200/AE-50/EW-50. Refer to section 6-2-3
[5] “Send” for details. Note also that even when
saved, the settings are still not been saved in
a settings file. To save a settings file, click [File]
> [Save] or [Save As...] in the tool bar.
® [Back] Click to display the previous settings without
making any changes.
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6-2-3. List of tool bar operations

| File (E} Data acquisition (M) Send (S) Data verification (V) Option (O) Hf\p (H)
4

Bazic Settings t Settings | Floor #ettings | Billing Fyfnotion Settines | IniATlock Control Setties |

File
System Configyfation i
Creates, opens (loads) and saves ¥ Basic Systy

settings files, and saves settings
files with another name.

[10] Help
Displays the version of this software.

1] ‘
2] = | Fior Setings [ il oo Gontal Stings
save (5) Syster Fle(F) Dataacquisition (M) Send (S) Data verification (V) Option (0) | Help (H)
[3] z;e (}S% ® Basic Settines: | Lnit Settings | Floor Settings | Billng Function Settings | Iterlock Gontral 5 20Ut (A) i
[11] System Gonfiewation |Basic System
[4] Qata acqwsmon Option
Acquires settings status of the Able to select the temperature display format
centralized controller. and to output trial run check sheets. 7]
Fle () Deta sopision () Sand (5) _ Data vanatn ) [ opein 0) | K (H)
Basi Seftnes | Unit Setings | Floor Sttings | Biling Funotion Settngs | It ™ 0 ':
e A e
B e oo et
[l
[5] Send [6] Data verification
Sends the settings data to the centralized Verifies the settings data between the Initial Setting Tool
controller. and the centralized controller.

File (E)  Data acquisition (M) | Send () | Data verfication (V) ~ Option (Q)  Help (1)

‘sasm Sotines [Uni Settngs [Foor 509526705 ) | ok Gonvol St File (F) Data acquisition (M) Send (S) | Data verification (V) | Option (Q) Help (H)
e Corfoeston | MBS
Basic Settings | Unit Ssttines | Floor Settines | Bl =Y 93t (V) Control Ssitings

System Configuration | Basic System

[1] New
Click [File] > [New] in the tool bar to create a new “settings file”.

[2] Open
Click [File] > [Open] in the tool bar to load the “settings file” saved on the PC.

[3] Save

Click [File] > [Save] or [Save As...] in the tool bar to save a settings file on the PC.
Note: After the settings are completed, save the settings file and store it in a safe place.
Note: The file will not be saved on the AE-200/AE-50/EW-50.
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[4] Data acquisition
Loads the AE-200/AE-50/EW-50 settings data on the Initial Setting Tool.
Note: When changing the AE-200/AE-50/EW-50 settings, make sure to select [Acquire data] first.

(1) Click [Basic Settings] > [System Configuration] and enter the IP address of the AE-200/AE-50/EW-50 from
which the data is to be acquired. Then click [OK] at the bottom of the screen. (Refer to section 6-3-1 “System
Configuration settings” for details.)

(2) Click [Data acquisition] > [Acquire data] in the tool bar.

(3) If the settings have been changed, a “Confirmation” screen will be displayed asking you to confirm the save
operation. Select [Yes] to display the “Authentication information input” screen.

Password input

Enter the password for initial
settings for the centralized
controller.

Centralized controller system

ID input
Enter the ID for initial settings for
the centralized controller.

Centralized controller name —!

Check box

Check the checkbox when the ID
and password are the same as the
ones for the centralized controller
No. 1.

(4) Enter the maintenance user ID and password of the centralized controller from which the data is to be
acquired.
If the ID and password are the same as ones for the centralized controller No. 1, check the “Same as No.1”
checkbox.

(5) Click [OK] to acquire the data of the settings on the centralized controller. The settings will then be applied
on the Initial Setting Tool.

Note: If data acquisition fails, the settings on the centralized controller registered in “System Configuration” will not be
applied to the settings on the Initial Setting Tool.
Refer to section 6-3-1 “System Configuration settings”.

[5] Send

Click [Send] > [Send settings] in the tool bar to send all Initial Setting Tool settings to the centralized controller.
Note: This sends the settings data to all the centralized controller IP addresses set in “System Configuration” at once.

Note: Always check that all the items that require settings are entered and set before sending the data. Any items that are not set
will be sent to all the centralized controllers as unset items.

Note: To change the settings, first save the acquired settings and make the setting changes before sending the settings data.

[6] Data verification

Checks whether there are mismatched data in the billing-related settings between the Initial Setting Tool and the
centralized controller.
Note: Refer to the Instruction Book (Apportioned Electricity Billing Function) for details of data verification.

, ,

Output target: @ Single output

() Batch output

Gentralized controller: [1 AE-200 V]

Cutput type: [Itsms to be checked durine the trial run ‘]

Data Output l l Cloge l

[71 Temperature unit
Click [Option] > [Temperature] in the tool bar to select the temperature display format on the Initial Setting Tool from
Celsius (°C) and Fahrenheit (°F).

Note: Switching between Celsius and Fahrenheit consists of changing the unit shown on the Initial Setting Tool and does not
set the unit used on each of the centralized controllers. To change the unit shown on the centralized controllers, make the
settings in “Unit of temperature” setting in [Basic Settings] > [Basic System].
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[8] Output - Check sheet for billing function trial run
Click [Option] > [Output - Check sheet for billing function trial run] in the tool bar to output the check sheet used for
billing function trial runs.

Note: The check sheet will be output based on the settings on the Initial Setting Tool.

If the settings on the AE-200/AE-50/EW-50 and the Initial Setting Tool are not the same, the billing function trial will not run
correctly. Be sure to complete [5] “Send” before starting the trial run.

(1) Click [Option] > [Output - Check sheet for billing function trial run] in the tool bar.

Output - Check sheet for billing function m_ =)
Output target
. CQutput target @ Single: output
Centralized controller © Batch output
Output type Centralized contraller: (1 aE-200 ~|

Output type [ems to be checked during the wial run

-]
Data Output Close
~ Close

Data Output

(2) Click the pull-down menu (V) for “Centralized controller” and select the number for the centralized controller
to be output.
Note: This centralized controller number is the one set in section 6-3-1 “System Configuration settings”.
Note: To output the check sheet for all centralized controllers and all output types at once, select [Batch output] for “Output
target”.

(38) Click the pull-down menu (V) for “Output type” and select the [ltems to be checked during the trial run] for
the first trial run. For the second trial run, select [Iltems to be checked 10 days after the trial run]. For the
third trial run, select [Items to be checked on the next day of the closing date].

(4) Click [Data Output].

(5) Set the file name and save destination and then click [Save].
Note: Refer to the Instruction Book (Apportioned Electricity Billing Function) for details of the check sheet.

[9] Output - Check sheet for air-conditioner ON/OFF trial run
Click [Option] > [Output - Check sheet for air-conditioner ON/OFF trial run] in the tool bar to output the check sheet
used for air-conditioner ON/OFF trial runs.

Note: The check sheet will be output based on the settings on the Initial Setting Tool.
If the settings on the AE-200/AE-50/EW-50 and the Initial Setting Tool are not the same, the air-conditioner ON/OFF trial will
not run correctly. Be sure to complete [5] “Send” before starting the trial run.

(1) Click [Option] > [Output - Check sheet for air-conditioner ON/OFF trial run] in the tool bar.

Output - Check sheet for air-conditioner ON/OFF _ =]

Output target

Output targst: @ Sinele output

Centralized controller © Bateh autput

Gentralized contraller 1 AE-200 -

Data Qutput Close

Close
Data Output

(2) Click the pull-down menu (V) for “Centralized controller” and select the number for the centralized controller

to be output.
Note: This centralized controller number is the one set in section 6-3-1 “System Configuration settings”.
Note: To output the check sheet for all centralized controllers at once, select [Batch output] for “Output target”.

(3) Click [Data Output].

(4) Set the file name and save destination and then click [Save].
Note: Refer to “Appendix 1: Air-conditioner ON/OFF trial run” for the contents of the check sheet.
Note: When the PC with Initial Setting Tool installed and the centralized controller are connected via a LAN, the license
registration status can be output in the check sheet.
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[10] Help
Click [Help] > [About] in the tool bar to display the version of the current Initial Setting Tool.

F ™
About M
z MITSUBISHI
ELECTRIC
MITSUEISHI Air Gonditioning Control System - Ihitial Setting
ﬂ Tool
Wer, A%
L.

[11] Exit
Click [File] > [Exit] in the tool bar to exit the Initial Setting Tool.
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6-2-4. Unit address selection screen

On unit address selection screen and group registration screen displayed from the group settings screen, the

selectable unit addresses and groups will be displayed.

When an icon is clicked and selected, the background will change to yellow-green. To deselect an icon, click

the icon again and it will then turn into deselected status (the background will change to light gray). Click [OK]

to complete the selections and close the screen. Click [Cancel] to cancel your selections and close the screen.
Addresses and groups that have already been registered elsewhere will be in gray background and will not be able

to be selected.

On unit address selection screen displayed from the group settings screen, an icon can be changed. To change an
icon, click the icon selection button. Select the desired icon on the group icon selection screen. The selected icon

will be displayed on the AE-200/AE-50’s LCD and in the AE-200/AE-50/EW-50 web browser.

Group other than general equipment group

Group Name:
I Group01

HIHP

Chillr
LOSSNAY

General Equipment (via PAC-YGESDCA)

==

=

System controller

Select Unit Addresses

Group Name:
Groupd!

Block settings

Select Groups

Energy management block settings

Select Blocks

==

Enerey mangement block name:

Enerey Mansgement Block001

B vt 5 Bt

B 0

6-2-5. Other settings
* Up to 40 characters can be entered as the name on the basic system settings screen. Up to 20 characters

/

Icon selection

Remote controller

General equipment group

Select Unit

Gra

up Name:

Groupd!

Addresses

(via PAG-YGEEDGA)

[T
[CRIRTIE)
% W @

© N aperations (Manitor only)
® w0 " Y
48| Meni

© Output status

Tput status

Select Unit Addresses ﬂ

Refrigerant system (indoor unit) settings,

Interlocked LOSSNAY settings, Al controller

settings

Select Unit Addresses. =X
e e le el olee
W oW w ww
o 2w s w a w ww
s e (s s s s w ke
A A A A A

PI controller settings

Select Unit Addresses ==
Pl
ilelslelalalo ool
Mo 1 1w 15 B 7 1B 1w
ETIEIY I TRR IR T T I
s 82 8 8 % % ¥ B 8 M
LI I Tt ST B I )

can be entered as names in other setting screens.

AHC

Select Unit Addresses

Group Name:
Groupd!

Refrigerant system (outdoor unit) settings

Select Unit Addresses

Metering device settings

Select Unit Addresses =

B vt 5 Bt

ilelelelalala ool

* The following characters cannot be used for name settings: <, >, &, “, or ‘
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6-2-6. Preparation and flow of the Initial Setting Tool
To change the AE-200/AE-50/EW-50 settings (for systems with initial settings already made), make sure to first
acquire data of the settings status using the Initial Setting Tool and then follow the procedure below. If you follow a
different procedure, the settings may not be correctly made.

(1) Connect the AE-200/AE-50/EW-50 to a PC (the Initial Setting Tool) via a LAN.
(2) Start up the Initial Setting Tool.

(3) Click [New] or [Open].
To load a settings file stored on the PC, select [Open].
Otherwise, select [New].

(4) Register the IP address of the AE-200/AE-50/EW-50 in [Basic Settings] > [System Configuration].
Refer to section 6-3-1 “System Configuration settings” for details.

(5) Click [Data acquisition] > [Acquire data] in the tool bar to load the AE-200/AE-50/EW-50 settings information
onto the Initial Setting Tool.
* Enter the user ID and password for an AE-200/AE-50/EW-50 maintenance user.

(6) Click [File] > [Save As...] in the tool bar to save the pre-change initial settings data.
Note: For backup purposes, save the pre-change settings file under a file name such as “date + pre-change”.
Note: At this point, the settings will not be sent to the AE-200/AE-50/EW-50.

(7) Change the initial settings. Refer to sections 6-3 “Basic settings”, 6-4 “Unit settings”, 6-5 “Floor Settings”,
6-6 “Billing function settings”, and 6-7 “Interlock Control”.

(8) Click [File] > [Save As...] in the tool bar to save the settings data on the PC.
Note: Save the data using a different name to the pre-change settings file, such as “date + post-change”.
Note: At this point, the settings will not be saved on the AE-200/AE-50/EW-50.

(9) Click [Send] > [Send settings] to overwrite the AE-200/AE-50/EW-50 settings data registered in System
Configuration settings.
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6-3. Basic settings

6-3-1. System Configuration settings
Make the configuration settings of centralized controllers and expansion controllers on the Initial Setting Tool.

Click [Basic Settings] > [System Configuration] to access the system configuration settings screen.

Note: Connection settings can be made for up to 40 centralized controllers.
AE-200 units set as the [AE-200 (Billing)] or [AE-200 (No M-NET)] will not be included in this 40 controllers.

or [EW-50].

1 to 4.

Click the “Expansion controller” checkbox.

Click [Save] after completing the settings.

Enter the IP address in “Destination IP address”.

Enter the IP address of the AE-50/EW-50 in “Destination IP address”.

Click the “Controller type” pull-down menu (V) and select [AE-200], [AE-200 (No M-NET)], [AE-200 (Billing)],

If there are multiple AE-200/EW-50 units, click the “Centralized controller” checkbox and repeat procedures

Note: The selectable options vary depending on the type of centralized controller selected in the “Controller type” of
Centralized controller.
Note: The AE-200/AE-50/EW-50 IP address and expansion controller connection settings cannot be changed in this setting

screen.

To set the AE-200/AE-50/EW-50 IP address, set on the AE-200/AE-50’s LCD, the web browser for initial settings, or
the quick IP address setting switch (EW-50 only).

Controller type
Set the centralized controller

type.

Centralized controller
Check the checkbox to add
a centralized controller.
The checkbox of the first
row is checked and cannot
be unchecked.

Destination IP address
Set the IP address of the
centralized controller.
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@ MITSUBISHI Air Conditioning Control System - Initial Setting Tool @
File (F) Dataacquisition (M) Send (S) Data verification (V) ~ Option (Q)  Help (H)
Basic Settines | Unit Settings | Floor Settings | Billing Function Settings |
Expansion controller
System Configuration Settings Check the checkbox to add
Centralized controll Destination IP addr E: itroll Destination IP addr i
enraled controller estnation P addess sparien contoly estnation I ahess an expansion controller.
T 7 [AE-200 Biling) Bl T E
Vs 9
2 [AE-200 (Mo M-NET) | [192768.12 | B 1921681215 ]
b EALRED Destination IP address
I Set the IP address of the
& o expansion controller.
3 [AE-200 (Mo W-NET) ] [182758.13 ]| 55
4| 7 [Ew- ] [1e2tea e
yia N\
Save — —— Back

Click to save the settings.
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Click to display the previous
settings without making any
changes.



6-3-2. Basic System settings
Click [Basic Settings] > [Basic System] to access the basic system settings screen.
Make necessary basic system settings such as unit settings and M-NET settings for each centralized controller.

Target centralized

controller [ vimsvsisiar condiionng conroNeam -incal seting o3

Select the connected File (F) Data acquisition (M)  Send (S)\ Data verification (V) ~ Option (0)  Help (H)
. Basic Settings | Linit Settines | Floor Settines | BillineNnetion Settines | Interlock Gontral Settines |
centralized controller whose System Ganfirotin] Bsie System _
basic SettlngS aren‘:gdbee Target centralized controHe$[] Mitsubishi building L M-NET Settings
' = Set the M-NET address
Unit Settings and range of prohibited
Set the centralized controller ame controllers.
name and unit ID. The serial e e T s ] _
number and the software e % External Input Setting
version can be acquired. 6 Demar (Lovel s ot 115 Set the external signal input
Emereency Stop (Level sienal)
Decimal point character © OuE v s mode.
d separator character % T~ ©) ON/OFF/Prohibit/Permit (Pulse signal)
an
— 00 75
for CSV file 1202342
o 5 Advanced Setting
Set the format of the CSV <
file that is output from the I e
! it of Temperature @ Al | S— i
centralized controller. Presure i of e St O etz | Advanced Setting
_g Date Format @ 31/12/2016 © 12/31/2016 © 2016/12/31 1 Click to dISpIay the screen
e oot s o 00 for making advanced
Display Format Bo-| Fitersien Dol on o oF settings.
Set the screen display items Terersor dese 10D S e G5t v oo e e v b 4
for the centralized controller
and the Web browser.
Save 7/ \— Back
Click to save the settings. Click to display the previous
settings without making any
changes.

[1] Unit Settings

Set the AE-200/AE-50/EW-50 unit name and unit ID in “Unit Settings”.

Clicking [Acquire] will start communication with the AE-200/AE-50/EW-50 selected in “Target centralized controller”,
and its serial number and software version will be displayed.

Mame |Mitsubishi building |
Unit ID nooom (f figures)

SERIAL Mo. 23164-027
Software Werzion prorrRR

(1) Enter the unit name in “Name” in 40 characters or less. The name entered here will be used as a sender
name in the error notification e-mail and e-mail alarm.

(2) Enter the unit ID in “Unit ID” in 6 figures. Use this setting to manage the multiple unit IDs.

Note: The unit name and the unit ID can be set for each centralized controller that can be selected in “Target centralized
controller”.

Note: The name entered here will be displayed in “Target centralized controller”.

Note: The unit ID will be used as a sender ID in the error notification e-mail and e-mail alarm.

Note: When the software is updated, check that the ####(****) in “Software Version” is the same as the # of the update file
(AEXx_FWi#HHtE **** dat).
For example, if the AE-200 software version is 7.30 (1.05), the update file name is “AE200_FW0730_0105.dat”.

WT07627X03 1 00



[2] M-NET settings

M-MET fddress D

Range of Prohibited Contrallers @) SC/RGC ) RG Only

(1) Enter [0] in “M-NET Address” (unless otherwise specified).

(2) When the local remote controller operation is prohibited on the centralized controller, this setting determines
the scope of its applicability. Select [SC/RC] to prohibit the operation from both the sub system controllers
and the remote controllers. Select [RC Only] to prohibit the operation only from the remote controllers.

[3] External Input setting
In “External Input Setting” column, set the external contact input function. Using a level signal or pulse signal of the
external contact input function, the air conditioning units can be collectively controlled (e.g., stopped, operated) via
a separately-sold external input/output adapter (PAC-YG10HA-E).

Note: Peak Cut control is performed based on the demand level signal (level 1 to 4) input from the connected demand controller.

Note: A separate license is required to use the Peak Cut function.
Note: The external input setting is required for each AE-200/AE-50/EW-50.

Important
e Refer to the AE-200 Installation Manual for details.

@ Demand (Level signall/Naot in use

) Emergency Stop (Level signal)

() OMAOFF (Level gignal)

() ONAOFF/Prohibit/Permit (Pulzse sienal)

(1) Select one of the following options, referring to the AE-200 Installation Manual: [Demand (Level signal)/Not
in use], [Emergency Stop (Level signal)], [ON/OFF (Level signal)], [ON/OFF/Prohibit/Permit (Pulse signal)].

[4] Advanced Settings
Click [Advanced Setting] to open the advanced settings screen.

Advanced Setting M
Time Master @ Master () Sub
Schedule: Seazon setting @ Available ) Mot Available
Old model compatibility mode ) ON @ OFF
Hald type @ Mormal () Farced
i— 0K ] [ Cancel

(1) Time Master/Sub

(1) In“Time Master”, select [Master] or [Sub]. When using two AE-200 units to operate and monitor the
connected units, set to [Master] on only one AE-200, and set to [Sub] on the other AE-200.
The date and time synchronization is performed from the AE-200 whose “Time Master” setting is set to
[Master] to the AE-200 whose “Time Master” setting is set to [Sub].

Important

e When only one AE-200 unit is connected to the system, leave the default setting [Master] as it is.
e When multiple AE-50/EW-50 units are connected to the system, leave the default setting [Master] as it is on all

AE-50/EW-50 units.
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(2) Schedule: Season setting

(1) In“Schedule: Season setting”, select [Available] to enable the seasonal settings of the weekly schedules
and [Not Available] to disable. Unless otherwise specified, leave the default setting [Available] as it is.

(3) Old model compatibility mode

(1) In “Old model compatibility mode”, select [ON] or [OFF].
Select [ON] when not using a Dual set point function and the Prohibit Remote Controller function (Timer, Air
Direction, Fan Speed).
When some of the connected indoor units support a Dual set point function and some do not, selecting [ON]
will mean that they all do not support the function.
When some of the connected indoor units support the Prohibit Remote Controller function (Timer, Air
Direction, Fan Speed) and some do not, selecting [ON] will mean that they all do not support the function.
Note: When changing the old model compatibility mode while this mode is used, note the following.
» The set temperature will go back to the default setting value. Write down the current set temperature of each
group to reconfigure the set temperature settings later.
* The set temperature for the schedule settings will be cleared. Write down the current set temperature of each
group for schedule settings to reconfigure the set temperature settings later.
* Some equipment whose operation is to be interlocked with another equipment support the dual set point
function in the Auto mode. Reconfigure the Interlock Control setting if it is affected by the change of the old
model compatibility mode.

(4) Hold type

(1) In“Hold type”, select [Normal] or [Forced].
The Hold function is a function to disable the operations that were scheduled for air conditioning unit
groups. If the setting for [Hold] is set to [ON] on the Monitor/Operation screen and the “Hold type” on the
screen above is set to [Forced], the [Hold] setting can be cancelled only from the AE-200/AE-50/EW-50.
If the “Hold type” is set to [Normal], the [Hold] setting can be cancelled from AE-200/AE-50/EW-50, other
system controllers, or remote controllers.

Note: The Hold function can be used on the AE-200A/AE-50A/EW-50A, but not on the AE-200E/AE-50E/EW-50E.

Note: The Hold function cannot be used on general equipments.

Note: The setting [Forced] will not be effective on Air To Water (PWFY)) unit groups, LOSSNAY unit groups, and air conditioning
unit groups that do not support the Hold function (i.e., Mr. Slim M-Series/P-Series indoor units).

[5] Display Format
Set the items in “Display Format”.

Display Format
Unit of Temperature @"c O°F
Pressure unit of measure @ MPa (0 PSI O ket/om2
Date Format @ 3171242018 (0 1243172016 () 2016712431
Time Format ) DE0D PM @ 1800
Giroup name display on Gondition List screen () QN @ OFF
Filter Sign Display @ OM () OFF
Temperature display (for LCD) @ Rpom temp. {Always) O Room temp. (During operation) () Set temp.
) Room temp. {Ahwaye)/Set temp, () Room temp. (During op )/Set temp. () Hide
Temperature dizplay (for Web) @ Foom temp {Always) ) Room temp. (During operation) ) Set temp
) Foom temp. (Always)/Set temp. () Room temp. (During op)/Set temp. () Hide
Cocupancy sensor display () Hide @ Show occupancy icon. () Show vacancy icon. () Show both icons.
Brightness sensor display @ Hide ) Show bright icon. (0) Show dark icon. () Show both icons
Humidity sensor display @ ON () OFF

In “Unit of Temperature”, select the desired temperature unit.

In “Pressure unit of measure”, select the desired pressure unit.

)
)
(3) In “Date Format”, select the desired display format for year, month, and date.
) In“Time Format”, select the desired display of time format.

)

In “Group name display on Condition List screen”, select [ON] to display the group names under the icons
on the Monitor/Operation screen. Select [OFF] not to display the group names.
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(6) In “Filter Sign Display”, select [ON] to display the filter sign on the Monitor/Operation screen, and select [OFF]
not to.
When the “Filter Sign Display” is set to [OFF], the filter sign will not appear on the Monitor/Operation screen
even when the indoor unit detects a filter cleaning signal.
If the filter is regularly cleaned and the sign display is unnecessary, set it to [OFF].

(7) In the [Temperature display (for LCD)] section, select the desired display option for the room temperature or
the set temperature to be used on the [Floor] or [Block] display on the LCD.
In the [Temperature display (for Web)] section, select the desired display option for the room temperature or
the set temperature to be used on the [Floor Layout] screen on the Integrated Centralized Control Web.
Select [Room temp. (Always)] to display the room temperature at all times, [Room temp. (During operation)]
to display the room temperature only during operation, [Set temp.] to display the set temperature at all
times, [Room temp.(Always)/Set temp.] to display both the room temperature and set temperature at all
times, [Room temp.(During op.)/Set temp.] to display the room temperature only during operation and
to display the set temperature at all times, and [Hide] not to display the room temperature or the set
temperature.

Note: The room temperature shown may be higher than the actual temperature especially when the unit is stopped during

the Heat mode. Therefore, selecting [Room temp. (During operation)] is recommended when displaying the room
temperature.

(8) In “Humidity sensor display”, make the Show/Hide setting for the humidity reading of the built-in humidity
sensor on the ME remote controller (North America: PAR-UO1MEDU, Other countries: PAR-U0O2MEDA).
Select [ON] to display the humidity reading on the Monitor/Operation screen.

Note: The table below summarizes the items that are displayed on the Monitor/Operation screen according to the
combination of the settings for “Temperature display” and “Humidity sensor display.”

Temperature display
Humidity [Room temp. (Always)] [Room temp.(Always)/
sensor Set temp.]
i or [Set temp.] or Hide
displa i .
pay [Roor:pteerrzt;i)c.)r(]l):;urlng [Room temp.(During op.)/
Set temp.]
OFF Upper: Room temp. Upper: Set temp. Upper: Room temp. Upper: N/A
Lower: N/A Lower: N/A Lower: Set temp. Lower: N/A
ON Upper: Room temp. Upper: Set temp. Upper: Room temp. Upper: N/A
Lower: Humidity Lower: Humidity Lower: Set temp. Lower: Humidity

(9) In “Occupancy sensor display”, make the Show/Hide setting for the occupancy/vacancy status that is
detected by the built-in occupancy sensor on the ME remote controller (North America: PAR-UO1MEDU,
Other countries: PAR-U02MEDA).

Occupancy icon Vacancy icon

(Blue) (Gray)

Select [Hide] not to display the occupancy/vacancy status on the Monitor/Operation screen.

Select [Show occupancy icon] to display the occupancy icon when the sensor on the remote controller
detects occupancy.

Select [Show vacancy icon] to display the vacancy icon when the sensor on the remote controller detects
vacancy.

Select [Show both icons] to display the occupancy or vacancy icon according to the occupancy status of the

room.
Note: If the ME remote controller has no built-in occupancy sensor, the occupancy/vacancy icons will not be displayed on
the Monitor/Operation screen.
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(10) In “Brightness sensor display”, make the Show/Hide setting for the brightness/darkness status that is
detected by the built-in brightness sensor on the ME remote controller (North America: PAR-U0O1MEDU,
Other countries: PAR-U02MEDA).

Brightness icon Darkness icon

(Yellow) (Gray)

Select [Hide] not to display the brightness/darkness icons on the Monitor/Operation screen.

Select [Show bright icon] to display the brightness icon when the brightness level in the room reaches the
predetermined brightness level.

Select [Show dark icon] to display the darkness icon when the darkness level in the room reaches the
predetermined darkness level.

Select [Show both icons] to display the brightness or darkness icon according to the brightness/darkness
level of the room.

[6] CSV file format settings (separator character and decimal point character)

(1) Set the format of the AE-200 CSV file (apportioned results, charges calculation results from the Charge
Calculation Tool).

Important

e This setting must be the same with the “Decimal point character for CSV file” and “Separator character for CSV file”
settings on the [Advanced Settings] screen on the Charge Calculation Tool. If the settings are not the same, an error
message “The CSV file format is not appropriate. Check the directory from which the CSV file is acquired.” will appear.

e When multiple AE-200 units are connected, make the same settings for all of them.

[7] Saving the settings
Click [Save] after setting [1] to [6] above.
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6-4. Unit settings

This section explains how to make unit settings on the Initial Setting Tool.

6-4-1. Group settings

Note: Each group can contain up to 16 air conditioners.

Note: Air conditioners (City Multi indoor unit), Air conditioners (A-control), LOSSNAY units, Air To Water (PWFY) units, HWHP (CAHV,
CRHV) units, chiller units, and general equipment groups cannot be combined in one group.

Note: HWHP (QAHV) units cannot be registered from the Initial Setting Tool. Register the HWHP (QAHYV) units on the LCD.

Note: When registering LOSSNAY units or OA Processing units, do not combine the units that support Night Purge function and the
units that do not in one group.

Note: The addresses of the units that have been registered to other groups or used for the interlocked LOSSNAY settings, PI controller
settings, or Al controller settings will appear with a gray background and cannot be selected.

(1) Click [Unit Settings] > [Groups] to access the group settings screen.
Register the groups of air conditioning units, LOSSNAY units, OA Processing units, Air To Water (PWFY)
units, HWHP (CAHV, CRHV) units, general equipment, remote controllers, system controllers, or AHC to be
connected to the AE-200/AE-50/EW-50.

Unit registration

'@ MITSUBISHI Air Conditioning Contral System - Intal Setting Tool E==1  Click to display the screen
Target centralized ———— = m e for registering the air
controller Groups \R:ngevam System | Interlocked io *vsl Blocks | Ener:y Management Black | Pl entroller | AL oummuy/ condltloner_s, Air To Water
Select the connected Tt certazct conoi RS - (PWFY) units, LOSSNAY

units, OA Processing units,

centralized controller whose

group Settings are to be Group Settings HWHP (CAHV, CRHV) units,
made. crap ame chiller units, and general
J [ — equipment.
Group No. System controller
et & registration
2 * Click to display the screen

Group name for registering the system

controllers.

Remote controller
registration

. Click to display the screen
: E;I o for registering the remote
= N controllers.

ﬁ

“—- — AHC registration

A Click to display the screen

for registering the AHC.
Save — 9 9
Click to save the settings. Back

Click to display the previous
settings without making any
changes.

(2) In “Group Name”, enter the group name in 20 characters or less.
(3) Click the icon in “Unit registration” ( W& ) to display the unit address selection screen.

(4) Select [Air-conditioners], [Air-conditioners (A-control)], [Air To Water], [HWHP], [Chiller], [LOSSNAY], or
[General Equipment (via PAC-YGG66DCA)].

(5) Select the address numbers of the units to be registered.

(6) When [General Equipment (via PAC-YG66DCA)] is selected, select the contact number that is connected to
the general equipment to be registered.

(7) To change the icon, click the right or left arrow.
The selected icon will be displayed on the AE-200/AE-50’s LCD and on the AE-200/AE-50/EW-50's
Integrated Centralized Control Web.

(8) When [General Equipment (via PAC-YG66DCA)] is selected, make the setting to allow or disallow operation
in “Allow Operations”.
Select [In batch and on individual group] to allow the operator to turn on or off the general equipment
collectively or by the groups.
Select [On individual group] to allow the operator to turn on or off the general equipment by the groups.
Select [No operations (Monitor only)] to disallow the operator to turn on or off the general equipment.
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(9) When [General Equipment (via PAC-YG66DCA)] is selected, in “Monitor”, select which status will be used
to reflect the units’ ON/OFF status to the unit icons on the Monitor/Operation screen.
Select [Output status] to use the status that is sent to the general equipment, and [Input status] to use the
status that is sent from the general equipment.

(10) Click [OK] after completing the settings.
(11) Click the icon in “Remote controller registration” ( EI ) to display the unit address selection screen.

(12) Select the address numbers of the ME remote controllers to be registered, and click [OK].
Note: Each group can contain up to two ME remote controllers.
Note: Each group can contain up to four ME remote and system controllers combined.
Note: MA remote controllers do not need to be registered to a group.

(13) Click the icon in “System controller registration” ( ] ) to display the unit address selection screen.

(14) Select the address numbers of the system controllers to be registered, and click [OK].
Note: Each group can contain up to four ME remote and system controllers combined.

(15) Click the icon in “AHC registration” ( | < ) to display the unit address selection screen.

(16) Select the address number of the AHC to be registered, and click [OK].
Note: Each group can contain one AHC.

(17) Click [Save] to save the settings.

Note: Switch the “Target centralized controller” setting to make group settings for each centralized controller.

Note: The controllers to which [AE-200 (Billing)] or [AE-200 (No M-NET)] is set in section 6-3-1 “System Configuration
settings” will not be displayed in “Target centralized controller”.

Note: Up to six general equipment can be registered for each DIDO controller (PAC-YG66DCA). Each contact counts as
one unit.

Note: Each group can contain up to 16 general equipment. (Each contact counts as one unit.)

Note: To register general equipment to a group to which units other than general equipment are already registered, delete
the existing registration first before registering general equipment to it.

Note: General equipment groups cannot include remote controllers or system controllers.
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6-4-2. Refrigerant System settings
Refrigerant system information (connection information of outdoor, sub outdoor, and indoor units) can be set.

(1)

Click [Unit Settings] > [Refrigerant System] to access the refrigerant system settings screen.

@ MITSUBISHI Air Conditioning Control System - Initial Setting Tool &*
. Fila () Dataacquisition (M) Send (S) Data verification (V) Option (Q) Help (H) . . .
Target centralized e e <o | Bl Fasin Sstns] ’ ) Indoor unit registration
controller Refisrent System | triocked oSS Blcks | Enerey Maragsmant Bl | P Gantaller | Gantolkr Click to display the screen
Select the connected Targetcentralized corioller (11 Miisubish bulding 1F 3 for registering the indoor
centralized controller whose i units.
refrigerant system settings
Outdoor unit Sub outdoor unit Indoor unit
are to be made. poe —
.ﬁ 51 j 52 \E'J 12345 F
’,/ j 56 ofa 57 \Q 673910
Outdoor unit registration — = — I
C||Ck to d|Sp|ay the Screen g i1 g 62 63 ‘ \Q 111213 14 16 16 17 18 19 20
for registering the outdoor |8 v
units.
2 |9 L
o = Sub outdoor unit
d 4 i registration
¥ i | I Click to display the screen
d e — for registering the sub
e outdoor units.
oS’ =
s _sge i
Data acquisition —J_ ] [ i i
Click to acquire the N
connection information
of the actual unit from / N
AE-50/EW-50 and replace Save — \ Back

the settings.

Click to save the settings.

Click to display the previous
settings without making any
changes.

Click [Data acquisition] with the units properly connected to acquire the connection information from AE-200.
Click the icon in “Outdoor unit registration” ( ,E ) to display the unit address selection screen.

Select the address number of the outdoor unit to be registered, and click [OK].

Click the icon in “Sub outdoor unit registration” ( OE ) to display the unit address selection screen.

Select the address number of the sub outdoor unit to be registered, and click [OK].

Click the icon in “Indoor unit registration” ( "f ) to display the unit address selection screen.

Select the address number of the indoor unit to be registered, and click [OK].

Note: Ensure that these settings match the actual connection status. Also open [Initial Settings] > [System View] screen on
the AE-200’s LCD and check that the settings are the same. If the settings are not the same, the charges will not be

If A-control units are group registered, the addresses of the A-control units will be displayed under “Indoor unit” or

If a “warning message” appeared during [Data acquisition], there may be an error in the air conditioner connection

information and in the group setting, Pl controller setting or Al controller setting on the Initial Setting Tool.
Review the settings on the Initial Setting Tool and then try the data acquisition again.

condition. In this case, add or change the information on this screen.

centralized controller or check the air conditioning units.

2)
3)
(4)
(5)
(6)
(7)
(8)
(9) Click [Save] to save the settings.
properly calculated.
Note:
“Outdoor unit”.
Note:
Note:
Note:
Note:
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Adding or deleting the information on this screen will not change the actual refrigerant system.
Not all the refrigerant system information may be acquired depending on the centralized controller’s start-up

If the displayed information acquired from the centralized controller differs from the actual system, restart the



6-4-3. Interlocked LOSSNAY settings

The ON/OFF status of the LOSSNAY or OA Processing units can be interlocked with the operation of indoor units.
Note: The ON/OFF status of the indoor units are not interlocked with the ON/OFF status of the LOSSNAY unit.

(1) Click [Unit Settings] > [Interlocked LOSSNAY] to access the interlocked LOSSNAY settings screen.

@ MITSUBISHI Air Conditioning Control System - Initial Setting Tool @
File (F) Data acquisition (M) Send (S) Data verification (V) Option (Q)  Help (H)
Basic Settings | Unit Settines | Floor Settings | Billing Function Settings|
stem | Interlocked LOSSNAY | Blocks | Energy Management Black | PI Gontraller | Al Gontroller
Target centralized controller [1,1 Misubishi building 1F -
Interlocked LOSSNAY Settings
Interlocked LOSSNAY Indoor Units
e i
L
Interlocked LOSSNAY 5 e & Interlocked indoor unit
. ' registration registration
Cllcl_( to (_:hsplay the screen > — Click to display the screen
for registering the LOSSNAY for registering the air
unit to be interlocked. 3w — conditioners with whose

operations are to be

e e interlocked.

e g 910

b ) U 11218 1415

save —/ N Back
Click to save the settings. Click to display the previous

settings without making any
changes.

(2) Click the icon in “Interlocked LOSSNAY registration” ( 3% ) to display the unit address selection screen.
(3) Select the address number of the LOSSNAY to be interlocked, and click [OK].
(4) Click the icon in “Interlocked indoor unit registration” ( " ) to display the unit address selection screen.

(5) Select the address number of the air conditioners with whose operations are to be interlocked, and click [OK].
Each LOSSNAY can be interlocked with up to 16 indoor units.

(6) Click [Save] to save the settings.
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6-4-4. Block settings
By making block settings, multiple groups in a given block can be collectively monitored or operated on the AE-200’s
LCD and the Integrated Centralized Control Web.

Note: The ventilation will stop when the Peak Cut control runs for the LOSSNAY units or OA Processing units that perform Night
purge operation. For this reason, do not register the LOSSNAY units and OA Processing units that perform Night purge
operation to the same block.

Note: HWHP (CAHV, CRHV, QAHV) unit groups and chiller unit groups cannot be registered to a block.

(1) Click [Unit Settings] > [Blocks] to access the block settings screen.

Target centralized

contr 0" er File (F)  Data acquisition (M) ~Snd (S) Data verification (¥)  Option (Q)  Help (H)
[ Basic Settings | Linit Settines | Floor Settings | Sng Function Settings | | CO from rou Settin s
Select one of the connected Groups | Refrigerant System | Interlocked Lo‘mﬂvgy Wanazs ment Block | P1 Gortraller | AL Controller Cli pkyt gt EI K tgh
centralized controllers Target cenfraized controler. |1-1_ Misubishi Buiding 1F = Ic o_crea e a OCK Wi
whose block settings are to - the settings copied from the
be made. group settings.
Block Name Member Groups:
) gy s 1
BIOCk No | up3 nant G G i t t-
' F oen e 3 roup registration
“ Tt E Click to display the screen
T oo e for selecting groups.
& g Tme
O g T
Block name _ w 2 )
Tenant & @ Groupls  Tenant O
Save — \_ Back
Click to save the settings. Click to display the previous
settings without making any
changes.

(2) In “Block Name”, enter the block name in 20 characters or less.

The name entered here will be displayed on the LCD and the Integrated Centralized Control Web.
Note: Click [Copy from group settings] to create a block with the settings copied from the group settings.

(3) Click the icon in “Group registration” ( W&# ) to display the group selection screen.

(4) Select the group numbers to be registered, and click [OK].
(To show the group name, move the cursor to the group number.)

(5) Click [Save] to save the settings.
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6-4-5. Energy management block settings
Make the settings for the energy management block (tenant) used as collective unit for the apportioned electricity
billing function.

[1] General descriptions
(1) What is energy management block (tenant)?

* An energy management block (tenant) is the unit used for displaying and outputting charge calculation
results.
* An energy management block (tenant) is a collection of operation blocks.

* An operation block is a collection of groups.

Energy management block

Operation block

(2) LOSSNAY (including OA Processing unit) settings
Make the settings based on the LOSSNAY system configuration.

Usage Energy management block setting method
LOSSNAY When not interlocked with the operation of | To apportion the electric energy, set as energy
indoor units management block (tenant). (See [2] (3).)
When interlocked with the operation of No settings are required (cannot be set as a target
indoor units for billing function).

Note: The LOSSNAY electric energy will be
apportioned based on the operating status
of the interlocked indoor units.

OA Processing unit | When not interlocked with the operation of | Set as energy management block (tenant). (See [2]
indoor units (3).)

When When interlocked with Set as same energy management block (tenant)
interlocked with | the operation of same as the interlocked indoor units. (See [2] (6).)

the operation of | tenant’s indoor units
indoor units

When interlocked with Make the settings in one of the following ways:
h i f multipl
the operation of multiple <Method 1>

tenants’ indoor units

Set as independent energy management block
(tenant) and invoice the electricity charges by
including it to common area charges, etc. (See [2]

(6).)

<Method 2>

Exclude these units from the tenant settings.

In this case, the electric energy for OA Processing
units will be apportioned based on the operating
status of the interlocked indoor units.
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[2] Energy management block settings

(1) Click [Unit Settings] > [Energy Management Block] to access the energy management block settings
screen.

Target centralized —= e ——"— Member LOSSNAY

controller W Gxm@ = with heater/humidifier
SeIeCt one Of the ConneCted isr‘f‘anasemem Black | PI Gontraller | Al Gontroller / regiStration
centralized controllers / Click to display the screen
Target centraized controller. |1 Miisubishi Buiing / B X |
whose energy management / for selecting OA Processing
block settings are to be Energy Management Block Settings units.
made' Enerey management block name Member LOSSNAY with heater and i “"‘:'
i ) eot win E| .
—— Copy from block settings
—/ .
Energy management block Click to create an energy
No. ¢ (=7} management block with the
settings copied from the
s = N& = block settings.
0 BN o ¥z::::m w e
Member block registration
5 D0 B3 oty Teeun w/ Click to display the screen
Expl  Blockd  Tenant P .
for selecting member blocks.
J BE [ fon Bog =
Expl  Block12 it S
TR O =) T L4 J
Save — \_ Back
Click to save the settings. Click to display the previous
settings without making any
changes.

(2) In“Energy management block name”, enter the energy management block number in 20 characters or less.
Note: By setting the same name for the energy management blocks that are connected to different AE-200 units, the
calculation results can be merged.
Refer to the Instruction Book (Apportioned Electricity Billing Function) for details.
Note: Click [Copy from block settings] to create an energy management block with the settings copied from the block
settings. Then, make the setting for the OA Processing units in steps (6) through (8).

(3) Click the icon in “Member block registration” ( £ ) to display the member block selection screen.
(4) Select one of the controllers ([AE200], [Exp1] through [Exp4]) of the member block to be registered.

(5) Select the block number of the member block to be registered, and click [OK].
Note: To show the block name, move the cursor to the block number.

(6) Click the icon in “Member LOSSNAY with heater/humidifier registration” ( W# ) to display the OA Processing
unit address selection screen.

Note: The setting for the OA Processing units in steps (6) through (8) is required only when the apportioned electricity
billing function is used.

(7) Select the controller ([AE200], [Exp1] through [Exp4]) of the OA Processing unit to be registered.

(8) Select the unit address of the OA Processing unit to be registered, and click [OK].
Note: To show the block name, move the cursor to the block number.

(9) Click [Save] to save the settings.
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6-4-6. Pl controller settings
To use metering device on the centralized controller, follow the instructions below to register Pl controllers (PAC-

YG60MCA) and to make measurement settings.
Note: The maximum settable number of Pl controllers for each centralized controller is 15. The maximum number of connectable
P1 controllers in an AE-200 system is 20.
Note: A separate license is required to use the Peak Cut function using the measurement values.
Note: Only the addresses that have not been registered on the group, interlocked LOSSNAY, or Al controller setting screens are
available for selection.

(1) Click [Unit Settings] > [PI Controller] to access the Pl controller settings screen.

I MITSUBISHI Air Conditioning Control System - Initial Setting Tool =

Target centralized

File (F)  Data acquisition (M)\Gend (S)  Data verification (V)  Option (Q)  Help (H)

controller T i I ] i i
S Metering device name
Select one of the connected Groups | Refrigerant System | Interlocked LOSSNAT Nqeks, | Enerey Management Block | PI Controller | Al Gontraller
centralized controllers Taygemenmedmmuiﬂ 11 Misubishi buiding 1F -
whose PI controtllekr) settnr:jgs i S
are o e ma e- PI Controller address Metering device name Pulse Weight
i [Outdoor Tnit ]| [ \l ﬁmh .D
. ch? ndoor Tt 1| @ u_[kw" - |7
) ) /*v;g IR ik _ = Pulse Weight
Pl controller registration
Click to display the screen o U I\ - D,
for registering PI controllers. Y 1 [E—
. o | ]| 1 I )
= . 1k I 3 ;
Measurement unit
o | ]| T | B
o | ]| 1 I )
- che [ ][ [ It )
3 ;é

Save —/ ) Back
Click to save the settings. Click to display the previous
settings without making any
changes.

(2) Click the icon in “PI controller registration” ( =3 ) to display the unit address selection screen.

(8) Select the address number of the Pl controller to be registered.
When a built-in Pulse Input (PI) of AE-200/AE-50/EW-50 is used, select [PI].

(4) In “Metering device name” (Ch1 to Ch4), enter the metering device name in 20 characters or less.

(5) Enter the pulse weight and select the measurement unit.
Note: The measurement unit can be selected from [kWh], [m3], [MJ], or [--(no unit)].
Note: When not using a metering device, leave the pulse weight blank and select [--(no unit)] for the measurement unit.

(6) Click [Save] to save the settings.

Important

e Set the pulse weight according to the metering device to be used. To ensure proper settings, first check the value
measured by the metering device and the value counted by the built-in Pulse Input (PI) of AE-200/AE-50/EW-50 or the PI
controller. Then, after a certain time, check that both values have increased by equal values. (The values that the built-
in Pulse Input (PI) of AE-200/AE-50/EW-50 or the PI controller counts can be checked on the LCD and the Integrated
Centralized Control Web.
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6-4-7. Al controller settings
To use temperature and humidity sensors, follow the instructions below to register Al controllers (PAC-YG63MCA)

and to make measurement settings.

Note: Only the addresses that have not been registered on the group, interlocked LOSSNAY, or Pl controller setting screens are
available for selection.

(1) Click [Unit Settings] > [Al Controller] to access the Al controller settings screen.

& MITSUBISHI Air Conditioning Control System - Initial Setting Tool

Target centralized Eila(F)__Data at}qu\g\l\on‘L) Send (S) Data verification (¥) ~ Option (Q)  Help (H)
s | LNt Floor Settings | Billing Fun ings
contro"er Groups ||‘R.34 rigerant Syster m|yn«ey\ack%'t«!suL|m rey I‘Aanagemem Black | PIContraller | AI Controller
Select one Of_ the connected Target cenfraized confrollr. [1-1_ Mitsubishi buiding 1F -
centralized controllers
whose Al controller settings Eligonholleisstings)
are to be made. Al Controller address Sensar range Measurement setting
Bt o ] y'd al
I i Wesrable ranee § B e i
. . @ M Temperatire sercer Modified Value Sensor value
Al controller registration T & Funidty sonor o o [ -
Click to display the screen M s iy ]
for registering Al controllers. I i Weasuae enee O v - @ @ s T8
M Tenperati sercer Modified Value Sensor value Offset =
@ Q) Hunstty ser ‘- v [ ] 0=
]
@ Not in use
Chi (5] M Temperature sensor
_M Q0 Humidity sensor
@ Mot in use
Ch2 M Temperature sensor
Q] Humiity sensor
Save — ) Back
Click to save the settings. Click to display the previous
settings without making any
changes.
Measurable range
Al Cantroller sddress Sensor name/Measurable range / N Upper/lower ON- and
Sensor name P-{outei Tero ! OFF-threshold settings
) > ot 11 use Measrable ranee @ Far oo ) o0 ) for e-mail alarm function
SEIeCtlo.n.Of ] . RN Modified Value S Offset
temperature or hum!dlty © Q] Humidity soncor ‘os o[ feaie |+ [0 < 0 Upper limit
sensor icon =M s Famidi | (ON-threshold)

@ Not in use
> Measurable range:

O s - @ [0 s
Offset
20 ~]%

Gh?

Upper limit
(OFF-threshold)

Lower limit
(OFF-threshold)

@ [y Tenperaturs sensor
Modified Value

% =

Sensor value
£

cquire

0.0 96
\;

Click the icon in “Al controller registration” ( .53 ) to display the unit address selection screen.

@ m Humidity sensor

Acquire

Lower limit
(ON-threshold)

()
®)
(4)
®)

Select the address number of the Al controller to be registered, and click [OK].

Enter the name of the sensor in 20 characters or less.

Select a temperature sensor icon ( JM ) or humidity sensor icon ( Qﬁl
in use” can also be selected.

) for Ch1 and Ch2 respectively. “Not

(6) Enter the measurable range of the sensor.
When the Pt sensor is connected, the range must be between -30°C (-22°F) and +60°C (+140°F).
When the sensors other than the Pt sensors are connected, enter the ranges that are described in the

operation manuals of the sensor.

(7) To receive an e-mail alarm when the temperature or the humidity exceeds certain predetermined values, set
the ON- and OFF-thresholds for both the upper and lower limit temperatures.
To avoid frequent ON/OFF cycling, the minimum differential between the ON- and OFF-threshold values

should be 1°C (2°F).
(8)

Click [Save] after completing the settings.
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[1] Offsetting the measured temperature/humidity values
To set the offset value for the measured values, click [Acquire] to acquire the current value, and set the offset value

according to your usage environment.

Note: If Al controller connection settings for a given centralized controller have not been saved, the “measurement value” will not
be displayed even when [Acquire] is clicked.

Note: When registering an Al controller for the first time, the “measurement value” cannot be acquired. To input the “offset value”
after acquireing and checking the “measurement value”, once the setting information must be sent to the centralized
controller. After registering the Al controller and temperature/humidity sensors, send the settings data to the centralized
controller. (See section 6-2-3 [5] “Send”.)

Note: The default offset value for temperature sensor is “0.0”. The settable offset value range is between -10.0°C (-18.0°F) and
+10.0°C (+18.0°F).

Note: The default offset value for humidity sensor is “0.0”. The settable offset value range is between -10.0% and +10.0%.
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6-5. Floor Settings

6-5-1. Floor settings for LCD
The floor layout on the floor display under the [Monitor/Operation] menu on the LCD can be set and changed, and
the display position of the group icons on the floor can be changed.

(1) Click [Floor Settings] > [Floor] to access the LCD’s floor settings screen.

& MITSUBISHI Air Conditioning Control System - Inital Setting Tool s =)
File(F) Data acquisition (M) Send (S) Data verification (V) Option (Q) Help (H)

Basic Settings | Unit Settings | Floor Settines | Billing Function Settines | Ta rg et centralized
Floor [ Floor Layout | Floor for Iterated Gentralized Gontrol Wieb | Floor Layout for Integrated Gentralized Gontral Web / controller

-]

Target centralized controller- [| Mitstubishi building

Total Floors ‘ Floor level name
. & e _ =
Floor Layout Clear Floor name

war IS
v ar 4

L Import floor plan

. Inpart
/'
Clear floor plan
Floor Layout
Import \\\.
T~— Floor plan image
BE 1l 1 i ) [ | — Back
LA
— Save

(2) In[Target centralized controller], select a target centralized controller.

The floor level settings for the selected centralized controller will appear.
Note: The target centralized controller No. is the number shown in 6-3-1 “System Configuration settings”. The controller name
is the name registered in unit settings in Basic System settings.

(3) Click [Edit] in [Total Floors] to display the “Total number of floors setting” screen.
(4) Set the total number of floors by entering the number on the keyboard or by clicking [+! [=] buttons.

-
Total number of floors setting g—ﬂ
L Total number of floors

=]
OK

I GCancel ;‘!‘\
b —— Cancel

Note: If the total number of floors is set to “0,” all groups will appear as unassigned groups.
Note: Up to ten floors can be registerted.
The display range of the area on the Floor Layout screen vary, depending on the selected floor layout.

Floor layout Display area Floor layout Display area

Uil
L

th

JLIE

) In [Floor Layout], select the floor layout to be used.
) In [Floor level name], enter the floor level name in 3 alphanumeric or symbol characters or less.
(7) In [Floor name], enter the floor name in 20 alphanumeric or symbol characters or less.
)

To read a floor plan file, click [Import] and select a file. Refer to the table below for the restrictions on the floor
plan files to be imported. Click [Clear] to delete the imported floor plan file.

WT07627X03 11 5



Restrictions on the floor plan files to be read

900 (height) x 1890 (width) dots for each floor plan
Note: The file size must be 900 (height) x 1890 (width) dots regardless of the display range of the area. (Even
when the floor layout shows only one display area, the file size must be 900 (height) x 1890 (width)
dots. In this case, create a file plan only in the left top area.)
File size 630 dots
——>
450 dots:D
900 dots
1890 dots
File capacity Max. 600 KB for each floor plan
gif
File format Note: Files that contain extension data (metadata such as XMP, transparent GIF, interlace GIF, animated GIF)
cannot be read.
R G B R G B R G B R G B
224 71 72 101 112 150 130 150 153 176 255 185
221 151 152 126 137 176 105 134 135 238 255 240
81 66 81 142 149 175 37 96 86 154 255 163
105 89 105 175 180 199 204 214 211 198 255 203
17 16 17 33 77 225 48 64 59 106 255 116
51 42 52 37 83 234 250 255 253 137 255 144
27 23 30 39 86 240 227 255 243 226 252 227
165 145 185 41 89 245 241 255 248 124 233 125
33 37 57 42 92 249 237 249 243 250 255 250
2 17 85 46 93 246 67 97 79 167 229 166
6 35 160 23 47 124 59 78 66 107 145 104
6 28 122 63 104 238 61 116 80 182 211 180
9 40 168 77 116 241 85 128 100 23 95 15
12 45 176 99 137 255 154 177 162 149 211 141
154 162 194 126 146 214 14 45 24 128 140 126
211 214 227 149 170 235 59 93 70 95 202 74
15 49 182 70 79 108 178 187 181 194 231 186
17 53 188 179 189 222 46 181 88 147 169 142
20 57 195 191 202 230 59 157 90 41 177 3
24 64 205 192 210 241 90 213 129 166 203 154
17 46 149 163 170 180 214 255 225 208 224 202
21 52 163 236 242 250 224 239 228 219 235 211
28 70 215 159 185 210 129 155 135 172 187 164
32 64 178 144 154 162 178 194 182 203 211 197
45 80 204 204 228 245 115 255 143 241 244 238
44 75 190 112 183 219 99 193 117 199 201 195
55 90 213 126 139 145 182 201 185 110 114 98
69 99 205 214 241 251 59 255 88 127 129 119
99 122 202 159 240 253 19 255 48 210 211 196
Available colors
(RGB) to be R G B R G B R G B R G B
/ ) 255 253 185 179 159 1 225 148 50 195 195 195
used in the file 193 193 150 172 169 147 214 159 89 193 193 193
255 255 221 187 185 169 77 76 75 191 191 191
121 121 106 179 177 162 230 211 206 189 189 189
162 162 147 205 203 187 207 203 202 185 185 185
142 142 129 224 222 206 225 197 192 179 179 179
94 94 89 212 201 139 225 8 8 173 173 173
212 212 203 136 134 122 221 179 179 171 171 171
235 235 227 158 156 143 152 151 151 169 169 169
213 213 207 217 215 202 255 255 255 166 166 166
203 203 198 230 228 216 250 250 250 161 161 161
137 137 134 142 128 71 249 249 249 154 154 154
116 116 114 254 246 220 246 246 246 148 148 148
245 245 242 244 237 215 243 243 243 143 143 143
85 85 84 33 25 2 241 241 241 133 133 133
121 121 120 111 110 107 239 239 239 129 129 129
253 253 252 63 43 4 236 236 236 103 103 103
119 117 23 106 104 100 232 232 232 82 82 82
255 253 143 133 132 130 228 228 228 70 70 70
253 241 7 116 79 14 225 225 225 64 64 64
174 173 157 254 251 246 220 220 220 58 58 58
208 195 0 255 151 0 217 217 217 51 51 51
220 210 64 93 61 13 215 215 215 44 44 44
156 153 113 254 221 171 211 211 211 41 41 41
201 199 175 157 97 18 209 209 209 34 34 34
151 150 136 211 205 197 207 207 207 4 4 4
187 175 71 205 128 31 205 205 205 0 0 0
195 193 175 187 116 28 202 202 202 255 170 63
198 197 187 219 138 35 198 198 198 255 203 131
* Use the colors in the table above, otherwise the floor plan will appear in different colors.
* The default background color is RGB [103, 103, 103].

(9) Click [Save] to save the settings.
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6-5-2. Floor Layout settings for LCD
Click [Floor Settings] > [Floor Layout] to access the LCD’s floor layout settings screen.

File(F) Data acquisition (M) Send (S) Data verification (v) Option (Q)  Help (H)

e e T Target centralized
Floar | Floor Layout [Floar for Itesrated Gentralized Gantral Web | Flar Layaut for htegrated Gentralized Ganiral Web | }/ controller

Target cenfraized controller: [4_ Misubishi builing

Assign with gridline

Floor switching
Group Name:
L Tenant E
Group name /'-w — Assigned group
Centralized controller  EEEEEEEEE
switching i i 0 0 0
23 24 .... 29 30
) e
Groups to be assigned < 1) i1 [ i ) i ) i o) Selected group

e (e
>

/'

Assignment mode/

Deletion mode ~— Floor plan image

T~—— Back

Save
[1] Assigning groups
(1) Click [Assignment mode].
(2) Select a target centralized controller.
(3) In [Floor switching], select a floor to set the layout.
(4) Switch between display areas by scrolling up/down, and left/right.
(5) Select the controller managing the group to assign. (EW-50 cannot be selected.)

(6) Select the group number to assign.

Note: . (green) indicates a selected group, - (dark gray) an assigned group, and 1 (light gray) a selectable group.
Note: Groups of air conditioners, Air To Water (PWFY) units, LOSSNAY units, and general equipment can be assigned to the
floor layout.

(7) Click on the floor plan image to assign the group.
Note: If assigning group icons overlappedly, groups having higher group number are placed above.

(8) Click [Save] to save the changes.

[2] Moving groups within areas

(1) Click [Assignment mode].

(2) Click the group icon you wish to move within the display area, and this will become selected (with orange
frame).

Note: Before clicking the group icon, placing a check mark in “Assign with gridline” to select ( ) will allow assignment of
the group icons at a set interval.

Additionally, removing this check mark ( ) will allow fine assignment of group icons.
(3) Click again in the location to move to in order to confirm the group icon positions.

(4) Click [Save] to save the changes.

[3] Deleting groups
(1) Click [Deletion mode].
(2) Click the assigned group icon, and this will return to the selectable group.

(38) Click [Save] to save the changes.

Note: Up to 30 groups can be assigned to each area. If the layout is 2 (height) x 3 (width), up to a maximum of 180 groups
can be assigned on each floor.
Note: Groups that have not been assigned to any area will appear in “Unassigned groups” on the LCD.
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6-5-3. Floor settings for Integrated Centralized Control Web
Configure floor-related settings for when monitoring and operating air conditioning units with centralized controllers
using the Integrated Centralized Control Web. Logging in to the centralized controller set as the login destination
using a Web browser enables monitoring and operating of all air conditioning units connected to the managing
centralized controller using the Integrated Centralized Control Web.

Wireless LAN router Tablet

(((I ',))) ((((I @ Integrated Centralized Control Web login destination

AE-200 & N\

)
J

>
2
S
-

]
i b
Ul s

Max. 50 units

I

) |

Integrated Centralized

Control Web Max. 50 units

Max. 50 units

|

Max. 50 units

Max. 50 units

,
\
(E
—~

Air conditioning units that can be used on the
Integrated Centralized Control Web

Here, use the Integrated Centralized Control Web to configure the managing centralized controller, floor level, floor
name and other floor settings, and the floor plan settings.

Floor setting —\ Floor plan

[EEgERR  show groups HWHP| Measema] e S
A Al S ) - B =

@0 Monitor/Operation . Today's electric energy consumption 1F Office 1

wn
ik

Select all X

10F Office 10 w0
= o

= st N
9F Office ws e ==
8F Office 8 i
sS
o 0l
P A 834 G304 0904 13000 O30 GE0OM G500
SF Office 5 A& 8 Notice
Error code: 3602
| — W S ot e
" sFoffice s ¢ Error code: 7106
Addees oL 011
e 2R00ie2 ﬁ o
Goupo111 Addess: 01012
2
WQ Error code: 3602
' efined floor A Groupo2-s._Addess: 2005

1

A\ Number of errors: 5

/
Floor name J

~
Entire building
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(1) Click [Floor Settings] > [Floor for Integrated Centralized Control Web] to access the Integrated Centralized
Control Web'’s floor settings screen.

W& MITSUBISHI Air Conditioning Control System - Initial Setting Tool =
File (F) Data acquisition (M) Send (§) Data verification {¥)  Option {0)  Help (H)
Basio Settings | Unit Settings | Floor Settines | Billing Function Settings)| Target centralized
Floor | Flaor Layeut | Floor for Integrated Centralized Gontrol Web |F\nnv Lawaut for Inteerated Gentralized Cantral Web K co ntl’Ol |e|'
Target centralized controller [1 Yt =
‘ Floor Settings for Integrated Centralized Control Web
Total number of floors —J | Pl tme P sin Sty Copy floor settings
setti ng Tots! Floors Inport =
B Managed certralized controller Import
Managed centralized —lF o i P
controller G
q Glear
m Floor plan image
A\ AN \ )
\
Floor name setting
\ Import
7
Floor No. Floor level name setting
L FE 1T 11T | — 11~
~T~— Back
Save

(2) In [Target centralized controller], select a target centralized controller.
The setting contents of the selected centralized controller will appear.

(3) In [Total number of floors setting], set the total number of floors to be displayed on the Integrated Centralized
Control Web.
Click [Edit] in [Total Floors], and set the total number of floors by entering the number on the keyboard or by
clicking = = | buttons.
Up to 99 floors can be set. In the Integrated Centralized Control Web, floors can be divided up into 10 floor
units and displayed.
Note: If the total number of floors is set to “0,” all groups will appear as unassigned groups.

Number of floors: 0 to 10 Number of floors: 41 to 50 Number of floors: 91 to 99
10F Office 10 10F Office 10 I 10F Office 10
9F Office 9 OF Office 9 I 9F Office 9
8F Office 8 8F Office 8 I 8F Office 8
7F Office 7 7F Office 7 7F Office 7
6F Office 6 6F Office 6 I 6F Office 6
SF Office 5 YN I SF Office 5 A I SF Office 5 A
4F Office 4 4F Office 4 I 4F Office 4
) 21F ) 31F )
3F Office 3 3F Office 3 3F Office 3
_2FoOfficec 2§ 2FOfficea 20F | 2FOffice2
1F Office 1 AN 1F Office 1 A 1F Office 1 PAN
11F 11F
Undefined floor A ' Undefined floor A ' Undefined floor A
I 1F
\ \ \ Display area switching

(4) In[Managed centralized controller], set the centralized controllers to be managed with the Integrated
Centralized Control Web.
Centralized controllers and expansion controllers set in section 6-3-1 “System Configuration settings” will
appear.
The centralized controller with a check mark ( ) next to [Manage] will be a control target of Integrated

Centralized Control Web. Even if only one AE-200 is shown with a check mark ( ) in gray, settings and
reflecting the settings on the Initial Setting Tool is required.
Note: Any centralized controller without a check mark ( |:] ) is not a control target of Integrated Centralized Control Web.
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(5) In [Floor name setting], set the floor level name and floor name to be displayed on the floor layout.
Enter the floor level name in 3 alphanumeric or symbol characters or less.
Enter the floor name in 20 alphanumeric or symbol characters or less.

1F|[Office 1
F—MF [1F]pffice 1_ | A
Floor level name ; Floor name

(6) In [Floor plan image], import a floor layout image and configure settings.
Click [Import] and select a file to import.

To delete the imported floor layout image, click [Clear].
Note: Floor layout images other than the following file sizes and file formats cannot be read.

Floor layout size Between 450 (height) x 630 (width) and 900 (height) x 1890 (width) dots

File format gif

File capacity Max. 600 KB for each floor plan

(7) After the settings are completed, click [Save].

Note: Adjusting the floor name settings enables application in managing multiple buildings.

Example) To manage three buildings A to C, configure the floor settings as follows.

10F Office 10

Building A Building B Building C
8 floors 10 floors 5 floors

9F Office 9

8F Office 8

7F Office 7

6F Office 6

SF Office 5 AN
4F Office 4
Setting contents e

Total number of floors: 25

Floor level name: No. 1 =A, No. 11 =B, No.21=C LOlCCL .

Floor name: No. 1 to No. 8 = 1F **** to 8F ***** 1F Office 1 A

No. 11 to No. 20 = 1F **** to 10F *****

Undefined floor A

No. 21 to No. 25 = 1F **** to 5F *****
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6-5-4. Floor Layout settings for Integrated Centralized Control Web

Assign the air conditioning unit icons to display on the Integrated Centralized Control Web floor layout.
Note: Assignment of unit groups registered in the centralized controllers selected as “Managed centralized controller” on the “Floor
for Integrated Centralized Control Web” screen is possible.

Al

Showgrops | HWHP

A

Select all ’

1F Office 1

‘ Deselect all ' |

Schedule settings

Copy from: —

o~ Air conditioning unit group
Assign on the floor plan
image.

(1) Click [Floor Settings] > [Floor Layout for Integrated Centralized Control Web] to access the Integrated
Centralized Control Web’s floor layout settings screen.

Floor switching

File (F) Data acquisition (M) Send (S) Data verification (¥)  Option (0)  Help (H)

Basic Settings | Unit Settings | Floor Settines | Biling Function Settings |

Target centralized

Floor | Floor Layout | Floor for Inteereted Gentralized Gontrol Web | Floar Layout for Inteerated Gentralized Gantrol eb |

“ ]

Target cenfralized controller: [1 Mitsubishi building

controller

Group name

Centralized controller —

switching

Groups to be assigned ——

b4

Lt

—
P | Fisor (7] Assien with ericline

I Group Name:

60 2 3 [ 8] oo 6 w6 w0 0
Errrrrrrd

[ e

4

Assignment mode/
Deletion mode

Scroll bar

Terant G

R | | B,

Assign with gridline
Selecting this enables
movement in grid units.

T— Back

()

Assignment area )

In [Target centralized controller], select a target centralized controller.

Save

Note: Make sure to select a target centralized controller set in section 6-5-3 “Floor settings for Integrated Centralized Control

Web".
)

In [Floor switching], select a floor to which the unit groups are assigned.

The floor layout set in section 6-5-3 “Floor settings for Integrated Centralized Control Web” will appear.

(4)
®)

In [Groups to be assigned], select a unit group to assign.

In [Centralized controller switching], select a centralized controller of the unit group to assign.

Note: Groups of air conditioners, Air To Water (PWFY)) units, LOSSNAY units, and general equipment can be assigned to the

floor layout.
(6)
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In the floor layout in [Assignment area], assign unit group icons.
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(7) After the settings are completed, click [Save].
Note: Up to 180 unit group icons can be assigned in each floor layout.
Note: When no floor layout is registered, a white floor will appear.
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6-5-5. Convenient usage methods

[1] Matching the AE-200’s LCD and the Integrated Centralized Control Web floor layout
Use the Integrated Centralized Control Web to configure the settings to use the floor layout which is the same as on
the LCD.

Integrated Centralized Control Web

P <row groups

TEssIEeT

o AHCStats,

] Moni tor/

Operation il | i A

A
1F Lobby Select all X

.
&
S
o

EEEREE!

1F Lobby

S EE

CopyrigntC) 2015 MITSUBISHI ELECTRIC CORPORATION A1 Rights Reserved

Note: On the LCD, the floor layout image is divided for display, however on the Integrated Centralized Control Web, it is not divided
for display.

(1) Carry out LCD floor settings.
Configure the 6-5-1 “Floor settings for LCD” and 6-5-2 “Floor Layout settings for LCD” settings for the target
centralized controller.

(2) Configure the floor settings for the Integrated Centralized Control Web.
From [Floor Settings], click [Floor for Integrated Centralized Control Web], and from [Target centralized
controller], select the centralized controller set in (1) above.

File (F) Data acquisition (M) Send (S) Data verification (V)  Option (0)  Help ()

| Basic Settines | Unit Settings | Floor Settines | Billing Function Settines |

[ Floor [ Floor Layout | Floor for Inesrated Gentralized Control Web | Floor Layout for Inteerated Centralized Gontrol Wieb |

Select a centralized controller set in
“Floor settings for LCD.”

Flor Name Flor plon I Gopy floor setines Copy floor settings
| —8

(3) Click [Copy floor settings] and select [Floor and floor layout settings].

Target centralized controller: [1 vl I:

r M
Copy floor and floor layout settings g
o

Select a setting to be copied

@ Flaor and floor layout settings

() Flaor and floor layout settings for Inteerated Centralized Control Web

(4) Click [OK].
The settings details for 6-5-1 “Floor settings for LCD” and 6-5-2 “Floor Layout settings for LCD” for the
centralized controller set in (1) above are copied to the 6-5-3 “Floor settings for Integrated Centralized Control
Web” and 6-5-4 “Floor Layout settings for Integrated Centralized Control Web”.

Note: Even if the floor layout settings for LCD are other than 2 (height) x 3 (width) layout, the copied Web floor plan size will be 900
(height) x 1890 (width). When handling a floor layout of other than 2 (height) x 3 (width), we recommend that this be replaced
with a floor plan that has unnecessary areas cut away for Web use.
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[2] Creating the login destination centralized controller for backup

Multiple login destinations can be set for the Integrated Centralized Control Web.

By copying the login destination centralized controller floor settings and preparing a backup centralized controller,
then if the login destination centralized controller malfunctions, it is possible to use the Integrated Centralized
Control Web by logging in to the backup centralized controller.

Wireless LAN router Tablet

Normal_l_y %)))) (((((‘ @’ N
: ‘W i

Normally logged-in centralized controller

Max. 50 units

S

LAN

evNEEEEEEEE

’ AE-50/EW-50

fi-

ﬁ_
o

T

LD E
ﬁ_

) |
ﬁ_

Max. 50 units

Max. 50 units

Backup log-in

|

Max. 50 units

I Max. 50 units
[

Target centralized controllers for the backup centralized
controller

»
D)

0
sssssssmmmmnnnnns?

Backup centralized controller
Target centralized controller for the normally logged in centralized

controller

Note: Air conditioning unit groups managed by a malfunctioning centralized controller are not covered by monitoring and operation.
In the event of a malfunction, promptly replace with a new product and configure.

(1) Add an IP address of the backup centralized controller in 6-3-1 “System Configuration settings”.

(2) Configure the centralized controller to be normally logged in.
Configure the 6-5-3 “Floor settings for Integrated Centralized Control Web” and 6-5-4 “Floor Layout settings for
Integrated Centralized Control Web” settings for Integrated Centralized Control Web login destination target
centralized controller.

(3) From [Floor Settings], click [Floor for Integrated Centralized Control Web], and from [Target centralized
controller], select the backup centralized controller.

W) MITSUBISHI Air Conditioning Contrel System - Initial Setting Tool (=3
File () Data acquisition (M) ~Send (S) Data verification (V) ~ Option (0)  Help (H)

| Basic Settings | Unit Settings | Floor Settines | Billing Function Settines |

[ Flocr [ Floor Layaut | Floor for Integrated Gentralized Gontrol Web | Floor Layout for Integrated Centralized Gontrol Wieb |

Y

Select the backup centralized controller.

Fioor Name Floar plan I Gopy floor ssttines Copy floor settings
| e—

Target centralized controller: [1
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(4) Click [Copy floor settings], select [Floor and floor layout settings for Integrated Centralized Control Web], and
select a centralized controller set in (1).

Copy floor and floor layout settings ﬂ]q
Select a setting to be copied.
© Floor and floor layout settines Copy from )
® Floor and floor layout settines for Tntegrated Centralized Gontrol Wieb Select a centralized
controller to be normally
Copy from logged in.
1 Mitstubishi building -

(5) Click [OK].
The settings details for 6-5-3 “Floor settings for Integrated Centralized Control Web” and 6-5-4 “Floor Layout
settings for Integrated Centralized Control Web” for the centralized controller set in (1) above are copied to the
backup centralized controller.

6-6. Billing function settings

Configure the billing function settings on the Initial Setting Tool. For details about the billing function settings, refer to
the Instruction Book (Apportioned Electricity Billing Function).
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6-7. Interlock Control

Set the Interlock Control setting to interlock the operation of multiple units.

Note: A separate license is required to use the Interlock Control function. Make sure that the required license has properly been
registered on the Registration of Optional Functions screen. (Refer to section 4-5 “License registration for optional functions”
for details.)

Note: The Interlock Control settings may not be accessible if logged in as a building manager.

Note: When [External Input Setting] on the AE-200/AE-50/EW-50 that controls the equipment whose operation is to be interlocked
with another equipment is set to [Emergency Stop (Level signal)] (see section 6-3-2 “Basic System settings”) and the
external input contact is ON, or when the indoor unit is stopped due to the Peak Cut control (see section 7-2-2 “Peak Cut
(Energy-save control function)”), only the Interlock Control of free contact and DIDO controller (PAC-YG66DCA) will be
performed, but other Interlock Control will not be.

Note: If a group is deleted on the group settings screen, be sure to delete the Interlock Control settings in which the group is
selected as the input units or the output units.

Note: For how to connect general equipment to the free contact, refer to the AE-200/AE-50/EW-50 Technical Manual.

Up to 200 Interlock Control settings from No.1 through No.200 can be set for each AE-200/AE-50/EW-50. (Up to
800 Interlock Control settings can be made when one AE-200 and three AE-50/EW-50 controllers are connected.
Up to 1000 Interlock Control settings can be made when one AE-200 (No M-NET) and four AE-50/EW-50 controllers
are connected.)

The Interlock Control verifies the state changes in an ascending order of No.1 to No.200 every three to five
seconds. When the interlocking conditions are met, the interlocking action commands will be issued to the output
units.

By making the interlocking condition settings (input category, input states, and input units) and interlocking action
settings (output unit type, actions, and output units) for each Interlock Control setting, the operation of the output
units can be interlocked with the operation of the input units.

Caution:
Before using the Interlock Control function, you must agree to the following.

1. This function must not be used for disaster prevention or security purposes unless a backup device is
provided in case of failure of this function. (This function should never be used in the way that would put
people's lives at risk.)

2. The interlocking action settings that are not supported by the interlocked output units must not be made on
the [Set up Actions] screen. Failure to observe this precaution may result in malfunctions.

3. Both the Interlock Control settings set from AE-200 and from expansion controllers AE-50/EW-50 will
run. To avoid their settings competing against each other, make the setting from expansion controllers
AE-50/EW-50 if the setting is only for units under the control of the same expansion controller.

4. After completing each Interlock Control setting, perform a test run and confirm proper settings and
operation.

5. Do not set the Interlock Control settings as the following examples show. Doing so will cause short-cycling,
resulting in unit damage.

Example 1: Group 1 is turned off when Group 1 is turned on.
Example 2: Group 1 is turned on when Group 1 is turned off.
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Shown below are eight examples of Interlocked operations.

Example 1: Interlocked operation of indoor unit and card key via a DIDO controller

4 )
’ (D The card key status is input ’

@ Signal indicating the card
key has been removed

—V — V -_ulf

through the contact.

A

AE-200
= \ DIDO controller Card key
% (PAC-YGB6DCA)

(3 Signal to stop the indoor
unit

Indoor unit
Y o y,

Example 2: Interlocked operation of operation mode between indoor units
4 )

(@ Signal indicating the operation mode for the (D The operation mode has changed
indoor unit #1 has changed to fan mode from heating to fan mode.
< \V
AE-200 |% =
= \ Remote
Indoor unit #1 controller
(conference room No.1)
(3 Signal to change the
operation mode for the
indoor unit #2 to fan
mode
Indoor unit #2
\_ (conference room No.2) )

Example 3: Interlocked operation of indoor unit and window through the free contact on an indoor unit

4 N\
(@ Signal indicating the (D The open/close status of the window is
window has been opened input to the free contact (CN32).
< \/ F
AE-200 |2 [
= ,\ nd " Window
(3 Signal to stop the indoor ndoor uni
unit

" S

Example 4: Interlocked operation of indoor unit, lighting, and card key through the free contact on an indoor

unit
( N\
@ Signal indicating the card (@ The card key status is input Card :fy
key has been removed to the free contact (CN32). . 1

P\

<

FET)

AE-200 4
> J

® Signal to stop the indoor Indoor unit ; \ Lighting

unit and turn off the
‘ @ Signal to turn off the lighting ’

lighting
via the free contact
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Example 5: Interlocked operation of indoor unit and other company’s ventilation unit via a DIDO controller

4 N\
(2 Signal to operate the other company’s
ventilation unit

AE-200 |2 o @
= \ —_— Other company’s
% DIDO controller ventilation unit

(PAC-YG66DCA)

E]

(D The indoor unit has
started operation

Indoor unit

\ J
Example 6: Interlocked operation of the indoor unit in error and the auxiliary unit
4 N
(M An error has occurred in the
indoor unit.

A

?

AE-200 |2

Indoor unit

Indoor unit in error

(2 Signal to operate the
auxiliary unit

Auxiliary unit
\_ J

Example 7: Interlocked operation of the indoor units

4 N\
(@ The representative indoor unit
has stopped

A

[EE)

AE-200

Representative
indoor unit

T~

(@ Signal to stop the other
indoor units

9 Indoor unit Indoor unit Indoor unit

Example 8: Interlocked operation of the security system and the connected units

4 N\
(D The security system alarm is input to
the free contact (CN32).

AE-200 | =
—> == ——
Indoor unit Representative Security system
(@ Signal to stop the indoor unit
indoor unit

(@ Signal to stop the
indoor unit

o

Indoor unit LOSSNAY unit
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By connecting expansion controllers to AE-200, operation of units that are connected to different expansion
controllers can be interlocked.

4 N\
(@ Signal to operate the other company’s
ventilation unit
; AE-200 |F = @
= —_— Other company’s
(EADCOY%’QQ'SE:‘?&) ventilation unit
7l
AE-50/EW-50 - -
(D The indoor unit has Ind it
started operation ndoor uni
\_ J

Make the settings for AE-200 when interlocking the operation of units that are under the control of different
expansion controllers.

Make the settings for the expansion controller when interlocking the operation of units within the control of the same
expansion controller.

Click [Interlock Control] in the menu bar, and then click [Interlock Control] to access the Interlock Control settings
screen.

MITSUBISHI Air Conditioning Contral System - Initial Setti

Target centralized
controller

File (F) Dataacquisition (M) Send (S) Data verification (V)  Option (Q)

[ Basic Seffines | Linit Settings | Floor Settines | Billne Function Settines | hnterlock Control Settnes |

Select the connected [

Help (H)

Tnter]

Control |

Input Units
centralized controller whose \ Target centralized controller: lM Mitubishi building 1F '] P
i Input State
Interlock Control settings are Interlock Control Settings p
to be made. y Interlack contral ® Execute  © Stop Execution Output Units

Enable/Disable Tput Units Tnput State

Delete all
Action

rection_Swing, Fan Speed_auto ||

Execute/Stop Execution — om gDy, e W —— Delete all
CIle to enable/disable the 1 U Group2 TenantB Conl \o |/ Groupd ] Di
Interlock Control. /&Il Groups On p2 18 on 1_ Action

Enable/Disable
Click to enable/disable each

oN

Interlock Control setting. -
Row selection - [
Select the row to make the N 1 Edit button

Interlock Control settings.

[ com || Peste [ et ][ Delete

Click to display the window
to set the Interlock Control
settings.

Edit buttons |IH

e

Save
Click to save the settings.

[1] Selecting the Interlock Control setting to be made

\— Back

Click to display the previous
settings without making any
changes.

(1) Select the row to make the settings for. A frame will appear around the selected item.

(2) Click [Settings] to display the window for setting the detail settings for Interlock Control.

[2] Disabling/Enabling Interlock Control settings
Interlock Control setting of each item can be enabled or disabled by checking “Enabled (checked)” or “Disabled
(unchecked).” No actions will be taken for the Interlock Control setting that is set to [Disable].

[3] Temporarily disabling the Interlock Control
Click the [Stop Execution] button to temporarily disable the Interlock Control. Click [Execute] to resume the Interlock
Control.
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[4] Editing Interlock Control settings
Use the Edit buttons to edit each row of Interlock Control setting.

Button name Function
Delete all Deletes all Interlock Control settings.
Copy By selecting the row to be copied and clicking [Copy] and then clicking [Paste] on the paste
Paste destination, the settings of a given row can be pasted to another row.
Inserts a blank row of Interlock Control setting above the row that is displayed, and moves all
Insert rows down by one.
If interlocking conditions are entered in the last row, no more rows can be inserted.
Delete Deletes the Interlock Control settings of the selected row.
Whether to move up the row below the deleted row or not can be selected.
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Set the Interlock Control settings on the window for setting the detail settings for Interlock Control.

Output Unit Type
Input Category T Gty Outpt Ut Typo

[Group (Modz) - [roup -

Input State 1 — onjorE
P B B State

[l groups in the mode: -

Mode

Input State 2 — ~a

Select mode
(ool -

W
(]

Prohibit Operation
ONAOFF Mode

Action

Set Temp

Select Lhits Seleet Lhits

Selecting the equipment — =7 T2 N
to which the operation

of another equipment is

interlocked

Displays the window to

Selecting the equipment
whose operation is to be
interlocked with another
equipment

Displays the window to

select the equipment.

select the equipment.

Cancel

OK
Click to save the settings.

[1] Making the interlocking condition settings

(1) Setting an Input Category and Input States

Cancels the settings and
reverts the window to the
previous state.

Select an Input Category and Input States 1 and 2, referring to the table below.

Table: Interlocking condition settings

One or more groups out of the mode

Input
Input Category unit icon Input State 1 Input State 2

All Groups On
Group - All Groups Off B
(On/Off) \'\:J One or more Groups On

One or more Groups Off

All groups in the mode Air conditioning unit group: 1723
Group - All groups out of the mode Cool, Dry, Fan, Heat, Auto, Setback
(Mode) \" /' | One or more groups in the mode LOSSNAY unit group:

Bypass, Heat Recovery, Auto

All units in error
Group All units in normal operation
(Error/Normal) One or more units in error

One or more units in normal operation

All Units On
Free Input Points All Units Off
(On/Off) One or more Units On

One or more Units Off

*1 The operation modes for Air To Water (PWFY) unit groups, HWHP (CAHV, CRHV) unit groups, chiller unit groups, or general

equipment groups are not available for selection.

*2 If the selected operation mode is not available on the input unit, interlocking conditions will not be fulfilled.
*3 The Setback mode can be selected on the AE-200A/AE-50A/EW-50A, but not on the AE-200E/AE-50E/EW-50E.

Note: If the Input Category is set to [Group (On/Off)] and the Input State 1 is set to [All Groups On], the interlocking action

commands will be issued to the output units when the state on the input units changes to [All Groups On] from another state [All

Groups Off], [One or more Groups On], or [One or more Groups Off].

Note: Free contact is available for use on R410A- and R407C-compatible indoor units with software Ver. 33 or later. The software

version can be confirmed with the Maintenance Tool.

Note: When [External Input Setting] on the AE-200/AE-50/EW-50 that controls the equipment whose operation is to be interlocked

with another equipment is set to [Emergency Stop (Level signal)] (see section 6-3-2 “Basic System settings”) and the
external input contact is ON, or when the indoor unit is stopped due to the Peak Cut control (see section 7-2-2 “Peak Cut
(Energy-save control function)”), only the Interlock Control of free contact and DIDO controller (PAC-YG66DCA) will be

performed, but other Interlock Control will not be.
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(2) Selecting the input units
Click [Select Input Units] to display one of the following screens, depending on the selected Input Category.
Note: Operation of the units under the control of different expansion controllers can be selected only when the settings

are made for AE-200.
(A) When [Group (On/Off)], [Group (Mode)], or [Group (Error/Normal)] is selected as the Input Category

The [Select Input Groups] screen will appear.

Select the group numbers of the input unit groups. The

selected group numbers will appear with a yellow-green aeon [Epll B2 Bpd
background. -- 3 s 10

Click again to deselect. The deselected group numbers will %-----
appear with a light-gray background. ----------
To deselect all selected groups, click [Reset selections]. W@ W oW % % 9w w0

To select a block of groups, click [Select a Block]. Select a : Y |
(8] 4 Cancel

block name and press [OK]. The groups that are registered
to the block will appear with a yellow-green background.

Note: If the Input Category is set to [Group (On/Off)] or [Group (Error/Normal)], air conditioning unit groups, LOSSNAY
unit groups, Air To Water (PWFY) unit groups, HWHP (CAHV, CRHV) unit groups, chiller unit groups, and general
equipment (connected via DIDO controller PAC-YG66DCA) groups can be selected.

If the input category is set to [Group (Mode)], air conditioning unit groups and LOSSNAY unit groups can be
selected.

Note: Different types of groups (air conditioning unit groups, LOSSNAY unit groups, or general equipment (connected
via DIDO controller PAC-YG66DCA) groups) cannot be simultaneously selected.

(B) When [Free Input Points (On/Off)] is selected as the Input Category

The [Select Addresses of Input Units] screen will appear.

Select the addresses of the indoor units to which the

general equipment is connected, and select contact points ae200 B9l Bp2 Bps
for each indoor unit. -- ORI T T T T T
The selected unit address will appear with a red frame. The TR

unit addresses whose contact points have been set will ™ --------
appear with a yellow-green background. (i [ ) [ e e s e s e

Contact Points

-234

I ’ CGancel
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[2] Making the interlocking action settings

(1) Setting an Output Unit Type and Actions
Select an Output Unit Type and set the Actions, referring to the table below.

Table: Interlocking action settings

. Actions
Qutput Unit Output
Type unit icon Setting item*2 Setting options
ON/OFF ON, OFF
Air conditioning unit group:
Mode *1 Cool, Dry, Fan, Heat, Auto, Setback"3
LOSSNAY unit group:
Bypass, Heat Recovery, Auto
Set Temp. ™ Desired temperature
— Air direction *1 Mid3, Mid2, Mid1, Mid0, Horizontal, Swing, Auto
Group T
Fan speed "1 Low, Mid2, Mid1, High, Auto

Prohibit Remote Controller

Operation (ON/OFF) Permit, Prohibit

Prohibit Remote Controller

Operation (Mode) Permit, Prohibit

Prohibit Remote Controller

Operation (Set Temp.) Permit, Prohibit

Free Output

. ON/OFF ON, OFF
Points

*1 The available setting options vary, depending on the connected indoor unit model.
Make the interlocking action settings that are available for the output units.

*2  Only the items “ON/OFF” and “Prohibit Remote Controller Operation (ON/OFF and Set Temp.)” can be selected for Air To Water
(PWFY) units. Only the item “ON/OFF” can be selected for HWHP (CAHV, CRHV) units.

*3 The Setback mode can be selected on the AE-200A/AE-50A/EW-50A, but not on the AE-200E/AE-50E/EW-50E.
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The screen display under Action will vary, depending on the selected Output Unit Type.

(A) When [Group] is selected as the Output Unit Type

Click [Edit] under Action. The [Set up Actions]

screen will appear. o OE 2
. . . Mode Set Temp.
Set the interlocking actions to be taken when the [Goo - -
interlocking conditions are met. E] c
Fan Speed Air Direction
S (a)  [EEEe (a)
5 d =

Note:

Note

Note:

Note:

Note:

Note:

Prohibit Operation
OMNAIFF Mode Set Temp.

]

The current operation status will be maintained for the setting items that were not changed.

: The set temperature cannot be set unless the operation mode has been set.
Note:

If the selected operation mode is not available on the interlocked output units, the Interlock Control will not be
performed.

To prevent malfunctions of the air conditioning units, be sure to set the set temperature to a temperature within
the normal operating temperature range, although there may be rare cases in which it is possible to set the set
temperature to a temperature outside the normal operating temperature range (depending on the model of the
air conditioning units that are connected to a system).

When making the set temperature setting for the Auto mode, set two different set temperatures for both cooling
and heating in [Set temp.] for the units that support the dual set point function, and set the single set temperature
in [Set temp. (Single set point model)] for the units that do not support the dual set point function.

Signals for Swing and Auto of Air direction setting and Auto of Fan speed setting will not be output unless these
functions are available on the interlocked output units.

With respect to the air direction and fan speed, if the number of settable air directions and fan speeds vary
among the connected unit models, the signals that are rounded up to the settable range may be output.

When the interlocking conditions are met, it will take some time to issue the interlocking action commands to the
output units. This may delay the state change verification, which is usually performed every three to five seconds.

(B) When [Free Output Points] is selected as the Output Unit Type

WT07627X03
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(2) Selecting the output units
Click [Select Output Units] to display one of the following screens, depending on the selected Output Unit

Type.
Note: Operation of the units under the control of different expansion controllers can be selected only when the settings
are made for AE-200.

(A) When [Group] is selected as the Output Unit Type

The [Select Output Groups] screen will appear.

Select the group numbers of the output unit groups. The

selected group numbers will appear with a yellow-green wen [ D
background. || [Eiiin BN R
Click again to deselect. The deselected group numbers will non ‘3----
appear with a light-gray background. A wow u B % A % W N
To deselect all selected groups, click [Reset selections]. IR R T I R

I OK Ii Cancel ]

To select a block of groups, click [Select a Block]. Select a
block name and press [OK]. The groups that are registered
to the block will appear with a yellow-green background.

Note: If the Output Unit Type is set to [Group], air conditioning unit groups, LOSSNAY unit groups, Air To Water (PWFY)
unit groups, HWHP (CAHV, CRHV) unit groups, chiller unit groups, and general equipment (connected via DIDO
controller PAC-YG66DCA) groups are available for selection.

Note: Different types of groups (air conditioning unit groups, LOSSNAY unit groups, Air To Water (PWFY) unit groups,
HWHP (CAHV, CRHV) unit groups, chiller unit groups, or general equipment (connected via DIDO controller
PAC-YG66DCA) groups) cannot be simultaneously selected.

(B) When [Free Output Points] is selected as the Output Unit Type

The [Select Addresses of Output Units] screen will appear.

Select the addresses of the indoor units to which the

general equipment is connected, and select contact points AEZ0D B2 B3
for each indoor unit. [ | AR R R
The selected unit address will appear with a red frame. 112 18 5 18 118 13w
The unit addresses whose contact points have been set n o [ N S a0 e DE e

will appear with a yellow-green background. BRI I R TR R TR TR
R N LA R

Contact Points

Mo

I OK I [ Cancel

[3] Saving the Interlock Control detail settings
Click [OK] to save the settings.
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7. Settings using Web Browser for Initial Settings

7-1. Initial Settings

This section explains how to set the initial settings on the Web Browser for Initial Settings.
Note: When one or more AE-50/EW-50 controllers are connected, initial settings must be made on each AE-50/EW-50’s Web
browser. However, only Date and Time settings (section 7-1-1 “Date and Time”) and Basic System settings (section 7-1-2
“Basic System”) must be made on the AE-200 Web browser.

Important

e If the system is connected to a TG-2000A, make or change all settings from the TG-2000A so that the data in the
TG-2000A and AE-200 will match.

e Any control (such as interlock control or Peak Cut control) between the outdoor and indoor units connected to the AE-200,
AE-50, and EW-50, as well as between the units connected to different AE-50/EW-50 controllers, cannot be performed.
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7-1-1. Date and Time
Click [Initial Settings] in the menu bar, and then click [Date and Time] to access the date and time settings screen.

Set the current date and time, and then click [Save Settings].

Note: The date and time settings may not be accessible if logged in as a building manager.

Note: The date and time settings made on this screen will be reflected on all the units in the M-NET system, all connected
AE-50/EW-50 units, and the AE-200 units whose [Time Master] setting is set to [Sub].

Note: The date and time cannot be set on this screen if the [Time Master] setting is set to [Sub].

Note: The daylight saving time setting is required only on the AE-200.

Note: Changing the date and/or time when the charging function is in use can affect the calculation of the charges.

Note: When AE-50/EW-50 controller, DIDO controller (PAC-YG66DCA), Al controller (PAC-YG63MCA), or PI controller (PAC-
YG60MCA) is added to the system, set the current date and time on this screen to synchronize the date and time on the
added controller.

Note: Although date and time settings can be made on each AE-50/EW-50, the date and time synchronization from AE-200 is
performed once a day. Make the date and time settings on the AE-50/EW-50 only after the AE-50/EW-50 is replaced.

=l o=

Qw )| I htp://192.168.1 1init/en/administrator. htmi 0~ & X |[ I MITSUBISHI Air Conditione... ‘ _-“ A ok IH

Fle Edit View Fovoites Tools Help

Initial Settings

Date and Time Basic System Groups Inferlocked L OSSNAY Blocks
M Date and Time
Year Month Day Current date and time
R A T A A/ Enter the current date and
time.
Dayllght saving tlme Hour Minute Second
Setting A o pra W;]
Click to enable the daylight = = =
saving time setting. ]
W Altomaticaily adiust clock for daviight saving changes;
Custom Settings ~ P Custom Seftings
®Rsfresh Sawe Seftings @
Refresh bl Save Settings
Click to acquire the current Click to save the changes
date and time from the made.
AE-200/AE-50/EW-50.

©100% ~

(1) Enter the current date and time.

(2) To adjust the daylight saving time automatically, check the [Automatically adjust clock for daylight saving
changes] checkbox, and select the applicable country in the pulldown menu.

If the applicable country is not in the pulldown menu, select [Custom Settings] instead. A [Custom Settings]
button will appear on the right of the pulldown menu.
Click the [Custom Settings] button to open the Custom Settings screen, and configure the daylight saving

time setting.
Custom Settings
Day Manth Time
o Ped o v 3o 2
or &l [0 s o 2:oo v [0z 2:fo0 2
Cancell Ok |

Custom Settings screen
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7-1-2. Basic System
Click [Initial Settings] in the menu bar, and then click [Basic System] to access the Basic System settings screen.
Make necessary basic system settings such as AE-200/AE-50/EW-50 unit settings, network settings, and M-NET
settings, and then click [Save Settings] to send the settings to the AE-200/AE-50/EW-50. A message will appear
asking whether or not to restart the AE-200/AE-50/EW-50. Click [OK] to restart the AE-200/AE-50/EW-50 to reflect
the changes.
Note: The Basic System settings may not be accessible if logged in as a building manager.

Q\ )| i hetp//192.468. /it /en/administratorirtmi £ - ¢ x| _inamsusisH ir Conditone.. || ok
File Edit View Favortes Tools Help

——M-NET Settings
Initial Settings ~ Functions 1 Functions 3 User Seffings Uil Set the
Date and Time Basic System Groups Interlocked LOSSNAY 4 AE-200/AE-50/EW-50

M-NET address and range
Unit Settings —\ M Basic System of prohibited controllers.
Set the A Unit Settings ‘ System Configuration Semngs}{
Name AE-200 M-NET Settings
AE'ZOO/AE'SO/EW'SO name Unitin [0000T (8 figures) M—NET»\ndr:sslu— .
and unit ID. SERIAL No 23164116 Range of Prohibited Controllers  [ISCRC  IRC Only External |nput Sethng
Software Version 7.10(1.00)
. External Input Se“ing/ Set the
Network Settings —n_, | | [ [ e—p———— AE-200/AE-50/EW-50
Set the 'TE':';"“‘“"!‘ e si‘ e e S external signal input mode.
AE-200/AE-50/EW-50 IP Subnet Mask WWWF L ON/OFFIPohibitP ermit (Pulse signal)
stows e
address and subnet mask. EA‘CM:;ress 002692418944 . @ Advanced Setting Advanced Setting

Disp_lay qumat > W:T‘ — -‘-‘ Click to_display the screen

Set the screen display items o e s, s Wi for making advanced

for the AE-200/AE-50/EW-50 — T veny Mo, [z u settings.
and the Web browser. Group Names on Ovendewblonitor oW [l0EE
Filter Sign Display Hon  [lofF =
/' ®Refresh Save Seftings @,
_ _ Refresh ~—— Save Settings
Click o mport e setngs | Y| C'ic (o save the changes
from AE-200/AE-50/EW-50. s, e e e made.

7-1-2-1. Unit Settings
Follow the instructions below to set the AE-200/AE-50/EW-50 unit name and unit ID in the [Unit Settings] section.
The AE-200/AE-50/EW-50 serial number and software version will appear.

Unit Settings

Name |RE-200

Unit 1D nnooot (G figures)
SERIAL Mo. 23164-116

Software Version 7.10{1.00)

(1) Enter the unit name in the [Name] field in 40 alphanumeric or symbol characters or less. The name entered
here will be used on the screen of the software that controls multiple AE-200/AE-50/EW-50 units and will
also be used as a sender name in the error notification e-mail and e-mail alarm.

Note: The following characters cannot be used in the [Name] field: <, >, &, “, or*

(2) Enter the unit ID in the [Unit ID] field in 6 figures. Use this setting to manage the multiple unit IDs. The unit
ID entered here will be used on the screen of the software that controls multiple AE-200/AE-50/EW-50 units
and will also be used as a sender ID in the error notification e-mail and e-mail alarm.
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7-1-2-2. M-NET Settings
M-NET Settings
M-NET Address [I
Range of Prohibited Controllers lIscrc EC Only

(1) Enter [0] in the [M-NET Address] field (unless otherwise specified).

(2) When the local remote controller operation is prohibited, this setting determines the scope of its applicability.
Select [SC/RC] to prohibit the operation from both the sub system controllers and the remote controllers.
Select [RC Only] to prohibit the operation only from the remote controllers.

7-1-2-3. External Input Setting
Using the external signal input function, the following types of collective operations can be performed for all
connected air conditioning units: Emergency stop, ON/OFF operation, and Prohibit/Permit local remote controller
operation.
A separately-sold external input/output adapter (PAC-YG10HA-E) is required for each AE-200, AE-50 and EW-50.
Select the external signal input mode, referring to the explanations below.
Note: Peak Cut control is performed based on the demand level signal (level 1 to 4) input from the connected demand controller. (A
separate license is required to use the Peak Cut function.)
Note: If an external signal is input to the AE-200 only, the collective operations will not be performed for the units connected to the
AE-50/EW-50 controllers.
Note: Refer to the AE-200 Installation Manual for details about the external signal input function.
Note: General equipment connected via DIDO controller (PAC-YG66DCA) cannot be collectively run or stopped by using the
external signal input function unless [Emergency Stop (Level signal)] is selected and relevant switches on the DIDO
controller are set.

External Input Setting

lDemand(Lwel signal)MNot in use
Ermergency Stop (Level signaly
OMMIFF (Level signal
OM/OFF/Prohibit’Permit (Pulse signal)

(1) Select [Demand(Level signal)/Not in use] when using a level signal to receive a demand level or when not

using the external signal input function.
Note: Refer to the AE-200 Installation Manual for details about the demand level.

n 12 or 24 VDC
19 =
=X o0 T< Demand level 4
7 Lo 0——| < Demand level 3 Contact ON

16 1

1 5 | o0 < Demand level 2 Contact OFF | |

— g oo < Demand level 1 Demand | Demand | Demand

= 2 OFF ‘ ON ‘ OFF

1 1 1 !
4_
Connection to AE-200/AE-50/EW-50 (CN5)

WT07627X03 1 39



(2) Select [Emergency Stop (Level signal)] when using a level signal to collectively run or stop all the air
conditioning units connected to the AE-200, AE-50, or EW-50 in an emergency. During an emergency stop,
the ON/OFF operation from the local remote controllers will be prohibited, and the ON/OFF operation and

Prohibit/Permit settings on the AE-200, AE-50, or EW-50 will be prohibited.
Note: Refer to the AE-200 Installation Manual for details about the demand level.

_ 12 or 24 VDC Contact ON
: —_—
= . oo T< Demand level 4 Contact OFF QEmergency |—
7 Lo 0—— < Demand level 3
6| — Normal sto Normal
1 5 | oL < Demand level 2 P
% g o0 < Emergency stop/ Contact ON
1 2
1 1

Normal operation Contact OFF I |—

2 Demand Demand Demand

4—
Connection to AE-200/AE-50/EW-50 (CN5) OFF ON OFF

(3) Select [ON/OFF (Level signal)] when using a level signal to collectively run or stop all the air conditioning
units connected to the AE-200, AE-50, or EW-50. The ON/OFF operation from the local remote controllers
will be prohibited, and the ON/OFF operation and Prohibit/Permit settings on the AE-200, AE-50, or EW-50
will be prohibited.

19
=X 12 or 24 VDC J_l__
Contact ON
1 6
% i ON;%:gI Contact OFF Q l—
: l
| 3 OFF signal Stop ‘ Run ‘ Stop
1 1 ¥ Y
4—
Connection to AE-200/AE-50/EW-50 (CN5)
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(4) Select [ON/OFF/Prohibit/Permit (Pulse signal)] when using a pulse signal to collectively run or stop all the
air conditioning units connected to the AE-200, AE-50, or EW-50, or to collectively prohibit or permit the
operation from the local remote controllers.

M 12 0or 24 VDC

9
% 8 ® = Permit signal
I | —0 Prohibit signal
15 |_(J-|.) OFF signal
] 4 |
13 @ ON signal
— 2
— 1

+— @ : Pulse generator

Connection to AE-200/AE-50/EW-50 (CN5)

(Example) ON/OFF
0.5-1.0 second

Nk
T
Contact ON  ________
(ON) Contact OFF rl
0.5-1.0 second
(i
Contact ON
(OFF) Contact OFF | |
Stop Run \\/ Stop

(Example) Prohibit/Permit
0.5-1.0 second

Nk
I T
... Contact ON ...
(Prohibit) Contact OFF rl
0.5-1.0 second
(i
; Contact ON
P t
(Permit) 2 ontact OFF 'l
Permit Prohibit \L Permit
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7-1-2-4. Advanced Setting

Advanced Setting

Time Master Emaster Sub
Schedule: Season sefting ln\railahle Mot Available
Hold type EMormal Forced

Old model compatibility mode On IOFF

Cancel | Ok |

[1] Time Master/Sub
In the [Time Master] section, select [Master] or [Sub]. The default setting is [Master].
This setting is required to change only for a system with multiple AE-200 controllers. Set to [Master] on only one
of the AE-200 controllers in a system, and set to [Sub] on the rest of the AE-200 controllers. The date and time
synchronization is performed from the AE-200 whose [Time Master] setting is set to [Master] to the AE-200 whose
[Time Master] setting is set to [Sub].

Note: When only one AE-200 controller is connected to the system, leave the default setting [Master] as it is.

Note: When multiple AE-50 controllers are connected to the system, leave the default setting [Master] as it is on all AE-50
controllers.

[2] Schedule: Season setting
In the [Schedule: Season setting] section, select [Available] to enable the seasonal settings of the weekly schedules

and [Not Available] to disable. Unless otherwise specified, leave the default setting [Available] as it is.
Note: The settings made on this screen on the AE-200 will be reflected on this screen on the AE-50/EW-50.

[3] Hold type

In the [Hold type] section, select [Normal] or [Forced].

The Hold function is a function to disable the operations that were scheduled for air conditioning unit groups.

If the setting for [Hold] is set to [ON] on the Monitor/Operation screen and the [Hold type] on the screen above is
set to [Forced], the [Hold] setting can be cancelled only from the AE-200/AE-50/EW-50. If the [Hold type] is set
to [Normal], the [Hold] setting can be cancelled from AE-200/AE-50/EW-50, other system controllers, or remote
controllers.

Note: The Hold function can be used on the AE-200A/AE-50A/EW-50A, but not on the AE-200E/AE-50E/EW-50E.

Note: The Hold function cannot be used on general equipments.

Note: The setting [Forced] will not be effective on Air To Water (PWFY) unit groups, LOSSNAY unit groups, and air conditioning
unit groups that do not support the Hold function (i.e., Mr. Slim M-Series/P-Series indoor units).
If the setting for [Hold] is set to [ON] on those unit groups on the Monitor/Operation screen and the [Hold type] on the screen
above is set to [Forced], the setting [Normal] will be effective.

[4] Old model compatibility mode
In the [Old model compatibility mode] section, select [ON] or [OFF].
Select [ON] when not using the Dual set point function.

When [ON] is selected, the Prohibit Remote Controller function (Timer, Air Direction, Fan Speed) cannot be used.
Note: If the setting is changed, the controller will reboot.
Note: When changing the old model compatibility mode while this mode is used, note the following.
» The set temperature will go back to the default setting value. Write down the current set temperature of each group to
reconfigure the set temperature settings later.
* The set temperature for the schedule settings will be cleared. Write down the current set temperature of each group for
schedule settings to reconfigure the set temperature settings later.
+ Some equipment whose operation is to be interlocked with another equipment support the dual set point function in the
Auto mode. Reconfigure the Interlock Control setting if it is affected by the change of the old model compatibility mode.
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7-1-2-5. Network Settings
Network settings vary depending on whether the AE-200/AE-50/EW-50 is connected to a dedicated LAN or an
existing LAN. See the sections below for how to set the AE-200/AE-50/EW-50 IP, subnet mask, and gateway

addresses in the [Network Settings] section.

Note: LAN2 (Network Settings 2) is exclusively used for BACnet® function. For BACnet® function settings, refer to the Instruction
Book (BACnet® function).

Note: Although the settings for LAN1 (Network Settings) and LAN2 (Network Settings 2) will appear on the screen, only the
settings for LAN1 is required. However, only when the LAN1 IP address is required to be set to [192.168.2.1], change the
default LAN2 IP address to avoid address overlap.

Note: After the AE-200 IP address is changed, the AE-50/EW-50 power will be reset.

Network Settings
IP Address HEE _]188 . I1 _]1
Subnet Mask |255 ; |255 ; 255 . ][I LAN1
Gateway | | | |
MAC Address 00269241B94A ]
Network Settings 2 —
IP Address HEE _1188 _JE _{1
Subnet Mask |265 _]255 _JEEE _|IJ LAN2
MAC Address 002692418948 ]

[1] Settings for connecting the AE-200/AE-50/EW-50 to a dedicated LAN

(1) Enter the AE-200, AE-50, or EW-50’s IP address in the [IP Address] field. If the LAN has been newly set up,
allocate IP addresses to the AE-200 units in a sequential order starting with [192.168.1.1]. For example, the
first AE-200 unit will have an IP address of [192.168.1.1], the second AE-200 unit will have an IP address of
[192.168.1.2] and so on.

Allocate IP addresses to the AE-50/EW-50 units in a sequential order starting with [192.168.1.211].

Note: The recommended IP address ranges are as follows.
AE-200: Between [192.168.1.1] and [192.168.1.40]
AE-50/EW-50: Between [192.168.1.211] and [192.168.1.249]
PC: Between [192.168.1.101] and [192.168.1.150]

[IP address setting example]

Hub
100 BASE-TX LAN straight cable |
AE-200 E AE-50 E AE-50 E
| 192.168.1.1 | [192.168.1.211] [192.168.1.212 | [ 192.168.1.101

Note: Some hubs have dedicated ports for connection with another hub.
Connect the AE-200/AE-50/EW-50 and PC to the normal ports.

(2) Enter [255.255.255.0] in the [Subnet Mask] field (unless otherwise specified).
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(3) When monitoring the system remotely or using e-mail function via a dial-up router, enter the router IP

address in the [Gateway] field.

Leave the [Gateway] field blank when not connecting a dial-up router.

[Remote Monitoring System example]

Telecommunication Network

Dial-up router

[ IPAddress: 192.168.1.254 |

AE-200 |2

Dial-up router, cellular phone etc.

IP Address: 192.168.1.1
Subnet Mask: 255.255.255.0
Gateway: 192.168.1.254

IP Address: 192.168.1.101
Subnet Mask: 255.255.255.0

Gateway: Blank

Note: [192.168.1.254] is recommended for use as the IP address of the dial-up router. Refer to the dial-up router
instruction manual for details of how to set the IP address.

Note: The use of a dial-up router with no modem requires a modem (for analog or ISDN) to be connected between the

router and the public phone line.

[2] Settings for connecting the AE-200/AE-50/EW-50 to an existing LAN

(1) When connecting the AE-200/AE-50/EW-50 to an existing LAN, consult the system administrator to decide

the IP, subnet mask, and gateway addresses.

[Existing LAN System example]

Backbone LAN

Gateway

[ 10.1.1.250

Gateway
[ 10.1.2.250 |

AE-200

Obtain the addresses from
the system administrator.

Y\

Obtain the addresses from
the system administrator.

X

IP Address: 10.1.1.1
Subnet Mask: 255.255.255.0
Gateway: 10.1.1.250

IP Address: 10.1.1.101
Subnet Mask: 255.255.255.0
Gateway: 10.1.1.250

IP Address: 10.1.2.51
Subnet Mask: 255.255.255.0
Gateway: 10.1.2.250
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7-1-2-6. Display Format
Follow the instructions below to set the items in the [Display Format] section.

Display Format

Unit of Temperature Hcc oF

Pressure unit of measure Hrpa PSl [ kofiend

Date Format HN22016 12312016 H2016M2i31
Time Format 06:00 PM l1B:l]l]

Group Names on Overview Monitor lon OFF

Filter Sign Display lon OFF

Setternp Room temp. (Always) i Setternp
Shirwy bioth icons

Temperature display (except for group list) [JRoom temp. (Always) Room temp. (During operation: Room temp. {During op )/ Setternp Hide
Hidle lShnw occupancy icon.
Brightness sensor display HHide Show bright syrobol

Humidity sensor display on - JorF

Occupancy sensor display Show vacancy icon

Shovw dark symbol. Show both symbols.

In the [Unit of Temperature] section, select [°C] or [°F].

In the [Pressure unit of measure] section, select [MPa], [PSI], or [kgf/cmZ].

)
)
(3) Inthe [Date Format] section, select the desired display format for year, month, and date.
) Inthe [Time Format] section, select the desired display of time format.

)

The [Group Names on Overview Monitor] is for use with Web Browsers up to version 7.2 and does not need
to be set.

(6) In the [Filter Sign Display] section, select [ON] to display the filter sign, and select [OFF] not to.
When the [Filter Sign Display] is set to [OFF], the filter sign will not appear on the Monitor/Operation screen
even when the indoor unit detects a filter cleaning signal.
If the filter is regularly cleaned and the sign display is unnecessary, set it to [OFF].

(7) Inthe [Temperature display (except for group list)] section, select the desired display option for the room
temperature or the set temperature to be used on the [Floor Layout] screen on the Integrated Centralized
Control Web.

Select [Room temp. (Always)] to display the room temperature at all times, [Room temp. (During operation)]
to display the room temperature only during operation, [Set temp.] to display the set temperature at all times,
[Room temp.(Always)/Set temp.] to display both the room temperature and set temperature at all times,
[Room temp.(During op.)/Set temp.] to display the room temperature only during operation and to display
the set temperature at all times, and [Hide] not to display the room temperature or the set temperature.

Note: The room temperature shown may be higher than the actual temperature especially when the unit is stopped during

the Heat mode. Therefore, selecting [Room temp. (During operation)] is recommended when displaying the room
temperature.

(8) Inthe [Humidity sensor display] section, make the Show/Hide setting for the humidity reading of the built-in
humidity sensor on the ME remote controller (North America: PAR-U0O1MEDU, Europe: PAR-U02MEDA).
Select [ON] to display the humidity reading on the Block display of the Monitor/Operation screen.

Note: The table below summarizes the items that are displayed on the Monitor/Operation screen according to the
combination of the settings for “Temperature display” and “Humidity sensor display.”

Temperature display
Humidity | [Room temp. (Always)] [Room temp.(Always)
sensor or [Sett | et temp.] "
displa ) et temp. or ide
play [Roorgpt:rrgt;i)c.)rgl)D]urlng [Room temp.(During op.)/
Set temp.]
OFF Upper: Room temp. Upper: Set temp. Upper: Room temp. Upper: N/A
Lower: N/A Lower: N/A Lower: Set temp. Lower: N/A
ON Upper: Room temp. Upper: Set temp. Upper: Room temp. Upper: N/A
Lower: Humidity Lower: Humidity Lower: Set temp. Lower: Humidity
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(9) Inthe [Occupancy sensor display] section, make the Show/Hide setting for the occupancy/vacancy status
that is detected by the built-in occupancy sensor on the ME remote controller (North America: PAR-
UO1MEDU, Europe: PAR-U0O2MEDA).

Select [Hide] not to display the occupancy/vacancy status on the Monitor/Operation screen.

Select [Show occupancy icon] to display the occupancy icon when the sensor on the remote controller
detects occupancy.

Select [Show vacancy icon] to display the vacancy icon when the sensor on the remote controller detects
vacancy.

Select [Show both icons] to display the occupancy or vacancy icon according to the occupancy status of the

room.
Note: If the ME remote controller has no built-in occupancy sensor, the occupancy/vacancy icons will not be displayed on
the Monitor/Operation screen.

Occupancy icon Vacancy icon

(Blue) (Gray)

(10) In the [Brightness sensor display] section, make the Show/Hide setting for the brightness/darkness status
that is detected by the built-in brightness sensor on the ME remote controller (North America: PAR-
UO1MEDU, Europe: PAR-UO2MEDA).

Select [Hide] not to display the brightness/darkness icons on the Monitor/Operation screen.
Select [Show bright symbol] to display the brightness icon when the brightness level in the room reaches
the predetermined brightness level.
Select [Show dark symbol] to display the darkness icon when the darkness level in the room reaches the
predetermined darkness level.
Select [Show both symbols] to display the brightness or darkness icon according to the brightness/darkness
level of the room.

Note: If the ME remote controller has no built-in brightness sensor, the brightness/darkness icons will not be displayed on

the Monitor/Operation screen.

Note: The brightness/darkness detection thresholds are set on the ME remote controller (North America: PAR-UO1MEDU,
Europe: PAR-U02MEDA).

Brightness icon Darkness icon

(Yellow) (Gray)
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7-1-3. Groups

Click [Initial Settings] in the menu bar, and then click [Groups] to access the group settings screen. Register the
groups of air conditioning units, LOSSNAY units (ventilators), Air To Water (PWFY) units, AHC, HWHP (CAHYV,

CRHV) units, chiller units, or general equipment to be connected to the AE-200/AE-50/EW-50, and then touch [Save

Settings].

Note: HWHP (QAHV) units cannot be registered from the Web Browser for Initial Settings. Register the HWHP (QAHV) units on

the LCD.

Note: Some settings may not be accessible if logged in as a building manager.

Note: When registering LOSSNAY units or OA Processing units, do not combine the units that support Night Purge function and

the units that do not in one group.

/

Unit registration

Q{ )| 1 http://102.1681.1/init/en/ad ministrator.htmi

E=SEeR ) Click to display the screen

ok

File Edit Niew Favorites Tool

Initial Settings i

p-ox] %USUBISHIAW(ondmonem ‘ i3

iRt for registering the air
conditioners, Air To Water
(PWFY) units, LOSSNAY
units, HWHP (CAHV, CRHV)
units, chiller units, and
general equipment.

System controller
registration

Click to display the screen
for registering the system
controllers.

Remote controller

Date and Time Basic System Groups // Interlocked LOSSNAY Blocks
M Groups
Group Name System Structure
GI’OU NO Entrance = 2
. 1
P / = L] 2w
Group name »” 203\ \
P v
5 Lobby (South) \;_l ) 4
= RLE] ] 2o
AHC registration n
Click to display the screen e & °
for registering the AHC. . T
"
ORefresh Save Settings @

Refresh
Click to import the settings

L re——

registration

Click to display the screen
for registering the remote
controllers.

7-1-3-1. Setting group names

Save Settings
Click to save the changes
made.

In the [Group Name] field, enter the group name to be displayed in 20 characters or less.
Note: The following characters cannot be used in the [Group Name] field: <, >, &, “, or

7-1-3-2. Registering air conditioners, Air To Water (PWFY) units, LOSSNAY units, HWHP (CAHV,

CRHV) units, or chiller units to a group

(1) To register air conditioners, Air To Water (PWFY) units,
LOSSNAY units, or HWHP (CAHV, CRHV) units to each group,
click the [Unit registration] field next to the target group name.
The [Select Unit Addresses] screen will appear.

Check the radio button next to [Air-conditioners / Air to water
/ HWHP], and select the address numbers of the units to be
registered.

The selected unit addresses will appear with a yellow-green
background.

Click again to deselect. The deselected unit addresses will
appear with a light-gray background.

Note: Each group can contain up to 16 units.

Note: Units other than general equipment cannot be combined with
general equipment in one group. To register general equipment to
a group to which units other than general equipment are already
registered, delete the existing registration first before registering
general equipment to it.

Note: The addresses of the units that have been registered to other
groups will appear with a gray background and cannot be
selected.

(2) To change the icon, click the right or left arrow.
The selected icon will be displayed on the Web browser.
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Entrance ﬂ

= Air-conditioners [ Air to water | HWHP
(™ General Equipment (via PAC-YGBEDCA)

i

Unit Addresses

I B2 Bl e NS SlEE Kl Sled N R
N e sEel Feal loEd BoRH Roinl do8d ROl S0
SN RN fCEE BN e 5ES e Ead BRE R

41 42 43 44 45 46 47 48 43 A0

Cancel | QK |




7-1-3-3. Registering remote controllers to a group

(1) To register remote controllers to a group, click the [Remote
controller registration] field next to the target group name. The Entrance

[Select Unit Addresses] screen will appear. 187 102 188 104 [168 106 {03 102 {68 110

111 112 113 114 115 116 117 118 119 120

Select the address numbers of the remote controllers to be
registered. The selected unit addresses will appear with a yellow-
green background.

Click again to deselect. The deselected addresses will appear
with a light-gray background.

121 122 123 124 125 126 127 128 129 130
131 132 133 134 135 136 137 138 139 140
141 142 143 144 145 146 147 148 149 150

181 152 153 154 155 156 157 158 159 160

Note: Each group can contain up to two remote controllers. el kb jibs) s Nilss) 1) ey e ibs) Kd

Note: Each group can contain up to four remote and system controllers 171 172 173 174 175 176 177 178 179 180
combined. 181 182 183 184 185 186 187 188 189 180

Note: MA remote controllers do not need to be registered to a group.
191 192 193 194 195 196 197 198 199 200

Cancel | Qk |

7-1-3-4. Registering system controllers to a group

(1) To register system controllers to a group, click the [System Select Unit Add
controller registration] field next to the target group name. The Ertrance 0
[Select Unit Addresses] screen will appear. 38 202

203 204 205 206 207 208 209 210

211 212 213 214 2145 216 217 218 219 220
Select the address numbers of the system controllers to be

registered. The selected unit addresses will appear with a yellow-
green background.
Click again to deselect. The deselected addresses will appear

with a light-gray background. Cancel | 0K |

Note: Each group can contain up to four remote and system controllers
combined (excluding AE-200/AE-50/EW-50).

221 222 223 224 225 228 22T 228 229 230
231 232 233 234 235 236 237 238 239 240
241 242 243 244 245 246 247 248 249 250

7-1-3-5. Registering AHC to a group

(1) To register an AHC to a group, click the [AHC registration] field Select Unit Ad
next to the target group name. The [Select Unit Addresses]
screen will appear.

Entrance

- 202 203 204 205 206 207 208 209 210

Select the address number of the AHC to be registered. The ) ) ) ) ) I ) )

selected unit address will appear with a yellow-green background. ) ) ) ) ) ) e ) el
Click again to deselect. The deselected address will appear with 231 232 233 234 235 236 237 238 238 240
a light-gray background. 241 242 243 244 245 245 247 248 248 260

Cancel oK
Note: Each group can contain one AHC. ﬂl _l

Note: AHC must be registered to a group in which air conditioners are
registered. Do not register AHC to a group in which Air To Water
(PWFY) units, LOSSNAY units, HWHP (CAHV, CRHV) units, chiller
units, or general equipment (via PAC-YG66DCA) are registered.
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7-1-3-6. Registering general equipment to a group

(1) To register general equipment to a group, click the [Unit  EEEIEE

registration] field next to the target group name. The Lighting(IF St ﬂﬂ
[Select Unit Addresses] screen will appear. b s s
* General Equipment (via PAC-YGB6DCA)
Unit Addresses
H H H ---------- Allow Operations
Check the radio button next to [General Equipment (via I O R R | v s o v
PAC_YGGGDCA)] 5 55 i ) S R B ) S ;zg;ﬂ:;;ﬁf;;ﬁmmmw
Select the device number of the DIDO controller (PAC- S 2] ] L 13 ; SEERERER | o
. . 41 42 43 44 45 47 48 43 50 + Output status
YG66DCA) that is connected to the general equipment Siiea ppe
to be registered. The selected number will appear with I e | R U
. . Cancel e
a red frame. Also, select contact points to which the e |

general equipments are connected.
Click again to deselect. The deselected numbers will
appear with a light-gray background.

Note: Each contact of DIDO controller counts as one unit.

Note: Each group can contain up to 16 general equipment.

Note: Up to six general equipment can be registered for each DIDO controller.

Note: Units other than general equipment cannot be combined with general equipment in one group. To register general
equipment to a group to which units other than general equipment are already registered, delete the existing
registration first before registering general equipment to it.

Note: General equipment groups cannot include remote controllers or system controllers.

(2) To change the icon, click the right or left arrow.
The selected icon will be displayed on the Web browser.

(3) In the [Allow Operations] section, make the setting to allow or disallow operation.
Select [In batch and on individual group] to allow the operator to turn on or off the general equipment
collectively or by the groups.
Select [On individual group] to allow the operator to turn on or off the general equipment by the groups.
Select [No operations (Monitor only)] to disallow the operator to turn on or off the general equipment.

(4) In the [Monitor] section, select which status will be used to reflect the units’ ON/OFF status to the unit
icons on the Monitor/Operation screen. Select [Output status] to use the status that is sent to the general
equipment, and [Input status] to use the status that is sent from the general equipment.
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7-1-4. Interlocked LOSSNAY

The ON/OFF status of the LOSSNAY unit/OA Processing unit can be interlocked with the operation of indoor units.
Click [Initial Settings] in the menu bar, and then click [Interlocked LOSSNAY] to access the Interlocked LOSSNAY
settings screen. Set the interlocking conditions, and then click [Save Settings].

Note: The Interlocked LOSSNAY settings may not be accessible if logged in as a building manager.

Note: The ON/OFF status of the indoor units are not interlocked with the ON/OFF status of the LOSSNAY unit.
Note: The interlock settings between the units connected to the AE-200, AE-50, and EW-50, as well as between the units

connected to different AE-50/EW-50 controllers, cannot be made.

oo =s
e

Interlocked indoor unit
registration

Click to display the screen
for registering the air
conditioners.

Save Settings
Click to save the changes

QC;“Jhnp""1921651.1'Wt'sr\‘az\m\r\l!tramrMm\ £~ & X |[ _IMITSUBISHI Air Conditione... ‘ |
File Edit View Faverites Tools Help
Initial Settings
Date and Time Basic System Interlocked LOSSNAY Blocks
M Interlocked LOSSNAY
Interlocked LOSSNAY Indoor Units
. \f\
Interlocked LOSSNAY unit > 5 o SRR
registration
Click to display the screen = « & "t
for registering the LOSSNAY
unit. = \E] 15 16
x 14 @ 17 18
* = ]
@Refresh Save Settings @
Refresh el AN
Click to import the settings
from AE-200/AE-50/EW-50. | | 2.

(1) Click the [Interlocked LOSSNAY unit registration] field. The [Select a
Unit Address] screen will appear.
Select the address number of the LOSSNAY unit to be registered.
The selected unit address will appear with a yellow-green
background.
Click again to deselect. The deselected address will appear with a
light-gray background.

(2) Click the [Interlocked indoor unit registration] field. The [Select Unit
Addresses] screen will appear.
Select the address numbers of the indoor units to which the selected
LOSSNAY unit will be interlocked. The selected unit addresses will
appear with a yellow-green background.
Click again to deselect. The deselected addresses will appear with a
light-gray background.

Note: Each LOSSNAY unit can be interlocked with up to 16 air conditioners.
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7-1-5. Blocks

By making block settings, multiple groups in a given block can be collectively monitored or operated on the Web
browser. Click [Initial Settings] in the menu bar, and then click [Blocks] to access the block settings screen. Register
the groups to each block, and then click [Save Settings].
Note: Some settings may not be accessible if logged in as a building manager.
Note: The groups of units connected to the AE-200, AE-50, and EW-50, as well as the groups of units connected to different
AE-50/EW-50 controllers, cannot be registered to the same block.
Note: The ventilation will stop when the Peak Cut control runs for the LOSSNAY units or OA Processing units that perform Night
purge operation. For this reason, do not register the LOSSNAY units and OA Processing units that perform Night purge

operation to the same block.

[E=SEoR &)
ok

Group registration

Save Settings
Click to save the changes

g()\ I httpi//192468:1.1/init/en/administratorhtml £~ & %[ _immsusis air Conditione ‘ |
File Edit View Favoites Tools Help
Initial Settings
Date and Time Basic System Groups Interlocked LOSSNAY Blocks
M Biocks
Block Name Member Groups
Block Name <
1 |Cobby = Groupl Entrance ‘E‘
Group2 L ¢ —
Group3 Lobby(Eash
Group4 Lobby(Genten
Groups Lobby(iest)
2 [ieeting roon =) oroups Meeting room A
Group? Meeting room B
Groups Maeting room C
Groupy Meeting roomm D
Groupt Meeting room E
Groupt 1 Large Meeting room
3 [Tenant ) Grouptz Tenant 1F-A
Groupl3 Tenant 1F-B
GroupT4 Tenant 1F-C o
‘@Refresh Save Settings @
Refresh
Click to import the settings
fom AE-200/AE-50/EW-50. | I | 2.

H100% -

(1) Enter the block name in the [Block Name] field in 20 characters or less.

Note: The following characters cannot be used in the [Block Name] field: <, >, &, “, or*

(2) Click the [Group registration] field next to the target block. The [Select

Groups] screen will appear.

Select the group numbers to be registered. (To show the group name,

move the cursor to the group number.)

The selected group numbers will appear with a yellow-green

background.

Click again to deselect. The deselected group numbers will appear

with a light-gray background.

Note: HWHP (CAHV, CRHV, QAHV) unit groups and chiller unit groups cannot

be registered to a block.

WT07627X03

151

Block Mame : Laobby
Group Mame : Lobby({South)

Cancel | Ok |




7-2. Functions 1
7-2-1. E-Mail

E-mail settings must be configured properly to use the error notification e-mail function or the e-mail communication
function. Error notification e-mail function is the function to send the error information to the specified e-mail
addresses. E-mail communication function is the function to send the units’ maintenance data to the specified e-mail
addresses of the PCs to which Maintenance Tool is installed.
Click [Functions 1] in the menu bar, and then click [E-Mail] to access the e-mail settings screen. Make the various
e-mail settings, and then click [Save Settings].

Note: The E-mail settings may not be accessible if logged in as a building manager.

6 MITSUBISHI A Conditioning ControlSyster - Windows Intemnet Explorer

Q) - [m row 923031

0 MITSUBISHI Air Conditioning Control System

[ =8 e =

<[4 | x ][ ging o -]

B v B - & v Pagev Safetyv Toolsv @~

4 Favorites

Functions 1

E-Mail Peak Cut Measurement Energy Management Setings

Mail Server Information
Set the mail server/DNS
server information.

E-Mail Settings of AE-200A
E-blail A g

E-Mail Settings of
AE-200/AE-50/EW-50

- Error Mail Settings

Enter the e-mail information
for error notification e-mail
function.

Mail Communication
Setting

Set the e-mail addresses
of the PCs that will receive
maintenance data through
e-mail communication
function.

s [UnitEror -

E-Mail Address | { [eerviceBaeZll. co. Jp =
- |\ 2 =
5 q

2 3
3 4
:: 5

@ Refresh Save Settings @

Save Settings
Click to save the changes

Refresh
made.

Click to import the settings
from AE-200/AE-50/EW-50.

[1]1 E-Mail Settings of AE-200/AE-50/EW-50

E-Mail Settings of AE-200A
E-Mail Address {mi taubizhiBac?ll.melco.co.jp

UserID Jae200

Password [t

Interval of checking incoming mails {T— iminute(s}

Enter the AE-200/AE-50/EW-50’s e-mail information provided by the Internet Service Provider (ISP) or the system
administrator. The items required to be set vary, depending on the functions to be used. Refer to the table below to

determine which items need to be set.
Note: A contract with the ISP is required to send e-mail via an ISP.

Table: ltems required to be set (E-Mail Settings of AE-200/AE-50/EW-50)

Error notification e-mail function E-mail communication function
Item Without SMTP With SMTP Without SMTP With SMTP
authentication authentication authentication authentication
E-Mail Address \% \% \% Vv
User ID - Vv \% \%
Password - \% \% Vv
Interval of checking incoming mails - - \% \%
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(V) Required to be set, (-) Not required to be set




[2] Mail Server Information

Mail Server Information

Qutgoing Mail Server (SMTP) 1smlp.aezﬂﬂ.cu.jp

[¥ Use SMTP Authentication

Port |25

Incoming Mail Server (POP3) ™1 [pap.as200.ca. jp
o po f[a
i Al

DNS Senver (Primary)

DS Server (Secondary)

Enter the e-mail server information provided by the ISP or the system administrator. The items required to be set
vary, depending on the functions to be used. Refer to the table below to determine which items need to be set.
Either the IP address or the host name (server name) can be entered in the [Outgoing Mail Server (SMTP)] and
[Incoming Mail Server (POP3)] fields.

Note: The port number of the Outgoing Mail Server (SMTP) can be changed. (Factory setting: 25)
Note: When “587” is entered in the [Port] field, make sure to check the checkbox next to [Use SMTP Authentication].

Table: Items required to be set (Mail Server Information)

Error notification e-mail function E-mail communication function
ltem Without SMTP With SMTP Without SMTP With SMTP
authentication authentication authentication authentication
V \% \% V
Outgoing Mail Server (SMTP) IP address or Host name IP address or Host name
host name host name
Use SMTP Authentication - Vv - V
\% \%
Incoming Mail Server (POP3) - - IP address or IP address or
host name host name
DNS Server (Primary) (V)™ Y, (V)™ \Y
DNS Server (Secondary) (V)™ Vv (V)™ \%

(V) Required to be set, (-) Not required to be set

*1 Not required if the IP address is entered in the [Outgoing Mail Server (SMTP)] or [Incoming Mail Server (POP3)] field.

[3] Error Mail Settings

Error Mail Settings

Mail Subject

Kind of Errars  Unit Error

]A.-"C Error at Mitsubishi Building

-

E-Mail Address [7 Juseraez00. co.ip

[wing] »

(1) In the [Mail Subject] field, enter the mail subject to be used for the error notification e-mail function in 40

characters or less.

Note: The following characters cannot be used in the [Mail Subject] field: <, >, &, “, or

()

In the [Kind of Errors] field, select the error type out of the following: [Unit Error], [Preliminary Unit Error],

[Communication Error], [General Equipment], and [User Setting 1] through [User Setting 6]. Then, in the
[E-Mail Address] field, enter the e-mail addresses of the recipients of the error notification e-mail.

@)

If [User Setting 1] through [User Setting 6] is selected in the [Kind

of Errors] field, a [User Settings] button will appear. To send error
notification e-mail only upon occurrences of certain errors, click
[User Settings] to display the User Settings screen.
Enter the error codes to be notified.

Up to 20 error codes can be set for each user setting. In addition
to specific error codes such as [1302] or [6607], codes that use
asterisks as wildcards such as [10**] or [12**] can also be used.

If [10**] is entered, for example, error notification e-mail will be
sent upon an occurrence of any type of errors between [1000] and
[1099]. If error codes are entered on this screen, confirm that the
e-mail addresses of the recipients are registered.
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User Setting 1 (Error codes to be

e sent)
erey

3 [ 4]

s [ e [ 7 ]

s [ s [0

Enor Code

User Seting 2 (Error

[z [z [os o [oiez [ [eim  [ziss [wiai [
< >

codes ta be sent)
[N R

<]
I

s [ s [ 7 [ s [ s [0
I A N

User Setting 3 (En

| 2]

vor codes ta be sen)
N [T T=2T= \‘ + ]

s [ s [ 7 [ s [ s [0
[ [ [ [ [

Erotode [ [ I
<

User Setting 4 (Error codes to be sent)
I N

2]

[ |
I

feaaa | [ [
<

s [ s [ 7 [ s [ s [0
[ [ [ [ [

2]
oK




(4) If [General Equipment] is selected in the [Kind of Errors] field, a

[PLC Connection] button will appear. To send error notification Bgapnn, R
e-mail upon occurrences of errors on the general equipment that - e
are connected to PLC Software for General Equipment, click [PLC s =
Connection] to display the [PLC Connection] screen. Enter the IP Pmsﬂy 2 ,C;;; |
addresses of PLC Software for General Equipment. i : ;;;;

|l el ™
The row number that corresponds to each IP address will appear _oansel | ok |

in the error notification e-mail as a PLC number. (e.g., When an
error occurs on the general equipment #20 connected to the PLC
Software in the second row, “PLC2-20” will appear in the [Error
unit] section in the error notification e-mail.)

Note: A TG-2000A is required to monitor the status of the general

equipment that is connected to the PLC Software for General
Equipment.

[4] Mail Communication Setting

Mail Communication Setting
AE-200Acancommunicate with Maintenance Tool etc by e-mail
from the following addresses

1 }maintenanceae?ﬂﬂ.co.jp
2]
3|
4 | -

[m] »

To use an e-mail communication function, enter the addresses of the PCs that will receive the units’ maintenance
data in the [Mail Communication Setting] section. Up to 10 e-mail addresses can be set.

[5] E-mail format
Error notification e-mail will be sent in the format shown below.

From:Mitsubishi Building(000001)
Date:01/06/2014 16:32:12

Error unit:065

Error code:1302
Status:Occurrence

Mail subject

The mail subject entered in section 7-2-1 “E-Mail” [3] will appear.

From

The AE-200/AE-50/EW-50 unit name and unit ID entered in section 7-1-2-1 “Unit Settings” will appear.

Date

Error occurrence date and time will appear in the format entered in section 7-1-2-6 “Display Format”.

Error unit

- When an error occurs on air conditioning units or general equipment, the M-NET address of the unit
in error will appear.

- When an error occurs on general equipment connected to PLC Software for General Equipment, PLC
number* (1 to 20) and connection number of general equipment (1 to 32) will appear.

- When a communication error occurs on PLC Software for General Equipment, PLC number* (1 to 20)
will appear.

* PLC number indicates the row number on the [PLC Connection] screen. (Refer to section 7-2-1 “E-Mail” [3].)

Note: When an error occurs on the general equipment connected via DIDO controller, M-NET address of
the DIDO controller will appear. (The recipients will know that an error has occurred on one of the
general equipment that is connected to the DIDO controller.)

Error code

Error code (4-digit) will appear.

- When an error occurs on air conditioning units, refer to the service manual of the unit for the error
codes.

- When an error occurs on general equipment, “0091” (General equipment error) will appear.

- When a communication error occurs on PLC Software for General Equipment, “0003” (LAN
communication error to PLC) or “0007” (PLC program stopped) will appear.

Status

Error status “Occurrence” (The error is occurring) or “Recovery” (The error has been resolved) will
appear.
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7-2-2. Peak Cut (Energy-save control function)

Accordin

g to the selected Peak Cut method, the AE-200/AE-50/EW-50 obtains the demand level or the electric

energy values to determine the control level, and operates outdoor units and blocks of indoor units below the

specified
Click [Fu

maximum capacity that corresponds to the control level.
nctions 1] in the menu bar, and then click [Peak Cut] to access the Peak Cut control settings screen. Make

necessary settings, and then click [Save Settings].

Important: The amount of electricity that is actually used may exceed the maximum power demand due to unexpected

problems such as controller malfunctions or broken transmission cables. Mitsubishi Electric will not be
responsible for exceeding the maximum power demand.

Note:

Note:

Note:

Note:

Note:
Note:

After completing the settings, perform a test run and confirm proper connections of equipment before using the Peak Cut
function.

A separate license is required to use the Peak Cut function. Make sure that the required license has properly been registered
on the Registration of Optional Functions screen. (Refer to section 4-5 “License registration for optional functions” for
details.)

Some settings may not be accessible if logged in as a building manager.

Peak Cut control cannot be performed on DIDO controller (PAC-YG66DCA), AHC, Air To Water (PWFY) unit, HWHP (CAHV,
CRHV, QAHV) unit, or chiller unit.

The Peak Cut control of indoor units is performed per block. Be sure to make block settings to use the Peak Cut function.
The Peak Cut control settings between the outdoor and indoor units connected to the AE-200, AE-50, and EW-50, as well as
between the units connected to different AE-50/EW-50 controllers, cannot be made.

B & X § = MITSUBISHI Air Conditione...

Functions 1

Peak Cut Measurement Enegry Management

M Peak Cut
2] system setings
Peak Cut method —p" ™8t ™ e | E] Setting details for the
L e Control levels 2 % m “ ]ﬁl:ec‘ Temperature difference between set point selected Peak Cut method
Wy P Sonioter 20[140 KW - 160 With this limitor greater difference
MWlM20 |y - 140 indoor units wil not be controlled on level O
Wl Remote AE oo WA - 1200 W
From external system
a Control details for outdoor units é Control details for indoor units
contro' details for Addr55551Max\mumCzpac\Iy Cuntm\%:i (perSEIrF:::Tes) T S mem\ Method Cuntm\%:i (perSEIrF:::Tes) B co.ntrOI deta_ils for bIOCKs
outdoor units Hios s fe fox Bow | B B s B s fe ds s e of indoor units
3|lo0% faow feow Jrew [eow 2 Pe Ja Fs I 2 B f2 M5 B
2 |f100% [ao% [Feow [70% (e 2 Pe f2 Mz I B3 Bs 3 s fzo
1 |100% Feo% [Heow [i7o [eox U3 Fs s s fizo U3 fs 3 s fzo
i oo Foow Pooe frow Beox | B Be M3 W15 Mo = z BB f3 s =
I Batch Operations I Batch Operations
@Refresh Save Settings @,
Refresh o Save Settings
Click to import the settings RSSO, (Click to send the settings to
from AE-200/AE-50/EW-50 AE-200/AE-50/EW-50 and
and PLC. PLC.
[1] Peak Cut method
[Demand-Input PLC] [Electric Amount Count PLC]
4 N\ 4 N\
Demand level is Reads electric
Demand level energy values.
signal is sent.
= e T
— T
AE-200; E@E [ AE-200[ H1d [
= HICHE: Electric Amount Pulse-watt-
el Dem;ajrll_délnput Demand 0 k| — Count PLC hour meter
50 [} < controller .
AE-50 [3| €= AE-50 2| —|
Maximum ten Maximum fourteen
i AE-200/AE-50/EW-50 units . .
AE-50 3| <€) AE-50 ;) = _/ AE-200/AE-50/EW-50 units
\ Y, \ . Y,
WTO07627X03
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[Pl Controller]

/

\
<When a PI controller (PAC-YG60MCA) is used> <When a built-in Pulse Input (PI) is used>
Reads electric
energy values.
=
(Built-in Pulse Input (PI)) Pulse-watt-
PI controller Pulse-watt- hour meter
hour meter 1. ~
Reads control | Reads control
_—"" level. |_— level.
Maximum three Maximum three
s AE-200/AE-50/EW-50 units z AE-200/AE-50/EW-50 units
Peak Cut method [Remote AE] Peak Cut method [Remote AE] )

[External Contact point input] (1)

[From external system]
e N\

Demand level
signal is sent.

N
External input/output Demand level is
adapter (PAC-YG10HA-E) input.

LAN \
=
Demand
I controller
Reads control
— level.
Maximum three
AE-200/AE-50/EW-50 units
=
Peak Cut method [Remote AE]
. J

|
PLC etc. Pulse-watt-
; < hour meter
E « Maximum ten
AE-200/AE-50/EW-50 units
=
. J

WT07627X03

[External Contact point input] (2)

- N\
External input/output Demand level is
adapter (PAC-YG10HA-E) input.

Demand
E controller
E Maximum three
AE-200/AE-50
E /EW-50 units
\ J

Note: An external input/output adapter (PAC-YG10HA-E) is

required for each AE-200/AE-50/EW-50.
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(A) When the Peak Cut method [Demand-Input PLC] is selected

1l g Demand InputPLC @uitialge | PAdcress 1927 [ige [T [i7
.T. Electric Amount Count PLC Cantrolled AE
PAC-YG11CDA 1 mmrr:
- glﬁ\g?‘?ggg:erA 9oz [es [ [z =| [3=]>c . Temperature difference between set point
& Remote A Bllez [e3 [ 3 = andinlet. ]
sz es T With this limit or greater difference,
indoor units will not be controlled on level 0
External Contact point Input ] = 1 . -
From external system

(1

~

In the [IP Address] field, enter the IP address of the Demand-Input PLC.

(2) When using the Demand-Input PLC for the first time, click [Initialize] to initialize its internal memory.

Note: Do not initialize the Demand-Input PLC after the operation has begun, for it will clear all operation data.

(3) In the [Controlled AE] field, enter the IP addresses of the AE-200/AE-50/EW-50 units to which the demand

level signal is sent. Up to 10 IP addresses can be registered.

(4) In the [Temperature difference between set point and inlet] section, a temperature differential can be set to

(B)

between 3 and 9 as necessary. The Peak Cut control setting that corresponds to the control level 0 will be
disregarded for the indoor unit groups in which the temperature difference between the set temperature and
the room temperature is greater than the specified temperature differential.

Note: The Peak Cut control setting that corresponds to the control levels 1 to 4 will be effective regardless of the
temperature differential setting.

When the Peak Cut method [Electric Amount Count PLC] is selected
Dermand Input FLC
L1 I=pelitebhegy IIP Address 192 [68 [T 159
].T.ElecchmuumCoumPLC IDI Board 1= — 0 '! Pulse Unit 0 FI-M KWh/pulse
O nfzlize 'Contral levels (4 1180 kW -
= EL\%U‘?E;EE%C 360 Wy - 180w [3 =]z Temperature difference between set point
2 140 i - 160 (A and inlet.
Bl Remote AE 120 WA - 140 With this limit or greater difference,
indoor units will not be controlled on level 0
Extarnal Contact point Ingut & 0 Ky <200 ey
From external system

(1)
()

@)

(4)

®)

In the [IP address] field, enter the IP address of the Electric Amount Count PLC.

When using the Electric Amount Count PLC for the first time, click [Initialize] to initialize the internal memory.
Note: Do not initialize the Electric Amount Count PLC after the operation has begun, for it will clear all operation data.

In the [DI Board] field, select the DI board number to which the watt-hour meter is connected, and the
terminal number. If the watt-hour meter is connected to terminal 2 on a DI board 1, select 1-2.
Note: Select a DI board number 1 or 2, and select a terminal number/code between 0 and F.

In the [Pulse Unit] field, enter the pulse value that the watt-hour meter outputs. Set the pulse value according
to the watt-hour meter to be used.

Important: Check the watt-hour meter readings several times on the hour and the half-hour. Then, be sure to check
that the increase in the watt-hour meter reading for each 30-minute period and the average electric power
consumption in the same period that the Peak Cut function is used are the same amount.

In the [Control levels] section, the range of the electric power must be set for each control level. For control
level 4, enter the value that is 10% to 15% below the maximum power demand (average electric energy that
cannot be exceeded in any 30-minute period). For control levels 3 to 0, enter the value that is decreased

by about 10% from the set value of the previous control level. (The screenshot above shows the setting
example of the maximum demand of 200 kW.)

Note: The optimum setting depends on the system configuration of the electric equipment and on the indoor environment in
each building. Determine the appropriate values accordingly.
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(6) In the [Temperature difference between set point and inlet] section, a temperature differential can be set to
between 3 and 9 as necessary. The Peak Cut control setting that corresponds to the control level 0 will be
disregarded for the indoor unit groups in which the temperature difference between the set temperature and

the room temperature is greater than the specified temperature differential.
Note: The Peak Cut control setting that corresponds to the control levels 1 to 4 will be effective regardless of the
temperature differential setting.

(C) When the Peak Cut method [Pl Controller] is selected

i Demand Input PLC
PAC—YGM(?DA Watthaur meter  [Address48-1 -]

Electric Amount Count PLC [[e0
Ly | PAC-YE 1 G0 GContral levels -4 1180 K- T 3 _~|°C: Temperature difference between set point
3| E: x
| B Pl Caontraller B {1@—_ i 160 s and inlet.
PAC-YGEOMOA, 140 KA - i ki With this limit or greater difference,
1120 KA - ) indoor units will nat be controlled on level 0.
Ml Remots A 0o W - 1200w

External Contact point Input

From external system

(1) In the [Watthour meter] field, select the watt-hour meter used for the Peak Cut function or the PI controller to
which the watt-hour meter is connected.

Note: Only the watt-hour meters that have been registered on the Measurement screen are selectable. Refer to section
7-2-3 “Measurement” for how to register metering devices.

Note: When a built-in Pulse Input (PI) is used, [‘Meter” + Channel No. + (space) + Metering device name] will appear. (For
example, if the watt-hour meter used for the Peak Cut function is connected to channel 3 of CN7 of AE-200 and the
metering device name is “For Peak Cut function,” [Meter3 For Peak Cut function] will appear.)

When a PI controller (PAC-YG60MCA\) is used, [‘Address” + Pl controller address + “-” + Channel No. + (space) +
Metering device name] will appear. (For example, if the watt-hour meter used for the Peak Cut function is connected
to channel 2 of a PI controller (address 10) and the metering device name is not registered, [Address10-2] will
appear.)

(2) Inthe [Control levels] section, the range of the electric power must be set for each control level. For control
level 4, enter the value that is 10% to 15% below the maximum power demand (average electric energy that
cannot be exceeded in any 30-minute period). For control levels 3 to 0, enter the value that is decreased
by about 10% from the set value of the previous control level. (The screenshot above shows the setting
example of the maximum demand of 200 kW.)

Note: The optimum setting depends on the system configuration of the electric equipment and on the indoor environment in
each building. Determine the appropriate values accordingly.

(3) In the [Temperature difference between set point and inlet] section, a temperature differential can be set to
between 3 and 9 as necessary. The Peak Cut control setting that corresponds to the control level 0 will be
disregarded for the indoor unit groups in which the temperature difference between the set temperature and
the room temperature is greater than the specified temperature differential.

Note: The Peak Cut control setting that corresponds to the control levels 1 to 4 will be effective regardless of the
temperature differential setting.

Note: When a PI controller is only connected to AE-200, and when AE-50/EW-50 monitors AE-200, select “Remote AE” for
AE-50/EW-50.
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(D) When the Peak Cut method [Remote AE] is selected

Demand Input PLC

L Eoritwhey PAddress 192 _[wee 1[4
Electric Atnount Count PLC

.T. PAC-YGT1CDA

—=1, Pl Cantraller

3 »|°C: Temperature difference between set point
and inlet.

I B Remote AE With this limit or greater difference,

indoor units will not be controlled on level 0.

< PAC-YGEOMCA

External Contact point Input

From external system

(1) Inthe [IP address] field, enter the IP address of the AE-200/AE-50/EW-50 that uses one of the following.
- Built-in Pulse Input (PI)
- PI controller (PAC-YG60MCA)
- External contact input (Refer to (E) “When the Peak Cut method [External Contact point input] is
selected” for details.)

Note: As the control level is obtained every minute from the AE-200/AE-50/EW-50 that uses a built-in Pulse Input (PI) or

a PI controller (PAC-YG60MCA), the control will be late for up to one minute on the AE-200/AE-50 whose Peak Cut
method setting is [Remote AE].

Note: Up to three AE-200/AE-50/EW-50 units can be connected to the AE-200/AE-50/EW-50 unit that uses a built-in Pulse
Input (PI) or a PI controller (PAC-YGB60MCA). When five or more AE-200/AE-50/EW-50 units are connected, add the

settings in (C) “When the Peak Cut method [PI Controller] is selected” or use the Peak Cut method [Electric Amount
Count PLC].

(2) Inthe [Temperature difference between set point and inlet] section, a temperature differential can be set to
between 3 and 9 as necessary. The Peak Cut control setting that corresponds to the control level 0 will be
disregarded for the indoor unit groups in which the temperature difference between the set temperature and
the room temperature is greater than the specified temperature differential.

Note: The Peak Cut control setting that corresponds to the control levels 1 to 4 will be effective regardless of the
temperature differential setting.

(E) When the Peak Cut method [External Contact point input] is selected

Note: The external signal can be input to AE-200, AE-50, and EW-50, so that all outdoor units and blocks of indoor units can be
selected.

Cemand Input PLC
.T. PAC-YGE41CDA 3 =|°C: Temperature difference between set point

i Electric Amount Count PLC andinlet.
PAC-YG11CDA With this limit or greater difference,
~ -, Pl Controller indoor units will not be controlled on level 0
St PAC-YGEOMCA
Ml Remote AE

Il External Contact point Input

From external system

(1) In the [Temperature difference between set point and inlet] section, a temperature differential can be set to
between 3 and 9 as necessary. The Peak Cut control setting that corresponds to the control level 0 will be
disregarded for the indoor unit groups in which the temperature difference between the set temperature and
the room temperature is greater than the specified temperature differential.

Note: The Peak Cut control setting that corresponds to the control levels 1 to 4 will be effective regardless of the
temperature differential setting.

Note: When an external input is only connected to AE-200, and when AE-50/EW-50 monitors AE-200’s control level, select
“Remote AE” for AE-50/EW-50.
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(F) When the Peak Cut method [From external system] is selected

.[. E:Qi%ﬂnggfw 3 =|°C: Temperature difference between set point
g Electric Amount Count PLC and inlet
FPAC-YG11CDA With this limit or greater difference,
~- 1, Pl Controller indoor units will not be controlied on level 0.
=5 PAC-YGEOMGA
Ml Remote AE

External Contact point Input

N From external system

(1) Inthe [Temperature difference between set point and inlet] section, a temperature differential can be set to
between 3 and 9 as necessary. The Peak Cut control setting that corresponds to the control level 0 will be
disregarded for the indoor unit groups in which the temperature difference between the set temperature and

the room temperature is greater than the specified temperature differential.
Note: The Peak Cut control setting that corresponds to the control levels 1 to 4 will be effective regardless of the

temperature differential setting.
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[2] Control details for outdoor units (All Peak Cut methods)

Follow the instructions below to make the Peak Cut control settings for each control level for given outdoor units.
Note: If the outdoor unit is a City Multi unit, the M-NET address will appear. If the outdoor unit is an A-control (Mr. Slim) unit, the
M-NET address and group name will appear.
Note: As for A-control outdoor units, only the inverter models can perform Peak Cut control. The Peak Cut control settings for
constant-speed models can not be made.
Note: Do not make the Peak Cut control settings for heat pump models of outdoor units or some types of outdoor units.

c Copy
;q Control details for outdoor units /
= »
Address 51 Copy Paste < —*—1— Paste
Maximum Capacity Control Time (per 30 minutes) |E |
Control level =4 |[100% [Jao% [0 [J7owe @60% oo a 6 M2 [is Mo Control Time
3 ||Moow Foos Faowe Wrow [feok [0 3 B B2 Bs Bz
2 |T1oo% [oow Weess (70w [0 (oo 3 B B Bz B
1[B1o0% Weow Moo Brow Neow Mso% s Bs B Bs B
0 |Bwow [oow Peow f7ow feow [aos s g M3 Mis [ao
= =
Batch Operations —®  Batch Operations \
Click to make settings for \
all outdoor units at once. Maximum Capacity
Select the upper limit of outdoor unit
operating capacity.
(1) To make settings for all outdoor units at once, Capacity , ,
. e.g., Maximum capacity at 80%
check the [Batch Operations] checkbox. A

Then, set the maximum operating capacity for
each control level.
The smaller the maximum operating capacity, 80% [~-----------------—2
the more energy will be saved.
Note: Energy-saving effects cannot be expected Operating
during low-load operation with the capacity Capacity
below the selected maximum capacity.
Note: For heat pump outdoor units and City Multi
S series (PUMY) outdoor units, leave the
default setting [100%] as it is not to activate
the capacity-save control.
However, [50%] though [100%] can be set on
the following models.
PUMY-P**KM or later
PUMY-P**KM-A or later
PUMY-P**HMC-S or later
PUMY-P**HMC-C or later
PUMY-P**KMC-C or later
PUMY-P**YKM.TH(-T) or later
Note: AE-200/AE-50/EW-50 that support Maximum
Capacity [50%)] are from Ver. 7.23 or later.

B
— o ——
— -

No energy-saving effects Energy-saving effects

> Time

(2) For each control level, set the total time in which the Peak Cut control is performed during every 30 minutes.
Setting the time to [30] or [15] minutes is preferable, for shorter control time is not likely to bring much
benefit.

If any time other than [30] minutes is selected, the outdoor units will operate in rotation so that they will not
perform the Peak Cut control at the same time.

(3) To copy the settings of an outdoor unit to the settings for other outdoor units, display the outdoor unit whose
settings are to be copied and click [Copy], then display the outdoor unit to which the copied settings are to
be pasted and click [Paste]. The rectangular icons next to the selected buttons will appear in yellow-green.
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[3] Control details for blocks of indoor units

Follow the instructions below to make the Peak Cut control settings for each control level for given blocks of indoor
units.
If the block settings have not been made, refer to section 7-1-5 “Blocks” for how to make the block settings.

Co
g} Control details far indoor units Py
— Paste
Block 1 Lobhy{1F) co”  paste®
Cantral Method Cantrol Time {per 30 minutes)
Control level 4 |[Mone [1£2°C [[Fan [JOFF 3 e 3 [z o< Control Time
3 |more [zzec JFan [oFE s B 3 [1s ‘=
2 one | tzec [lFan | OFF B ‘5 (g2 ‘15 a0
1 \lrone  [zzec JFan [ OFF B 5 (g [15 [a0
0 |BMone [2°C [Fan OFF B3 (6 (2 [1z a0 =
Batch Operations — Batch Operations \
Click to make settings for \______ Control method

all blocks at once.

(1) Scroll up or down to display the block whose settings are to be made. To make settings for all blocks at
once, check the [Batch Operations] checkbox.
Then, select the control method for each control level, referring to the table below.

Note: Only the control method “OFF” is effective for Air To Water (PWFY) units. Other methods can be selected, but are not
effective.

Table: Indoor Unit Control Method
Control Method Control details

None Peak Cut control will not be performed.

During the Peak Cut control, the set temperature in the Cool or Dry mode will be offset by +2°C (+4°F),
and the set temperature in the Heat mode will be offset by -2°C (-4°F).
Note: Peak Cut control will not be performed during the Fan or Auto mode.
+29C (+4°F) Note: When the unit of temperature is Fahrenheit, the set temperature may not be offset by +4°F
- - exactly because 2°C is used for the calculation first, and then the temperature in Celsius is
converted into the temperature in Fahrenheit.
Note: The set temperature will be adjusted within the set temperature restrictions settings.
Refer to section 7-3-1 “Set Temperature Range Limit” for details.

During the Peak Cut control, free-plan indoor units and A-control Mr. Slim indoor units (M-Series/
P-Series indoor units) will go in to the Thermo-OFF state, and the units older than free-plan units will
operate in the Fan mode. (When the units are in the Thermo-OFF state, the operation mode on the
remote controller LCD will not change.)

Fan ™1

During the Peak Cut control, the units will stop.
OFF ™ Note:If the control method is set to [OFF] and the Control Time is set to [30] minutes, the groups
that are operated in the Peak Cut control cannot be operated from any controller.

*1  When the indoor unit Peak Cut control function is used during the heating operation, it takes a while to resume operation to prevent cold air
draft. This may negatively affect the performance of the unit for a certain period of time after the operation is resumed. To ensure maximum
performance, it is recommended to use an outdoor unit capacity-save control function (that will not stop the compressor operation) during the
heating operation. If the indoor unit Peak Cut control function is still used, selecting [3] minutes in the Control Time section is recommended.
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(2) For each control level, set the total time in which
the Peak Cut control is performed during every 30
minutes.

Each Peak Cut control is performed for three
minutes. If [6] minutes is selected, three-minute
Peak Cut control will be performed twice during
every 30 minutes.

If any time other than [30] minutes is selected, the
indoor units will operate in rotation so that they will

not perform the Peak Cut control at the same time.

@)

When [6] minutes is selected

0

A= A

Group 1

A=

Group 2

A Ao

Group 3

3 5

Il Control time
8 10 1315 18 20 23 25 28 30 min

To copy the settings of a block to the settings for other blocks, display the block whose settings are to be

copied and click [Copy], then display the block to which the copied settings are to be pasted and click [Paste].
The rectangular icons next to the selected buttons will appear in yellow-green.
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7-2-3. Measurement
Measurement settings must be made to use temperature sensors, humidity sensors, and metering devices.
Click [Functions 1] in the menu bar, and then click [Measurement] to access the measurement settings screen. Set

the measurement settings, and then click [Save Settings].
Note: The measurement settings may not be accessible if logged in as a building manager.

fello /==
Qu’ )| _ htp://192:168.L1 /int/en/acministrator.ntmi £ ~ & X || _yMirsuBisHI Air Conditione. | ‘ ok

File Edit View Favorites Tools Help

Functions 1

E-Mail Peak Cut Measurement

. M Measurement Setting details
SeIeCtlon Of AI or PI Aiﬂress MName J Sensor Range f Alarm hail +
controller —. a 7 [Exhibition Fall (T3
|| W e - Cpcp—
— & L - | ETe Bl Scroll bar
M-NET address of >, = ¥ setonset oo Slide to show the address to
Al or PI controller ‘E‘"‘Ej'“'” BLE S which the Al or PI controller
. 2 L OFTT% - @ T % ﬁe:;:j ) will be connected.
) Set offset % T % =
Selection of separator i i
character for energy B o - :Avp:fmju !Ao‘ut—ni—:ml‘talavm €¢— E-mail Settlngs
management data IW --- E-Mail Address [ tsubi shiBae200. 0. Jp -
commay ¥ E-Mail Seftings z : El
Selection of decimal point £
character for energy Refresh Save Settings®
management data L— Save Settings

S Click to save the changes

] made.
Refresh

Click to import the settings
from AE-200/AE-50/EW-50.

[1] Registering Al controllers and temperature/humidity sensors
Follow the instructions below to make the system settings for measurement sensors. Up to two measurement
sensors can be connected to an Al controller (PAC-YGG63MCA).

Selection of temperature

or humidity sensor icon Measurable range
Sensor name
\ Upper/lower ON- and
ddress ‘ I Name [ Sensor Range [ Alarm Mail / OFF'threShOld settings

= & Qoo o -} o é % g / \Upperlimit
Setting details of—y‘l—40 — P Setofeet o I\ (ON-threshold)

C

sensor 1 | Exnibition hall (Hy

' - . 1
Al controller icon ——p 3 2 B ST / —1  for e-mail alarm function
& e B 450
21 B ez N [T - \
10.0
0.0

A [a0n % Upper limit
Setting details of o a @ ven OF9 % — Bl % (OFF-threshold)
sensor 2 » Setofiset %o N\#H . Lower limit

f 3 (OFF-threshold)
Set offset
Lower limit

(ON-threshold)

(1) Using the scroll bar, select the address to which the Al controller (PAC-YG63MCA) will be connected.

(2) Select the Al controller icon ( '—H 1.

Note: Click again to deselect.

(3) Inthe [Sensor name] field, enter the name of the sensor.

(4) Select the temperature sensor icon ( &_II ) or the humidity sensor icon (‘@ ).

(5) Enter the measurable range of the sensor.
Note: When the Pt sensor is connected, the range must be between -30°C (-22°F) and +60°C (+140°F).
When the sensors other than the Pt sensors are connected, enter the ranges that are described in the operation
manuals of the sensor.
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(6) To receive an e-mail alarm when the temperature or the humidity exceeds certain predetermined values, set
the ON- and OFF-thresholds for both the upper and lower limit temperatures.
Note: To avoid frequent ON/OFF cycling, the minimum differential between the ON- and OFF-threshold values should be
1°C (2°F).

[2] Offsetting the measured temperature/humidity values
To set the offset value for the measured values, follow the instructions below.
Note: The actual measurement values or the adjusted measurement values are not displayed until the connection settings of the

Al controller are completed.
When the Al controller is registered for the first time, click [Save Settings] to send the settings data, and click [Functions
1]-[Measurement] to refresh the measurement settings screen.

(1) Click [Set offset] in the [Setting details] section.

(2) Select the offset value in the [Offset] pulldown menu, or :
select the desired value in the [Modified value] pulldown Wosed vale S i

menu. EEERNEI = @z T + [w5 =]

The settable offset value range for temperature sensor is Zj 1
between -10.0°C (-18.0°F) and +10.0°C (+18.0°F), and Lo jgfg _LI
for the humidity sensor is between -10.0% and +10.0%. I

[3] Registering Pl controllers and metering devices
Follow the instructions below to make the system settings of the metering devices. Up to four metering devices can

be connected to a PI controller (PAC-YG60MCA) or CN7 of AE-200/AE-50/EW-50.

Note: Although the maximum settable total number of built-in Pulse Input (PI) and PI controllers (PAC-YG60MCA) for each
AE-200/AE-50/EW-50 is 15, the number of them in a system with connection to one or more AE-50/EW-50 controllers must
be 20 or less. (Each built-in Pulse Input (PI) counts as one unit.)

<When a built-in Pulse Input (Pl) is used>

Metering device name /— Pulse value
\ Mame f Pulse Weight / / M urement unit
—ill = frest -
|_ ”ih;‘ B e - H B o - —— Setting details of

metering device 2

Setting details of
[souTH [FoRTH

metering device 1 i i
= _ = 14— Setting details of
—:A i (L | T H e - metering device 4

=

Setting details of —
metering device 3

<When a PI controller (PAC-YG60MCA) is used>

Metering device name —\
A |

/— Pulse value
e 7

Tarne [ Flse WeTgnt Measurement unit

Pl controller icon — - |5 [ 1F) [whin (2Fy p S
- Wﬁ{ o Lo e o ‘ l & e 41—— Setting details of

metering device 2

Setting details of ————

metering device 1 \WBC’-F) ‘ “\WE(F’eakcun f | Setting details of

= T Lo [ewn - = JLlia i - P i
Setting details of —— | metering device 4
metering device 3 =

(1) Using the scroll bar, display the address to which the PI controller (PAC-YG60MCA) will be connected or to
display the settings area for a built-in Pulse Input (PI) at the top.
(2) Select the PI controller icon (;z_J ).

When a built-in Pulse Input (PI) is used, the top row shows the setting area for the built-in Pulse Input (PI)

and there is no need to select an icon.
Note: Click again to deselect.

(3) In the [Metering device name] field, enter the name of the metering device.
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(4) Enter the pulse value of the metering device, and select the measurement unit.
Note: The measurement unit can be selected from [kWh], [m3], [MJ], or [--(no unit)].
Note: Select the blank in the measurement unit pulldown menu when not using a metering device.
Note: If the pulse value field is left blank, the reading of the metering device cannot be properly obtained. Be sure to set the

pulse value.

Important: Set the pulse value according to the metering device to be used. To ensure proper settings, first check the value
measured by the metering device and the value counted by the Pl controller. Then, after a certain time, check
that both values have increased by equal values. (The values that the Pl controller counts can be checked on
the LCD and the Integrated Centralized Control Web.)

[4] E-mail alarm function settings

To receive an e-mail alarm when the temperature or the humidity exceeds certain predetermined values, set the
e-mail settings by following the instructions below.

(1) In the [Type of E-Mail] field, select [Out-of-limit alarm].

Then, enter the mail subject and the e-mail addresses.
Note: The following characters cannot be used in the [Mail

Subject] field: <, >, &, “, or*

An e-mail alarm will be sent in the format shown below.

Type of E-Mail  Out-of-limit alarm

Mail Subject  [Alarn Mail

E-Mail Address | 9 uitsubishifaeil.co.jp

P E-Mail Settings

Wl

From: Mitsubishi Building(000001)
Date/Time: 13/03/2014 09:38:39
Address: 50-1

Current value: 24.9 deg C
Status: Exceeded lower limit
Trend Data:

09:38 25.2deg C

09:37 25.4 deg C

09:36 25.6 deg C
09:3525.8deg C

09:34 26.1 deg C

09:33 26.4 deg C

09:32 26.7 deg C
09:3127.0deg C

09:30 27.5deg C

09:29 27.7 deg C

AE-200/AE-50/EW-50 name + Unit ID
Note: The AE-200/AE-50/EW-50 unit name and unit

From ID entered in section 7-1-2-1 “Unit Settings”
will appear.
yyyy/mm/dd hh:mm:ss
Date/Time Note: The date and time will appear in the format
selected in section 7-1-2-6 “Display Format”.
Address M-NET address of Al controller + sensor No.

Current value

Current temperature or humidity (one decimal place)
Note: [**.*] may appear until the value measured by
sensor becomes stable.

“Exceeded upper limit,” “Recovered from upper

Status limit,” “Exceeded lower limit,” or “Recovered from
lower limit”
Trend Data Time + Temperature or humidity values (for the last

10 minutes)

(2) Click [E-Mail Settings] to enter the mail server

information.

Note: The setting details are the same as those described
in sections 7-2-1 “E-Mail” [1] and [2]. Refer to those

sections for details.
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E-Mail Bettings

E-Mail Settings of AE-200A

E-Mail AddressimilsubishianUU.CD.JD

UserID |00

Password [ttt

Mail Server Information

Outgoing Mail Server (SMTF) [snip. aef00. co. jp

[¥ Use SMTP Authentication
[
ol o

DNS Server (Primary)
DNS Server (Secondary)

= =
=

Cancel




[5] Energy management data format settings
Set the format of the energy management data that can be output in a CSV format from the screens under the
Energy Management menu.

| — Select the separator character.

Hcomma () >
Semmicolon )
HDot () p
comma ()

L— Select the decimal point character.
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7-2-4. Energy Management Settings
On the Energy Management Settings screen, make the settings for the energy-control-related items, such as
temperature sensor to measure the outdoor temperature with, electricity meters that are used for acquiring the data
to display the trend graph of indoor unit electricity consumption, and also the mode that are used for apportioning
indoor unit electricity consumption.
Click [Functions 1] in the menu bar, and then click [Energy Management Settings] to access the energy
management settings screen.

Note: The energy management settings may not be accessible if logged in as a building manager.
Note: Electricity consumption is apportioned based on the electricity consumed by outdoor units. The electricity consumed by
indoor units is not considered.

Important: The energy management settings must be made after all units have been started up.
The settings that have been saved while one or more units are starting up may be lost.

&) oi//192: html P~ & X[ _MITsuBISHI Air Conditione... ‘ ‘ ok 2X
File Edit View Fevorites Tools Help

Functions 1

Peak Cut Measurement Energy Management Seftings L |nd°°r unit operation
M Energy Management Settings apportioning mode
External TemperatureSensor Indoor unit operation apportioning mode
Temperature sensor —— st oussorTenperae v fesiopaonune  IhemoONume Beapacity save amount L Indoor unit electricity
Select a temperature sensor Indoor unit electricity meter T meter

Address Group Name Electricity meter

to measure the outdoor
temperature with.

1" Entrance Address50-1 Electric Meter1
2 Lobby({South) Address50-1 Electric Meter1
2 Lobby(East) Address50-1 Electric Meter1
Obby({Center) Address50-1 Electric Meter1

= >

Indoor unit address

FIRIKI KIEIR

Lobby(West) Address50-1 Electric Meter1
Conference Room A Address50-2 Electric Meter2

©® o Ak

Conference Room B - Group Name
Conference Room € Address50-3 Electric Meter3 -
Conference Room D Address50-3 Electric Meter3 -

10 Conference Room E Address50-4 Electric Meterd. K > Electl’icity meter

11" Conference Room F Address50-4 Electric Meterd v -

®Refresh Save Seffings @
| R i
Refresh | ——— —Sae Seitings
Click to import the settings R - Click to save the changes
from AE-200/AE-50/EW-50. made.

(1) Inthe [Temperature sensor] section, select a temperature sensor to measure the outdoor temperature with.
In the pulldown menu, the name of the temperature sensor that is connected to the Al controller or the AHC
will appear.

Note: Connect the temperature sensor to either the Analog Input 1 or Analog Input 2 port on the AHC.
Note: This setting is interlocked with the temperature sensor setting on the External Temperature Interlock settings screen.

(2) In the [Indoor unit operation apportioning mode] section, select the way indoor units' operation time is
counted that is used to apportion the electricity consumption, which appears on the screens under the
Energy Management menu.

Select [Fan operation time] to apportion the electricity consumption based on the fan operation time, and
select [Thermo-ON time] to apportion the electricity consumption based on the Thermo-ON time of the
indoor units.
Select [Capacity save amount] to apportion the electricity consumption based on the indoor unit operation
time that was calculated based on the amount of energy saved on the indoor units.
The selected setting must meet the system requirements. Selecting [Capacity save amount] is
recommended.

Note: “FAN operation time” is the cumulative duration of time in which the indoor unit is powered on.

Note: “Thermo-ON time” is the cumulative duration of time in which the refrigerant is flowing into the indoor unit.

Note: “Capacity save amount” is the cumulative operation time of the outdoor unit based on its capacity.

Note: Electricity consumption is apportioned based on the electricity consumed by outdoor units. The electricity consumed

by indoor units is not considered.

Note: When an AE-200 apportioned electricity billing function is used, this setting is not effective because the billing
function settings are used to apportion the electricity consumption.
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(3) Inthe [Indoor unit electricity meter] section, select the electricity meter to be used to measure the electricity
consumption of each group of indoor units.
In the pulldown menu, [“Address”+ Pl controller address + “-” + Electricity meter number + Electricity
meter name] will appear when a PI controller (PAC-YG60MCA) is connected, or [‘Meter” + Channel No. +
Electricity meter name] will appear when a metering device is directly connected to the controller.

Note: If the electricity meter name is long, only part of it may be displayed.
Note: The electricity meter name will be blank if it has not been registered.
Note: Only the electricity meters whose measurement unit setting is set to [kWh] on the Measurement screen are available

for selection.
Note: When an AE-200 apportioned electricity billing function is used, this setting is not effective because the billing
function settings are used to apportion the electricity consumption.

(4) Click [Save Settings] to save the settings.
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7-3. Functions 2

7-3-1. Set Temperature Range Limit
The settable temperature range for the local remote controllers can be limited. By restricting the lower and upper
limit of the set temperatures for cooling, heating, and auto modes, energy consumption can be reduced.
Click [Functions 2] in the menu bar, and then click [Set Temperature Range Limit] to access the set temperature
range restrictions settings screen.
Note: The set temperature range restrictions settings may not be effective, depending on the unit model of the remote controller
and the indoor unit.
Note: A-control (Mr. Slim) units, room air conditioners, and residential air conditioners do not support the set temperature range
restrictions settings.
Note: The set temperature range restrictions settings may not be accessible if logged in as a building manager.
Note: The set temperature limit range for the AUTO mode cannot be set for the groups that support the dual set point function in
the AUTO mode. The set temperature ranges for the normal cooling and heating modes will be used for the ones for cooling
and heating in the Auto (dual set point) mode.

===

html P~ &% |[ _iMTsuBIsHI air Conitione ‘ ‘ {1} 5g ko3
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File Edit View Favori

Functions 2

Set Temperature Range Limit Night Mode Schedule System-changeover
M Set Temperature Range Limit Set temperature range
Group No. and + + + @ Comztn ““””SV\
group name \ Group Name Cooling Mode Heating Mode Auto Mode Batch Ope rations
- Eou-no)B - ©o|B - ofbew e I Click to make settings for all
2 Lobbyoutr) B 26 -2 B - z2ac |[BH - ¢ Bcopy [Raste groups COHeCtively-
3 LobbyEash B 26 -2 B - 2ac|EH - oflcay IPaste
4 Lobbyenten B 26 -28c | m-2c|E - o lcay lIpaste s copy
6 Lobhyores) B 6 -2c | m-2c|EH - o lcay lpaste
he Paste
6 Mesting room A E‘ - < E[ - E‘ 19 = 23 | NCopy Paste
7 Mesting room B &= 24 - 28c | = - o= - ¢ | Pcopy Paste t
P> oreiresh Save Seflings @ — Sav i
Refresh > <—— — Save Settings

Click to import the settings Click to save the changes
rom AE-200/AE-50Ew-50. | I el | 1.

(1) Scroll up or down to display the group whose settings are
to be made. To make settings for all groups at once, click

et Tempers I
Group Name : Lobby (South)

Cooling Mode Heating Mode ALto Mode
[Batch Operations]. B2 - A EA - Eac (=4 - Hac
Then, click the [Set temperature range] area to display — —

the setting screen.
Set the temperature ranges for cooling, heating, and auto
modes.

Click [OK] to return to the previous screen.
Note: When the temperature unit is Fahrenheit, temperatures
are displayed in 2°F increments.
Note: The temperature range for Dry mode will be the same as
the one for cooling mode.

(2) To copy the settings of a group to the settings for other groups, click [Copy] in the row of the group whose
settings are to be copied, then click [Paste] in the row of the group to which the copied settings are to be
pasted. The rectangular icons next to the selected buttons will appear in yellow-green.

(3) Click [Save Settings] to save the settings.
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7-3-2. Night Mode (quiet operation) Schedule
Outdoor units can be operated in a quiet mode for the specified time period. Use the Night mode when low-noise
operation of the outdoor unit is preferable during the night.
Click [Functions 2] in the menu bar, and then click [Night Mode Schedule] to access the Night Mode Schedule
settings screen.
Note: Make the Night Mode Schedule settings only when all the units are in normal operation. When connection error occurs with
the indoor or the outdoor units, the target outdoor units may not be displayed properly.

Note: The degree of noise reduction depends on the outdoor unit model.
Note: The Night Mode Schedule settings may not be accessible if logged in as a building manager.

(E=8 BB -

| ¢ |6 ETErTE— £~ 0 x| _wmsumst arcondtone. x| | 0o

Functions 2

et Temperature Range Limit Night Mode System-changeover

M Night Mode Schedule

Start Time ’/ End Time
e — PP
Target Outdoor Units \

Target Outdoor Units
S

Night Mode:  The naise Ievel is reduced by controlling the maximurn
fan frequency to be lawer under the fallowing candition
Conling mode: armbientterp. (THE) < 30°C (87°F)
Heating mode: ambient temp. (THE) » 3°C (37°F)

®Refresh Save Settings @
I — N
e e e e S B s O A0 s v Click to save the ChangeS

Click to import the settings R0~
from AE-200/AE-50/EW-50. made.

(1) Inthe [Start Time] and [End Time] sections, specify the start and end times for the Night mode.
Note: When the start time and the end time is the same, the units will operate in the Night mode at all times.
Note: The time period over the next day (such as 22: 00 - 6: 00) can be set.

(2) In the [Target Outdoor Units] section, select the M-NET addresses of the target outdoor units.

(3) Click [Save Settings] to save the settings.
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7-3-3. System-changeover
The System-changeover function switches the operation modes of the indoor units connected to the same outdoor
unit between cooling and heating based on the room temperature and the set temperature. Click [Functions 2] in the
menu bar, and then click [System-changeover] to access the System-changeover settings screen.
The System-changeover function is available only on the Y series of outdoor units, whose operation modes do not
include the Auto mode. Use this function to operate the air conditioning units in the heating mode in the morning
and in the cooling mode in the afternoon. The operation mode of all indoor units will automatically be switched,
eliminating the need to switch the operation mode manually from the remote controllers.

Note: Because the operation mode is selected based on the demands of the representative group or of the majority of the groups,
not all areas may be air conditioned to the optimum temperature.

Note: The System-changeover settings may not be accessible if logged in as a building manager.

Note: If the outdoor unit is an R2 series, whose operation modes include the Auto mode, use the Auto mode instead of the System-
changeover function to switch the operation mode automatically.

=leEd

A k3
R o

Q\ )| bttp://192.168.11 irit/en/admiistrator i

File Edit View Favorites Tools Help

£ - & x| | MTsuBIsHI Air Conditione.. ‘ ‘

Functions 2

Night Mode Schedule Svystem-changeover

Set Temperature Range Limit

M System-changeover

™

Address

3
/

Systern-changeover: AE-SDA switches the mode to caoling o heating for all the aroups that are connected to an outdoor ‘

Change Mode Representative Group

Groups  Lobby(West) /

Grouph _Meeting room A
Group?  Meeting room B

Target outdoor unit —
The M-NET address of the
outdoor unit appears.

Groups

The names of the groups
that are connected to the
outdoor unit appear.
When the [Representative
Group] mode is selected,
select the representative
group from among these
groups.

N

Mone
NAveraging

Group

Change Mode

INene
Averagin
Representative Group Groupl _ Entrance

Group2  Lobby(South

unit by monitoring each aroup to compare the inlst tsmperature with the set tsmperature

®Refresh Save Settings @

Refresh —
Click to import the settings

ﬁ

Hq100% -

— Save Settings
Click to save the changes

from AE-200/AE-50/EW-50.

made.

(1) Select the Change Mode [None], [Averaging], or [Representative Group], referring to the table below.
If [Representative Group] is selected, also select a representative group from among the groups on the
right.
Table: Change Mode
Change Mode Content
None System-changeover function will not be used.
The operation mode (cooling or heating) will be determined and switched every 15
Averagin minutes based on the demands of the majority of all groups connected to the outdoor
ging unit, taking into consideration the capacity of each indoor unit and the temperature
differences between the set temperatures and room temperatures.
The operation mode (cooling or heating) will be switched based on the temperature
Representative Group difference between the set temperature and the room temperature of the
representative group.
(2) Click [Save Settings] to save the settings.
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The action of the system-changeover function varies with the availability of dual set point function.
1. Groups that do not support dual set point function

Mode change (heating -> cooling)

1.5 degC (3F)

Set temp.
24 degC (75F)

Cooling operation

Heating operation 1.5 degC (3F)

Mode change (cooling -> heating)

<) (uummd> (um=)

Summer Winter Summer

2. Groups that support dual set point function

Mode change (heating -> cooling)

Cooling set temp. Cooling operation /\ I1 .5 degC (3F)
24 degC (75F) vAvAvAvAvA \
Thermo OFF Thermo OFF

Heating set temp.
20 degC (68F) AAALAALN

VVVV
\/Heating operation 11 .5 degC (3F)

Mode change (cooling -> heating)

A— > )

Summer Winter Summer

Note: Set the cooling set temperature and heating set temperature so that the heating set temperature is not higher than the
cooling set temperature.

Note: On the units that support the dual set point function, when the difference between the cooling set temperature and the
heating set temperature is great, the operation mode may not be switched instantly. For this reason, it is recommended to
set the same temperature for both the cooling and the heating set temperatures where possible.
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7-4. Functions 3

7-4-1. External Temperature Interlock
Based on the temperature difference between the set temperature and the outdoor temperature, the set temperature
can be adjusted automatically. Making this control setting on the air conditioning unit at an entrance of a building
prevents extreme temperature change from distressing our bodies and sending us into shock. Click [Functions 3] in
the menu bar, and then click [External Temperature Interlock] to access the External Temperature Interlock settings

screen.

Note:
Note:

Note:

Note:

Note:

External Temperature Interlock is available only for air conditioning unit groups.

Either an Al controller (PAC-YG63MCA) or AHC, and an outdoor temperature sensor are required to measure the outdoor
temperature.

When connecting one or more AE-50/EW-50 controllers, connect an Al controller (PAC-YG63MCA) and outdoor temperature
sensor on each AE-50/EW-50.

The External Temperature Interlock settings between the units connected to the AE-200, AE-50, and EW-50, as well as
between the units connected to different AE-50/EW-50 controllers, cannot be made.

The External Temperature Interlock settings may not be accessible if logged in as a building manager.

=la s
| % T

rator. html

(< 8

£+ & % || _1MsusIsHI Air Conditione... ‘

|‘4hnp 192.168.1.

Temperature Sensor—\
Select a temperature sensor

to measure the outdoor

temperature with.

File

Edit  Miew

External Temperature Interlock

.\

External Temperature Sensor

Address49-1 Qutdoor Temperature

Caontrol Object Group

Group Name

Group No. and
group name

Refresh —
Click to import the settings

from AE-200/AE-50/EW-50.

Functions 3

Interloc

Night Setback Confrol

M External Temperature Interlock

MITSUBISHI
ELECTRIC

AHC Port Name Setfings

Set Temperature Variation

o

Set Temperature YVariation Range

-
1 Entrance

+2°

I

£3%

=
&
=
&
s

]
s}
|o

Ixac ‘

2 Lobbytsout)

i,

£2°C I#3c

=
&
=
&
s
s}

E

3 LobbyiEast)

£2°C [l#3c

=
5
=
&
i
s}

k

4 Lohby(Center)

£2°C [Il#3c

5 Lobbytwest)

B[22

IS

+3°C [4°C

@Refresh

Loading is completed.

Save Setings @

H100% -

Range

Select a maximum
temperature value to be
added to or subtracted from
the set temperature.

— Save Settings
Click to save the changes

made.

(1)

In the [Temperature Sensor] section, select a temperature sensor to measure the outdoor temperature with.

In the pulldown menu, the name of the temperature sensor that is connected to the Al controller or the AHC

will appear.

Note: Connect the temperature sensor to either the Analog Input 1 or Analog Input 2 port on the AHC.

()

added to or subtracted from the set temperature.
For example, when [£4°C] (£8°F) is selected and the set temperature for the Cool or the Dry mode is set to
24°C (75°F), the set temperature will be adjusted to a maximum of 28°C (83°F) based on the temperature
difference between the set temperature and the outdoor temperature. When [+2°C] (+4°F) is selected, the

In the [Set Temperature Variation Range] section, select a maximum temperature value for each group to be

@)

WT07627X03

set temperature will be adjusted to maximum of 26°C (79°F).
Note: When the unit of temperature is Fahrenheit, the selected temperature value may not be added to the set temperature
accurately because 2°C is used for the calculation first, and then the temperature in Celsius is converted into the

temperature in Fahrenheit.

Click [Save Settings] to save the settings.
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When the External Temperature Interlock function is active, the set temperature will be adjusted as shown
below.

H “Cool” and “Dry” modes

36 ~| Outdoor temperature i
% N/\
34
3 / \
) 32 / Set temperature after being adjusted
< / when [Set Temperature Variation
g 31 / Range] is set to [+4°C] (+8°F)
£ % / A\
S % / L\
sn /T 1\
26
—
e | D\
24
23 !_S'et temperature |:
Time
Outdoor temperature conditions Set temperature after being adjusted

Outdoor temperature =
Set temperature + 1.5°C (3°F)

Outdoor temperature =
Set temperature + 4.5°C (9°F)

Outdoor temperature =
Set temperature + 6.5°C (12°F)

Outdoor temperature =
Set temperature + 7.5°C (14°F)

Set temperature + 1°C (2°F)

Set temperature + 2°C (4°F)

Set temperature + 3°C (6°F)

Set temperature + 4°C (8°F)

M “Heat” mode
Set temperature

19 N
18 — L l /
17 N\ L I/
16 N\ L I/

O 15 \ | /

Rl \ 7 /

2 13 | | Set temperature after being adjusted /

g 12 | | when [Set Temperature Variation /

g— 11 | | Range] is set to [+4°C] (+8°F) /

@ 10 \ /
9 \ A
8 \ /A
7 \L /| Outdoor temperature
5 N |

Time
Outdoor temperature conditions Set temperature after being adjusted

Outdoor temperature <
Set temperature - 4.0°C (8°F)

Outdoor temperature <
Set temperature - 6.0°C (11°F)

Outdoor temperature <
Set temperature - 8.0°C (15°F)

Outdoor temperature <
Set temperature - 10.0°C (18°F)

Set temperature - 1°C (2°F)

Set temperature - 2°C (4°F)

Set temperature - 3°C (6°F)

Set temperature - 4°C (8°F)
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7-4-2. Night Setback Control
The Night Setback Control function (hereafter abbreviated as Setback Control) prevents indoor condensation by
performing heating operation automatically when the room temperature goes outside of the specific range during
the night. Click [Functions 3] in the menu bar, and then click [Night Setback Control] to access the Night Setback
Control settings screen.
Heating operation starts when a given group is stopped and the room temperature drops below the specified
minimum temperature.

Note: The Setback Control function also prevents excessive temperature rise by performing cooling operation automatically when
the room temperature goes outside of the specific range. Cooling operation starts when a given group is stopped and the
room temperature rises above the specified maximum temperature.

Note: If the room temperature is measured by the return air temperature sensor on the air conditioning unit, the measured value
may not be an accurate representation of the temperature in the room, especially when the air conditioning unit is stopped
and the room air is stagnant. When this is the case, use an external temperature sensor (PAC-SE40TSA) or remote

controller sensor to measure the room temperature.
Note: The Night Setback Control may not be accessible if logged in as a building manager.

o =3 e o<
a‘ )| _nitpyas2ases it orhtml £ - & X|[_immsusisH air Condtone... x| (o) 2 e

File Edit View Fa

Functions 3

External Temperature Interlock Night Setback Conrol Interlock control AHC Port Name Settings
M Nigh k | .
ight Sethask €antee Setback Control Period
Setback Control Usability —a Setback Control Period /
we  [TH Y — FA
Do not use
Cortrol Object Group Temperature range
Gro“p No_ and groUp N Group Name, Minimum Temp  Maximum Temp
name 1 Entrance Eﬁc - ﬂ“c Copy  fPaste M Copy
Nz
2 Lobby(Soutn) Eﬁ“@ - ﬁ“c @w’ Paste
-
3 | Lobby(East) F4c - gl Cony Paate\ [ Paste
4 Lobby(Center) Ei,‘“c - ilhc Copy Paste
5 Lobby(west) Eﬂr - gr copy  NPaste N
@Refresh Save Seftinas @
Rt — 57 Seligs
Click to import the settings saon - Click to save the changes
from AE-200/AE-50/EW-50. made.

(1) Select [Use] and set the time period in which Setback Control is performed.
Note: When [00: 00 - 00: 00] is selected, Setback Control is active for 24 hours.

(2) Inthe [Temperature range] section, set the maximum and minimum temperatures for each group.
For example, if [Setback Control Period] is set to [01:00 - 05:00] and [Temperature range] is set to
[12°C - --°C] ([53°F - --°F]), heating operation starts automatically when the room temperature drops below
the set temperature 12°C (53°F) between 1:00 and 5:00. When the Setback Control ends at 5:00, the set
temperature returns to the original setting, and the operation stops.
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Note: The air conditioning units in the heating operation will stop and the set temperature will return to the original setting
when the Setback Control period is over or the room temperature rises to the minimum temperature plus 3°C (6°F).
Likewise, the air conditioning units in the cooling operation will stop and the set temperature will return to the original
setting when the Setback Control period is over or the room temperature drops to the maximum temperature minus

3°C (6°F).
Setback
operation
Room temp. Setback il
21°C(69°F) =K =~ ==~ ~ | operation -==|7/-"-"~-"—-=---
starts.

Min. temp.
12°CB3°F) =~ T~~~ ~—~ ubeininininininis

Heat ON Heat OFF Heat ON Heat OFF
21°C (69°F) 12°C (53°F) 21°C (69°F)
-
¢ >

Setback Control period

When the temperature drops below the minimum temperature (heating operation)

Setback
operation
Max. temp. B
28°C(83°F) ==~ ————=-— 11/z S it

Setback

Room temp. operation
24°C (75°F) N o/ AF"— — — = — ~ starts. R
Cool ON Cool OFF Cool ON Cool OFF
24°C (75°F) 28°C (83°F) 24°C (75°F)
>
- >

Setback Control period

When the temperature rises above the maximum temperature (cooling operation)

(3) To copy the settings of a group to the settings for other groups, click [Copy] in the row of the group whose
settings are to be copied, then click [Paste] in the row of the group to which the copied settings are to be
pasted. The rectangular icons next to the selected buttons will appear in yellow-green.

(4) Click [Save Settings] to save the settings.
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7-4-3. AHC Port Name Settings
On the AHC Port Name Settings screen, enter the names of the input and output ports of the Advanced HVAC
CONTROLLER (AHC).
The names that are entered on this screen will appear on the AHC List screen.
Click [Functions 3] in the menu bar, and then click [AHC Port Name Settings] to access the AHC Port Name Settings

screen.
Note: The AHC port name settings may not be accessible if logged in as a building manager.

Important: The AHC port name settings must be made after all units have been started up.
The settings that have been saved while one or more units are starting up may be lost.

@w )| _ http://192.168.1.1/init/en/edministrtor tml £+ ¢ X _imrisusisH air Condiione.. % ||

File Edit View Favorites Tools Help

— Extended Input
(1-4)

H AHC Port Name Settings

— Output Port Name
) Input Narne Output Narme é
Unit address erter Errar ot [eeter 12t -

N 003 et 7 — Digital Output
(1-9)

DO4 [oehunidifier

oos[
Dos [

ooz [

)— Extended Output

DOB: (1_4)
=
Digital Input £on
N (1-?5) an: — Analog Output
Sy N (1-2)
it a0z
Input Port Name ot EN 1 \ : — Ana|°g |nput
®zehiesn Saue Sutings @ (1-8)
L T e
Click to import the settings Q0% - Click to save the changes
from AE-200/AE-50/EW-50. made.

(1) Inthe [Input Port Name] field, enter the input port name in 20 characters or less.
Note: Digital Input (DI) 1-15, Extended Input (El) 1-4, and Analog Input (Al) 1-8 will appear regardless of whether the
ports are used or not.
Note: The following characters cannot be used in the [Input Port Name] field: <, >, +, &, “, or

(2) In the [Output Port Name] field, enter the output port name in 20 characters or less.
Note: Digital Output (DO) 1-9, Extended Output (EO) 1—4, and Analog Output (AO) 1-2 will appear regardless of whether
the ports are used or not.
Note: The following characters cannot be used in the [Output Port Name] field: <, >, +, &, “, or

(3) Click [Save Settings] to save the settings.
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7-5. Ventilation Settings

7-5-1. Night purge
During summer, the Night purge function draws cooler outside air into the room to suppress temperature rises at
night. This energy conservation reduces the load when air conditioning starts the next morning.
Click [Ventilation Settings] in the menu bar, and then click [Night purge Setting] to access the Night purge settings
screen.
All LOSSNAY unit groups that support the Night purge function from AE-200 will appear.
Note: During the Night purge operation, LOSSNAY units operate in the Bypass mode.
Note: Night purge setting cannot be made from AE-200 for the LOSSNAY units that are connected to the AE-50/EW-50 in
communication error.
Note: Some models of LOSSNAY units do not support the Night purge function from AE-200. (As of March 2015, only LGH-RVX-E
models support the function.)
For more details about the Night purge function, refer to the Installation Manual, Instruction Book, or technical documents
that are provided with the LOSSNAY unit .

o Setting contents

Night purge setting
[Available]/[Not Available]

I Night purge Setting

M Night purge Setting - Batch Operations
@ stch Operations Click to operate the units in
Group No. and group —; G Avalable Nt Avfale Setings all groups at once

name Corance Sun Mon Tue Wed Thu Fri Sat 0100 — 0600
30 Mot Available 17 50 ey

Lovty Sun Won Tus Vied Tha Fi Sat 0109 — 0600
Mokl g ——

Jesingroom Sun Won Tus Vied Tha Fi Sat 0109 — 0600
e o

Meating room B Sun Mon Tue Wed Thu Fri Sat  01:00 — 0600
Mokl g ——

®Refresh Save Settings @
/ g Save Settings
Refresh

Click to save the changes
made.

(1) Click the “Setting contents” section in the row of the group whose settings are to be made. A settings screen

will appear.
Note: To make settings for all groups at once, click [Batch Operations].

2] Setting
Night purge setting Group Name : All Groups
[Available]/[Not \ Mt purce Seting T P Days of the week
Available] Havailable  [NatAvallable gsun  QOMen QUTue [wed QBThu [Fri  [Sat
St rt T' Start Time End Time
a ime | . s gy . < i
A — Eamae End Time
OT threshold RoomTemp dif Init fan spd
Outdoor temperature oc ™ Ec™ - =
2 .
threshold = = // = Initial fan speed
Cancel / _IOK

/

Temperature
difference between
room temperature and
outdoor temperature

(2) In the Night purge setting section, select [Available] to enable the Night purge settings.
(3) Select one or more days on which the Night purge control is executed at the selected start time.
(4) Set the times at which the Night purge control starts and ends.

(5) Set the outdoor temperature threshold value as a condition for activating the Night purge operation.
* The settable temperature is between 15°C and 30°C.
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(6)

(7)
(8)
©)

Set the temperature difference as a condition for activating the Night purge operation.
* The settable temperature is between 0°C and 7°C.

Set the fan speed to be set when the Night purge operation activates.
Click [OK] to go back to the previous screen.

After the settings are completed, click [Save Settings] to send the settings to the AE-200/AE-50/EW-50.

Starting condition
Condition #1: LOSSNAY units stop at 20:00.
Condition #2: Between the start time 1:00 and the end time 6:00
Condition #3: LOSSNAY units detected the outdoor temperature threshold 17°C or higher in the past 24 hours.
Condition #4: The current room temperature is higher than 22°C. (The temperature 22°C cannot be set from
AE-200/AE-50/EW-50.)
Condition #5: The temperature difference between room temperature and outdoor temperature is greater than
the temperature difference 5°C.
* LOSSNAY units start the Night purge operation at 3:00 when the temperature difference between room
temperature and outdoor temperature exceeds 5°C.
» The Night purge operation is not activated at 1:00 or 2:00 because the temperature difference between room
temperature and outdoor temperature is less than 5°C.

s 12:00 16:00 20:00 1:00 3:00 6:00
i Condition #4 Condition #5
/Y\ Room temp.: 25°C Temp. difference: 6°C
7 E i S 3
T ¢ ! Condition #3 : ~ \5\
emperature o~] | Maximumoutdoor | TS A oy i
i temperature: 29°C \

: . : 100 |i[ 200
= Qutdoor temp. i i i Temp. i Temp. ;
— = Room temp. 17°ClH4—————————— —————————— —_—————— difference: |+-{ difference: | ————— +—
[17°C ; ; : rc__|i| _ «c ;
Night purge
LOSSNAY ON OFF operation OFF

WT07627X03

180




7-6. User Settings

On the User Settings screen, the user names and passwords of maintenance users and building managers can be
changed, and the available functions for building managers can be limited.

For example, you can allow building managers to change the group name settings when the tenant is changed, or

disallow them to change the basic system settings such as unit settings or network settings.

Also, maintenance users can use this screen to change the user name and password of building managers in case
that they are forgotten.

Click [User Settings] in the menu bar to access the User Settings screen.

=l o =g

)| _Ihttpi//192.168.11 /int/en/edministrator htmi P - & % || _imrsusisH air Conditione.. ‘ ‘ ok £

(¢

View Favorites Tools Help

User Settings

M User Settings
Maintenance user name Sl o rorwamenance usae
and paSSWOI'd > b User Name initial New Password  [£rxx
User name and password Retype Passworarn
@ For Building Manager
can be changed. » UserName pduinistrator | newpasswora  [errer
/ Retype PassworsFF Available functions
g - - Select the available functions
Initial Settings o
Building manager’s userJ IDate and Time | for building managers.
name and password fasic Systern
IGroups (NGroup Name [Group Structure )
User name and password Interlocked LOSSMAY
can be Changed_ IBlocks (liBlock Name [lBlock Structure )
Functions 1
E-tail 1
®Refresh Save Settings @
Refresh — S = — Save Settings
Click to import the settings T awe - | Click to save the changes
from AE-200/AE-50/EW-50. made.

(1) To change the maintenance user name or password, type new information in the [User Name], [New

Password], and [Retype Password] fields.
Note: If the user logs in as a building manager, the maintenance user name and the password will not be displayed, and
cannot be changed.
Note: User name must contain only alphanumeric characters.
Note: The user name and password are case-sensitive.
Note: The user name must be in 20 characters or less, and the password in 3 to 10 characters.

(2) To change the building manager’s user name or password, type new information in the [User Name], [New
Password], and [Retype Password] fields.
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(3) Click the functions to be made available for building managers. The rectangular icons next to the selected
functions will appear in yellow-green.
Click again to deselect. The rectangular icons next to the deselected functions will appear in gray.
For more information on each function, refer to the table below.

Note: If the user logs in as a building manager, the currently available functions can be checked, but cannot be changed.
Note: The settings on this screen will not be reflected to the functions on the AE-200/AE-50’s LCD.

(4)

WT07627X03

Initial Settings
lpate and Time
Basic System
lGroups (lGroup Name
Interincked LOSSNAY
UBlocks (MBlock Name
Functions 1
E-Mail
lPeak cut ([ System settings
IMeasurement

Group Structure )

Block Structure )

lcentrel Details )

NEnergy Management Settings
Functions 2

lISet Temperature Range Limit

liNight Mode Schedule

lsystem-changeover
Functions 3

lExternal Temperature Interlock

INight Setback Gontrol

linterlock contrel

JAHC Port Name Settings
Ventilation Settings

liNight purge Setting

Table: Available Function List

Function Content
Date and Time Refer to section 7-1-1 for details.
Basic System 1 Refer to section 7-1-2 for details.
Group Name . )
o ) Groups Refer to section 7-1-3 for details.
Initial Settings Group Structure
Interlocked LOSSNAY *1 Refer to section 7-1-4 for details.
Block Name ) )
Blocks Refer to section 7-1-5 for details.
Block Structure *1
E-Mail "1 Refer to section 7-2-1 for details.
System Settings . )
) Peak Cut - Refer to section 7-2-2 for details.
Functions 1 Control Details
Measurement Refer to section 7-2-3 for details.
Energy Management Settings Refer to section 7-2-4 for details.
Set Temperature Range Limit Refer to section 7-3-1 for details.
Functions 2 Night Mode Schedule Refer to section 7-3-2 for details.
System-changeover Refer to section 7-3-3 for details.
External Temperature Interlock Refer to section 7-4-1 for details.
Functions 3 Night Setback Control Refer to section 7-4-2 for details.
AHC Port Name Settings Refer to section 7-4-3 for details.
Ventilation . . . .
Settings Night purge Setting Refer to section 7-5-1 for details.

*1 At factory shipment, these settings by the building managers are prohibited.

Click [Save Settings] to save the settings.
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8. Maintenance

This section explains backup and reading of settings data.

There are two ways to backup the settings data — from the AE-200’s LCD to a USB memory device, and from
AE-200/AE-50/EW-50 Web Browser for Initial Settings.

8-1. Settings Data Backup from the AE-200’s LCD

Backup the settings data from the AE-200’s LCD to a USB memory device.

Backup of settings for the AE-200 and for the expansion controller is possible.

Note: Test the USB memory device several times before use and verify that the device functions properly. Reading data from or
writing data to a USB memory device that has not been confirmed to work may cause unexpected problems. (If the data
cannot be output to the USB memory device after a writing error occurs and the device is replaced, reboot the AE-200/AE-50
(turn off the power and restart). Do not use the USB memory device that has experienced writing error once.)

8-1-1. Backing up settings data

The settings data can be exported to a USB memory as a backup.

Touch [Maintenance] in the menu bar, and then touch [Backup].
Note: IP address settings will not be backed up. Make sure to write them down.

 Settinas

Backup Energy data outm

Setting data for main unit and air conditioners

All settings

All settings

Copy to USB Memory

Copy to USB Memory
Touch to back up the
settings data.

Important

e The USB memory device may not be recognized if you insert and remove it within a short time. If this happens, reset the
AE-200/AE-50.
e The AE-50/EW-50 data can be output from the AE-200.

(1) Remove the controller cover, and insert a USB memory device to the USB port.
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(2) Touch [All settings], then touch [Copy to USB Memory].
The settings data file will be created in the root folder of the USB memory.

M File output destination, folder name, and file name

[Root folder of the USB memory]\[Serial No.]\"SettingData”\"AE” "1
*1 “AE1,” “AE2,” “AE3,” or “AE4” when one or more AE-50/EW-50 controllers are connected

<Example>

Root folder of the USB memory

12345-123 (AE-200 serial No.)

l—SettingData

AE — AE-200 settings file
——AE1 — AE-50_1 settings file
——AE2 — AE-50_2 settings file
——AE3 — AE-50_3 settings file
——AE4 — AE-50_4 settings file
Note: It will take a few minutes to create the settings data.
Note: Do not remove the USB memory device while the data is being output.
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8-1-2. Importing settings data
The exported data can be imported back to the AE-200/AE-50/EW-50 to restore the previous settings after the
controller replacement.
Touch [Maintenance] in the menu bar, and then touch [Import].

, 2 - Mainte-
‘ ! Settings A nance

Backup Import Energy data nutm

Setting data for main unit and air conditioners

All settings

All settings

Read from USB Memory

Read from USB Memory
Touch to import the settings
data.

Important

e The USB memory device may not be recognized if you insert and remove it within a short time. If this happens, reset the
AE-200/AE-50/EW-50.

(1) Have the settings data to be imported ready in the root folder of the USB memory as shown below.

B File location, folder name, and file name

[Root folder of the USB memory]\“SetupData”_[IP address|\“AE” *1
*1 “AE1,” “AE2,” “AE3,” or “AE4” when one or more AE-50/EW-50 controllers are connected

<Example (When AE-200 LAN1 IP address is [192.168.1.1]>

Root folder of the USB memory
SetupData_192_168_1_1 "2
AE — AE-200 settings file
——AE1 — AE-50_1 settings file
——AE2 — AE-50_2 settings file
——AE3 — AE-50_3 settings file
—— AE4 — AE-50_4 settings file
*2 The folder name will not be [SetupData_192_168_001_001].
Note: Only the data that have been backed up from the AE-200 can be imported to the AE-200. The data that have been
backed up from the AE-50 must be imported to the AE-50.
Note: Do not change the file name from that of when backup was performed. If the folder name or file name is different from
the given name, no data can be read.

(2) Remove the controller cover, and insert a USB memory device to the USB port.

(3) Touch [All settings], then touch [Read from USB Memory].
Note: It will take a few minutes to import the settings data.
Note: Do not remove the USB memory device while the data is being imported.
Note: If the data is not read, check the folder name and the file name.
Note: If the data is not read, check if the USB memory device is inserted correctly.
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8-2. Settings Data Backup from the Web Browser for Initial Settings
Backup settings data from the AE-200/AE-50/EW-50 Web Browser for Initial Settings to a hard disk or to a USB
memory device.
If there are multiple AE-200/AE-50/EW-50, then it is necessary to back up these individually.

Click [Utility] in the menu bar, and then click [Back up/import settings data] to access the Back up/import settings
data screen.
Note: Back up/import settings data function is accessible only if logged in as a maintenance user.

6\ )| _Inttp://192.168.1.1/init/en/administratorhtmi £ - & X || _ MTsuBIsH air Condtione. ‘ ‘ X
File Edit View Favori s Help

utility

Back up/import seftings data

M Back up/import settings data

L Back up settings data
Back up settings data Click to back up the

= AE-200/AE-50/EW-50
settings data.

Back up settings data

Tmport settings data — Browse...
Data import souee: Click to browse for a file
= that contains the data to be
Data import source —J s ] imported.

The path to the file to be
imported will appear.

— Import settings data
Click to import the file
)] specified in the ‘Data
import source” field to the
AE-200/AE-50/EW-50.

8-2-1. Backing up settings data

(1) To back up the data, click [Back up settings data]. The settings data will be created and the Window’s
standard file download dialog will appear.

Note: It will take a few minutes to create the settings data.
Note: The name of the settings data will be “SettingData.dat”.

- 6 X]|_svsvmsa e conione nxE [ ¢ |6 ST £+ 6 X[ ivarsvsa e condions.

utility utility

Settings data have been created.

Downloading data.

Creating settings data. (=)
Please wait

Hi00% - ®100%
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8-2-2. Importing settings data

(1) Click the [Browse...] button to launch the explorer and browse for a file that contains the data to be imported.
Select the desired file, and click [Open]. The path to the file to be imported on an external storage media will
appear in the [Data import source] field.

(2) Click [Import settings data] to import the data from the external storage media to the AE-200/AE-50/EW-50.
Note: It will take a few minutes to import the settings data.

=

£~ & X[ _iMmsuBisH i Conditione.

It/ 1521681 it

Fie Edt View Favortes Took

utility

Please wait.

Please wait.
The settings data is being sent

The settings data is being updated

A100% -

0%~

(8) When the settings data has been successfully imported, the AE-200/AE-50/EW-50 will restart.

py =

utility

The settings data have been successfully updated. The computer will restart.

Please try accessing later.

(4) Go back to the login screen and login again.
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9. Troubleshooting

See the table below and troubleshoot accordingly.

No.

Problem

Possible cause

Solution

(1)

()

®)

(4)

Errors are displayed
on the [Malfunction]
screen under the
[Status List] menu
on the AE-200’s
LCD.

Or,

Error log is
displayed on the
[Unit Error] screen
under the [Log]
menu on the
AE-200’s LCD.

“Version combination error
(0092)”

The versions of the
AE-200/AE-50/EW-50 do
not match.

* Check the versions of the AE-200
and AE-50/EW-50.

Refer to the Instruction Book
(Apportioned Electricity Billing
Function) for details.

“Warning - possibility of
damaged metering device
(0095)”

The measurement value
of the metering device
(which should count up the
operation amount of air-
conditioning units) does
not count up for3to 7
days.

* Whether to warn (3 to 7 days
before the warning is issued)
or not to warn can be set.
When “Not warn” is set,
errors cannot be detected.

 Check if the measurement value
is properly counted up on the
[Measurement] screen under the
[Monitor/Operation] menu.

When an electricity meter with
large pulse value is used, the error
message may appear even if the
wiring connection is correct.

» Check for proper connection
between the electricity meter
and the PI controller (when a Pl
controller is used).

» Check for proper connection
between the electricity meter
and the built-in Pulse Input (PI)
on the AE-50/EW-50 (when a
built-in Pulse Input (PI) on the
AE-50/EW-50 is used).

» Check if no communication error
between the PI controller and the
AE-50/EW-50 is occurring.

“Communication error - No
response error (6920)”

The communication
between AE-200 and
AE-50/EW-50 is not
properly established.

» Check if the destination IP address
is properly entered.

» Check for proper connection
between the AE-200 and
AE-50/EW-50.

“System abnormality -
Attribute setting error
(71086)”

1) In the group of units
such as PI controllers,
chiller units, or HWHP
(QAHV) units, an
address with attribute
for different type of units
(such as air conditioning
units) exists.

2) The address of the
unit to be interlocked
set in the [Interlocked
LOSSNAY] screen is not
an address of LOSSNAY
unit.

3) The attribute setting (IC/
FU) for OA processing
unit is not correct.

Cause 1)

Configure the groups so that all
addresses in each group have
the same attribute (such as PI
controllers, chiller units, or HWHP
(QAHV) units).

Cause 2)

Correct or delete the address of
the unit to be interlocked set in the
[Interlocked LOSSNAY] screen.

Cause 3)

Switch the attribute using a
dipswitch. Refer to the installation
manual of the OA processing unit
for details.
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No. Problem Possible cause Solution
Errors are displayed | “System abnormality - 1) The group setting Cause 1)
on the [Malfunction] | Connection setting error contents set on the Check the addresses in the group
screen under the (7109)” AE-200 do not match settings and the unit configuration
[Status List] menu with the chiller unit for chiller units. If they do not match,
on the AE-200’s configuration and the reconfigure them.
(5) LCD. setting contents. . Cause 2)
2) The HW Supply setting | check the addresses in the HW
Or, contents set on the Supply settings and the unit
, AE-200 do not match = configuration for HWHP (QAHV)
Error log is with the HWHP (QAHV) | hits™if they do not match,
dlsplayed on the unit coqflguratlon and reconfigure the address settings.
[Unit Error] screen the setting contents.
under the [Log] “System abnormality - 1) The digital setting on Cause 1)
(6) menu on the Different unit model error the HWHP (QAHV) unit | Set the digital setting item code
AE-200's LCD. (7130)" is wrong. “107” on the circuit board on the
HWHP (QAHV) unit to “2”.
Errors are displayed | “Communication error - No | 1) The communication = Check for proper connection
on the [Malfunction] | response error (6920)” between AE-50 and between the AE-200 and AE-50.
screen under the AE-200 is not properly » Make the AE-50/EW-50
[Status List] menu established. communication error detection
on the AE-50’s 2) An error for the settings on the [Network] screen
LCD. communication with under the [Initial Settings] menu.
the AE-200 that was Refer to section 5-1-5 “Network” [5]
connected in the past is “Communication error detection”
(7) being detected. for details.
3) The IP address of
the AE-200 has been
changed.
4) The AE-50/EW-50
that experienced 2)
or 3) above has been
updated to Ver. 7.3 or
later.
A message is Message: Settings were transmitted | Settings for functions added in new
displayed when “The versions of one or from a new Initial version have not been carried out.
Initial Setting more centralized controllers | Setting Tool to an old Update the AE-200/AE-50/EW-50.
Tool settings are are old and not compatible | AE-200/AE-50/EW-50. Refer to section 3-1 “Separately
(8) | transmitted. with this tool. The settings sold parts” for compatible version
that are not supported for combination of Initial Setting Tool
these centralized controllers and AE-200/AE-50/EW-50.
will not be sent. Check the Refer to section 4-4 “Software
transmission result.” Update” for details of updates.
A message is Message: 1) The centralized Cause 1)-1
displayed when “The unit configuration controller type set on Check the “AE-200 M-NET” and
data is acquired settings for the following the system configuration | “AE-200 Apportion” settings on the
or Initial Setting centralized controller does settings screen differs [Unit Info.] screen on the LCD.
Tool settings are not match with the actual from the actual type. Cause 1)-2
() transmitted. unit configuration. 2) The configuration Change the system configuration
setting for the expansion | settings so that the settings match
controller set on the with the actual unit configuration.
system configuration Cause 2)
settings screen Make the expansion controller
differs from the actual | qoitings on the [Network] screen on
configuration. the LCD.
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No.

Problem

Possible cause

Solution

(10)

Initial settings data cannot be output from the
LCD to the USB memory device.

1) The USB memory
device is not set
correctly.

2) There is insufficient
free space on the USB
memory device.

3) The USB memory
device does not support
the AE-200/AE-50.

4) The USB memory
device was removed or
inserted too quickly.

5) The USB memory
device is write-
protected.

Check causes 1) to 3).

Cause 1)
Check that the USB memory device
is fully inserted.

Cause 2)

Check that there is sufficient free
space on the USB memory device,
and if necessary, create more free
space. (Maximum 64 MBytes)

Cause 3)

Use a USB memory device as
detailed in section 8 “Maintenance”.
After a malfunction has occurred, if
writing does not proceed normally
even after using a different USB
memory device, then restart the
AE-200/AE-50 (power OFF—ON),
then try again using a USB memory
different from that originally used.

Cause 4)
Restart the AE-200/AE-50 (power
OFF—ON).

Cause 5)

Unlock the write-protect switch on
the USB memory.

For details, refer to the USB
memory device Instruction Book.

(11)

Reading of initial settings data from the USB
memory device by using an LCD is not possible.

1) The USB memory
device is not set
correctly.

2) The USB memory
device read folder is
different.

3) A USB memory device
that supports the
AE-200/AE-50 is not
used.

Check causes 1) to 3).

Cause 1)
Check that the USB memory device
is properly inserted.

Cause 2)

Check that the folder name for the
initial settings data is correctly set
as “SetupData_][IP address]” (case-
sensitive).

For details, refer to section 8-1
“Settings Data Backup from the
AE-200’s LCD”.

Cause 3)
Refer to Cause 3) of problem (10).

(12)

Login to the initial settings screen from the LCD
was successful, but the settings button stays
pressed, and cannot be operated.

1) This is logged in as
the building manager,
so there is no right for
settings.

Cause 1)

Input the maintenance user login
name and password, and log in.

In order to log in as the building
manager and configure settings,
have the settings rights changed to
maintenance user.

(13)

When the AE-200’s Web Browser for Initial
Settings is accessed, the message “If you see
this you don’t have a Java-enabled Web browser.

Here’s a picture of what you are missing.” or “Error.

Click for details.” appears, and no login window
appears.

1) Improper temporary
files remain in the web
browser, generating an
error.

Cause 1)

Refer to section 9-1 “Notes on
connecting to Web browser” and
use the web browser.

(14)

Even though the LAN is properly connected, the
AE-200’s Web Browser for Initial Settings fails to
be logged in or the settings fail to be made.

1) The AE-200/AE-50/
EW-50 version has been
updated.

Cause 1)

Refer to section 9-1 “Notes on
connecting to Web browser” and
use the web browser.
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9-1. Notes on connecting to Web browser

Follow the instructions below to change settings if the message “If you see this you don’t have a Java-enabled
Web browser. Here’s a picture of what you are missing.” or “Error. Click for details.” appears, and no login window

appears when the AE-200’s Web page is accessed.

Note: To remedy the above-mentioned problem, go to section 9-1-1 “Clearing cache” first, and if the problem still persists, go to
section 9-1-2 “Resetting Internet Explorer”. Resetting Internet Explorer will reset Internet Explorer’s settings to their default

condition.

9-1-1. Clearing cache

[1] How to clear Java cache
(1) Click [Control Panel]>[Java].

Note: If [Category] is selected in the top right corner, next to [View by: ], change it to [Large icons] or [Small icons].

(2) Java Control Panel will open.

(3) Click [Settings...] under [Temporary Internet Files].

(4) The [Temporary Files Settings] dialog will appear. Click [Delete
Files...].

(5) The [Delete Files and Applications] dialog will appear. Make sure
that the checkboxes next to [Trace and Log Files] and [Cached
Applications and Applets] are both checked, and then click [OK].
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[£] Java Control Panel ==

General [ Update | Java | Security | Advanced

About

View version information about Java Gontrol Panel.
Metwork Settines

Hetwork ssttings ars used when making Intemet connestions . By dsfault, Java will use the
network settings in your web browser. Only advanced users should modify these settings.

Network Settines,
Temporary nternet Files

Files you uss in Java applications are stored in 5 spesial folder for quick exesution Iater. Only
advanced users should delete files or modify these settings.

Java in the browser is ensbled
See the Security tab

by

=

Temporary Files Settings

Keep temporary files on my computer
Location
Select the location where temporary files are kept
IM1215 4 AppData¥ Locallow¥Sun¥ Java¥Deploymentécache Change

Disk Space
Select the compression level for JAR files Nane -

Set the amount of disk space for storing temporary files:

0 arress| M

[ Delete Fils.. | [ Restore Defouhts |

Delete Files and Applications @I
/1 Delete the follonine files?

Cached Applications and Applets
[T hztalled Applications and Applets

[ OF ] [ Cancel




[2] How to clear Internet Explorer cache

(1) Open the Internet Explorer, click [Tools] in the menu bar, and then click [Internet options].

(2) The [Internet Options] dialog will appear.
Click [Delete...] under [Browsing history].

(3) Make sure to deselect the checkbox next to [Preserve Favorites
website data], select the checkbox next to [Temporary Internet

files], and then click [Delete].
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Internet Options =

General |security [ Privacy | Content [ Connections | Programs [ Advanced|

Home page
l/’ To create home page tabs, type each address on its own line.
thz

[ Use current ][ Use default ][ Use blank

Browsing history

Iy Delete temporary fies, history, cookies, saved passwords,
) and web form information.

[ Delete browsing history on exit

Search
p Change search defaults.

Tabs

7] Change how webpages are displayed in

] tebs.

Appearance
e e e [
ok J[ cancel ][ ooy |
Delete Browsing History @

Preserve Favorites website data

Keep cookies and temporary Internet files that enable your favorite
websites to retain preferences and display faster.

Temporary Internet files
Trrmatir e o merm e e
viewing.

Cookies

Files stored on your computer by websites to save preferences
such as login information.

History
List of websites you have visited,

[ Form data
Saved information that you have typed into forms.

[ Passwords
Saved passwords that are automatically filed in when you sign in
to a website you've previously visited.
[ nPrivate Filtering data
Saved data used by InPrivate Filtering to detect where websites may
be automatically sharing details about your visit,

About deleting browsing history




9-1-2. Resetting Internet Explorer

If the problem persists after section 9-1-1 “Clearing cache”, reset Internet Explorer settings.
Note: Resetting Internet Explorer’s settings will impact the following. Before you make any changes, write down the current

settings if necessary.
- Disable toolbars and add-ons
- Advanced options
- Default web browser settings
- Tabbed browsing settings
- Privacy settings
- Pop-up settings
- Security settings

(1) Open the Internet Explorer, click [Tools] in the menu bar, and then click [Internet options].

(2) The [Internet Options] dialog will appear. Internet Opsons
Click the [Advanced] tab, and then click [Reset...] under [Reset sepeal | seaie | Pivecy | Cotept | Comecions | Progass | Advarced
Internet Explorer settings]. Samglcass.bm

Always expand ALT text for images
[ Enable Caret Browsing for new windows and tabs |
[F] Mave system caret with focus/selection changes
[F] Reset text size to medium for new windows and tabs
Reset text size to medium while zooming™
[ Reset zoom level for new windows and tabs
[=] Browsing
Automatically recover from page layout errors with Compe
[F] Close unused folders in History and Favorites®
Disable script debugging (Internet Explorer)
Disable script debugging (Other)
[ Display a notification about every saipt errar
[¥] Enable automatic crash recovery* %
< 1 ] *
*Takes effect after you restart Internet Explorer

Restore advanced settings
Reset Internet Explorer settings
Resets Internet Explorer's settings to their default
condition.

‘You should only use this if your browser is in an unusable state.

i »

@ Some settings are managed by your system administrator.

[ ok J[ concel ][ #poy ]
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10.Advance preparation

This section explains preparations for prior to configuring initial settings.

10-1. Preparation of the PC

Prepare a PC with which to use the Initial Setting Tool and Web Browser for Initial Settings.
These preparations are not required when configuring all settings using only the LCD.

Carry out preparations using the following procedure.

J/Use Initial Setting Tool Not use Initial Setting Tool

| .NET Framework installation |

V
| Initial Setting Tool installation |

V Vv
| PC’s IP address setting |
Not use Web Browser for Use Web Browser for Initial
Initial Settings Settings
A4

| Web browser settings |

WV
| Java settings |

WV
| Login to the Web Browser for Initial Settings |

V WV
Completed |
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In order to use the Initial Setting Tool, connect to the Internet,
and install the .NET Framework.

(See section 10-1-1 “Installation procedures of .NET
Framework”.)

Install Initial Setting Tool.
(See section 10-1-2 “Installation procedures of the Initial
Setting Tool”.)

Set the IP address of the PC.
(See section 10-1-3 “Setting the PC’s IP address”.)

Configure Web browser settings to use the Web Browser for
Initial Settings.
(See section 10-1-4 “Setting the Web Browser”.)

Configure Java settings to use the Web Browser for Initial
Settings.
(See section 10-1-5 “Java settings”.)

Check that you can log into the Web Browser for Initial
Settings.

(See section 4-1 “Logging in to the Web Browser for Initial
Settings”.)



10-1-1. Installation procedures of .NET Framework

If NET Framework 4.5.2 or later is not already installed, download the .NET Framework 4.5.2 installer from the URL

shown below, and then install it.

If the .NET Framework version is earlier than the required version, the installation process of the Initial Setting Tool
will be canceled and a message will appear indicating that the installation of the .NET Framework is necessary.

URL for when the Internet is connected (Web installer) (English):
http://www.microsoft.com/en-US/download/details.aspx?id=42643

URL for when the Internet is not connected (Offline installer) (English):
http://www.microsoft.com/en-US/download/details.aspx?id=42642
* Other language can also be selected from this website.

10-1-2. Installation procedures of the Initial Setting Tool

(1) Execute the install file for the Initial Setting Tool.

* The install file name is “SetuplSToolA_V***” for AE-200A/AE-50A/EW-50A.
The install file name is “SetuplSToolE_V***” for AE-200E/AE-50E/EW-50E.
(“V***” indicates version number. “V120” indicates Ver. 1.20.)

(2) If the “Security Warning” message appears, click [Run].

(3) When the “Setup Wizard” screen appears, click [Next].

(4) The “License Agreement” screen will appear. Select [| Agree] and
click [Next].

(5) The “Select Installation Folder” screen will appear. Select the save

destination folder and click [Next].
Note: To allow all users who can login the PC to have access to the Initial
Setting Tool, check that the [Everyone] checkbox is selected and
then click [Next].
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48] AE-200 Initial Setting Tool [E=REES)
Welcome to the AE-200 Initial Setting Tool Setup [l
Wizard P=- ) )

The installer will guide you thrauah the steps requited ta install AE 200 Initial Setting Tool on your
computer.

WARNING: This computer program is protected by copyriaht la and intemational teaties.
Unavthorized dupication or cistrbution of this pragram, or anp parfion of . may resul in severe civil
o criminal penalties, and wil be prosecuted to the maxinum extent possible under the law:

Cancel <Back [Cret ]
) AE-200 Initial Setting Tool =R
License Agreement [N

Please take @ moment ta read the license agreement now. |f you aceept the tems below, elick "1
Agree'!, then "Next". Othernise dlick "Cancel”

| »

SOFTWARE USER LICENSE AGREEMENT

IThese terms and conditions stipulate the conditions of use of the
[MITSUBISHI Air Conditioning Control System - Initial Setting Tool]
(hereinafter referred to as the "Software") provided by Mitsubishi
Electric Corporation (hereinafter referred to as the "Company”) for the _

*) | Do Not Agree. @ | Agree

Cacel | [ cBak | [ Ne> ]

18 AE-200 Initial Setting Tool

Select Installation Folder [N

The installer vl install AE-200 Iilial Setting Tool to the following folder.

Ta installin this folder. clisk “Newt”. To install to 3 different folder, enter it below or click ‘Browse”

Folder

C¥Program Files¥MITSUBISHI ELEGTRIC CORPORATIONEAE-! Browse.

Install AE-200 Initis| Settine Toal for yourse . or for anyone wha uses: this computer

© Evenyone

© Just me

Cacel | [ cBack | [ WNew>
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(6) When the “Confirm Installation” screen appears, click [Next]

(7) The Initial Setting Tool will be installed.

(8) Once installation is completed, click [Close].

Note: An Initial Setting Tool shortcut icon will be created on the desktop.
To launch the software, double-click the icon.

196

1) AE-200 Initial Setting Tool

Confirm Installation (el
=
The installer is redy to install AE-200 Irital § etting Tool an your computer,
Click "Next" to start the installation.
Cancel | [ cBack | [ HWews
1) AE-200 Initial Setting Tool =i

Installing AE-200 Initial Setting Tool

AE-200 Inkial Setting Tool is being installed.

Please wai

Cancel

<Back

Next >
) AE-200 Initial Setting Tool = =
Installation Complete [N
P
AE-200 Intial Setting Tool has been successhily instaled.

Click “Close’" to ext,

Please use Windows Updaie o cheek for anp criical updates ta the NET Framewark.

Cancel

<Back




10-1-3. Setting the PC’s IP address
Set the PC’s IP address so that settings data can be sent from the Initial Setting Tool to the AE-200/AE-50/EW-50.
When setting the PC’s IP address, set a network address in the same system as the IP address for the
AE-200/AE-50/EW-50.
(Example: AE-200 IP address: 192.168.1.1; PC IP address: 192.168.1.101)

[1] For Windows 7
(1) Click [Control Panel] in the Start menu. é wmdo;smedi, . —

Control Panel

Calculator ]
il NP} Change settit

Sticky Notes
Default Programs

Snipping Tool
% PPing Help and Support

»  AllPrograms

l Search programs and files ol Shut down | v |

(2) Click [Network and Sharing Center] > [Local Area Connection]. U Local Area Connection Status (===
General

(3) Inthe “Local Area Connection Status” window, click [Properties]. Comc
IPv4 Connectivity: No Internet access
IPv6 Connectivity: No network access
Media State: Enabled
Duration: 00:41:47
Speed: 100.0 Mbps |

Activity
Sent — | — Received |
e
Bytes: 8,418 | 1,084,650
bl
|| (Srmetes) (e ) [ooose ] .
(4) Click [Internet Protocol Version 4 (TCP/IPv4)] to select it, and click § Local Area Connection Propertes )
[Properties]. Networking
Connect using:
¥ Broadcom NetXtreme Gigabit Ethemet ‘
This connection uses the following items: (|

[V 9% Client for Microsoft Networks

451005 Packet Scheduler

4=} File and Printer Sharing for Microsoft Networks
~4- Intemet Protocol Version 6 (TCP/IPv6) L
B et Protocol Version 4 (TCP/IPv4) |

-4 Link-Layer Topology Discovery Mapper 1/0 Driver
<4 Link-Layer Topology Discovery Responder fl

([ osal. ] [ Unnsal | (L Propeties

Description

Transmission Control Protocol/Intemet Protocol. The default f
wide area network protocol that provides communication

across diverse interconnected networks.
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(5) In the [Internet Protocol Version 4 (TCP/IPv4) Properties] window, [1ntemet Protocol version 4 (TCPAPv) Propertes 2]
check the radio button next to [Use the following IP address]. General

You can get IP settings assigned automatically if your network supports
this capability. Otherwise, you need to ask your network administrator
for the appropriate IP settings.

(6) Enter the PC’s IP address (e.g., [192.168.1.101]) in the “IP

(©) Obtain an IP address automatically

” '
address” field. (| @ use the folowing 1p adcress:
‘
| IP address: 192 .168 . 1 .101
Subnet mask: 255 .255.255 . 0

(7) Enter the subnet mask [255.255.255.0] (unless otherwise specified)
in the “Subnet mask” field.

Default gateway:

Obtain DNS server address automatically
@) Usg the following DNS server addresses:
Preferred DNS server:

(8) In the “Default gateway” field, enter the gateway address as

Alternate DNS server:

necessary.
[ validate settings upon exit
Cec )
Important

e Consult the system administrator to decide the IP, subnet mask, and gateway addresses.

(9) Keep clicking [OK] or [Close] to close all windows.

[2] For Windows 8.1
(1) Click the [Desktop] icon on the Start screen.

(2) Double-click the [My Computer] icon on the desktop.

(3) Click [Open Control Panel] in the tool bar.

(4) Click the [Network and Sharing Center] icon.

(5) Click [Change adapter settings].

(6) Double-click the [Ethernet] icon.

(7) In the “Ethernet Status” window, click [Properties].

(8) Click [Internet Protocol Version 4 (TCP/IPv4)] to select it, and click [Properties].

(9) In the [Internet Protocol Version 4 (TCP/IPv4) Properties] window, check the radio button next to [Use the
following IP address]

(10) Enter the PC’s IP address (e.g., [192.168.1.101]) in the “IP address” field.
(11) Enter the subnet mask [255.255.255.0] (unless otherwise specified) in the “Subnet mask” field.

(12) In the “Default gateway” field, enter the gateway address as necessary.
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Important
e Consult the system administrator to decide the IP, subnet mask, and gateway addresses.

(13) Keep clicking [OK] or [Close] to close all windows.

[3] For Windows 10

(1) From the right-click menu of the Start button, click [Control Panel].
The Control Panel will open.

Disk Management
Computer Management
Command Prompt

Command Prompt (Admin)

Task Manager

Control Panel
File Explorer
Search

Run

Shut down or sign out

Desktop

(2) Click the [Network and Sharing Center] icon.

(3) Click [Charge adapter settings]. e
View your basic network information and set up connections

e

Hetwork
Public netwerk

(4) Double-click the [Ethernet] icon.

(5) In the [Ethernet status] window, click [Properties]. U Ethernet Status X
General
Connection
IPv4 Connectivity: No network access
IPv6 Connectivity: No network access
Media State: Enabled
Duration: 00:00:00
Speed: 100.0Mbps
Details...
Activity

Sent L! Received

==
Bytes: 0 0

gPropemes GDisable Diagnose

Close
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(6) Click [Internet Protocol Version 4 (TCP/IPv4)] to select it, and click
[Properties].

(7) In the [Internet Protocol Version 4 (TCP/IPv4) Properties] window,
check the radio button next to [Use the following IP address].

(8) Enter the PC’s IP address (e.g., [192.168.1.101]) in the “IP
address” field.

(9) Enter the subnet mask [255.255.255.0] in the “Subnet mask” field.

(10) In the “Default gateway” field, enter the gateway address as

Networking

Connect using:
(o
=

This connection uses the following items:

22005 Packet Scheduler "
[ & Microsoft Netwark Adapter Multiplexor Protocol

& Microsoft LLOP Protocol Driver

-4 Link-Layer Topology Discovery Mapper 170 Driver

=& Link-Layer Topology Discovery Responder

= Intemet Protocol Version 6 (T £)

- PPN Intemet Protocol Version 4 (TCP/IPvd) l

v
< >
Install .. Uninstall Properties
Description
Transmission Control Protocol/Intemet Protocol. The default
wide area network protocol that provides communication
across diverse interconnected networks.
OK Cancel
Internet Protocol Version 4 (TCP/IPv4) Properties X

General

You can get IP settings assigned automatically if your network supports
this capability. Otherwise, you need to ask your network administrator
for the appropriate IP settings.

(O Obtain an IP address automatically
(®) Use the following IP address:

IP address: 192.168 . 1 .101
Subnet mask: 255.255.255. 0
Default gateway: . . .

Obtain DNS server address automatically

(@) Use the following DNS server addresses:

necessa I’y Preferred DNS server: I:l
Alternate DNS server: l:l
[[] validate settings upon exit R
o[ e
Important

e Consult the system administrator to decide the IP, subnet mask, and gateway addresses.

(11) Keep clicking [OK] or [Close] to close all windows.
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10-1-4. Setting the Web Browser

Web browser setting varies with the Internet connection type. See the sections below for how to make Web browser
settings for different types of Internet connection.

Note: To prevent unauthorized access, always use a security device such as a VPN router when connecting the
AE-200/AE-50/EW-50 to the Internet.

[1] No Internet connection

To monitor and operate the air conditioning units from a PC with no Internet connection, follow the instructions
below to set the environment for the Web browser.

(1) Click [Tools] in the menu bar, then click [Internet options]. m

File Edit View Favorites WIS Help

B Delete browsing history... Ctrl+ ShiftDel
[ The webpag|  InPfivete Brousing CtrleShiftP
Tracking Protection...
ActiveX Fitering
Things to try: Diagnose connection problems...
5 Reopen last browsing session
oo Add site to Start menu
®  Make sure View downloads Ctrl+) k
check marl

Pop-up Blacker 3
SmartScreen Filter »

@ For offl
s Ton TAne [orrrsaitie

Compatibility View
Compatibility View settings

Subscribe to this feed
Feed discovery »
Windows Update

F12 developer tools

Sun Java Console

Intemet options

(2) In the [Internet Options] window, click the [Connections] tab. [internet Options [ERE=)
General | Security | Privacy | Content | Connections | programs | Advanced

To set up an Internet connection, dlick

Setup.

Dial-up and Virtual Private Network settings ———————————————————

(3) Check the radio button next to [Never dial a connection] in the middle

&5 Dial-up Connection Add...
of the window, and click [OK] to close the window.
Remove.

Choose Settings if you need to configure a proxy

server for a connection.

@) Never dial a connection

Dial whenever a network connection is not present.
© Always dial my default connection

Current None Set default

Local Area Network (LAN) settings

LAN Settings do not apply to dial-up connections.
Choose Settings above for dial-up settings.

ok [ concel J[ soov |
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[2] Connecting to the Internet via proxy server using an existing LAN

To monitor and operate the air conditioning units from a PC that connects to the Internet through a proxy server
by connecting to an existing LAN, such as a LAN within your company, follow the instructions below to set the
environment for the Web browser.

(1) Click [Tools] in the menu bar, then click [Internet options]. m

File Edit View FavonlEsHe\p

- Delete browsing history.. CirleShift~Del
[ The webpag  InPrivete Browsing Cirl+Shift+P
Tracking Protection..
ActiveX Filtering
Things to try: Diagnose connection problems.
- Recpen last browsing session
i Add site to Start menu
® Make sure View downloads el [k
checkmarl  pop-up Blocker ,

T SmartSereen Filter 3
® For offline
© Manage add-ons

Compatibility View
Compatibility View settings

Subscribe to this feed...
Feed discovery »
Windows Update

F12 developer tools

Sun Java Console

Internet options

(2) In the [Internet Options] window, click the [Connections] tab. [‘ntemet Options [E==)
|.ceneral [ seauity [ Privacy | Content | Connectons [programs [ Advanced
@ 1s’a ns;tupan Internet connection, dick _ﬂ_

Dial-up and Virtual Private Network settings ——————————

(3) Check the radio button next to [Never dial a connection] in the middle

) &3 Dial-up Connection Add...
of the window.
Remove.

(4) Click [LAN settings] under [Local Area Network (LAN) settings]. ST ertore s

@) Never dial a connection

Dial whenever a network connection is not present.
© Always dial my default connection

Current None Set default

Local Area Network (LAN) settings

LAN Settings do not apply to dial-up connections. LAN settings
Choose Settings above for dial-up settings.

[ ok ][ concel J[ apy ]

(5) In the [Local Area Network (LAN) Settings] window, check [Bypass [Local Area Network (LaN) Settings 1 | ==

proxy server for local addresses], and click [Advanced]. Automatic configuration

Automatic configuration may override manual settings. To ensure the
use of manual settings, disable automatic configuration.

[7] Automatically detect settings
[] Use automatic configuration script

-

Address

Proxy server

Use a proxy server for your LAN (These settings will not apply to
dial-up or VPN connections).

Address:  192.168.1.254  Port: | 8080
Bypass proxy server for local addresses

(S =

(6) In the [Proxy Settings] window, enter the AE-200/AE-50/EW-50’s (proy settings =
IP address (e.g., 192.168.1.1) in the [Exceptions] field. Then, keep S;f_ve's TIPS -
clicking [OK] or [Close] to close all windows. L o i
If connecting multiple AE-200/AE-50/EW-50 units, enter their e = [
addresses (e.g., [192.168.1.1; 192.168.1.2]). It is also possible to use Sogs: :
an asterisk as a wildcard (e.g., [192.168.1.%]). [Z]se the same proxy server for l protocols |

E:Zuw:o not use proxy server for addresses beginning with: ‘
Use semicolons ( ; ) to separate entries.
Cx )
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10-1-5. Java settings
Java settings are required to use the Web Browser for Initial Settings.
[11 How to register exception site list
(1) Click [Control Panel]>[Java].
Note: If [Category] is selected in the top right corner, next to [View by: ], change it to [Large icons] or [Small icons].
(2) Ja.va Control Pa.nel will open. B
Click the [Security] tab.

About

View version information about Java Gantrol Panel

Hetwork ssttines are used when msking Ihtemet connections. By detault, Java will use the
network settings in your web browser. Only advanced users should modify these settines:

Network Settings

Metwark Settings

Temporary Ftermet Files
Files you use in Java applications are stored in a speciel falder for quick execution later. Gnly
advanced users should delete files or madlify these settins

Java in the browser is enabled
See the Security tab

oy

(3) The security setting window will open. U —————
Click the [Edit Site List...] button.

Enable Java content in the browser

[E=EEoR >3

Security level for applications not on the Excention Site list

Wery High - Only Java applications idertified by a certificate from a trusted authority
are allowed to run, and anly if the certificate can be verified as not revoker

@ High - Java applications identified by a certificate fram a trusted authority are
allomed to run, even i the revocation status of the certificate cannat be verified

Exception Site List
Applications launched from the sites listed below will be allowed to run after the appropriate
security prompts
F\mk Edit Site List
o

add items to this list Edit Site List,

Restore Security Frompts | [ Manage Certificates.. |

seply

(4) The [Exception Site List] dialog will appear. e =
Click [Add].

[Click Add to add an tem to this list

inched from the sites listed below will be alloved ta run after the appropriate security promats.

G FILE and HTTP protacs

(5) The [Exception Site List] dialog will appear. [T
In the white box, enter the following, and then click [OK]. .
[ htto://192.168.1.1
http://[IP address of AE-200, AE-50, or EW-50] 3
Note: If the IP address of the AE-200 is [192.168.1.1], enter
[http: //192.168.1.1].
Note: When using HTTPS (SSL) connection, prefix the web address with O ]
[https]. (https: //[IP address of AE-200, AE-50, or EW-50])

from the sites listed below will be allowed to run after the apprapri

(6) The security warning screen will appear. Galalialss, =
C||Ck [Contmue] ) Including an HTTP Location on the Excention Site / ‘ \

List is considered a security risk =

Note: The security warning screen will not appear when HTTPS (SSL)
connection is used. Lacation: it /19215811

Locations that use HTTF are a security risk and may compremise the personal information
on your computer. W recommend including enly HTTFS sites on the Exception Site List.

Glick Gontinue to aceept this loeation or Caneel to abort this chanee.

Gontinue Gancel
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(7) Add all AE-200/AE-50/EW-50 to the list in the same manner, and B c == &5

General | Update | Java| Security [ Advanced

CI |Ck [O K] . EnableJava content in the branser

Security level for applications not on the Exception Site list
*) Very High - Only Java applications identified by a certificate from a trusted authority
are allawed to run, and anly if the certificate can be verified as not revoked.

© High - Java applications identified by a certificate from 2 trusted authority are
2llomed to run, even if the revocation status of the certficate cannot be ver fied.

Exception Site List
Applications launched from the sites listed belon will be allowed to run after the appropriate

secur ity prom
/192 16011 =
itp//192.160.1.212 - Edt e Ll

Restore Security Prompts | [ Manage Gertificates.. |

(8) If a PC with 32-bit OS is used, after completing the settings, close all Internet Explorer windows, and access
the Web page again to make sure the appropriate window will appear.
If a PC with 64-bit OS is used, go to step (9) below.

(9) Click [My Computer]>[Local Disk (C:)]>[Program Files (x86)]"'>[Java]>[jre*] (The asterisk indicates a version
number. (i.e., jre1.8.0_31))>[bin] to open the [bin] folder.

*1 If a PC with 64-bit OS is used, both [Program Files] and [Program Files (x86)] folders will appear. Make sure to select [Program
Files (x86)].

(10) Double click the “javacpl.exe” file in the [bin] folder.
(11) Java Control Panel will open. Follow the steps (3) through (8) again.

[2] How to enable Java content

(1) Open the security setting window. (See [1] “How to register exception site list”.)

(2) Click on the checkbox next to [Enable Java content in the browser] L e e
unless it is already checked.
Click [Apply] at the right bottom corner of the screen, and then click S

are allawed to run, and anly if the certificate can be verified as not revaked.

@ High - Java applications identified by a certificate from a trusted authority are
allowed to run, even if the revocation status of the certificate cannot be verified.

Exception Site List
Applications launched from the sites listed belon will be allowed to run after the appropriate

Curity prompts.

thp:/7 192 160.1.1 =

/71921661211
/7 192.168.1.212 o Edit Site List

Restore Security Prompts | [ Manage Certificates.. |

(3) After completing the settings, close all Internet Explorer windows, and access the Web page again to make
sure the appropriate window will appear.
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11.Explanation of terms

This explains terms used in this manual.

* AE-200 system
This indicates one AE-200 connected to 0 to 4 AE-50/EW-50 expansion controllers.
System configurations are as follows.

m AE-200 (independent)

A system that does not use an expansion controller.
Use this configuration when not using the apportioned electricity billing function, with up to 50 units managed,
and controlled from the LCD.

(L]

M-NET [’m_l

AE-200

m AE-200

A system that uses 1 to 3 expansion controllers.
Use this configuration when not using the apportioned electricity billing function, with 50 or more units
managed.

LAN M-NET

(L]

— i 1
AE-200

M-NET Rm_l

AE-50/EW-50

m AE-200 (No M-NET)

A system that uses 1 to 4 expansion controllers.

Use this configuration when not using the apportioned electricity billing function, with 50 or more units
managed, and with the management room far from the indoor units, with electric power not reaching from the
AE-200 to the indoor units.

LAN

M-NET =
= : LN
: m

AE-200

l 1 M-NET =

,—
n

AE-50/EW-50
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m AE-200 (Billing)

A system that uses 1 to 4 expansion controllers.
Use this configuration when using the apportioned electricity billing function.

- - LAN M-NET =
m
' : L m I
| M-NET =
L | = p—
r > ( Im
AE-200 m I

m—_
|

]

m—_
|

]

AE-50/EW-50

* EW-50 system

This indicates a single EW-50 unit.
Use this configuration when not using the apportioned electricity billing function, with up to 50 units managed,
not using the LCD, and controlled from the Integrated Centralized Control Web.

« BACnet® Setting Tool
The BACnet® Setting Tool is used for configuring BACnet® functions from a PC.
This allows separate configuration of single AE-200/AE-50/EW-50 units.
For how to use the BACnet® Setting Tool, refer to the Instruction Book (BACnet® Setting Tool).
*BACnet®is a registered trademark of ASHRAE (American Society of Heating, Refrigerating and Air-Conditioning Engineers, INC.).

» Group
Groups are the smallest operational units. The same operation as with local remote controllers.
Control 1 to 16 units together.

* Block (Operation block)
Blocks are multiple groups grouped together.
It is possible to create blocks by partition or room, for batch monitoring and operation.
Control 1 to 50 groups together. However, blocks that cover AE-200/AE-50/EW-50 cannot be configured.

* Energy management block
An energy management block combines multiple operation blocks and OA Processing units (FU).
This is the unit at which AE-50/EW-50 are together managed, and using the apportioned electricity billing function,
at which the electric energy and billing calculation results are displayed and output.
Create energy management blocks by units such as tenant or floor, enabling batch monitoring, control, and
management of electric energy and billing.
Control 1 to 200 operations groups together. However, energy management blocks that cover AE-200/EW-50
systems cannot be configured.
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AE-200

¢’ Energy management block

\

(Energy management block \

Operation block

|
(o]

Processing

unit (FU)

AE-200

M-NET | | Operation block
P
— ) 2 Group Group Group
\\
Indoor unit
A \Z —/
fEnergy management block \
Operation block Operation block
Group Group Group
Indoor unit
(Energy management block \
Operation block
M-NET Group Group
Indoor unit

=

_/
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* Main and Sub system controllers

Each group can be controlled by a Main system controller or a Sub system controller.
AE-200/AE-50 is exclusively for use as a Main system controller and cannot be used as a Sub system controller.

Main system controller
Main system controller refers to a system controller that controls all other system controllers including the units

they control. If a given system has only one system controller, that controller becomes a Main system controller.
Group settings and interlock settings can be made only from a Main system controller.

Sub system controller
Sub system controller refers to a system controller that is controlled by a Main system controller.

Main system controller's
(AE-200/AE-50's) control range

Sub system controller's
control range

Group | | Group |

The system cannot be configured as shown in the examples below.

e Groups that are not under the control of a Main system controller cannot be controlled from a Sub system controller.

Main system Sub system
controller controller

e Each group cannot be placed under the control of two or more Main system controllers.

Main system
controller 1

Main system
controller 2

e Sub system controllers cannot be placed under the control of two or more Main system controllers.

Main system Sub system Main system

controller 1 controller controller 2
* License

A license may be required for AE-200/AE-50/EW-50 depending on the functions used.

Licenses required will differ depending on the functions used. Please contact your dealer as regards license types
and purchasing.

Refer to section 4-5 “License registration for optional functions” for license registration method.
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Error code list

Error codes that can be detected with AE-200/AE-50 (EW-50) and their definitions are shown below.
Refer to [3] “Errors on other related equipment” for errors on DIDO controller or AHC.

For other error codes, refer to the manual of the equipment of the error source address.

If an error occurs, note the error code and consult your dealer.

[1] M-NET errors

6600  Communication error - Address duplicate

6601 Communication error - Polarity unsettled

6602  Communication error - Transmission processor hardware error

6603  Communication error - Transmission line busy

6604  Communication error - No ACK (06H) (communication circuit error)
6605  Communication error - No response frame

6606  Communication error - Transmission processor communication error
6607  Communication error - No ACK return

6608  Communication error - No return of response frame

[2] AE-200 and AE-50 (EW-50) errors

0092  Version combination error

0093  System configuration change warning

0094  “Charge” license not registered

0095  Warning - possibility of damaged metering device

0096  Air conditioning charges file automatic output abnormality
0097  Apportioned calculation data collection error

6920  Communication error - No response error

6922  Communication error - Receiving frame ID error

7106  System abnormality - Attribute setting error

7109  System abnormality - Connection setting error

7130  System abnormality - Different unit model error

7901  System abnormality - Excessive number of connected units
7902  System abnormality - Connection lock error

7903  System abnormality - Unit information error

7904  System abnormality - System setting error

7905  System abnormality - Version error/Different unit model error

[3] Errors on other related equipment

0100  Equipment abnormality
01*0 Equipment abnormality (PAC-YG66DCA) in system *
01** Equipment abnormality in system **

(When these errors occur on the DIDO controller (PAC-YG66DCA), the error code will not appear, but the error status display
LED on the DIDO controller of the system in error will light up.)
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Appendix 1: Air-conditioner ON/OFF trial run

After the centralized controllers are installed, a check sheet can be output to be used for air-conditioner ON/OFF

trial runs.
Click [Option] > [Output - Check sheet for air-conditioner ON/OFF trial run] in the tool bar of the Initial Setting Tool to

output the check sheet for each AE-200 system.
Note: When the PC with Initial Setting Tool installed and the centralized controller are connected via a LAN, the license registration
status can be output in the check sheet.

[1] Centralized controller
Output this check sheet for each AE-200 system.

Check sheet for air-conditioner ON/OFF trial run Site name I I Output date: 2016/04/04 13:58 Da

Initial Setiing (1) (2)
Tool SIW Ver
120
~
Centralized Centralized
IP address Name UnitID SERIAL No. SIW Ver Charge TenantPersonal Web Maintenance Tool
controller No. controller
Status Period Status Period Status Period
1 AE-200 192.168.1.1 AE-200 000001 00000-001 7.40 Not available o Available Unlimited Not available ]
Expansion
-1 controller 192.168.1.211 AE-50-1 000002 00000-002 7.40 Not available 0 Available Unlimited Not available 0
Expansion
12 ontroller 192.168.1.212 AE-50-2 000003 00000-003 7.40 Not available 0 Available Unlimited Not available 0
Expansion
-3 ontroller 192.166.1.213 AE-50-3 000004 00000-004 7.40 Not available o Available Unlimited Not available 0
[ Date of triai run | | Personincharge | Operated by Approved by
Optional function usage status
Maintenance Tool Advanced PLC for General Equipments Energy Management License Pack Interlock control Super User Outdoor Unit Status Menitor BACnet connection Inte
Status Period Status Period Status. Period Status. Period Status Period Status Period Status Period
Nt available 0 Nt available 0 Notavailable 0 Notavailable o Nt available 0 Not available o Not available 0
Nt available 0 Nt available 0 Notavailable 0 Notavailable o Nt available 0 Not available o Not available 0
Not available 0 Not available 0 Not available 0 Not available o Not available 0 Not available o Not available 0
Not available 0 Not available 0 Notavailable 0 Not available o Not available 0 Not available 0 Not available 0
-

@)

Integrated Centralized Control Web
Status Period
Available Unlimited
Available Unlimited
Available Unlimited
Available Unlimited

(1) Checking the connection configuration
Check for proper IP addresses and software versions.
(2) Checking the license

Check that all required licenses are registered.
Note: To check the license registration status, output the check sheet when the PC with Initial Setting Tool installed and the
centralized controller are connected via a LAN.
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[2] Unit - Controller
Output this check sheet for each AE-200/AE-50/EW-50.

Check sheet for air-conditioner ONJOFF trial run [ Site name | Qutput date: 2016/04/04 13:58
-
Floor information Unitinformation Group information
Centralized Outdoor unit Remole controller| _ Interlocked
Floor No. Floor name controler Mo Adreee Outdoor unit model name | Indoor unit address|  Indoor unit mode! name Unittype addrese LOSSNAY addrsss Mo Name
1 Floor1 1-1 51 PUHY-P250YKB-AT 1 PLFY-P1SVFM-E Air-conditioner 101 1 TenantA
1 Floor1 11 51 PUHY-P250YKB-A1 2 PLFY-P15VFM-E Air-conditioner 102 2 Tenant B
2 Floor2 11 52 PUHY-P250YKB-A1 3 PLFY-P1SVFM-E Air-conditioner 103 3 TenantC
2 Floor2 11 52 PUHY-P250YKB-AT 4 PLFY-P16VFM-E Air-conditioner 104 4 Tenant D
2 Floor2 11 52 PUHY-P250YKE-AT 5 PLFY-P16VFM-E Air-conditioner 105 5 TenantE
1 Floor1 1-1 6 LGH-50RVX-E LOSSNAY 106 6 Communal area
.
[[Date oftrial un [Person in charge] |
\
Energy management block Centralized controller = Air- Local remote controller >
Block information
information conditioner operation check [Centralized controller display checl
. Error display N Error display
No. Name No. Name Individual group ook Individual group heck

1 Tenant ABC 1 Tenant ABC

1 Tenant ABC 1 Tenant ABC

1 Tenant ABC 1 Tenant ABC

2 Tenant DE 2 Tenant DE

2 Tenant DE 2 Tenant DE

=

(1) Checking the group configuration

Check for proper group registration and unit information of the unit.

(2) Checking the block configuration

Check for proper block configuration of the unit.

(3) Checking the energy management block (EM block) configuration

Check for proper energy management block (EM block) configuration of the unit.

(4) Checking the floor configuration

Check for proper floor configuration of the unit.

(5) Checking the operation between centralized controllers and air conditioning units

Check the operation status of centralized controllers and air conditioning units by turning on/off the units or

generating an error, and check for proper settings and connections.

(6) Checking the operation between centralized controllers and local remote controllers

Check the display of centralized controllers and local remote controllers by turning on/off the units or generating

an error, and check for proper settings and connections.
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[3] General Equipment
Output this check sheet for each AE-200 system.

Check sheet for air-conditioner ONJOFF trial run | Site name Output date: 2016/04/04 13:58
Floor information Unit information Function settings Group information Block information En
Centralized
Floor No. Floor name Address Ch. Allow Operations Monitor No. Name No. Name
controller No.

N Il

1 Floor1 11 1 1 (N?;‘i’t'za;;';? Output status 41 Keycard lock 1
No operations

2 Floor2z 11 41 2 P QOutput status 42 Keycard lock 2
(Monitor only)

[ Date of trial run | [ Person in charge [ ]

. .

Energy block Check item
Operation display | Ermor display
check check

No. Name

(1) Checking the group configuration
Check for proper group registration and unit information for the general equipment contact.
(2) Checking the block configuration
Check for proper block configuration for the general equipment contact.
(3) Checking the energy management block (EM block) configuration
Check for proper energy management block (EM block) configuration for the general equipment contact.
(4) Checking the floor configuration
Check for proper floor configuration for the general equipment contact.
(5) Checking the operation between centralized controllers and air conditioning units

Check the operation status of centralized controllers and general equipment by turning on/off the general
equipment contact or generating an error, and check for proper settings and connections.
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[4] PI Controller
Output this check sheet for each AE-200 system.

Gheck sheet for air-conditioner ONIOFF trial run | __Sie name ] Outputdate: 2016104104 1358 Dasorann Fersonincrargs ]
Unit information Check item
Centralized Measurement
A cn N unit Pussweignt | Unit
controller No. ress ame nittype uise welg ! display check
1-1 49 1 WHM OU Outdoor unit 1 KWh
1-1 49 2 WHM U Indoor unit 1 kWh
\C

(1) Checking the metering device
Check for proper type and settings for the metering device.
(2) Checking the operation of the metering device

Check for proper settings and connections between the centralized controllers and metering device by letting the
metering device count up.

[5] Al Controller
Output this check sheet for each AE-200 system.

Gheck sheet for air-conditioner ONIOFF trial run [ _Site name. Output date: 2016/04/04 1355 [Date orvaun Person in charge
[ Alertsefings A4 Check item
Centralized Messurement | Measurement Upper limit| Upper imit | Lower lmit| Lower iMoo roment | aertaispia
comotlrh. | ress o Name | Sersortpe | | angeapperimy | OBt | O | e | on | o (R AT
o e up threshold) | threshold) | threshold) | thresholc)f| “*P%
- 50 1 Outdoor lemp. | TSP -1000 1000 00
sensor
- 50 2 Outdoor humid. | Humidity sensor 00 1000 0o

(1) Checking the sensors
Check for proper type and settings for the sensors.
(2) Checking the operation of the sensors

Check for proper settings and connections between the centralized controllers and sensors by operating the
sensors.
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Appendix 2: Added functions

Version Added function Descriptions Reference
. Sets the Peak Cut settings. B
LCD Peak Cutsettings | 50, is selectable for outdoor unit 5-2-1"Peak Cut (EneEgy-
1 . save control function)
Ver. 7.2 capacity save amount.
Web Browser for Peak Cut settings | 50% is selectable for outdoor unit 7-2-2 “Peak Cut (Energy-
Initial Settings 1 capacity save amount. save control function)”
Displays the detection of communication
Network settings | error on expansion controllers AE-50/ 5-1-5 “Network”
EW-50.
Energy Units under the control of AE-200, AE-50,
management and EW-50 can be placed in the same 5-1-10 “EM Blocks”
LCD block block.
Sets the display or non-display of
Ver. 7.3 Floor Layout gridlines and the distance of icon 5-1-11 “Floor Layout”
movement.
Ven.t||at|on Sets Night purge on OA processing units. | 5-4 “Ventilation setting”
settings
Initial Setting Tool . Sets the floor layout for AE-200/AE-50 « N
(Ver. 1.1) Floor settings and Integrated Centralized Control Web. 6-5 “Floor Settings
Web Browser for Ventilation . . . “ _— N
Initial Settings settings Sets Night purge on OA processing units. | 7-5 “Ventilation Settings
. o Sets the display/non-display of room
LCD Alr. cond-ltlonlng temperature and set temperature on the | 5-1-4 “Unit Information”
unit settings .
[Floor] window.
Sets the display/non-display of room
Display settings temperature and set temperature on the | 6-3-2 “Basic System settings”
[Floor] window.
. . Copies the group settings to the block
Ver. 7.4 Initial Setting Tool Block settings settings when setting them to the same 6-4-4 “Block settings”
(Ver. 1.2) .
settings.
Energy Copies the block settlngs to the energy 6-4-5 “Energy management
management management block settings when setting block settings”
block settings them to the same settings. 9
Sets the display/non-display of room
W.e.b Browser for Display settings temperature and set temperature on the | 7-1-2 “Basic System”
Initial Settings .
[Floor] window.
Group settings Sets the chiller units to groups. 5-1-6 “Groups”
HW Supply Sets the HWHP (QAHV) units to groups. | 5-1-7 “HW Supply”
LCD settings
. T Enables the display of both the room
Air conditioning | i P
. - temperature and the set temperature on | 5-1-4 “Unit Information
unit settings .
the [Floor] window.
Enables the display of both the room
Display settings temperature and the set temperature on | 6-3-2 “Basic System settings”
- ) the [Floor] window.
Ver. 7.5 I(Q/l(talfI1S§)ttlng Tool Group settings Sets the chiller units to groups. 6-4-1 “Group settings”
Interlock Control Sets the Interlocking Control settings
. N for units under the control of different 6-7 “Interlock Control”
settings 2 .
expansion controllers.
Group settings Sets the chiller units to groups. 6-4-1 “Group settings”
Enables the display of both the room
Web Browser for Display settings temperature and the set temperature on | 7-1-2 “Basic System”
Initial Settings the [Floor] window.
Interlock*ControI The setting function was deleted. -
settings "2

*1 “Saving Energy Control (Peak Cut)” license is required to use the function.

*2 “Interlock control” license is required to use the function.
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This product is designed and intended for use in the residential,
commercial and light-industrial environment.

The product at hand is based on the following EU regulations:
* Low Voltage Directive 2014/35/EU
* Electromagnetic Compatibility Directive 2014/30/EU
* Restriction of Hazardous Substances 2011/65/EU

Please be sure to put the contact address/telephone number
on this manual before handing it to the customer.

MITSUBISHI ELECTRIC CORPORATION

HEAD OFFICE: TOKYO BLDG., 2-7-3, MARUNOUCH]I, CHIYODA-KU, TOKYO 100-8310, JAPAN
MANUFACTURER: MITSUBISHI ELECTRIC CORPORATION Air-conditioning & Refrigeration Systems Works
5-66, Tebira 6 Chome, Wakayama-city, 640-8686, Japan
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